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Preface

Intended Audience

This manual is for programmers at all levels of experience. It covers all user
interfaces of the OpenVMS Debugger:

e The command interface for terminals and workstations
e The HP DECwindows Motif for OpenVMS user interface for workstations
e The Microsoft Windows PC client interface

The OpenVMS Debugger on OpenVMS Alpha systems can access all the extended
memory made available by the 64-bit processing of the OpenVMS Alpha operating
system. Hence, you can examine and manipulate data in the complete 64-bit
address space.

The OpenVMS Debugger has been internationalized. For Asian users, the
debugger’s HP DECwindows Motif for OpenVMS, command line, and screen mode
user interfaces can be used with multibyte characters.

You can use the debugger to debug code only in user mode. You cannot debug
code in supervisor, executive, or kernel modes.

Document Structure
This manual is organized as follows:
e Part I introduces the OpenVMS Debugger. Part I contains one chapter:
— Chapter 1 introduces the debugger.

e Part II describes the debugger’s command interface. Part II includes the
following chapters:

— Chapter 2 gets you started using the debugger.

— Chapter 3 explains how to control and monitor program execution.

— Chapter 4 explains how to examine and manipulate program data.

— Chapter 5 explains how to control access to symbols in your program.
— Chapter 6 explains how to control the display of source code.

— Chapter 7 explains how to use screen mode.

e Part III describes the debugger’s HP DECwindows Motif for OpenVMS user
interface. Part III includes the following chapters:

— Chapter 8 gives an overview of its HP DECwindows Motif for OpenVMS
user interface features.

XXiii



— Chapter 9 explains how to prepare your program for debugging and then
start and end a debugging session using the HP DECwindows Motif for
OpenVMS user interface.

— Chapter 10, which is organized by task, explains how to use the debugger
via the HP DECwindows Motif for OpenVMS user interface.

Part IV describes the debugger’s PC interface. Part IV contains one chapter:
— Chapter 11 gives an overview of the debugger’s PC interface.

Part V describes advanced debugging topics. Part V includes the following
chapters:

— Chapter 12, which is organized by task, explains how to use the
debugger’s Heap Analyzer.

— Chapter 13 explains additional convenience features, such as key
definitions and other customizations.

— Chapter 14 explains some special cases, such as debugging optimized
programs and multilanguage programs.

— Chapter 15 explains how to debug multiprocess programs.
— Chapter 16 explains how to debug tasking (multithread) programs.
Part VI is the debugger command dictionary, followed by the appendixes:

— Appendix A lists the keypad-key definitions that are predefined by the
debugger.

— Appendix B identifies all of the debugger built-in symbols and logical
names.

— Appendix C identifies the debugger support for languages.

— Appendix D contains the source code of the programs shown in the figures
in Chapters 8, 9, and 10.

Related Documents

The following documents may also be helpful when using the debugger.
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Programming Languages
This manual emphasizes debugger usage that is common to all or most supported
languages. For more information specific to a particular language, see:

The debugger’s online help system (see Section 2.1)

The documentation supplied with that language, particularly regarding
compiling and linking the program for debugging

The VAX MACRO and Instruction Set Reference Manual or the MACRO-64
Assembler for OpenVMS AXP Systems Reference Manual for information
about assembly-language instructions and the MACRO assembler

Linker Utility

For information about the linking of programs or shareable images, see the
OpenVMS Linker Utility Manual.



Delta/XDelta Debugger

For information about debugging code in supervisor, executive, or kernel modes
(that is, in other than user mode), see the OpenVMS Delta /XDelta Debugger
Manual in the OpenVMS documentation set. This manual contains information
about debugging programs that run in privileged processor mode or at an elevated
interrupt priority level.

OpenVMS Alpha System-Code Debugger

See the OVMS_ALPHA_SYS_ANALYS_TLS_MAN for information on debugging
operating system code. This manual describes how to activate the OpenVMS
System-Code Debugger through the OpenVMS Debugger, and debug within the
OpenVMS System-Code Debugger environment.

For information on the OpenVMS System-Code Debugger-specific commands, see
the CONNECT and REBOOT commands in Part VI.

HP DECwindows Motif for OpenVMS

For general information about the HP DECwindows Motif for OpenVMS user
interface, see the Using DECwindows Motif for OpenVMS.

For additional information about HP OpenVMS products and services, visit the
following World Wide Web address:

http://www.hp.com/go/openvms

Reader’s Comments
HP welcomes your comments on this manual. Please send comments to:

openvmsdoc@hp.com

How to Order Additional Documentation

For information about how to order additional documentation, visit the following
World Wide Web address:

http://www.hp.com/go/openvms/doc/order

Conventions

VMScluster systems are now referred to as OpenVMS Cluster systems. Unless
otherwise specified, references to OpenVMS Clusters or clusters in this document
are synonymous with VMSclusters.

In this manual, every use of DECwindows and DECwindows Motif refers to HP
DECwindows Motif for OpenVMS software.

This manual contains many figures showing the DECwindows Motif user
interface to the debugger. Because the display configuration of this interface is
customizable, these figures may not exactly picture the appearance of debugger
displays on your system.

The examples in this manual have not been updated to reflect the fact that the
OpenVMS Debugger on OpenVMS Alpha systems can access all the extended
memory made available by the 64-bit processing of the OpenVMS Alpha operating
system. You should note that hexadecimal addresses are 16-digit numbers on
Alpha. For example,
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DBG> EVALUATE/ADDRESS/HEX $hex 000004A0
00000000000004A0
DBG>

The following conventions are also used in this manual:

Ctrl/x A sequence such as Ctrl/x indicates that you must hold down
the key labeled Ctrl while you press another key or a pointing
device button.

PF1 x or A sequence such as PF1 x or GOLD x indicates that you must
GOLD x first press and release the key labeled PF1 or GOLD and then
press and release another key or a pointing device button.

GOLD key sequences can also have a slash (/), (-), or
underscore (_) as a delimiter in EVE commands.

In examples, a key name enclosed in a box indicates that
you press a key on the keyboard. (In text, a key name is not
enclosed in a box.)

In the HTML version of this document, this convention appears
as brackets, rather than a box.

A horizontal ellipsis in examples indicates one of the following
possibilities:

e Additional optional arguments in a statement have been
omitted.

e The preceding item or items can be repeated one or more
times.

e Additional parameters, values, or other information can be
entered.

A vertical ellipsis indicates the omission of items from a code
example or command format; the items are omitted because
they are not important to the topic being discussed.

) In command format descriptions, parentheses indicate that you
must enclose the options in parentheses if you choose more
than one.

[] In command format descriptions, brackets indicate optional

choices. You can choose one or more items or no items.

Do not type the brackets on the command line. However,
you must include the brackets in the syntax for OpenVMS
directory specifications and for a substring specification in an
assignment statement.

In command format descriptions, vertical bars separate choices
within brackets or braces. Within brackets, the choices are
optional; within braces, at least one choice is required. Do not
type the vertical bars on the command line.

{} In command format descriptions, braces indicate required
choices; you must choose at least one of the of the items listed.
Do not type the braces on the command line.

bold text This typeface represents the introduction of a new term. It
also represents the name of an argument an attribute, or a
reason.
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italic text

UPPERCASE TEXT

Monospace text

numbers

Italic text indicates important information, complete titles

of manuals, or variables. Variables include information that
varies in system output (Internal error number), in command
lines (/PRODUCER=name), and in command parameters in
text (where dd represents the predefined code for the device

type).

Uppercase text indicates a command, the name of a routine,
the name of a file, or the abbreviation for a system privilege.

Monospace type indicates code examples and interactive screen
displays.

In the C programming language, monospace type in text
identifies the following elements: keywords, the names

of independently compiled external functions and files,

syntax summaries, and references to variables or identifiers
introduced in an example.

A hyphen at the end of a command format description,
command line, or code line indicates that the command or
statement continues on the following line.

All numbers in text are assumed to be decimal unless
otherwise noted. Nondecimal radixes—binary, octal, or
hexadecimal—are explicitly indicated.
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Partl

Introduction to the Debugger

This part introduces the Debugger.






1

Introduction to the Debugger

This chapter briefly describes the command interface of the OpenVMS Debugger,
and provides the following information:

e An overview of debugger features

e Instructions to compile and link your program for debugging
e Instructions to start and end a debugging session

e A list of the debugger commands grouped by function

For a tutorial introduction to basic debugging tasks, see Chapter 2.

1.1 Overview of the Debugger

The OpenVMS Debugger is a tool to locate run-time programming or logic errors,
also known as bugs, in a program that has been compiled and linked successfully
but does not run correctly. For example, the program might give incorrect output,
go into an infinite loop, or terminate prematurely.

By using the OpenVMS Debugger, you can locate program bugs by observing
and manipulating the program interactively as it executes. Debugger commands
enable you to:

e Control and observe execution of the program

e Display and browse through the source code of the program to identify
instructions and variables worth scrutiny

e Suspend program execution at specified points in order to monitor changes in
variables and other program entities

e (Change the value of a variable and, in some cases, test the modification
without having to edit the source code, recompile, and relink

e Trace the execution path of the program
e Monitor exception conditions and language-specific events

These are basic debugging techniques. After locating program errors, you can
edit the source code and compile, link, execute, and test the corrected version.

As you use the debugger and its documentation, you will discover and develop
variations on the basic techniques. You can also customize the debugger for your
own needs. Section 1.1.1 summarizes the features of the OpenVMS Debugger.

1-1
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1.1.1 Functional Features

Programming Language Support

On Alpha processors, you can use the debugger with programs written in the
following Compaq languages:

Ada BASIC BLISS C
C++ COBOL Fortran MACRO-32!
MACRO-64 Pascal PL/1

INote that MACRO-32 must be compiled with the AMACRO compiler.

On Integrity server, you can use the debugger with programs written in the
following Compaq languages:

Assembler (IAS) BASIC BLISS C
C++ COBOL Fortran MACRO-32!
IMACRO PASCAL

INote that MACRO-32 must be compiled with the AMACRO compiler.

The debugger recognizes the syntax, data types, operators, expressions, scoping
rules, and other constructs of a supported language. You can change the
debugging context from one language to another (with the SET LANGUAGE
command) during a debugging session.

Symbolic Debugging

The debugger is a symbolic debugger. You can refer to program locations by the
symbols used in your program—the names of variables, routines, labels, and so
on. You can also specify explicit memory addresses or machine registers if you

choose.

Support for All Data Types

The debugger recognizes the data types generated by the compilers of all
supported languages, such as integer, floating-point, enumeration, record, array,
and so on, and displays the values of each program variable according to its
declared type.

Flexible Data Format

With the debugger, you can enter and display a variety of data forms and data
types. The source language of the program determines the default format for the
entry and display of data. However, you can select other formats as needed.

Starting or Resuming Program Execution

Once the program is under control of the debugger, you can start or resume
program execution with the GO or STEP command. The GO command causes
the program to execute until specified events occur (the PC points to a designated
line of code, a variable is modified, an exception is signaled, or the program
terminates). You can use the STEP command to execute a specified number
instructions or lines of source code, or until the program reaches the next
instruction of a specified class.

Breakpoints

You can set a breakpoint with the SET BREAK command, to suspend program
execution at a specified location in order to check the current status of the
program. You can also direct the debugger to suspend execution when the
program is about to execute an instruction of a specific class. You can also
suspend execution when certain events occur, such as exceptions and tasking
(multithread) events.
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Tracepoints

You can set a tracepoint with the SET TRACE command, to cause the debugger
to report each time that program execution reaches a specified location (that is,
each time the program counter (PC) references that location). As with the SET
BREAK command, you can also trace the occurrence of classes of instructions
and monitor the occurrence of certain events, such as exceptions and tasking
(multithread) events.

Watchpoints

You can set a watchpoint with the SET WATCH command to cause the debugger
to suspend program execution whenever a particular variable (or other specified
memory location) has been modified, at which point the debugger reports the old
and new values of the variable.

Manipulation of Variables and Program Locations

You can use the EXAMINE command to determine the value of a variable or
memory location. You can use the DEPOSIT command to change that value. You
can then continue execution of the program to determine the effect of the change
without having to recompile, relink, and rerun the program.

Evaluation of Expressions

You can use the EVALUATE command to compute the value of a source-language
expression or an address expression in the syntax of the language to which the
debugger is currently set.

Control Structures

You can use logical control structures (FOR, IF, REPEAT, WHILE) in commands
to control the execution of other commands.

Shareable Image Debugging

You can debug shareable images (images that are not directly executable). The
SET IMAGE command enables you to access the symbols declared in a shareable
image (that was compiled and linked with the /DEBUG qualifiers).

Multiprocess Debugging

You can debug multiprocess programs (programs that run in more than one
process). The SHOW PROCESS and SET PROCESS commands enable you to
display process information and to control the execution of images in individual
processes.

Task Debugging

You can debug tasking programs (also known as multithread programs). These
programs use Compaq POSIX Threads Library or POSIX 1003.1b services, or
use language-specific tasking services (for example, Ada tasking programs). The
SHOW TASK and SET TASK commands enable you to display task information
and to control the execution of individual tasks.

Terminal and Workstation Support
The debugger supports all VT-series terminals and VAX workstations.

1.1.2 Convenience Features

Online Help

Online help is always available during a debugging session. Online help contains
information about all debugger commands and additional selected topics.
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Source Code Display

During a debugging session, you can display the source code for program modules
written in any of the languages supported by the OpenVMS Debugger.

Screen Mode

In screen mode, you can capture and display various kinds of information in
scrollable display units. You can move these display units around the screen and
resize them as needed. Automatically updated source, instruction, and register
displays units are available. You can selectively direct debugger input, output,
and diagnostic messages to specific display units. You can also create display
units to capture the output of specific command sequences.

Kept Debugger

The kept debugger enables you to run different program images or rerun

the same image from the current debugging session without having to first
exit and restart the debugger. When you rerun a program, you can choose to
retain or cancel any previously set breakpoints, as well as most tracepoints and
watchpoints.

DECwindows Motif User Interface

The OpenVMS Debugger has an optional HP DECwindows Motif for OpenVMS
graphical user interface (GUI) that provides access to common debugger
commands by means of pushbuttons, pulldown menus, and popup menus. The
GUI is an optional enhancement to the debugger command line interface that is
available on workstations running DECwindows Motif. When using the GUI, you
have full command-line access to all debugger commands that are relevant within
a DECwindows Motif environment.

Microsoft Windows Interface

The OpenVMS Debugger has an optional client/server configuration that allows
you to access the debugger and its functions from a PC running on your supplied
Microsoft operating system. This debugger implementation has a debug server
that runs on OpenVMS on an Alpha or Integrity server CPU, and a debug client
interface that runs on Microsoft operating systems on an Intel or Alpha CPU.

Client/Server Configuration

The client/server configuration allows you to debug programs that run on an
OpenVMS node remotely from another OpenVMS node using the DECwindows
Motif user interface, or from a PC using the Microsoft Windows interface. Up to
31 debug clients can simultaneously access the same debug server, which allows
many debugging options.

Keypad Mode

When you start the debugger, several predefined debugger command sequences
are assigned to the keys of the numeric keypad of the VT52, VT'100, and LK201
keyboards. You can also create your own key definitions.

Source Editing

As you find errors during a debugging session, you can use the EDIT command
to use any editor available on your system. You can specify the editor with the
SET EDITOR command. If you use the Language-Sensitive Editor (LSE), the
editing cursor is automatically positioned within the source file corresponding to
the source code that appears in the screen-mode source display.
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Command Procedures

You can direct the debugger to execute a command procedure (a file of debugger
commands) to re-create a debugging session, to continue a previous session, or
to avoid typing the same debugger commands many times during a debugging
session. In addition, you can pass parameters to command procedures.

Initialization Files

You can create an initialization file that contains debugger commands to set
default debugging modes, screen display definitions, keypad key definitions,
symbol definitions, and so on. Upon startup, the OpenVMS Debugger
automatically executes the initialization file to create the predefined debugging
environment.

Log Files

You can create a log file to contain a record of command input and debugger
output. You can then use the log file to analyze the debugging session, or edit the
file for use as a command procedure in subsequent debugging sessions.

Symbol Definitions

You can define your own symbols to represent lengthy commands, address
expressions, or values in abbreviated form.

1.2 Preparing an Executable Image for Debugging

To take full advantage of symbolic debugging, you must first compile and link the
program’s modules (compilation units) using the compiler and linker /DEBUG
qualifiers as explained in Section 1.2.1 and Section 1.2.2.

1.2.1 Compiling a Program for Debugging

Example 1-1 shows how to compile (for debugging) a C program, FORMS.EXE,
that consists of two source modules: FORMS.C and INVENTORY.C. FORMS.C is
the main program module.

Example 1-1 Compiling a Program with the /DEBUG Qualifier
$ CC/DEBUG/NOOPTIMIZE INVENTORY,FORMS

Note that the /DEBUG and /NOOPTIMIZE qualifiers are compiler command
defaults for some languages. These qualifiers are used in the example for
emphasis. (For information about compiling programs in a specific language, see
the documentation for that language.)

The /DEBUG qualifier in the compiler command in Example 1-1 directs

the compiler to include the symbol information associated with FORMS.C

and INVENTORY.C in object modules FORMS.OBJ and INVENTORY.OBJ,
respectively. This enables you to refer to the symbolic names of variables,
routines, and other declared symbols while debugging the program. Only object
files created with the /DEBUG qualifier contain symbol information. You can
control whether to include all symbol information or only that required to trace
program flow (see Section 5.1.1).
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Some compilers optimize the object code to reduce the size of the program or
to make it run faster. In such cases the object code does not always match the
source code, which can make debugging more difficult. To avoid this, compile
the program with the /NOOPTIMIZE command qualifier (or equivalent). After
the nonoptimized program has been debugged, you can recompile and test it
again without the /INOOPTIMIZE qualifier to take advantage of optimization.
Section 14.1 describes some of the effects of optimization.

1.2.2 Linking a Program for Debugging

Example 1-2 shows how to link a C program, FORMS.EXE that consists of two
source modules: FORMS.C and INVENTORY.C. FORMS.C is the main program
module. Both source modules were compiled with the /DEBUG qualifier (see
Example 1-1).

Example 1-2 Linking a Program with the /DEBUG Qualifier

$ LINK/DEBUG FORMS, INVENTORY

In Example 1-2, the /DEBUG qualifier in the LINK command directs the linker
to include in the executable image all symbol information that is contained in the
object modules being linked. Most languages require that you specify all included
object modules in the LINK command. See Section 5.1.3 for more details on how
to control symbol information with the LINK command.

On Alpha and Integrity server systems, you can now debug programs that have
been linked with the /DSF qualifier (and therefore have a separate debug symbol
file). The /DSF qualifier to the LINK command directs the linker to create a
separate .DSF file to contain the symbol information. This allows more flexible
debugging options. Debugging such a program requires the following:

e The name of the .DSF file must match the name of the .EXE file being
debugged.

e  You must define DBG$IMAGE_DSF_PATH to point to the directory that
contains the .DSF file.

For example:

$ CC/DEBUG/NOOPTIMIZE TESTPROGRAM

$ LINK/DSF=TESTDISK:[TESTDIR]TESTPROGRAM.DSF TESTPROGRAM
$ DEFINE DBGS$IMAGE DSF PATH TESTDISK:[TESTDIR]

$ DEBUG/KEEP TESTPROGRAM

See Section 5.1.5 for more information about debugging programs that have
separate symbol files. See the OpenVMS Linker Utility Manual for more
information about using the /DSF qualifier.

1.2.3 Controlling Debugger Activation with the LINK and RUN Commands

In addition to passing symbol information to the executable image, the
LINK/DEBUG command causes the image activator to start the debugger if you
execute the resulting image with the DCL command RUN. (See Section 1.6.)

You can also run an image compiled and linked with the /DEBUG command
qualifiers without invoking the debugger. To do so, use the /NODEBUG qualifier
in the DCL command RUN. For example:

$ RUN/NODEBUG FORMS
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This is convenient for checking your program once you think it is error free. Note
that the data required by the debugger occupies space within the executable
image. When your program is correct, you can link your program again without
the /DEBUG qualifier. This creates an image with only traceback data in the
debug symbol table, which creates a smaller executable file.

Table 1-1 summarizes how to control debugger activation with the LINK and
RUN command qualifiers. Note that the LINK command qualifiers /INOJDEBUG
and /[NO]JTRACEBACK affect not only debugger activation but also the maximum
level of symbol information provided when debugging.

Table 1-1 Controlling Debugger Activation with the LINK and RUN Commands

LINK Command To Run Program without  To Run Program with  Maximum Symbol
Qualifier Debugger Debugger Information Available'
/DEBUG! RUN/NODEBUG RUN Full

None or RUN RUN/DEBUG Only traceback*
/TRACEBACK or

/NODEBUG?

/NOTRACEBACK RUN RUN/DEBUGS None

/DSF* RUN DEBUG/KEEP’ Full

/DSF*® RUN DEBUG/SERVER’ Full

1 On OpenVMS Alpha systems, anything that uses system service interception (SSI), such as the debugger or the Heap
Analyzer, is unable to intercept system service call images activated by shared linkage. The image activator, therefore,
avoids shared linkage for images linked or run with /DEBUG, and instead activates private image copies. This affects

?erformance of user applications under debugger or Heap Analyzer control, as images activated by shared linkage run

aster.

3 LINK/TRACEBACK (or LINK/NODEBUG) is a LINK command default.

4 Traceback information includes compiler-generated line numbers and the names of routines and modules (compilation
units). This symbol information is used by the traceback condition handler to identify the PC value (where execution is
paused) and the active calls when a run-time error has occurred. The information is also used by the debugger SHOW
CALLS command (see Section 2.3.3).

5 The RUN/DEBUG command allows you to run the debugger, but if you entered the LINK/NOTRACEBACK command,
you will be unable to do symbolic debugging.

6Alpha and Integrity server only.
7L0g'ical name DBG$DSF_IMAGE_NAME must point to the directory that contains the .DSF file (see Section 1.2.2).

1.3 Debugging a Program with the Kept Debugger

You can run the OpenVMS Debugger as the kept debugger, which allows you
to rerun the same program again and again, or to run different programs, all
without terminating the debugging session. This section explains how to:

e Start the kept debugger and then bring a program under debugger control
¢ Rerun the same program from the current debugging session

e Run another program from the current debugging session

e Interrupt program execution and abort debugger commands

e Interrupt a debugging session and then return to the debugging session



Introduction to the Debugger
1.3 Debugging a Program with the Kept Debugger

1.3.1 Starting the Kept Debugger

This section explains how to start the kept debugger from DCL level ($) and
bring your program under debugger control. Section 1.6 and Section 1.7 describe
other ways to invoke the debugger.

Using the kept debugger enables you to use the debugger’s RERUN and RUN
features explained in Section 1.3.3 and Section 1.3.4, respectively.

Notes

The following problems or restrictions are specific to the kept debugger:

e If a previous debugger process has not completely stopped, you may
see the following error at debugger startup:

$DEBUG-E-INTERR, internal debugger error in
DBGMRPC\DBG$WAIT_FOR_EVENT got an ACK

To fix this problem, exit the debugger. Then use the DCL command
SHOW PROCESS/SUBPROCESS to check whether any debugger
subprocesses exist. If so, stop them by using the DCL command STOP
and then restart the debugger.

e Running a sequence of many large programs can cause the debugger
to fail because it has run out of memory, global sections, or some other
resource.

To fix this problem, exit the debugger and restart the debugging
session.

To start the kept debugger and bring your program under debugger control:

1. Verify that you have compiled and linked the program as explained in
Section 1.2.

2. Enter the following command line:
$ DEBUG/KEEP

Upon startup, the debugger displays its banner, executes any user-defined
initialization file (see Section 13.2), and displays its DBG> prompt to indicate
that you can now enter debugger commands, as explained in Section 2.1.

3. Bring your program under debugger control with the debugger RUN
command, specifying the executable image of your program as the parameter.
For example:

DBG> RUN FORMS
$DEBUG-I-INITIAL,Lanquage: C, Module: FORMS
DBG>

The message displayed indicates that this debugging session is initialized for a C
program and that the name of the main program unit (the module containing the
image transfer address) is FORMS. The initialization sets up language-dependent
debugger parameters. These parameters control the way the debugger parses
names and expressions, formats debugger output, and so on. See Section 4.1.9 for
more information about language-dependent parameters.



Introduction to the Debugger
1.3 Debugging a Program with the Kept Debugger

The debugger suspends program execution (by setting a temporary breakpoint) at
the start of the main program unit or, with certain programs, at the start of some
initialization code, at which point the debugger displays the following message:

$DEBUG-I-NOTATMAIN, Type GO to reach main program

With some of these programs (for example, Ada programs), the temporary
breakpoint enables you to debug the initialization code using full symbolic
information. See Section 14.3 for more information.

At this point, you can debug your program as explained in Chapter 2.

RUN and RERUN Command Options for Programs That Require Arguments

Some programs require arguments. This section explains how to use the RUN
and RERUN commands with the /ARGUMENTS and /COMMAND qualifiers
when debugging a program with the kept debugger.

After starting the kept debugger, you can specify the image to be debugged

by entering the RUN command with an image name, or the RUN/COMMAND
command with a DCL foreign command. Note that you can specify a DCL foreign
command only with the /COMMAND qualifier to the RUN command.

You can specify a list of arguments with the /ARGUMENTS qualifier to the RUN
and RERUN commands.

The different methods are shown in the following example of a debugger session.
The program to be debugged is echoargs.c, a program that echoes the input
arguments to the terminal:

#include <stdio.h>

main(int argc, char *argv[])
{
int i;
for (1 = 0; i < argc; i++)
printf("$s\n", argv[i]);

}

Compile and link the program as follows:

$ cc/debug/noopt echoargs.c
$ link/debug echoargs

Define a DCL foreign command as follows:
$ ECHO == "$ sys$disk:[]echoargs.exe"

Invoke the kept debugger. The debugger session in the example that follows
shows three ways of passing arguments:

e RUN with /COMMAND and /ARGUMENTS
e RERUN with /ARGUMENTS
e RUN with /ARGUMENTS and image name

RUN with /COMMAND and /ARGUMENTS This section of the debugger session
shows the use of the debugger RUN command with the /COMMAND and
/ARGUMENTS qualifiers. The /COMMAND qualifier specifies DCL foreign
command echo. The /ARGUMENTS qualifier specifies arguments fa sol la mi.
The first GO command executes the initialization code of echoargs.exe after which
the debugger suspends program execution at the temporary breakpoint at the
start of the program. The second GO command executes echoargs.exe, which
correctly echoes the arguments to the screen.
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$ DEBUG/KEEP
Debugger Banner and Version Number

DBG> RUN/COMMAND="echo"/ARGUMENTS="fa sol la mi"
$DEBUG-I-NOTATMAIN,Language: C, Module: ECHOARGS
$DEBUG-I-NOTATMAIN, Type GO to reach main program
DBG> GO
break at routine ECHOARGS\main
1602: for (i = 0; i < argc; it+)

DBG> GO

dsal:[jones.test]echoargs.exe;2
fa

sol

la
mi

$DEBUG-I-EXITSTATUS,is ’'$SYSTEM-S-NORMAL, Normal successful completion’

RERUN with /ARGUMENTS This section of the debugger session shows the

use of the RERUN command with the /ARGUMENTS qualifier to run the same
image again, with new arguments fee fii foo fum. (If you omit the /ARGUMENTS
qualifier, the debugger reruns the program with the arguments used previously.)

The first GO command executes the initialization code of echoargs.exe after which
the debugger suspends program execution at the temporary breakpoint at the
start of the program. The second GO command executes echoargs.exe, which
correctly echoes the arguments to the screen.

DBG> RERUN/ARGUMENTS="fee fii foo fum"
$DEBUG-I-NOTATMAIN,Language: C, Module: ECHOARGS
$DEBUG-I-NOTATMAIN,Type GO to reach main program
DBG> GO
break at routine ECHOARGS\main
1602: for (i = 0; i < argc; i++)
DBG> GO
_dsal:[jones.test]echoargs.exe;2
fee
fii
foo
fum
$DEBUG-I-EXITSTATUS,is '$SYSTEM-S-NORMAL, Normal successful completion’

RUN with /ARGUMENTS and Image Name This section of the debugging
session uses the RUN command to invoke a fresh image of echoargs, with the
/ARGUMENTS qualifier to specify a new set of arguments a b c.

The first GO command executes the initialization code of echoargs.exe after which
the debugger suspends program execution at the temporary breakpoint at the
start of the program. The second GO command executes echoargs.exe, which
correctly echoes the arguments to the screen.

DBG> RUN/ARGUMENTS="a b c" echoargs
$DEBUG-I-NOTATMAIN,Language: C, Module: ECHOARGS
$DEBUG-I-NOTATMAIN, Type GO to reach main program
DBG> GO
break at routine ECHOARGS\main

1602: for (i = 0; i < argc; i++)
DBG> GO
dsal:[jones.test]echoargs.exe;2

Q o ol

$DEBUG-I-EXITSTATUS,is ’'$SYSTEM-S-NORMAL, Normal successful completion’
DBG> quit
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RUN Command Restrictions
Note the following restrictions about the debugger RUN command:

®  You can use the RUN command only if you started the debugger with the
DCL command DEBUG/KEEP.

¢  You cannot use the RUN command to connect the debugger to a running
program (see Section 1.7).

e Unless you are using the debugger client/server interface, you cannot run a
program under debugger control over a network link. See Section 9.9 and
Chapter 11 for more information about using the debugger client/server
interface.

1.3.2 When Your Program Completes Execution

When your program completes execution normally during a debugging session,
the debugger issues the following message:

$DEBUG-I-EXITSTATUS,is ’'$SYSTEM-S-NORMAL, Normal successful completion’)
You then have the following options:

®  You can rerun your program from the same debugging session (see
Section 1.3.3).

¢ You can run another program from the same debugging session (see
Section 1.3.4).

*  You can end the debugging session (see Section 1.8).

1.3.3 Rerunning the Same Program from the Kept Debugger

You can rerun the program currently under debugger control at any time during
a debugging session, provided you invoked the kept debugger as explained in
Section 1.3.1. Use the RERUN command. For example:

DBG> RERUN
$DEBUG-I-NOTATMAIN, Language: C, Module: ECHOARGS
$DEBUG-I-NOTATMAIN, Type GO to reach main program

DBG>

The RERUN command terminates the image you were debugging and brings a
fresh copy of that image under debugger control, pausing at the start of the main
source module as if you had used the RUN command (see Section 1.3.1).

When you use the RERUN command you can save the current state (activated or
deactivated) of any breakpoints, tracepoints, and static watchpoints. Note that
the state of a particular nonstatic watchpoint might not be saved, depending

on the scope of the variable being watched relative to the main program unit
(where execution restarts). RERUN/SAVE is the default. To clear all breakpoints
tracepoints, and watchpoints, enter RERUN/NOSAVE.

The RERUN command invokes the same version of the image that is currently
under debugger control. To debug a different version of that program (or a
different program) from the same debugging session, use the RUN command. To
rerun a program with new arguments, use the /ARGUMENTS qualifier (see RUN
and RERUN Command Options for Programs That Require Arguments).
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1.3.4 Running Another Program from the Kept Debugger

You can bring another program under debugger control at any time during a
debugging session, provided you invoked the kept debugger as explained in
Section 1.3.1. Use the debugger RUN command. For example:

DBG> RUN TOTALS
$DEBUG-I-NOTATMAIN, Language: FORTRAN, Module: TOTALS
DBG>

The debugger loads the program and pauses execution at the start of the main
source module.

For more information about startup conditions and restrictions, see Section 1.3.1.

For information about all RUN command options, see the debugger RUN
command description.

1.4 Interrupting Program Execution and Aborting Debugger

Commands

If your program goes into an infinite loop during a debugging session so that
the debugger prompt does not reappear, press Ctrl/C. This interrupts program
execution and returns you to the debugger prompt (pressing Ctrl/C does not end
the debugging session). For example:

DBG> GO

DBG>

You can also press Ctrl/C to abort the execution of a debugger command. This is
useful if, for example, the debugger is displaying a long stream of data.

Pressing Ctrl/C when the program is not running or when the debugger is not
performing an operation has no effect.

If your program has a Ctrl/C AST (asynchronous system trap) service routine
enabled, use the SET ABORT_KEY command to assign the debugger’s abort
function to another Ctrl/key sequence. To identify the abort key that is currently
defined, enter the SHOW ABORT_KEY command.

Pressing Ctrl/Y from within a debugging session has the same effect as pressing
Ctrl/Y during the execution of a program. Control is returned to the DCL
command interpreter ($ prompt).

1.5 Pausing and Resuming a Debugging Session
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The debugger SPAWN and ATTACH commands enable you to interrupt a
debugging session from the debugger prompt, enter DCL commands, and return

to the debugger prompt. These commands function essentially like the DCL
commands SPAWN and ATTACH:

e Use the debugger SPAWN command to create a subprocess.

e Use the debugger ATTACH command to attach to an existing process or
subprocess.
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You can enter the SPAWN command with or without specifying a DCL command
as a parameter. If you specify a DCL command, it is executed in a subprocess
(if the DCL command invokes a utility, that utility is invoked in a subprocess).
Control returns to the debugging session when the DCL command terminates
(or when you exit the utility). The following example shows spawning the DCL
command DIRECTORY:

DBG> SPAWN DIR [JONES.PROJECT2]*.FOR

Control returned to process JONES_1
DBG>

The next example shows spawning the DCL command MAIL, which invokes the
Mail utility:

DBG> SPAWN MAIL
MAIL> READ/NEW

MAIL> EXIT
Control returned to process JONES_1
DBG>

If you enter the SPAWN command without specifying a parameter, a subprocess
is created, and you can then enter DCL commands. Either logging out of the
subprocess or attaching to the parent process (with the DCL command ATTACH)
returns you to the debugging session. For example:

DBG> SPAWN
$ RUN PROG2

$ ATTACH JONES_1
Control returned to process JONES 1
DBG>

If you plan to go back and forth several times between your debugging session
and a spawned subprocess (which might be another debugging session), use
the debugger ATTACH command to attach to that subprocess. Use the DCL
command ATTACH to return to the parent process. Because you do not create
a new subprocess every time you leave the debugger, you use system resources
more efficiently.

If you are running two debugging sessions simultaneously, you can define a new
debugger prompt for one of the sessions with the SET PROMPT command. This
helps you differentiate the sessions.

1.6 Starting the Debugger by Running a Program

You can bring your program under control of the non-kept debugger in one step
by entering the DCL command RUN filespec.

Note that when running the non-kept debugger, you cannot use the debugger
RERUN or RUN features explained in Section 1.3.3 and Section 1.3.4,
respectively. To rerun the same program or run another program under debugger
control, you must first exit the debugger and start it again.
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To start the non-kept debugger by running a program:

1. Verify that you have compiled and linked the program as explained in Section
1.2.1 and Section 1.2.2.

2. Enter the DCL command RUN filespec to start the debugger.
For example:
$ RUN FORMS

Debugger Banner and Version Number

$DEBUG-I-NOTATMAIN, Language: C, Module: FORMS
DBG>

Upon startup, the debugger displays its banner, executes any user-defined
initialization file, sets the language-dependent parameters to the source language
of the main program, suspends execution at the start of the main program, and
prompts for commands.

For more information about startup conditions, see Section 1.2.3 and
Section 1.3.1.

1.7 Starting the Debugger After Interrupting a Running Program
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You can bring a program that is executing freely under debugger control. This is
useful either if you suspect that the program might be in an infinite loop or if you
see erroneous output.

To bring your program under debugger control:

1. Verify that you have compiled and linked the program as explained in
Section 1.2.

2. Enter the DCL command RUN/NODEBUG filespec to execute the program
without invoking the debugger.

3. Press Ctrl/Y to interrupt the executing program. Control passes to the DCL
command interpreter.

4. Enter the DCL command DEBUG. This invokes the non-kept debugger.
For example:

$ RUN/NODEBUG FORMS

Interrupt
$ DEBUG

Debugger Banner and Version Number

$DEBUG-I-NOTATMAIN, Language: C, Module: FORMS
DBG>

Upon startup, the debugger displays its banner, executes any user-defined
initialization file, sets the language-dependent parameters to the source language
of the module where execution is interrupted, and prompts for commands.

To know where the execution is interrupted, enter the SHOW CALLS command
to determine where execution is paused and to display the sequence of routine
calls on the call stack (the SHOW CALLS command is described in Section 2.3.3).
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Note that when running the non-kept debugger, you cannot use the debugger
RERUN or RUN features explained in Section 1.3.3 and Section 1.3.4,
respectively. To rerun the same program or run another program under debugger
control, you must first exit the debugger and start it again.

For more information about startup conditions, see Section 1.2.3 and
Section 1.3.1.

1.8 Ending a Debugging Session

To end a debugging session in an orderly manner and return to DCL level, enter
EXIT or QUIT or press Ctrl/Z. For example:

DBG> EXIT
$

The QUIT command starts the debugger exit handlers to close log files, restores
the screen and keypad states, and so on.

The EXIT command and Ctrl/Z function identically. They perform the same
functions as the QUIT command, and additionally execute any exit handlers that
are declared in your program.

1.9 Debugging a Program on a Workstation Running DECwindows

Motif

If you are at a workstation running HP DECwindows Motif for OpenVMS, by
default the debugger starts up in the HP DECwindows Motif for OpenVMS user
interface, which is displayed on the workstation specified by the HP DECwindows
Motif for OpenVMS applicationwide logical name DECW$DISPLAY.

The logical name DBG$DECWS$DISPLAY enables you to override the default to
display the debugger’s command interface in a DECterm window, along with any
program input/output (I/0).

To display the debugger’s command interface in a DECterm window:

1. Enter the following definition in the DECterm window from which you plan
to start the debugger:

$ DEFINE/JOB DBG$DECWSDISPLAY " "

You can specify one or more space characters between the quotation marks.
You should use a job definition for the logical name. If you use a process
definition, it must not have the CONFINE attribute.

2. Start the debugger in the usual way from that DECterm window (see
Section 1.3.1). The debugger’s command interface is displayed in the same
window.

For example:

$ DEFINE/JOB DBGSDECWSDISPLAY " "
$ DEBUG/KEEP

Debugger Banner and Version Number

DBG>

You can now bring your program under debugger control as explained
in Section 1.3.1. For more information about the logical names
DBG$DECW$DISPLAY and DECW$DISPLAY, see Section 9.8.3.
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On a workstation running HP DECwindows Motif for OpenVMS, you can also
run the client/server configuration of the OpenVMS debugger. See Section 9.9 for
details.

1.10 Debugging a Program from a PC Running the Debug Client
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The OpenVMS Debugger Version 7.2 and later features a client/server interface
that allows you to debug programs running on OpenVMS on Alpha from a PC
debug client interface running:

e  Microsoft Windows (Intel)
e  Microsoft Windows NT Version 3.51 or greater (Intel or Alpha)

Note

The client/server interface for OpenVMS Integrity server systems is
planned for a future release.

The OpenVMS client/server configuration allows the following:

e Remote access to OpenVMS Debug servers from other OpenVMS systems or
from PCs running Windows 95 or Windows NT Version 3.51 or later

e (Client access to multiple servers, each running on the same or different
OpenVMS nodes

e  Multiple clients on different nodes to simultaneously connect to the same
server for teaching or team debugging

e Debugging of multitier client/server applications that are distributed among
several mixed-platform systems

The client and server communicate using Distributed Computing
Environment/Remote Procedure Calls (DCE/RPC) over one of the following
transports:

e TCP/IP
e TUDP
e DECnet

To invoke the server on an OpenVMS node, enter the following command:
$ DEBUG/SERVER

The server displays its network binding strings. You must specify one of these
strings when you connect a HP DECwindows Motif for OpenVMS or Microsoft
Windows client to this server. For example:

$ DEBUG/SERVER

$DEBUG-I-SPEAK: TCP/IP: YES, DECnet: YES, UDP: YES

%DEBUG-I-WATCH: Network Binding: ncacn ip tcp:16.32.16.138[1034]
$DEBUG-I-WATCH: Network Binding: ncacn dnet nsp:19.10[RPC224002690001]
$DEBUG-I-WATCH: Network Binding: ncadg ip udp:16.32.16.138[1045]
$DEBUG-I-AWAIT: Ready for client connection...

In the client’s Server Connection dialog box, enter the type of network protocol
(TCP/IP, DECnet, or UDP) and the corresponding network binding string (see
Section 9.9.4).
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Note

Messages and program output appear by default in the window in which
you start the server. You can redirect program output to another window
as required.

For more information about using the debug client interface, see Chapter 11.

1.11 Debugging Detached Processes That Run with No CLI

The design and implementation of the debugger’s HP DECwindows Motif for
OpenVMS user interface requires that the process being debugged have a
command line interpreter (CLI). To debug a detached process (such as a print
symbiont) that does not have a CLI, you must use the character-cell (screen
mode) interface to the debugger.

To do so, direct DBG$INPUT, DBG$OUTPUT and DBG$ERROR to a terminal
port that is not logged in. This allows the image to be debugged with the
standard character-cell interface on that terminal.

For example:

$ DEFINE/TABLE=GROUP DBG$INPUT TTA3:
$ DEFINE/TABLE=GROUP DBG$OUTPUT TTA3:
$ DEFINE/TABLE=GROUP DBGSERROR TTA3:
$ START/QUEUE SYS$PRINT /PROCESSOR=dev:[dir]test program

[Debugger starts up on logged-out terminal TTA3:]

1.12 Configuring Process Quotas for the Debugger

Each user needs a PRCLM quota sufficient to create an additional subprocess for
the debugger, beyond the number of processes needed by the program.

BYTLM, ENQLM, FILLM, and PGFLQUOTA are pooled quotas. You may need to
increase these quotas to account for the debugger subprocess as follows:

¢  You should increase each user’s ENQLM quota by at least the number of
processes being debugged.

*  You might need to increase each user’s PGFLQUOTA. If a user has an
insufficient PGFLQUOTA, the debugger may fail to activate or may cause
"virtual memory exceeded" errors during execution.

¢ You might need to increase each user’s BYTLM and FILLM quotas.
The debugger requires sufficient BYTLM and FILLM quotas to open
each image file being debugged, the corresponding source files, and the
debugger input, output, and log files. To increase these quotas, you can run
SYS$SYSTEM:AUTHORIZE.EXE to adjust parameters in SYSUAF.DAT.

1.13 Debugger Command Summary

The following sections list all the debugger commands and any related DCL
commands in functional groupings, along with brief descriptions. During a
debugging session, you can get online help on all debugger commands and their
qualifiers by typing HELP at the debugger prompt (see Section 2.1).
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1.13.1 Starting and Ending a Debugging Session

The following commands start the debugger, bring a program under debugger
control, and interrupt and end a debugging session. Except where the DCL
commands RUN and DEBUG are indicated specifically, all commands are

debugger commands.

$DEBUG/KEEP

$RUN SYS$SHARE:DEBUGSHR.EXE

$DEBUG/SERVER
$DEBUG/CLIENT

$RUN SYS$SHARE:DEBUGUISHR.EXE

RUN filespec
RERUN

$RUN program-image

EXIT, Ctrl/Z
QUIT

Ctrl/C

(SET,SHOW) ABORT_KEY

Ctrl/Y
$DEBUG

ATTACH

SPAWN

(DCL) Starts the kept debugger.

(DCL) Starts the kept debugger.

(DCL) Starts the debug server.

(DCL) Starts the debug client.

(DCL) Starts the debug client.

Brings a program under debugger control.

Reruns the program currently under debugger
control.

(DCL) If the specified image was linked
using LINK/DEBUG, starts the debugger
and also brings the image under debugger
control. When you start the debugger in this
manner, you cannot then use the debugger
RUN or RERUN commands. You can use
the /INOIDEBUG qualifiers with the RUN
command to control whether the debugger is
started when the program is executed.

Ends a debugging session, executing all exit
handlers.

Ends a debugging session without executing
any exit handlers declared in the program.

Aborts program execution or a debugger
command without interrupting the debugging
session.

(Assigns, identifies) the default Ctrl/C abort
function to another Ctrl/key sequence,
identifies the Ctrl/key sequence currently
defined for the abort function.

(DCL) Interrupts a program that is running
without debugger control and starts the
debugger.

Passes control of your terminal from the
current process to another process.

Creates a subprocess, which enables you to
execute DCL commands without ending a
debugging session or losing your debugging
context.

1.13.2 Controlling and Monitoring Program Execution

The following commands control and monitor program execution:
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GO
STEP

(SET,SHOW) STEP

Starts or resumes program execution

Executes the program up to the next line,
instruction, or specified instruction

(Establishes, displays) the default qualifiers
for the STEP command



(SET,SHOW,CANCEL) BREAK
(ACTIVATE,DEACTIVATE) BREAK

(SET,SHOW,CANCEL) TRACE
(ACTIVATE,DEACTIVATE) TRACE

(SET,SHOW,CANCEL) WATCH
(ACTIVATE,DEACTIVATE) WATCH

SHOW CALLS
SHOW STACK

CALL

1.13.3 Examining and Manipulating Data
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(Sets, displays, cancels) breakpoints

(Activates, deactivates) previously set
breakpoints

(Sets, displays, cancels) tracepoints

(Activates, deactivates) previously set
tracepoints

(Sets, displays, cancels) watchpoints

(Activates, deactivates) previously set
watchpoints

Identifies the currently active routine calls

Gives additional information about the
currently active routine calls

Calls a routine

The following commands examine and manipulate data:

EXAMINE

SET MODE [NOJOPERANDS

DEPOSIT

DUMP

EVALUATE
MONITOR

Displays the value of a variable or the
contents of a program location

Controls whether the address and contents of
the instruction operands are displayed when
you examine an instruction

Changes the value of a variable or the
contents of a program location

Displays the contents of memory in a manner
similar to the DCL command DUMP

Evaluates a language or address expression

(Applies only to the debugger’s HP
DECwindows Motif for OpenVMS user
interface) Displays the current value of

a variable or language expression in the
monitor view of the HP DECwindows Motif for
OpenVMS user interface

1.13.4 Controlling Type Selection and Radix

The following commands control type selection and radix:

(SET,SHOW,CANCEL) RADIX

(SET,SHOW,CANCEL) TYPE

SET MODE [NO]G_FLOAT

(Establishes, displays, restores) the radix for
data entry and display

(Establishes, displays, restores) the type for
program locations that are not associated with
a compiler-generated type

Controls whether double-precision floating-
point constants are interpreted as G_FLOAT
or D_FLOAT

1.13.5 Controlling Symbol Searches and Symbolization

The following commands control symbol searches and symbolization:

SHOW SYMBOL
(SET,SHOW,CANCEL) MODULE

Displays symbols in your program

Sets a module by loading its symbol
information into the debugger’s symbol table,
identifies, cancels a set module
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(SET,SHOW,CANCEL) IMAGE Sets a shareable image by loading data
structures into the debugger’s symbol table,
identifies, cancels a set image

SET MODE [NOJDYNAMIC Controls whether or not modules and
shareable images are set automatically when
the debugger interrupts execution

(SET,SHOW,CANCEL) SCOPE (Establishes, displays, restores) the scope for
symbol searches

SYMBOLIZE Converts a memory address to a symbolic
address expression

SET MODE [NOJLINE Controls whether or not program locations

are displayed in terms of line numbers or
routine-name + byte offset

SET MODE [NOJSYMBOLIC Controls whether or not program locations are
displayed symbolically or in terms of numeric
addresses

1.13.6 Displaying Source Code

The following commands control the display of source code:

TYPE Displays lines of source code

EXAMINE/SOURCE Displays the source code at the location
specified by the address expression

SEARCH Searches the source code for the specified
string

(SET,SHOW) SEARCH (Establishes, displays) the default qualifiers
for the SEARCH command

SET STEP [NO]JSOURCE Enables/disables the display of source code

after a STEP command has been executed or
at a breakpoint, tracepoint, or watchpoint

(SET,SHOW) MARGINS (Establishes, displays) the left and right
margin settings for displaying source code
(SET,SHOW,CANCEL) SOURCE (Creates, displays, cancels) a source directory

search list

1.13.7 Using Screen Mode

The following commands control screen mode and screen displays:

SET MODE [NOJSCREEN Enables/disables screen mode

DISPLAY Creates or modifies a display

SCROLL Scrolls a display

EXPAND Expands or contracts a display

MOVE Moves a display across the screen

(SHOW,CANCEL) DISPLAY (Identifies, deletes) a display

(SET,SHOW,CANCEL) WINDOW (Creates, identifies, deletes) a window
definition

SELECT Selects a display for a display attribute

SHOW SELECT Identifies the displays selected for each of the

display attributes

SAVE Saves the current contents of a display into
another display
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(SET,SHOW) TERMINAL

SET MODE [NOJSCROLL

Ctrl/'W
DISPLAY/REFRESH

1.13.8 Editing Source Code
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Saves a display or the current screen state
into a file

(Establishes, displays) the terminal screen
height and width that the debugger uses when
it formats displays and other output

Controls whether an output display is updated
line by line or once per command

Refreshes the screen

The following commands control source editing from a debugging session:

EDIT
(SET,SHOW) EDITOR

1.13.9 Defining Symbols

Starts an editor during a debugging session

(Establishes, identifies) the editor started by
the EDIT command

The following commands define and delete symbols for addresses, commands, or

values:

DEFINE

DELETE
(SET,SHOW) DEFINE

SHOW SYMBOL/DEFINED

1.13.10 Using Keypad Mode

Defines a symbol as an address, command, or
value

Deletes symbol definitions

(Establishes, displays) the default qualifier for
the DEFINE command

Identifies symbols that have been defined with
the DEFINE command

The following commands control keypad mode and key definitions:

SET MODE [NOJKEYPAD
DEFINE/KEY
DELETE/KEY

SET KEY

SHOW KEY

Enables/disables keypad mode
Creates key definitions

Deletes key definitions

Establishes the key definition state
Displays key definitions

1.13.11 Using Command Procedures, Log Files, and Initialization Files

The following commands are used with command procedures and log files:

@ (execute procedure)
(SET,SHOW) ATSIGN
DECLARE

(SET,SHOW) LOG
SET OUTPUT [NOJLOG

Executes a command procedure

(Establishes, displays) the default file
specification that the debugger uses to search
for command procedures

Defines parameters to be passed to command
procedures

(Specifies, identifies) the debugger log file

Controls whether or not a debugging session
is logged
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SET OUTPUT [NOJSCREEN_LOG Controls whether or not, in screen mode, the
screen contents are logged as the screen is
updated

SET OUTPUT [NOJVERIFY Controls whether or not debugger commands
are displayed as a command procedure is
executed

SHOW OUTPUT Identifies the current output options
established by the SET OUTPUT command

1.13.12 Using Control Structures

The following commands establish conditional and looping structures for debugger

commands:

FOR Executes a list of commands while
incrementing a variable

IF Executes a list of commands conditionally

REPEAT Executes a list of commands a specified
number of times

WHILE Executes a list of commands while a condition
is true

EXITLOOP Exits an enclosing WHILE, REPEAT, or FOR
loop

1.13.13 Debugging Multiprocess Programs

The following commands debug multiprocess programs. Note that these
commands are specific to multiprocess programs. Many of the commands
listed under other categories have qualifiers or parameters that are specific
to multiprocess programs (for example, SET BREAK/ACTIVATING, EXIT
process-spec, DISPLAY/PROCESS=).

CONNECT Brings a process under debugger control

DEFINE/PROCESS_SET Assigns a symbolic name to a list of process
specifications

SET MODE [NOJINTERRUPT Controls whether execution is interrupted in
other processes when it is paused in some
process

(SET,SHOW) PROCESS Modifies the multiprocess debugging

environment, displays process information

WAIT When debugging a multiprocess program,
controls whether the debugger waits until all
processes have stopped before prompting for
another command

1.13.14 Additional Commands

The following commands are used for miscellaneous purposes:
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HELP
ANALYZE/CRASH_DUMP
ANALYZE/PROCESS_DUMP

(DISABLE,ENABLE,SHOW) AST

PTHREAD

(SET,SHOW) EVENT_FACILITY

(SET,SHOW) LANGUAGE
SET OUTPUT [NOITERMINAL

SET PROMPT
(SET,SHOW) TASK | THREAD

SHOW EXIT_HANDLERS

SHOW MODE

SHOW OUTPUT

Introduction to the Debugger
1.13 Debugger Command Summary

Displays online help on debugger commands
and selected topics

Opens a process dump for analysis with the
System Dump Debugger (SDD)

Opens a process dump for analysis with the
System Code Debugger (SCD)

(Disables, enables) the delivery of ASTs in
the program, identifies whether delivery is
enabled or disabled

Passes a command to the POSIX Threads
Debugger

(Esstablishes, identifies) the current run-time
facility for Ada, POSIX Threads, and SCAN
events

(Establishes, identifies) the current language

Controls whether debugger output, except
for diagnostic messages, is displayed or
suppressed

Specifies the debugger prompt

Modifies the tasking environment, displays
task information

Identifies the exit handlers declared in the
program

Identifies the current debugger modes
established by the SET MODE command
(for example, screen mode, step mode)

Identifies the current output options
established by the SET OUTPUT command
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Part

Command Interface

This part describes the debugger’s command interface.

For information about the debugger’s DECwindows Motif user interface, see
Part III.






2

Getting Started with the Debugger

This chapter gives a tutorial introduction to the debugger’s command interface.

The way you use the debugger depends on several factors: the kind of program
you are working on, the kinds of errors you are looking for, and your own
personal style and experience with the debugger. This chapter explains the
following basic tasks that apply to most situations:

¢ Entering debugger commands and getting online help
e Viewing your source code with the TYPE command and in screen mode

e Controlling program execution with the GO, STEP, and SET BREAK
commands, and monitoring execution with the SHOW CALLS, SET TRACE,
and SET WATCH commands

e Examining and manipulating data with the EXAMINE, DEPOSIT, and
EVALUATE commands

e Controlling symbol references with path names and the SET MODULE and
SET SCOPE commands

Several examples are language specific. However, the general concepts are
readily adaptable to all supported languages.

The sample debugging session in Section 2.6 shows how to use some of this
information to locate an error and correct it.

For information about starting and ending a debugging session, see Section 1.3.

2.1 Entering Debugger Commands and Accessing Online Help

After you start the debugger as explained in Section 1.3, you can enter debugger
commands whenever the debugger prompt (DBG>) is displayed. To enter a
command, type it at the keyboard and press Return. For example, the following
command sets a watchpoint on the variable COUNT:

DBG> SET WATCH COUNT

Detailed reference information about debugger commands is available in Part VI
and through the debugger’s online help:

e To list the help topics, type HELP at the prompt.
e For an explanation of the help system, type HELP HELP.
¢ For complete rules on entering commands, type HELP Command_Format.

e To display help on a particular command, type HELP command. For example,
to display HELP on the SET WATCH command, type HELP SET WATCH.

e To list commands grouped by function, type HELP Command_Summary.
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Online help is also available on the following topics:

New_Features

Release_Notes

Address_Expressions

Built_in_Symbols
DECwindows_Interface
Keypad_Definitions

Language_Support

Logical Names

Messages (diagnostic messages)
Path_Names (to qualify symbolic names)
Screen_Mode

SS$_DEBUG condition (to start debugger from program)
System_Management

To display help about any of these topics, type HELP topic. For example, to
display information about diagnostic messages, type HELP Messages.

When you start the debugger, a few commonly used command sequences are
automatically assigned to the keys on the numeric keypad (to the right of the
main keyboard). Thus, you can perform certain functions either by entering a
command or by pressing a keypad key.

The predefined key functions are identified in Figure 2-1.

Most keypad keys have three predefined functions—DEFAULT, GOLD, and
BLUE.

e To enter a key’s DEFAULT function, press the key.

e To enter its GOLD function, first press and release the PF1 (GOLD) key, and
then press the key.

e To enter its BLUE function, first press and release the PF4 (BLUE) key, and
then press the key.

In Figure 2-1, the DEFAULT, GOLD, and BLUE functions are listed within each
key’s outline, from top to bottom, respectively. For example:

e Pressing KPO (keypad key 0) enters the STEP command.
¢ Pressing PF1 KPO enters the STEP/INTO command.
e Pressing PF4 KPO enters the STEP/OVER command.

Normally, keys KP2, KP4, KP6, and KP8 scroll screen displays down, left,
right, or up, respectively. By putting the keypad in the MOVE, EXPAND, or
CONTRACT state, indicated in Figure 2—1, you can also use these keys to
move, expand, or contract displays in four directions. Enter the command
HELP Keypad_Definitions to display the keypad key definitions.

You can redefine keypad key functions with the DEFINE/KEY command.
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Figure 2-1 Keypad Key Functions Predefined by the Debugger—Command Interface

( 17 N Fis F19 F20 I
DEFAULT MOVE EXPAND CONTRACT
(SCROLL) (EXPAND +) (EXPAND -)

g PF1 PF2 PF3 PF4 N

GOLD HELP DEFAULT | SET MODE SCREEN BLUE
GOLD HELP GOLD SET MODE NOSCR BLUE
GOLD HELP BLUE DISP/GENERATE BLUE
7 /s ™ o -
DISP SRC,INST,OUT|  SCROLL/UP DISPLAY next DISP next at FS
DISP INST,REG,OUT|  SCROLL/TOP SET PROC next
DISP 2 SRC, 2 INST SCROLL/UP... DISP 2 SRC DISP SRC, OUT
a N s a AY
SCROLU/LEFT EX/SOU .0\%PC SCROLL/RIGHT GO
SCROLL/LEFT:255 SHOW CALLS SCROLL/RIGHT:255 | SEL/SOURCE next
SCROLL/LEFT... SHOW CALLS 3 | SCROLL/RIGHT... SEL/INST next
1 6 \ 3 ENTER
EXAMINE SCROLL/DOWN SEL SCROLL next
EXAMA(prev) SCROLL/BOTTOM SEL OUTPUT next
DISP 3 SRC, 3INST | SCROLL/DOWN... | DISP 3 SRC
\ j ENTER
0 .
STEP RESET
STEP/NTO RESET
STEP/OVER RESET
LK201 Keyboard:
Press Keys 2,4,6,8
F17 SCROLL
F18 MOVE
F19 EXPAND
F20 CONTRACT
VT-100 Keyboard:
Ty_pe Keys 2,4,6,8
SET KEY/STATE=DEFAULT SCROLL
SET KEY/STATE=MOVE MOVE
SET KEY/STATE=EXPAND EXPAND
SET KEY/STATE=CONTRACT CONTRACT

)

"MOVE" MOVE/UP
MOVE/UP:999
MOVE/UP:5
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MOVE/LEFT:999 MOVE/RIGHT:999
MOVE/LEFT:10 MOVE/RIGHT:10
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2.2 Displaying Source Code

The debugger provides two modes for displaying information: noscreen mode
and screen mode. By default, when you start the debugger, you are in noscreen
mode, but you might find that it is easier to view source code in screen mode.
The following sections briefly describe both modes.

2.2.1 Noscreen Mode

Noscreen mode is the default, line-oriented mode of displaying input and output.
The interactive examples throughout this chapter, excluding Section 2.2.2, show
noscreen mode.

In noscreen mode, use the TYPE command to display one or more source lines.
For example, the following command displays line 7 of the module in which
execution is currently paused:

DBG> TYPE 7
module SWAP ROUTINES

7: T TEMP := A;
DBG>

The display of source lines is independent of program execution. To display source
code from a module (compilation unit) other than the one in which execution is
currently paused, use the TYPE command with a path name to specify the
module. For example, the following command displays lines 16 to 21 of module
TEST:

DBG> TYPE TEST\16:21

Path names are discussed in more detail in Section 2.3.2, with the STEP
command.

You can also use the EXAMINE/SOURCE command to display the source line for
a routine or any other program location that is associated with an instruction.

The debugger also displays source lines automatically when it suspends execution
at a breakpoint or watchpoint, after a STEP command, or when a tracepoint is
triggered (see Section 2.3).

After displaying source lines at various locations in your program, you can
redisplay the location at which execution is currently paused by pressing KP5.

If the debugger cannot locate source lines for display, it issues a diagnostic
message. Source lines might not be available for a variety of reasons. For
example:

e Execution is paused within a module that was compiled or linked without the
/DEBUG qualifier.

e Execution is paused within a system or shareable image routine for which no
source code is available.

e The source file was moved to a different directory after it was compiled (the
location of source files is embedded in the object modules). In this case, use
the SET SOURCE command to specify the new location.

¢ The module might need to be set with the SET MODULE command. Module
setting is explained in Section 2.5.1.

To switch to noscreen mode from screen mode, press PF1 PF3 (or type SET
MODE NOSCREEN). You can use the TYPE and EXAMINE/SOURCE commands
in screen mode as well as noscreen mode.
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2.2.2 Screen Mode

Screen mode provides the easiest way to view your source code. To switch to
screen mode, press PF3 (or type SET MODE SCREEN). In screen mode, by
default the debugger splits the screen into three displays named SRC, OUT, and
PROMPT, as shown in Figure 2-2.

Figure 2-2 Default Screen Mode Display Configuration

—SRC: module SWAP ROUTINES— scroll-source

2: with Text IO; use TEXT IO;

3: package body SWAP ROUTINES is

4z procedure SWAPT (A,B: in out INTEGER) is

5: TEMP: INTEGER;

6: begin

7: TEMP := A;
—> 8: A := B;

9: B := TEMP;

10: end;

11:

12: procedure SWAP2 (A,B: in out COLOR) is
—OUT-output

stepped to SWAP _ROUTINES\SWAP1\%LINE 8
SWAP_ROUTINES\SWAP1\A: 35

— PROMPT — error—-program-prompt
DBG> STEP

DBG> EXAMINE A

DBG>

ZK-6502-GE

The SRC display shows the source code of the module in which execution

is currently paused. An arrow in the left column points to the source line
corresponding to the current value of the program counter (PC). The PC is a
register that contains the memory address of the instruction to be executed next.
The line numbers, which are assigned by the compiler, match those in a listing
file. As you execute the program, the arrow moves down and the source code is
scrolled vertically to center the arrow in the display.

The OUT display captures the debugger’s output in response to the commands
that you enter. The PROMPT display shows the debugger prompt, your input (the
commands that you enter), debugger diagnostic messages, and program output.

You can scroll both SRC and OUT to see whatever information might scroll
beyond the display window’s edge. Press KP3 repeatedly as needed to select the
display to be scrolled (by default, SRC is scrolled). Press KP8 to scroll up and
KP2 to scroll down. Scrolling a display does not affect program execution.

In screen mode, if the debugger cannot locate source lines for the routine in which
execution is currently paused, it tries to display source lines in the next routine
down on the call stack for which source lines are available. If the debugger can
display source lines for such a routine, it issues the following message:

$DEBUG-I-SOURCESCOPE, Source lines not available for .0\%PC.
Displaying source in a caller of the current routine.
DBG>
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In such cases, the arrow in the SRC display identifies the line that contains code
following the call statement in the calling routine.

2.3 Controlling and Monitoring Program Execution

This section explains how to perform the following tasks:

e Start and resume program execution

e Execute the program to the next source line, instruction, or other step unit
e Determine where execution is currently paused

e Use breakpoints to suspend program execution at points of interest

e Use tracepoints to trace the execution path of your program through specified
locations

e Use watchpoints to monitor changes in the values of variables

With this information you can pick program locations where you can then test
and manipulate the contents of variables as described in Section 2.4.

2.3.1 Starting or Resuming Program Execution

Use the GO command to start or resume program execution.

After it is started with the GO command, program execution continues until one
of the following events occurs:

e The program completes execution
e A breakpoint is reached

e A watchpoint is triggered

¢ An exception is signaled

e You press Ctrl/C

With most programming languages, when you bring a program under debugger
control, execution is initially paused directly at the beginning of the main
program. Entering a GO command at this point quickly enables you to test for an
infinite loop or an exception.

If an infinite loop occurs during execution, the program does not terminate, so the
debugger prompt does not reappear. To obtain the prompt, interrupt execution by
pressing Ctrl/C (see Section 1.4). If you are using screen mode, the pointer in the
source display indicates where execution stopped. You can also use the SHOW
CALLS command to identify the currently active routine calls on the call stack
(see Section 2.3.3).

If an exception that is not handled by your program is signaled, the debugger
interrupts execution at that point so that you can enter commands. You can then
look at the source display and a SHOW CALLS display to find where execution is
paused.

The most common use of the GO command is in conjunction with breakpoints,
tracepoints, and watchpoints, as described in Section 2.3.4, Section 2.3.5, and
Section 2.3.6, respectively. If you set a breakpoint in the path of execution and
then enter the GO command, execution is paused at that breakpoint. Similarly, if
you set a tracepoint, execution is monitored through that tracepoint. If you set a
watchpoint, execution is paused when the value of the watched variable changes.
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2.3.2 Executing the Program by Step Unit

Use the STEP command to execute the program one or more step units at a time.

By default, a step unit is one line of source code. In the following example, the
STEP command executes one line, reports the action ("stepped to ... "), and
displays the line number (27) and source code of the line to be executed next:

DBG> STEP

stepped to TEST\COUNT\$LINE 27
27: X:=X+1;

DBG>

Execution is now paused at the first machine-code instruction for line 27 within
routine COUNT of module TEST.

When displaying a program symbol (for example, a line number, routine name, or
variable name), the debugger always uses a path name. A path name consists
of the symbol plus a prefix that identifies the symbol’s location. In the previous
example, the path name is TEST\ COUNT\ %LINE 27. The leftmost element of
a path name is the module name. Moving toward the right, the path name lists
any successively nested routines and blocks that enclose the symbol. A backslash
character (\ ) is used to separate elements (except when the language is Ada,
where a period is used to parallel Ada syntax).

A path name uniquely identifies a symbol of your program to the debugger. In
general, you need to use path names in commands only if the debugger cannot
resolve a symbol ambiguity in your program (see Section 2.5). Usually the
debugger can determine the symbol you mean from its context.

When using the STEP command, note that only those source lines for which code
instructions were generated by the compiler are recognized as executable lines by
the debugger. The debugger skips over any other lines—for example, comment
lines.

You can specify different stepping modes, such as stepping by instruction rather
than by line (SET STEP INSTRUCTION). Also, by default, the debugger steps
over called routines—execution is not paused within a called routine, although
the routine is executed. By entering the SET STEP INTO command, you direct
the debugger to suspend execution within called routines as well as within the
routine in which execution is currently paused (SET STEP OVER is the default
mode).

2.3.3 Determining Where Execution Is Paused

Use the SHOW CALLS command when you are unsure where execution is paused
during a debugging session (for example, after a Ctrl/C interruption).

The command displays a traceback that lists the sequence of calls leading to the
routine in which execution is paused. For each routine (beginning with the one in
which execution is paused), the debugger displays the following information:

e The name of the module that contains the routine
e The name of the routine

¢ The line number at which the call was made (or at which execution is paused,
in the case of the current routine)

e The corresponding PC value
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On Alpha and Integrity server processors, the PC is shown as a memory
address relative to the first code address in the module and also as an
absolute address.

Note that on Integrity server processors, there is no hardware PC register.
The PC is a software constructed value, built by adding the hardware
Instruction Pointer (IP) register and the slot offset of the instruction within
the bundle (0, 1, or 2).

For example:

DBG> SHOW CALLS

module name routine name line rel PC abs PC
*TEST PRODUCT 18 00000009 0000063C
*TEST COUNT 47 00000009 00000647
*MY_PROG MY PROG 21 0000000D 00000653
DBG>

This example indicates that execution is paused at line 18 of routine PRODUCT
(in module TEST), which was called from line 47 of routine COUNT (in module
TEST), which was called from line 21 of routine MY_PROG (in module MY_
PROG).

2.3.4 Suspending Program Execution with Breakpoints

The SET BREAK command enables you to select locations at which to suspend
program execution (breakpoints). You can then enter commands to check the call
stack, examine the current values of variables, and so on. You resume execution
from a breakpoint with the GO or STEP commands.

The following example shows a typical use of the SET BREAK command:

DBG> SET BREAK COUNT
DBG> GO

break at routine PROG2\COUNT
54: procedure COUNT(X,Y:INTEGER);
DBG>

In the example, the SET BREAK command sets a breakpoint on routine COUNT
(at the beginning of the routine’s code); the GO command starts execution. When
routine COUNT is encountered, the following occurs:

e Execution is paused.

e The debugger announces that the breakpoint at COUNT has been reached
("break at ... ").

e The debugger displays the source line (54) at which execution is paused.
e The debugger prompts for another command.

At this breakpoint, you can use the STEP command to step through routine
COUNT and then use the EXAMINE command (discussed in Section 2.4.1) to
check on the values of X and Y.

When using the SET BREAK command, you can specify program locations using
various kinds of address expressions (for example, line numbers, routine
names, memory addresses, byte offsets). With high-level languages, you typically
use routine names, labels, or line numbers, possibly with path names to ensure
uniqueness.
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Specify routine names and labels as they appear in the source code. Line
numbers can be derived from either a source code display or a listing file.

When specifying a line number, use the prefix #LINE; otherwise, the debugger
interprets the line number as a memory location. For example, the following
command sets a breakpoint at line 41 of the module in which execution is paused.
The breakpoint causes the debugger to suspend execution at the beginning of
line 41.

DBG> SET BREAK SLINE 41

Note that you can set breakpoints only on lines that resulted in machine-code
instructions. The debugger warns you if you try to do otherwise (for example, on
a comment line). To pick a line number in a module other than the one in which
execution is paused, you must specify the module’s name in a path name. For
example:

DBG> SET BREAK SCREEN IO\SLINE 58

You can also use the SET BREAK command with a qualifier, but no parameter, to
break on every line, or on every CALL instruction, and so on. For example:

DBG> SET BREAK/LINE
DBG> SET BREAK/CALL

You can set breakpoints on events, such as exceptions, or state transitions in
tasking programs.

You can conditionalize a breakpoint (with a WHEN clause) or specify that a list of
commands be executed at the breakpoint (with a DO clause).

To display the current breakpoints, enter the SHOW BREAK command.

To deactivate a breakpoint, enter the DEACTIVATE BREAK command, and
specify the program location exactly as you did when setting the breakpoint.
This causes the debugger to ignore the breakpoint during program execution.
However, you can activate it at a later time, for example, when you rerun the
program (see Section 1.3.3). A deactivated breakpoint is listed as such in a
SHOW BREAK display.

To activate a breakpoint, use the ACTIVATE BREAK command. Activating a
breakpoint causes it to take effect during program execution.

The commands DEACTIVATE BREAK/ALL and ACTIVATE BREAK/ALL operate
on all breakpoints and are particularly useful when rerunning a program.

To cancel a breakpoint, use the CANCEL BREAK command. A canceled
breakpoint is no longer listed in a SHOW BREAK display.

2.3.5 Tracing Program Execution with Tracepoints

The SET TRACE command enables you to select locations for tracing the

execution of your program (tracepoints), without stopping its execution. After
setting a tracepoint, you can start execution with the GO command and then
monitor the path of execution, checking for unexpected behavior. By setting a
tracepoint on a routine, you can also monitor the number of times it is called.

As with breakpoints, every time a tracepoint is reached, the debugger issues a
message and displays the source line. But the program continues executing, and
the debugger prompt is not displayed. For example:
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DBG> SET TRACE COUNT
DBG> GO
trace at routine PROG2\COUNT
54: procedure COUNT(X,Y:INTEGER);

This is the only difference between a breakpoint and a tracepoint. When

using the SET TRACE command, you specify address expressions, qualifiers,
and optional clauses exactly as with the SET BREAK command. The
commands SHOW TRACE, ACTIVATE TRACE, DEACTIVATE TRACE, and
CANCEL TRACE operate on tracepoints in a manner similar to the corresponding
commands for breakpoints (see Section 2.3.4).

2.3.6 Monitoring Changes in Variables with Watchpoints

The SET WATCH command enables you to specify program variables that the
debugger monitors as your program executes. This process is called setting
watchpoints. If the program modifies the value of a watched variable, the
debugger suspends execution and displays information. The debugger monitors
watchpoints continuously during program execution. (Note that you can also
use the SET WATCH command to monitor arbitrary program locations, not just
variables.)

You can set a watchpoint on a variable by specifying the variable’s name with the
SET WATCH command. For example, the following command sets a watchpoint
on the variable TOTAL:

DBG> SET WATCH TOTAL

Subsequently, every time the program modifies the value of TOTAL, the
watchpoint is triggered.

Note

The technique you use to set watchpoints depends on your system (Alpha
or Integrity servers) and the type of variable, static or nonstatic. On
Alpha systems, for example, a static variable is associated with the
same memory address throughout program execution.

The following example shows what happens when your program modifies the
contents of this watched variable:

DBG> SET WATCH TOTAL
DBG> GO

watch of SCREEN IO\TOTAL at SCREEN IO\%LINE 13
13:  TOTAL = TOTAL + 1; -
old value: 16
new value: 17
break at SCREEN IO\%LINE 14
14:  POP(TOTAL);
DBG>
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In this example, a watchpoint is set on the variable TOTAL and execution is
started. When the value of TOTAL changes, execution is paused. The debugger
announces the event ("watch of ... "), identifying where TOTAL changed (the
beginning of line 13) and the associated source line. The debugger then displays
the old and new values and announces that execution has been paused at the
beginning of the next line (14). Finally, the debugger prompts for another
command. When a change in a variable occurs at a point other than the
beginning of a source line, the debugger gives the line number plus the byte
offset from the beginning of the line.

On Alpha processors, you can set a watchpoint on a nonstatic variable by
setting a tracepoint on the defining routine and specifying a DO clause to set
the watchpoint whenever execution reaches the tracepoint. Since a nonstatic
variable is allocated on the stack or in a register and exists only when its
defining routine is active (on the call stack), the variable name is not always
meaningful in the way that a static variable name is.

In the following example, a watchpoint is set on the nonstatic variable Y in
routine ROUTS. After the tracepoint is triggered, the WPTTRACE message
indicates that the nonstatic watchpoint is set, and the watchpoint is triggered
when the value of Y changes. For example:

DBG> SET TRACE/NOSOURCE ROUT3 DO (SET WATCH Y)
DBG> GO

trace at routine MOD4\ROUT3
$DEBUG-I-WPTTRACE, nonstatic watchpoint, tracing every
instruction

watch of MOD4\ROUT3\Y at MOD4\ROUT3\3LINE 16

16: Y :=4
old value: 3
new value: 4
break at MOD4\ROUT3\$LINE 17
17: SWAP(X,Y);
DBG>

When execution returns to the calling routine, the nonstatic variable is no
longer active, so the debugger automatically cancels the watchpoint and issues a
message to that effect.

On Alpha processors and Integrity server, the debugger treats all watchpoints as
nonstatic
watchpoints.

The commands SHOW WATCH, ACTIVATE WATCH, DEACTIVATE WATCH,
and CANCEL WATCH operate on watchpoints in a manner similar to the
corresponding commands for breakpoints (see Section 2.3.4). However, a nonstatic
watchpoint exists only as long as execution remains within the scope of the
variable being watched.

2.4 Examining and Manipulating Program Data

This section explains how to use the EXAMINE, DEPOSIT, and EVALUATE
commands to display and modify the contents of variables and evaluate
expressions. Before you can examine or deposit into a nonstatic variable, as
defined in Section 2.3.6, its defining routine must be active.
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2.4.1 Displaying the Value of a Variable

To display the current value of a variable, use the EXAMINE command. It has
the following syntax:

EXAMINE address-expression

The debugger recognizes the compiler-generated data type of the variable you
specify and retrieves and formats the data accordingly. The following examples
show some uses of the EXAMINE command.

Examine a string variable:

DBG> EXAMINE EMPLOYEE NAME
PAYROLL\EMPLOYEE_NAME: "Peter C. Lombardi"
DBG>

Examine three integer variables:

DBG> EXAMINE WIDTH, LENGTH, AREA
SIZE\WIDTH: 4

SIZE\LENGTH: 7

SIZE\AREA: 28

DBG>

Examine a two-dimensional array of real numbers (three per dimension):

DBG> EXAMINE REAL ARRAY
PROG2\REAL_ARRAY

(1,1): 27.01000
(1,2): 31.00000
(1,3): 12.48000
(2,1): 15.08000
(2,2): 22.30000
(2,3): 18.73000

DBG>

Examine element 4 of a one-dimensional array of characters:

DBG> EXAMINE CHAR ARRAY(4)
PROG2\CHAR ARRAY(Z): 'm’
DBG>

Examine a record variable (COBOL example):

DBG> EXAMINE PART

INVENTORY \PART:
ITEM: "WF-1247"
PRICE: 49,95
IN STOCK: 24

DBG>

Examine a record component (COBOL example):

DBG> EXAMINE IN STOCK OF PART
INVENTORY\IN-STOCK of PART:
IN STOCK: 24

DBG>

You can use the EXAMINE command with any kind of address expression (not
just a variable name) to display the contents of a program location. The debugger
associates certain default data types with untyped locations. If you want the
data interpreted and displayed in some other data format you can override the
defaults for typed and untyped locations.
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2.4.2 Assigning a Value to a Variable

To assign a new value to a variable, use the DEPOSIT command. It has the
following syntax:

DEPOSIT address-expression = language-expression

The DEPOSIT command is like an assignment statement in most programming
languages.

In the following examples, the DEPOSIT command assigns new values to
different variables. The debugger checks that the value assigned, which can be a
language expression, is consistent with the data type and dimensional constraints
of the variable.

Deposit a string value (it must be enclosed in quotation marks (") or apostrophes
(")

DBG> DEPOSIT PART NUMBER = "WG-7619.3-84"

Deposit an integer expression:

DBG> DEPOSIT WIDTH = CURRENT_WIDTH + 10

Deposit element 12 of an array of characters (you cannot deposit an entire array
aggregate with a single DEPOSIT command, only an element):

DBG> DEPOSIT C_ARRAY(12) := 'K’

Deposit a record component (you cannot deposit an entire record aggregate with a
single DEPOSIT command, only a component):

DBG> DEPOSIT EMPLOYEE.ZIPCODE = 02172
Deposit an out-of-bounds value (X was declared as a positive integer):

DBG> DEPOSIT X = -14
$DEBUG-I-IVALOUTBNDS, value assigned is out of bounds
at or near DEPOSIT

As with the EXAMINE command, you can specify any kind of address expression
(not just a variable name) with the DEPOSIT command. You can override the
defaults for typed and untyped locations if you want the data interpreted in some
other data format.

2.4.3 Evaluating Language Expressions

To evaluate a language expression, use the EVALUATE command. It has the
following syntax:

EVALUATE language-expression

The debugger recognizes the operators and expression syntax of the currently
set language. In the following example, the value 45 is assigned to the integer
variable WIDTH; the EVALUATE command then obtains the sum of the current
value of WIDTH and 7:

DBG> DEPOSIT WIDTH :=
DBG> EVALUATE WIDTH +
52

DBG>

45
7
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In the next example, the values TRUE and FALSE are assigned to the Boolean
variables WILLING and ABLE, respectively; the EVALUATE command then
obtains the logical conjunction of these values:

DBG> DEPOSIT WILLING := TRUE
DBG> DEPOSIT ABLE := FALSE
DBG> EVALUATE WILLING AND ABLE
False

DBG>

2.5 Controlling Access to Symbols in Your Program

To have full access to the symbols that are associated with your program (variable
names, routine names, source code, line numbers, and so on), you must compile
and link the program using the /DEBUG qualifier, as explained in Section 1.2.

Under these conditions, the way in which the debugger handles these symbols is
transparent to you in most cases. However, the following two areas might require
action:

e Setting and canceling modules

e Resolving symbol ambiguities

2.5.1 Setting and Canceling Modules

To facilitate symbol searches, the debugger loads symbol information from the
executable image into a run-time symbol table (RST), where that information can
be accessed efficiently. Unless symbol information is in the RST, the debugger
does not recognize or properly interpret the associated symbols.

Because the RST takes up memory, the debugger loads it dynamically,
anticipating what symbols you might want to reference in the course of program
execution. The loading process is called module setting, because all symbol
information for a given module is loaded into the RST at one time.

Initially, only the module containing the image transfer address is set.
Subsequently, whenever execution of the program is interrupted, the debugger
sets the module that contains the routine in which execution is paused. This
enables you to reference the symbols that should be visible at that location.

If you try to reference a symbol in a module that has not been set, the debugger
warns you that the symbol is not in the RST. For example:

DBG> EXAMINE K
$DEBUG-W-NOSYMBOL, symbol ‘K’ is not in symbol table
DBG>

You must use the SET MODULE command to set the module containing that
symbol explicitly. For example:

DBG> SET MODULE MOD3
DBG> EXAMINE K
MOD3\ROUT2\K: 26
DBG>

The SHOW MODULE command lists the modules of your program and identifies
which modules are set.
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Dynamic module setting can slow the debugger down as more and more modules
are set. If performance becomes a problem, you can use the CANCEL MODULE
command to reduce the number of set modules, or you can disable dynamic
module setting by entering the SET MODE NODYNAMIC command (SET MODE
DYNAMIC enables dynamic module setting).

2.5.2 Resolving Symbol Ambiguities

Symbol ambiguities can occur when a symbol (for example, a variable name X) is
defined in more than one routine or other program unit.

In most cases, the debugger resolves symbol ambiguities automatically. First,

it uses the scope and visibility rules of the currently set language. In addition,
because the debugger permits you to specify symbols in arbitrary modules (to set
breakpoints and so on), the debugger uses the ordering of routine calls on the call
stack to resolve symbol ambiguities.

If the debugger cannot resolve a symbol ambiguity, it issues a message. For
example:

DBG> EXAMINE Y
$DEBUG-W-NOUNIQUE, symbol 'Y’ is not unique
DBG>

You can then use a path-name prefix to uniquely specify a declaration of the
given symbol. First, use the SHOW SYMBOL command to identify all path
names associated with the given symbol (corresponding to all declarations of that
symbol) that are currently loaded in the RST. Then use the desired path-name
prefix when referencing the symbol. For example:

DBG> SHOW SYMBOL Y
data MOD7\ROUT3\BLOCK1\Y
data MOD4\ROUT2\Y

DBG> EXAMINE MOD4\ROUT2\Y
MOD4\ROUT2\Y: 12

DBG>

If you need to refer to a particular declaration of Y repeatedly, use the SET
SCOPE command to establish a new default scope for symbol lookup. Then,
references to Y without a path-name prefix specify the declaration of Y that is
visible in the new scope. For example:

DBG> SET SCOPE MOD4\ROUT2
DBG> EXAMINE Y
MOD4\ROUT2\Y: 12

DBG>

To display the current scope for symbol lookup, use the SHOW SCOPE command.
To restore the default scope, use the CANCEL SCOPE command.

2.6 Sample Debugging Session

This section walks you through a debugging session with a simple Fortran
program that contains a logic error (see Example 2—-1). Compiler-assigned line
numbers have been added in the example so that you can identify the source lines
referenced in the discussion.

The program, called SQUARES, performs the following functions:

1. Reads a sequence of integer numbers from a data file and saves these
numbers in the array INARR (lines 4 and 5).
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2. Enters a loop in which it copies the square of each nonzero integer into
another array OUTARR (lines 8 through 13).

3. Prints the number of nonzero elements in the original sequence and the
square of each such element (lines 16 through 21).

Example 2-1 Sample Program SQUARES

1: INTEGER INARR(20), OUTARR(20)

2: C

3: C ---Read the input array from the data file.

4z OPEN(UNIT=8, FILE='DATAFILE.DAT’, STATUS='OLD')
5: READ(8,*) N, (INARR(I), I=1,N)

6: C

7: C ---Square all nonzero elements and store in OUTARR.
8: K=0

9: DO 10 I =1, N

10: IF(INARR(I) .NE. 0) THEN

11: OUTARR(K) = INARR(I)**2

12: ENDIF

13: 10 CONTINUE

14: C

15: C ---Print the squared output values. Then stop.
16: PRINT 20, K

17: 20 FORMAT(' Number of nonzero elements is’,I4)

18: DO 40 I =1, K

19: PRINT 30, I, OUTARR(I)

20 30 FORMAT(' Element’,I4,’ has value’,I6)

21: 40 CONTINUE

22: END

When you run SQUARES, it produces the following output, regardless of the
number of nonzero elements in the data file:

$ RUN SQUARES
Number of nonzero elements is 0

The error in the program is that variable K, which keeps track of the current
index into OUTARR, is not incremented in the loop on lines 9 through 13. The
statement K = K + 1 should be inserted just before line 11.

Example 2-2 shows how to start the debugging session and then how to use
the debugger to find the error. Comments, keyed to the callouts, follow the
example.

Example 2-2 Sample Debugging Session Using Program SQUARES

$ FORTRAN/DEBUG/NOOPTIMIZE SQUARES @
$ LINK/DEBUG SQUARES

$ DEBUG/KEEP ©
Debugger Banner and Version Number

DBG> RUN SQUARES @
Language: FORTRAN, Module: SQUARES$MAIN
DBG> STEP 4
stepped to SQUARESSMAIN\3LINE 9
9: DO 10 I =1, N

(continued on next page)
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Example 2-2 (Cont.) Sample Debugging Session Using Program SQUARES

DBG> EXAMINE N,k @
SQUARESS$MAIN\N: 9
SQUARESSMAIN\K: 0

DBG> STEP 2 @

stepped to SQUARES$MAIN\RLINE 11

11: OUTARR (K) = INARR(I)**2
DBG> EXAMINE I,K
SQUARESSMAIN\I: 1
SQUARESSMAIN\K: 0

DBG> DEPOSIT K =1 ©

DBG> SET TRACE/SILENT $LINE 11 DO (DEPOSIT K =K + 1) @
DBG> GO

Number of nonzero elements is 4
Element 1 has value 16
Element 2 has value 36
Element 3 has value 9
Element 4 has value 49
'Normal successful completion’
DBG> SPAWN

$ EDIT SQUARES.FOR (®

10: IF(INARR(I) .NE. 0) THEN
11: K=K+1
12: OUTARR (K) = INARR(I)**2

13: ENDIF

$ FORTRAN/DEBUG/NOOPTIMIZE SQUARES (@

$ LINK/DEBUG SQUARES

$ LOGOUT

DBG> RUN SQUARES O

Language: FORTRAN, Module: SQUARESSMAIN

DBG> SET BREAK $LINE 12 DO (EXAMINE I,K) @

DBG> GO
SQUARESSMAIN\I: 1
SQUARESSMAIN\K: 1
DBG> GO

SQUARESSMAIN\I: 2
SQUARESSMAIN\K: 2
DBG> GO

SQUARESS$MAIN\I: 4
SQUARESSMAIN\K: 3
DBG> EXIT @

$

The following comments apply to the callouts in Example 2—2. Example 2-1
shows the program that is being debugged.

@ The /DEBUG qualifier on the DCL. FORTRAN command directs the compiler
to write the symbol information associated with SQUARES into the object
module, SQUARES.OBJ, in addition to the code and data for the program.

The /NOOPTIMIZE qualifier disables optimization by the Fortran compiler,
which ensures that the executable code matches the source code of the
program. Debugging optimized code can be confusing because the contents
of some program locations might be inconsistent with what you would expect
from viewing the source code.
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2]

3]

The /DEBUG qualifier on the DCL command LINK causes the linker to
include all symbol information that is contained in SQUARES.OBJ in the
executable image.

The DCL command DEBUG/KEEP starts the debugger, which displays
its banner and the debugger prompt, DBG>. You can now enter debugger
commands.

The debugger command RUN SQUARES brings the program SQUARES
under debugger control. The informational message identifies the source
language of the program and the name of the main program unit (FORTRAN
and SQUARES, respectively, in this example).

Execution is initially paused at the start of the main program unit (line 1 of
SQUARES, in this example).

You decide to test the values of variables N and K after the READ statement
has been executed and the value 0 has been assigned to K.

The command STEP 4 executes 4 source lines of the program. Execution is
now paused at line 9. Note that the STEP command ignores source lines that
do not result in executable code; also, by default, the debugger identifies the
source line at which execution is paused.

The command EXAMINE N, K displays the current values of N and K. Their
values are correct at this point in the execution of the program.

The command STEP 2 executes the program into the loop that copies and
squares all nonzero elements of INARR into OUTARR.
The command EXAMINE LK displays the current values of I and K.

I has the expected value 1, but K has the value 0 instead of 1, which is the
expected value. Now you can see the error in the program: K should be
incremented in the loop just before it is used in line 11.

The DEPOSIT command assigns K the value it should have now: 1.

The SET TRACE command is now used to patch the program so that the
value of K is incremented automatically in the loop. The command sets a
tracepoint that triggers every time execution reaches line 11:

e The /SILENT qualifier suppresses the "trace at" message that would
otherwise appear each time line 11 is executed.

e The DO clause issues the DEPOSIT K = K + 1 command every time the
tracepoint is triggered.

To test the patch, the GO command starts execution from the current location.

The program output shows that the patched program works properly. The

EXITSTATUS message shows that the program executed to completion.

The SPAWN command spawns a subprocess to return control temporarily to
DCL level (without ending the debugging session) so that you can correct the
source file and recompile and relink the program.

The EDIT command invokes an editor and the source file is edited to add
K =K + 1 after line 10, as shown. (Compiler-assigned line numbers have
been added to clarify the example.)

The revised program is compiled and linked.
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The LOGOUT command terminates the spawned subprocess and returns
control to the debugger.

The (debugger) command RUN SQUARES brings the revised program under
debugger control so that its correct execution can be verified.

The SET BREAK command sets a breakpoint that triggers every time line
12 is executed. The DO clause displays the values of I and K automatically
when the breakpoint triggers.

The GO command starts execution.

At the first breakpoint, the value of K is 1, indicating that the program is
running correctly so far. Each additional GO command shows the current
values of I and K. After two more GO commands, K is now 3, as expected,
but note that I is 4. The reason is that one of the INARR elements was 0 so
that lines 11 and 12 were not executed (and K was not incremented) for that
iteration of the DO loop. This confirms that the program is running correctly.

The EXIT command ends the debugging session and returns control to DCL
level.
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Controlling and Monitoring Program Execution

This chapter describes how to control and monitor program execution while
debugging by using the following techniques:

e Executing the program by step unit
e Suspending and tracing execution with breakpoints and tracepoints

¢ Monitoring changes in variables and other program locations with
watchpoints

The following related functions are discussed in Chapter 2:
e Starting or resuming program execution with the GO command (Section 2.3.1)

e Monitoring where execution is currently paused with the SHOW CALLS
command (Section 2.3.3)

This chapter includes information that is common to all programs. For more
information:

e See Chapter 15 for additional information specific to multiprocess programs.

e See Chapter 16 for additional information specific to tasking (multithread)
programs.

For information about rerunning your program or running another program from
the current debugging session, see Section 1.3.3 and Section 1.3.4.

3.1 Commands Used to Execute the Program

Only four debugger commands are directly associated with program execution:

GO

STEP

CALL

EXIT (if your program has exit handlers)

As explained in Section 2.3.1 and Section 2.3.2, GO and STEP are the basic
commands for starting and resuming program execution. The STEP command is
discussed further in Section 3.2.

During a debugging session, routines are executed as they are called during the
execution of a program. The CALL command enables you to arbitrarily call and
execute a routine that was linked with your program. This command is discussed
in Section 13.7.

The EXIT command was discussed in Section 1.8, in conjunction with ending a
debugging session. Because it executes any exit handlers in your program, it is
also useful for debugging exit handlers (see Section 14.6).
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When using any of these four commands, note that program execution can be
interrupted or stopped by any of the following events:

e The program terminates
e A breakpoint is reached
e A watchpoint is triggered
e An exception is signaled

e  You press Ctrl/C

3.2 Executing the Program by Step Unit

The STEP command (probably the most frequently used debugger command)
enables you to execute your program in small increments called step units.

By default, a step unit is an executable line of source code. In the following
example, the STEP command executes one line, reports the action ("stepped

to ... "), and displays the line number (27) and source code of the next line to be
executed:

DBG> STEP

stepped to TEST\COUNT\$LINE 27
27: X :=X+1;

DBG>

Execution is now paused at the first machine-code instruction for line 27 of
module TEST. Line 27 is in COUNT, a routine within module TEST.

The STEP command can also execute several source lines at a time. If you specify
a positive integer as a parameter, the STEP command executes that number of
lines. In the following example, the STEP command executes the next three lines:

DBG> STEP 3

stepped to TEST\COUNT\SLINE 34
34: SWAP(X,Y);

DBG>

Note that only those source lines for which code instructions were generated by
the compiler are recognized as executable lines by the debugger. The debugger

skips over any other lines—for example, comment lines. Also, if a line has more
than one statement on it, the debugger executes all the statements on that line
as part of the single step.

Source lines are displayed by default after stepping if they are available for the
module being debugged. Source lines are not available if you are stepping in code
that has not been compiled or linked with the /DEBUG qualifier (for example,

a shareable image routine). If source lines are available, you can control their
display with the SET STEP [NOJSOURCE command and the /[NOJSOURCE
qualifier of the STEP command. For information about how to control the display
of source code in general and in particular after stepping, see Chapter 6.

3.2.1 Changing the STEP Command Behavior
You can change the default behavior of the STEP command in two ways:
¢ By specifying a STEP command qualifier—for example, STEP/INTO

¢ By establishing a new default qualifier with the SET STEP command—for
example, SET STEP INTO
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In the following example, the STEP/INTO command steps into a called routine
when the program counter (PC) is at a call statement. The debugger displays
the source line identifying the routine PRODUCT, which is called from routine
COUNT of module TEST:

DBG> STEP/INTO
stepped to routine TEST\PRODUCT

6: function PRODUCT(X,Y : INTEGER) return INTEGER is
DBG>

After the STEP/INTO command executes, subsequent STEP commands revert to
the default behavior.

In contrast, the SET STEP command enables you to establish new defaults

for the STEP command. These defaults remain in effect until another SET
STEP command is entered. For example, the SET STEP INTO command causes
subsequent STEP commands to behave like STEP/INTO (SET STEP LINE causes
subsequent STEP commands to behave like STEP/LINE).

There is a SET STEP command parameter for each STEP command qualifier.

You can override the current STEP command defaults for the duration of a single
STEP command by specifying other qualifiers. Use the SHOW STEP command to
identify the current STEP command defaults.

3.2.2 Stepping Into and Over Routines

By default, when the PC is at a call statement and you enter the STEP command,
the debugger steps over the called routine. Although the routine is executed,
execution is not paused within the routine but, rather, on the beginning of the
line that follows the call statement. When stepping by instruction, execution is
paused on the instruction that follows a called routine’s return instruction.

To step into a called routine when the PC is at a call statement, enter the
STEP/INTO command. The following example shows how to step into the routine
PRODUCT, which is called from routine COUNT of module TEST:

DBG> STEP
stepped to TEST\COUNT\SLINE 18
18: AREA := PRODUCT(LENGTH, WIDTH);

DBG> STEP/INTO
stepped to routine TEST\PRODUCT

6: function PRODUCT(X,Y : INTEGER) return INTEGER is
DBG>

To return to the calling routine from any point within the called routine, use
the STEP/RETURN command. It causes the debugger to step to the return
instruction of the routine being executed. A subsequent STEP command brings
you back to the statement that follows the routine call. For example:

DBG> STEP/RETURN

stepped on return from TEST\PRODUCT\$LINE 11 to TEST\PRODUCT\SLINE 15+4
15: end PRODUCT;

DBG> STEP

stepped to TEST\COUNT\S$LINE 19
19: LENGTH := LENGTH + 1;

DBG>

To step into several routines, enter the SET STEP INTO command to change the
default behavior of the STEP command from STEP/OVER to STEP/INTO:

DBG> SET STEP INTO
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As a result of this command, when the PC is at a call statement, a STEP
command suspends execution within the called routine. If you later want to step
over routine calls, enter the SET STEP OVER command.

When SET STEP INTO is in effect, you can qualify the kinds of called routines
that the debugger is stepping into by specifying any of the following parameters
with the SET STEP command:

e [NOJSHARE—Controls whether to step into called routines in shareable
images.

e [NOJSYSTEM—Controls whether to step into called system routines.

These parameters make it possible to step into application-defined routines and
automatically step over system routines, and so on. For example, the following
command directs the debugger to step into called routines in user space only. The
debugger steps over routines in system space and in shareable images.

DBG> SET STEP INTO,NOSYSTEM,NOSHARE

3.3 Suspending and Tracing Execution with Breakpoints and
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Tracepoints

This section discusses using the SET BREAK and SET TRACE commands to,
respectively, suspend and trace program execution. The commands are discussed
together because of their similarities.

SET BREAK Command Overview

The SET BREAK command lets you specify program locations or events at which
to suspend program execution (breakpoints). After setting a breakpoint, you can
start or resume program execution with the GO command, letting the program
run until the specified location or condition is reached. When the breakpoint

is triggered, the debugger suspends execution, identifies the breakpoint, and
displays the DBG> prompt. You can then enter debugger commands—for
example, to determine where you are (with the SHOW CALLS command), step
into a routine, examine or modify variables, and so on.

The syntax of the SET BREAK command is as follows:

SET BREAK[/qualifier[ ... ]] [address-expression[, ... ]]
[WHEN (conditional-expression)]
[DO (command[; ... ])]

The following example shows a typical use of the SET BREAK command and
shows the general default behavior of the debugger at a breakpoint.

In this example, the SET BREAK command sets a breakpoint on routine COUNT
(at the beginning of the routine’s code). The GO command starts execution. When
routine COUNT is encountered, execution is paused, the debugger announces that
the breakpoint at COUNT has been reached ("break at ... "), displays the source
line (54) where execution is paused, and prompts for another command:

DBG> SET BREAK COUNT
DBG> GO

break at routine PROG2\COUNT
54: procedure COUNT(X,Y:INTEGER);
DBG>
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SET TRACE Command Overview

The SET TRACE command lets you select program locations or events for tracing
the execution of your program without stopping its execution (tracepoints). After
setting a tracepoint, you can start execution with the GO command and then
monitor that location, checking for unexpected behavior. By setting a tracepoint
on a routine, you can also monitor the number of times it is called.

The debugger’s default behavior at a tracepoint is identical to that at a
breakpoint, except that program execution continues past a tracepoint. Thus,
the DBG> prompt is not displayed when a tracepoint is reached and announced
by the debugger.

Except for the command name, the syntax of the SET TRACE command is
identical to that of the SET BREAK command:

SET TRACE[/qualifier[ ... ]] [address-expression[, ... ]
[WHEN (conditional-expression)]
[DO (command[; ... 1)]

The SET TRACE and SET BREAK commands have similar syntax. When using
the SET TRACE command, specify address expressions, qualifiers, and the
optional WHEN and DO clauses exactly as with the SET BREAK command.

Unless you use the /TEMPORARY qualifier on the SET BREAK or SET TRACE
command, breakpoints and tracepoints remain in effect until you:

e Deactivate or cancel them (see Section 3.3.7)
e Rerun the program with the RERUN/NOSAVE command (see Section 1.3.3)

e Run a new program (see Section 1.3.4) or end the debugging session
(Section 1.8)

To identify all of the breakpoints or tracepoints that are currently set, use the
SHOW BREAK or SHOW TRACE command.

To deactivate, activate, or cancel breakpoints or tracepoints, use the following
commands (see Section 3.3.7):

DEACTIVATE BREAK, DEACTIVATE TRACE
ACTIVATE BREAK, ACTIVATE TRACE
CANCEL BREAK, CANCEL TRACE

The following sections describe how to specify program locations and events with
the SET BREAK and SET TRACE commands.

3.3.1 Setting Breakpoints or Tracepoints on Individual Program Locations

To set a breakpoint or a tracepoint on a particular program location, specify an
address expression with the SET BREAK or SET TRACE command.

Fundamentally, an address expression specifies a memory address or a register.
Because the debugger understands the symbols associated with your program,
the address expressions you typically use with the SET BREAK or SET TRACE
command are routine names, labels, or source line numbers rather than memory
addresses—the debugger converts these symbols to addresses.
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3.3.1.1 Specifying Symbolic Addresses

Note

In some cases, when using the SET BREAK or SET TRACE command
with a symbolic address expression, you might need to set a module or
specify a scope or a path name. Those concepts are described in detail in
Chapter 5. The examples in this section assume that all modules are set
and that all symbols referenced are uniquely defined, unless otherwise
indicated.

The following examples show how to set a breakpoint on a routine (SWAP) and a
tracepoint on a label (LOOP1):

DBG> SET BREAK SWAP
DBG> SET TRACE LOOP1

The next command sets a breakpoint on the return instruction of routine
SWAP. Breaking on the return instruction of a routine lets you inspect the
local environment (for example, to obtain the values of local variables) while the
routine is still active.

DBG> SET BREAK/RETURN SWAP

Some languages, for example Fortran, use numeric labels. To set a breakpoint or
a tracepoint on a numeric label, you must precede the number with the built-in
symbol %LABEL. Otherwise, the debugger interprets the number as a memory
address. For example, the following command sets a tracepoint on label 20:

DBG> SET TRACE 3LABEL 20

You can set a breakpoint or a tracepoint on a line of source code by specifying the
line number preceded by the built-in symbol %#LINE. The following command sets
a breakpoint on line 14:

DBG> SET BREAK 3LINE 14

The previous breakpoint causes execution to pause on the first instruction of line
14. You can set a breakpoint or a tracepoint only on lines for which the compiler
generated instructions (lines that resulted in executable code). If you specify a
line number that is not associated with an instruction, such as a comment line or
a statement that declares but does not initialize a variable, the debugger issues a
diagnostic message. For example:

DBG> SET BREAK %LINE 6

$DEBUG-I-LINEINFO, no line 6, previous line is 5, next line is 8
$DEBUG-E-NOSYMBOL, symbol ‘S$LINE 6’ is not in the symbol table
DBG>

The previous messages indicate that the compiler did not generate instructions
for lines 6 or 7 in this case.

Some languages allow more than one statement on a line. In such cases, you
can use statement numbers to differentiate among statements on the same line.
A statement number consists of a line number, followed by a period (.), and a
number indicating the statement. The syntax is as follows:

SLINE line-number.statement-number
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For example, the following command sets a tracepoint on the second statement of
line 38:

DBG> SET TRACE SLINE 38.2

When searching for symbols that you reference in commands, the debugger

uses the conventions described in Section 5.3.1. That is, it first looks within the
module where execution is currently paused, then in other scopes associated
with routines on the call stack, and so on. Therefore, to specify a symbol that is
defined in more than one module, such as a line number, you might need to use
a path name. For example, the following command sets a tracepoint on line 27 of
module MOD4:

DBG> SET TRACE MOD4\%LINE 27

Remember the symbol lookup conventions when specifying a line number in
debugger commands. If that line number is not defined in the module where
execution is paused (because it is not associated with an instruction), the
debugger uses the symbol lookup conventions to locate another module where
the line number is defined.

When specifying address expressions, you can combine symbolic addresses with
byte offsets. Thus, you can set a breakpoint or a tracepoint on a particular
instruction by specifying its line number and the byte offset from the beginning of
that line to the first byte of the instruction. For example, the next command sets
a breakpoint on the address that is five bytes beyond the beginning of line 23:

DBG> SET BREAK SLINE 23+5

3.3.1.2 Specifying Locations in Memory

To set a breakpoint or a tracepoint on a location in memory, specify its numerical
address in the currently set radix. The default radix for both data entry and
display is decimal for most languages.

On Alpha processors, the exceptions are BLISS, MACR0O-32, and MACRO-64,
which have a default radix of hexadecimal.

On Integrity server, the exceptions are BLISS, MACRO-32, and Intel Assembler.

For example, the following command sets a breakpoint at address 2753, decimal,
or at address 2753, hexadecimal:

DBG> SET BREAK 2753

You can specify a radix when you enter an individual integer literal (such as
2753) by using one of the built-in symbols %BIN, %0OCT, %DEC, or %HEX. For
example, in the following command line the symbol %HEX specifies that 2753
should be treated as a hexadecimal integer:

DBG> SET BREAK %HEX 2753

Note that when specifying a hexadecimal number that starts with a letter rather
than a number, you must add a leading 0. Otherwise, the debugger tries to
interpret the entity specified as a symbol declared in your program.

For additional information about specifying radixes and about the built-in
symbols %BIN, %DEC, %HEX, and %OCT, see Section 4.1.10 and Appendix B.

If a breakpoint or a tracepoint was set on a numerical address that corresponds
to a symbol in your program, the SHOW BREAK or SHOW TRACE command
identifies the breakpoint symbolically.
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3.3.1.3 Obtaining and Symbolizing Memory Addresses

Use the EVALUATE/ADDRESS command to determine the memory address
associated with a symbolic address expression, such as a line number, routine
name, or label. For example:

DBG> EVALUATE/ADDRESS SWAP
1536

DBG> EVALUATE/ADDRESS $LINE 26
1629

DBG>

The address is displayed in the current radix. You can specify a radix qualifier to
display the address in another radix. For example:

DBG> EVALUATE/ADDRESS/HEX $LINE 26
0000065D
DBG>

The SYMBOLIZE command does the reverse of EVALUATE/ADDRESS. It
converts a memory address into its symbolic representation (including its path
name) if such a representation is possible. Chapter 5 explains how to control
symbolization. See Section 4.1.11 for more information about obtaining and
symbolizing addresses.

3.3.2 Setting Breakpoints or Tracepoints on Lines or Instructions

The following SET BREAK and SET TRACE command qualifiers cause the
debugger to break on or trace every source line or every instruction of a particular
class:

/LINE
/BRANCH
/CALL
/INSTRUCTION

When using these qualifiers, do not specify an address expression.

For example, the following command causes the debugger to break on the
beginning of every source line encountered during execution:

DBG> SET BREAK/LINE

The instruction-related qualifiers are especially useful for opcode tracing, which
is the tracing of all instructions or the tracing of a class of instructions. The next
command causes the debugger to trace every branch instruction encountered (for
example BEQL, BGTR, and so on):

DBG> SET TRACE/BRANCH
Note that opcode tracing slows program execution.

By default, when you use the qualifiers discussed in this section, the debugger
breaks or traces within all called routines as well as within the currently
executing routine (this is equivalent to specifying SET BREAK/INTO or SET
TRACE/INTO). By specifying SET BREAK/OVER or SET TRACE/OVER, you
can suppress break or trace action within all called routines. Or, you can use
the /[NO]JSB, /[INO]JSHARE, or /[NO]JSYSTEM qualifiers to specify the kinds of
called routines where break or trace action is to be suppressed. For example, the
next command causes the debugger to break on every line except within called
routines that are in shareable images or system space:

DBG> SET BREAK/LINE/NOSHARE/NOSYSTEM
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3.3.3 Setting Breakpoints on Emulated Instructions (Alpha Only)

On Alpha systems, to cause the debugger to suspend program execution when
an instruction is emulated, use the command SET BREAK/SYSEMULATE. The
syntax of the SET BREAK command when using the /SYSEMULATE qualifier is:

SET BREAK/SYSEMULATE[=mask ]

The optional argument mask is a quadword with bits set to specify which
instruction groups shall trigger breakpoints. The only emulated instruction group
currently defined consists of the BYTE and WORD instructions. Specify this
instruction group by setting bit 0 of mask to 1.

If you do not specify mask, or if mask = FFFFFFFFFFFFFFFF, the debugger
stops program execution whenever the operating system emulates any
instruction.

3.3.4 Controlling Debugger Action at Breakpoints or Tracepoints

The SET BREAK and SET TRACE commands provide several options for
controlling the behavior of the debugger at breakpoints and tracepoints—the
/AFTER, /[NOJSILENT, /[NO]SOURCE, and /TEMPORARY command qualifiers,
and the optional WHEN and DO clauses. The following examples show several of
these options.

The following command sets a breakpoint on line 14 and specifies that the
breakpoint take effect after the fifth time that line 14 is executed:

DBG> SET BREAK/AFTER:5 SLINE 14

The following command sets a tracepoint that is triggered at every line of
execution. The DO clause obtains the value of the variable X when each line is
executed:

DBG> SET TRACE/LINE DO (EXAMINE X)

The following example shows how you capture the WHEN and DO clauses
together. The command sets a breakpoint at line 27. The breakpoint is triggered
(execution is paused) only when the value of SUM is greater than 100 (not each
time line 27 is executed). The DO clause causes the value of TEST RESULT to
be examined whenever the breakpoint is triggered—that is, whenever the value
of SUM is greater than 100. If the value of SUM is not greater than 100 when
execution reaches line 27, the breakpoint is not triggered and the DO clause is
not executed.

DBG> SET BREAK $LINE 27 WHEN (SUM > 100) DO (EXAMINE TEST RESULT)

See Section 4.1.6 and Section 14.3.2.2 for information about evaluating language
expressions like SUM > 100.

The /SILENT qualifier suppresses the break or trace message and source code
display. This is useful when, for example, you want to use the SET TRACE
command only to execute a debugger command at the tracepoint. In the following
example, the SET TRACE command is used to examine the value of the Boolean
variable STATUS at the tracepoint:
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DBG> SET TRACE/SILENT $LINE 83 DO (EXAMINE STATUS)
DBG> GO

SCREEN_IO\CLEAR\STATUS: OFF

In the next example, the SET TRACE command is used to count the number

of times line 12 is executed. The first DEFINE/VALUE command defines a
symbol COUNT and initializes its value to 0. The DO clause of the SET TRACE
command causes the value of COUNT to be incremented and evaluated whenever
the tracepoint is triggered (whenever execution reaches line 12).

DBG> DEFINE/VALUE COUNT=0
DBG> SET TRACE/SILENT RLINE 12 DO (DEF/VAL COUNT=COUNT+1;EVAL COUNT)

Source lines are displayed by default at breakpoints, tracepoints, and watchpoints
if they are available for the module being debugged. You can also control their
display with the SET STEP [NO]SOURCE command and the /[NOJ[SOURCE
qualifier of the SET BREAK, SET TRACE, and SET WATCH commands. See
Chapter 6 for information about how to control the display of source code in
general and in particular at breakpoints, tracepoints, and watchpoints.

3.3.5 Setting Breakpoints or Tracepoints on Exceptions

The SET BREAK/EXCEPTION and SET TRACE/EXCEPTION commands direct
the debugger to treat any exception generated by your program as a breakpoint
or tracepoint, respectively. The breakpoint or tracepoint occurs before any
application-declared exception handler is invoked. See Section 14.5 for debugging
techniques associated with exceptions and condition handlers.

3.3.6 Setting Breakpoints or Tracepoints on Events

The SET BREAK and SET TRACE commands each have an /EVENT=event-name
qualifier. You can use this qualifier to set breakpoints or tracepoints that are
triggered by various events (denoted by event-name keywords). Events and their
keywords are currently defined for the following event facilities:

e ADA event facility, which defines Compaq Ada tasking events. Ada events are
defined in Section 16.6.4.

e THREADS event facility, which defines tasking (multithread) events for
programs written in any language that uses POSIX Threads services.
Threads events are defined in Section 16.6.4.

The appropriate facility and event-name keywords are defined when the program
is brought under debugger control. Use the SHOW EVENT_FACILITY command
to identify the current event facility and the associated event-name keywords.
The SET EVENT_FACILITY command enables you to change the event facility
and change your debugging context. This is useful if you have a multilanguage
program and want to debug a routine that is associated with an event facility but
that facility is not currently set.

The following example shows how to set a SCAN event breakpoint. It causes the
debugger to break whenever a SCAN token is built, for any value:

DBG> SET BREAK/EVENT=TOKEN
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When a breakpoint or tracepoint is triggered, the debugger identifies the event
that caused it to be triggered and gives additional information.

3.3.7 Deactivating, Activating, and Canceling Breakpoints or Tracepoints

After a breakpoint or tracepoint is set, you can deactivate it, activate it, or cancel
it.

To deactivate a breakpoint or tracepoint, enter the DEACTIVATE BREAK

or DEACTIVATE TRACE command. This causes the debugger to ignore the
breakpoint or tracepoint during program execution. However, you can activate it
at a later time, for example, when you rerun the program (see Section 1.3.3). A
deactivated breakpoint or tracepoint is listed as such in a SHOW BREAK display.

To activate a breakpoint or tracepoint, use the ACTIVATE BREAK or
ACTIVATE TRACE command. Activating a breakpoint or tracepoint causes
it to take effect during program execution.

The commands DEACTIVATE BREAK/ALL and ACTIVATE BREAK/ALL
(or DEACTIVATE TRACE/ALL and ACTIVATE TRACE/ALL) operate on all

breakpoints or tracepoints and are particularly useful when rerunning a program
with the RERUN command.

To cancel a breakpoint or tracepoint, use the CANCEL BREAK or
CANCEL TRACE command. A canceled breakpoint or tracepoint is no longer
listed in a SHOW BREAK or SHOW TRACE display.

When using any of these commands, specify the address expression and qualifiers
(if any) exactly as you did when setting the breakpoint or tracepoint. For
example:

DBG> DEACTIVATE TRACE/LINE
DBG> CANCEL BREAK SWAP,MOD2\LOOP4,2753

3.4 Monitoring Changes in Variables and Other Program Locations

The SET WATCH command enables you to specify program variables (or arbitrary
memory locations) that the debugger monitors as your program executes. This
process is called setting watchpoints. If, during execution, the program modifies
the value of a watched variable (or memory location), the watchpoint is triggered.
The debugger then suspends execution, displays information, and prompts

for more commands. The debugger monitors watchpoints continuously during
program execution.

This section describes the general use of the SET WATCH command. Section 3.4.3
gives additional information about setting watchpoints on nonstatic variables—
variables that are allocated on the call stack or in registers.

Note

In some cases, when using the SET WATCH command with a variable
name (or any other symbolic address expression), you might need to set a
module or specify a scope or a path name. Those concepts are described
in Chapter 5. The examples in this section assume that all modules are
set and that all variable names are uniquely defined.

If your program was optimized during compilation, certain variables in
the program might be removed by the compiler. If you then try to set
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a watchpoint on such a variable, the debugger issues a warning (see
Section 1.2 and Section 14.1).

The syntax of the SET WATCH command is as follows:

SET WATCH[/qualifier[ ... 1] address-expression[, ... |
[WHEN (conditional-expression)]
[DO (command[; ... 1)]

You can specify any valid address expression, but usually you specify the
name of a variable. The following example shows a typical use of the SET
WATCH command and shows the general default behavior of the debugger at a
watchpoint:

DBG> SET WATCH COUNT
DBG> GO

watch of MOD2\COUNT at MOD2\%LINE 24
24: COUNT := COUNT + 1;
old value: 27
new value: 28
break at MOD2\%LINE 25
25: END;
DBG>

In this example, the SET WATCH command sets a watchpoint on the variable
COUNT, and the GO command starts execution. When the program changes the
value of COUNT, execution is paused. The debugger then does the following:

e Announces the event ("watch of MOD2\ COUNT . .. "), identifying the
location of the instruction that changed the value of the watched variable
(v ... at MOD2\ %LINE 24")

e Displays the associated source line (24)
¢ Displays the old and new values of the variable (27 and 28)

e Announces that execution is paused at the beginning of the next line ("break
at MOD2\ %LINE 25") and displays that source line

e Prompts for another command

When the address of the instruction that modified a watched variable is not at
the beginning of a source line, the debugger denotes the instruction’s location by
displaying the line number plus the byte offset from the beginning of the line.
For example:

DBG> SET WATCH K
DBG> GO

watch of TEST\K at TEST\3LINE 19+5
19:¢ DO 40K=1,7
old value: 4
new value: 5
break at TEST\$LINE 19+9
19:¢ DO 40K=1,7
DBG>
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In this example, the address of the instruction that modified variable K is 5 bytes
beyond the beginning of line 19. The breakpoint is on the instruction that follows
the instruction that modified the variable (not on the beginning of the next source
line as in the preceding example).

You can set watchpoints on aggregates (that is, entire arrays or records). A
watchpoint set on an array or record triggers if any element of the array or record
changes. Thus, you do not need to set watchpoints on individual array elements
or record components. However, you cannot set an aggregate watchpoint on a
variant record. In the following example, the watchpoint is triggered because
element 3 of array ARR was modified:

DBG> SET WATCH ARR
DBG> GO

watch of SUBR\ARR at SUBR\$LINE 12

12: ARR(3) := 28
old value:
(1): 7
(2): 12
(3): 3
(4): 0
new value:
(1) 7
(2): 12
(3): 28
(4): 0
break at SUBR\$LINE 13

DBG>

You can also set a watchpoint on a record component, on an individual array
element, or on an array slice (a range of array elements). A watchpoint set on an
array slice triggers if any element within that slice changes. When setting the
watchpoint, use the syntax of the current language. For example, the following
command sets a watchpoint on element 7 of array CHECK using Pascal syntax:

DBG> SET WATCH CHECK[7]

To identify all of the watchpoints that are currently set, use the SHOW WATCH
command.

3.4.1 Deactivating, Activating, and Canceling Watchpoints

After a watchpoint is set, you can deactivate it, activate it, or cancel it.

To deactivate a watchpoint, use the DEACTIVATE WATCH command. This
causes the debugger to ignore the watchpoint during program execution.
However, you can activate it at a later time, for example, when you rerun

the program (see Section 1.3.3). A deactivated watchpoint is listed as such in a
SHOW WATCH display.

To activate a watchpoint, use the ACTIVATE WATCH command. Activating a
watchpoint causes it to take effect during program execution. You can always
activate a static watchpoint, but the debugger cancels a nonstatic watchpoint

if execution moves out of the scope in which the variable is defined (see
Section 3.4.3).
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The commands DEACTIVATE WATCH/ALL and ACTIVATE WATCH/ALL operate
on all watchpoints and are particularly useful when rerunning a program with
the RERUN command.

To cancel a watchpoint, use the CANCEL WATCH command. A canceled
watchpoint is no longer listed in a SHOW WATCH display.

3.4.2 Watchpoint Options

The SET WATCH command provides the same options for controlling the behavior
of the debugger at watchpoints that the SET BREAK and SET TRACE commands
provide for breakpoints and tracepoints—namely the /AFTER, /[NOJSILENT,
/INOJSOURCE, and /TEMPORARY qualifiers, and the optional WHEN and DO
clauses. See Section 3.3.4 for examples.

3.4.3 Watching Nonstatic Variables

3-14

Note

The generic term nonstatic variable is used here to denote what is called
an automatic variable in some languages.

Storage for a variable in your program is allocated either statically or
nonstatically. A static variable is associated with the same memory address
throughout execution of the program. A nonstatic variable is allocated on the
call stack or in a register and has a value only when its defining routine is
active on the call stack. As explained in this section, the technique for setting a
watchpoint, the watchpoint’s behavior, and the speed of program execution are
different for the two kinds of variables.

To determine how a variable is allocated, use the EVALUATE/ADDRESS
command. A static variable generally has its address in PO space (0 to
3FFFFFFF, hexadecimal). A nonstatic variable generally has its address in
P1 space (40000000 to 7FFFFFFF, hexadecimal) or is in a register. In the
following Pascal code example, X is declared as a static variable, but Y is a
nonstatic variable (by default). The EVALUATE/ADDRESS command, entered
while debugging, shows that X is allocated at memory location 512, but Y is
allocated in register RO.

VAR
X: [STATIC] INTEGER;
Y: INTEGER;

DBG> EVALUATE/ADDRESS X
512

DBG> EVALUATE/ADDRESS Y
%R0

DBG>

When using the SET WATCH command, note the following distinction. You can
set a watchpoint on a static variable throughout execution of your program, but
you can set a watchpoint on a nonstatic variable only when execution is paused
within the scope of the variable’s defining routine. Otherwise, the debugger
issues a warning. For example:
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DBG> SET WATCH Y

$DEBUG-W-SYMNOTACT, nonstatic variable ’MOD4\ROUT3\Y’
is not active

DBG>

Section 3.4.3.2 describes how to set a watchpoint on a nonstatic variable.

3.4.3.1 Execution Speed

When a watchpoint is set, the speed of program execution depends on whether
the variable is static or nonstatic. To watch a static variable, the debugger write-
protects the page containing the variable. If your program attempts to write to
that page (modify the value of that variable), an access violation occurs and the
debugger handles the exception. The debugger temporarily unprotects the page
to allow the instruction to complete and then determines whether the watched
variable was modified. Except when writing to that page, the program executes
at full speed.

Because problems arise if the call stack or registers are write-protected, the
debugger must use another technique to watch a nonstatic variable. It traces
every instruction in the variable’s defining routine and checks the value of the
variable after each instruction has been executed. Because this significantly slows
down the execution of the program, the debugger issues the following message
when you set a nonstatic watchpoint:

DBG> SET WATCH Y
$DEBUG-I-WPTTRACE, nonstatic watchpoint, tracing every instruction
DBG>

3.4.3.2 Setting a Watchpoint on a Nonstatic Variable

To set a watchpoint on a nonstatic variable, make sure that execution is paused
within the defining routine. A convenient technique is to set a tracepoint on the
routine that includes a DO clause to set the watchpoint. Thus, whenever the
routine is called, the tracepoint is triggered and the watchpoint is automatically
set on the local variable. In the following example, the WPTTRACE message
indicates that a watchpoint has been set on Y, a nonstatic variable that is local to
routine ROUTS:

DBG> SET TRACE/NOSOURCE ROUT3 DO (SET WATCH Y)
DBG> GO

trace at routine MOD4\ROUT3
$DEBUG-I-WPTTRACE, nonstatic watchpoint, tracing every instruction

watch of MOD4\ROUT3\Y at MOD4\ROUT3\$LINE 16

16: Y := 4
old value: 3
new value: 4
break at MOD4\ROUT3\3LINE 17
17: SWAP(X,Y);
DBG>

When execution returns to the caller of routine ROUTS, variable Y is no longer
active. Therefore, the debugger automatically cancels the watchpoint and issues
the following messages:

$DEBUG-I-WATCHVAR, watched variable MOD4\ROUT3\Y has gone out of scope
$DEBUG-I-WATCHCAN, watchpoint now canceled
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3.4.3.3 Options for Watching Nonstatic Variables

The SET WATCH command qualifiers /OVER, /INTO, and /[NO]JSTATIC provide
options for watching nonstatic variables.

When you set a watchpoint on a nonstatic variable, you can direct the debugger
to do one of two things at a routine call:

e Step over the called routine—executing it at full speed—and resume
instruction tracing after returning. This is the default (SET WATCH/OVER).

¢ Trace instructions within the called routine, which monitors the variable
instruction-by-instruction within the routine (SET WATCH/INTO).

Using the SET WATCH/OVER command results in better performance. However,
if the called routine modifies the watched variable, the watchpoint is triggered
only after execution returns from that routine. The SET WATCH/INTO command
slows down program execution but enables you to monitor watchpoints more
precisely within called routines.

The debugger determines whether a variable is static or nonstatic by looking

at its address (PO space, P1 space, or register). When entering a SET WATCH
command, you can override this decision with the /[NOISTATIC qualifier. For
example, if you have allocated nonstack storage in P1 space, use the SET
WATCH/STATIC command to specify that a particular variable is static even
though it is in P1 space. Conversely, if you have allocated your own call stack in
PO space, use the SET WATCH/NOSTATIC command to specify that a particular
variable is nonstatic even though it is in PO space.

3.4.3.4 Setting Watchpoints in Installed Writable Shareable Images

When setting a watchpoint in an installed writable shareable image, use the SET
WATCH/NOSTATIC command (see Section 3.4.3.3).

The reason you must set a nonstatic watchpoint is as follows. Variables declared
in such shareable images are typically static variables. By default, the debugger
watches a static variable by write-protecting the page containing that variable.
However, the debugger cannot write-protect a page in an installed writable
shareable image. Therefore, the debugger must use the slower method of
detecting changes, as for nonstatic variables—that is, by checking the value at the
watched location after each instruction has been executed (see Section 3.4.3.1).

If any other process modifies the watched location’s value, the debugger may
report that your program modified the watched location.
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Examining and Manipulating Program Data

This chapter explains how to use the EXAMINE and DEPOSIT commands to
display and modify the values of symbols declared in your program as well as the
contents of arbitrary program locations. The chapter also explains how to use the
EVALUATE and other commands that evaluate language expressions.

The topics covered in this chapter are organized as follows:

e General concepts related to using the EXAMINE, DEPOSIT, and EVALUATE
commands.

e Use of the commands with symbolic names—for example, the names of
variables and routines declared in your program. Such symbolic address
expressions are associated with compiler generated types.

e Use of the commands with program locations (memory addresses or registers)
that do not have symbolic names. Such address expressions are not
associated with compiler generated types.

e Specifying a type to override the type associated with an address expression.

The examples in this chapter do not cover all language-dependent behavior.
When debugging in any language, be sure also to consult the following
documentation:

e Section 14.3, which highlights some important language differences that you
should be aware of when debugging multilanguage programs.

¢ The debugger’s online help (type HELP Language).

e The documentation supplied with that language.

4.1 General Concepts

This section introduces the EXAMINE, DEPOSIT, and EVALUATE commands
and discusses concepts that are common to those commands.

4.1.1 Accessing Variables While Debugging
Note

The generic term nonstatic variable is used here to denote what is called
an automatic variable in some languages.

Before you try to examine or deposit into a nonstatic (stack-local or register)
variable, its defining routine must be active on the call stack. That is,
program execution must be paused somewhere within the defining routine.
See Section 3.4.3 for more information about nonstatic variables.
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You can examine a static variable at any time during program execution, and
you can examine a nonstatic variable as soon as execution reaches its defining
routine. However, before you examine any variable, you should execute the
program beyond the point where the variable is declared and initialized. The
value contained in any uninitialized variable should be considered invalid.

Many compilers optimize code to make the program run faster. If the code that
you are debugging has been optimized, some program locations might not match
what you would expect from looking at the source code. In particular, some
optimization techniques eliminate certain variables so that you no longer have
access to them while debugging.

Section 14.1 explains the effect of several optimization techniques on the
executable code. When first debugging a program, it is best to disable
optimization, if possible, with the /INOOPTIMIZE (or equivalent) compiler
command qualifier.

In some cases, when using the EXAMINE or DEPOSIT command with a variable
name (or any other symbolic address expression) you might need to set a module
or specify a scope or a path name. Those concepts are described in Chapter 5.
The examples in this chapter assume that all modules are set and that all
variable names are uniquely defined.

4.1.2 Using the EXAMINE Command
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For high-level language programs, the EXAMINE command is used mostly to
display the current value of variables, and it has the following syntax:

EXAMINE address-expression[, ... ]

For example, the following command displays the current value of the integer
variable X:

DBG> EXAMINE X
MOD3\X: 17
DBG>

When displaying the value, the debugger prefixes the variable name with its path
name—in this case, the name of the module where variable X is declared (see
Section 5.3.2).

The EXAMINE command usually displays the current value of the entity, denoted
by an address expression, in the type associated with that location (for example,
integer, real, array, record, and so on).

When you enter an EXAMINE command, the debugger evaluates the address
expression to yield a program location (a memory address or a register). The
debugger then displays the value stored at that location as follows:

e If the location has a symbolic name, the debugger formats the value according
to the compiler-generated type associated with that symbol.

e If the location does not have a symbolic name, the debugger formats the value
in the type longword integer by default.

See Section 4.1.5 for more information about the types associated with symbolic
and nonsymbolic address expressions.

By default, when displaying the value, the debugger identifies the address
expression and its path name symbolically if symbol information is available. See
Section 4.1.11 for more information about symbolizing addresses.
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The debugger can directly examine a wchar_t variable:

DBG> EXAMINE wide_buffer
TST\main\wide buffer[0:31]: ’'test data line l................ !

OpenVMS Debugger on Integrity servers displays general, floatingpoint and
predicate registers as if the register rename base (CFM.rrb) and rotating size
(CFM.sor) are both zero. In other words, when rotating registers are in use, the
effects of the rotation are ignored.

Note

This is a rare condition that occurs only in unusual circumstances in C++
and asssembly language programs; most programs are not affected by this
problem.

In this condition, you must examine the CFM register and manually adjust the
EXAMINE command to account for the non-zero CFM.rrb and CFM.sor fields.

4.1.3 Using the DUMP Command

Use the debugger command DUMP to display the contents of memory, in a
manner similar to that of the DCL command DUMP, in one of the following
formats:

Binary

Byte

Decimal
Hexadecimal
Longword (default)
Octal

Quadword

Word

The DUMP command has the following syntax:
DUMP address-expressionl|:address-expression? ]

The default for address-expression2 is address-expressionl. For example, the
following command displays the current value of registers R16 through R25 in
quadword format.

DBG> DUMP/QUADWORD R16:R25

0000000000000078 0000000000030038 8....... Keveooos %R16

000000202020786B 0000000000030041 A....... kx ... %R18

0000000000030140 0000000000007800 .Xu'uuw. [N %R20

0000000000010038 0000000000000007 v.euvuunn Beveennn %R22

0000000000000006 0000000000000000 vuvuvuvenenenenn %R24
DBG>

You can use the command DUMP to display registers, variables, and arrays. The
debugger makes no attempt to interpret the structure of arrays. The following
qualifiers determine how the debugger displays output from the DUMP command:
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Qualifier Formats Output As
/BINARY Binary integers
/BYTE One-byte integers
/DECIMAL Decimal integers

/HEXADECIMAL Hexadecimal integers
/LONGWORD Longword integers (length 4 bytes)

/OCTAL Octal integers
/QUADWORD Quadword integers (length 8 bytes)
/WORD Word integers (length 2 bytes)

By default, the debugger displays examined entities that do not have a compiler-
generated type as longwords.

4.1.4 Using the DEPOSIT Command
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For high-level languages, the DEPOSIT command is used mostly to assign a new
value to a variable. The command is similar to an assignment statement in most
programming languages, and has the following syntax:

DEPOSIT address-expression = language-expression

For example, the following DEPOSIT command assigns the value 23 to the
integer variable X:

DBG> EXAMINE X
MOD3\X: 17

DBG> DEPOSIT X = 23
DBG> EXAMINE X
MOD3\X: 23

DBG>

The DEPOSIT command usually evaluates a language expression and deposits
the resulting value into a program location denoted by an address expression.

When you enter a DEPOSIT command, the debugger does the following:
e It evaluates the address expression to yield a program location.

e If the program location has a symbolic name, the debugger associates the
location with the symbol’s compiler generated type. If the location does not
have a symbolic name, the debugger associates the location with the type
longword integer by default (see Section 4.1.5).

e It evaluates the language expression in the syntax of the current language
and in the current radix to yield a value. This behavior is identical to that of
the EVALUATE command (see Section 4.1.6).

e It checks that the value and type of the language expression is consistent
with the type of the address expression. If you try to deposit a value that
is incompatible with the type of the address expression, the debugger issues
a diagnostic message. If the value is compatible, the debugger deposits the
value into the location denoted by the address expression.

Note that the debugger might do type conversion during a deposit operation if
the language rules allow it. For example, assume X is an integer variable. In the
following example, the real value 2.0 is converted to the integer value 2, which is
then assigned to X:
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DBG> DEPOSIT X = 2.0
DBG> EXAMINE X
MOD3\X: 2

DBG>

In general, the debugger tries to follow the assignment rules for the current
language.

4.1.5 Address Expressions and Their Associated Types

The symbols that are declared in your program (variable names, routine names,
and so on) are symbolic address expressions. They denote memory addresses

or registers. Symbolic address expressions (also called symbolic names in this
chapter) have compiler-generated types, and the debugger knows the type and
location that are associated with symbolic names. Section 4.1.11 explains how to
obtain memory addresses and register names from symbolic names and how to
symbolize program locations.

Symbolic names include the following categories:

e Variables

The associated program locations contain the current values of variables.
Techniques for examining and depositing into variables are described in
Section 4.2.

¢ Routines, labels, and line numbers

The associated program locations contain instructions. Techniques for
examining and depositing instructions are described in Section 4.3.

Program locations that do not have a symbolic name are not associated with

a compiler-generated type. To enable you to examine and deposit into such
locations, the debugger associates them with the default type longword integer.
If you specify a location that does not have a symbolic name, the EXAMINE
command displays the contents of four bytes starting at the address specified and
formats the displayed information as an integer value. In the following example,
the memory address 926 is not associated with a symbolic name (note that the
address is not symbolized when the EXAMINE command is executed). Therefore,
the EXAMINE command displays the value at that address as a longword integer.

DBG> EXAMINE 926
926: 749404624
DBG>

By default you can deposit up to four bytes of integer data into a program location
that does not have a symbolic name. This data is formatted as a longword integer.
For example:

DBG> DEPOSIT 926 = 84
DBG> EXAMINE 926

926: 84

DBG>

Techniques for examining and depositing into locations that do not have a
symbolic name are described in Section 4.5.

The EXAMINE and DEPOSIT commands accept type qualifiers (/ASCIIL:n, /BYTE,
and so on) that enable you to override the type associated with a program
location. This is useful either if you want the contents of the location to be
interpreted and displayed in another type, or if you want to deposit some value of
a particular type into a location that is associated with another type. Techniques
for overriding a type are described in Section 4.5.
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4.1.6 Evaluating Language Expressions
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A language expression consists of any combination of one or more symbols,
literals, and operators that is evaluated to a single value in the syntax of the
current language and in the current radix. (The current language and current
radix are defined in Section 4.1.9 and Section 4.1.10, respectively.) Several
debugger commands and constructs evaluate language expressions:

e The EVALUATE and DEPOSIT commands, which are described in this
section and in Section 4.1.4, respectively

e The IF, FOR, REPEAT, and WHILE commands (see Section 13.6)

e WHEN clauses, which are used with the SET BREAK, SET TRACE, and SET
WATCH commands (see Section 3.3.4)

This discussion applies to all commands and constructs that evaluate language
expressions, but it focuses on using the EVALUATE command.

The EVALUATE command evaluates one or more language expressions in the
syntax of the current language and in the current radix and displays the resulting
values. The command has the following syntax:

EVALUATE language-expression[, ... |

One use of the EVALUATE command is to perform arithmetic calculations that
might be unrelated to your program. For example:

DBG> EVALUATE (8+12)*6/4
30
DBG>

The debugger uses the rules of operator precedence of the current language when
evaluating language expressions.

You can also evaluate language expressions that include variables and other
constructs. For example, the following EVALUATE command subtracts 3 from
the current value of the integer variable X, multiplies the result by 4, and
displays the resulting value:

DBG> DEPOSIT X = 23

DBG> EVALUATE (X - 3) * 4
80

DBG>

However, you cannot evaluate a language expression that includes a function call.
For example, if PRODUCT is a function that multiplies two integers, you cannot
enter the EVALUATE PRODUCT(3,5) command. If your program assigns the
returned value of a function to a variable, you can examine the resulting value of
that variable.

If an expression contains symbols with different compiler generated types, the
debugger uses the type-conversion rules of the current language to evaluate
the expression. If the types are incompatible, a diagnostic message is issued.
Debugger support for operators and other constructs in language expressions is
listed in the debugger’s online help for each language (type HELP Language).

The built-in symbol %CURVAL denotes the current value—the value last
displayed by an EVALUATE or EXAMINE command or deposited by a DEPOSIT
command. The backslash (\ ) also denotes the current value when used in that
context. For example:
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DBG> EXAMINE X

MOD3\X: 23
DBG> EVALUATE %CURVAL
23

DBG> DEPOSIT Y = 47
DBG> EVALUATE \

47

DBG>

4.1.6.1 Using Variables in Language Expressions
You can use variables in language expressions in much the same way that you

use them in the source code of your program.

Thus, the debugger generally interprets a variable used in a language expression
as the current value of that variable, not the address of the variable. For example
(X is an integer variable):

DBG> DEPOSIT X = 12 ! Assign the value 12 to X.

DBG> EXAMINE X ! Display the value of X.

MOD4\X: 12

DBG> EVALUATE X ! Evaluate and display the value of X.

12

DBG> EVALUATE X + 4 ! Add the value of X to 4.

16

DBG> DEPOSIT X = X/2 ! Divide the value of X by 2 and assign
! the resulting value to X.

DBG> EXAMINE X ! Display the new value of X.

MOD4\X: 6

DBG>

Using a variable in a language expression as shown in the previous examples

is generally limited to single-valued, noncomposite variables. Typically, you can
specify a multivalued, composite variable (like an array or record) in a language
expression only if the syntax indicates that you are referencing only a single
value (a single element of the aggregate). For example, if ARR is the name of an
array of integers, the following command is invalid:

DBG> EVALUATE ARR
$DEBUG-W-NOVALUE, reference does not have a value
DBG>

However, the following commands are valid because only a single element of the
array is referenced:

DBG> EVALUATE ARR(2) ! Evaluate element 2 of array ARR.
37

DBG> DEPOSIT K = 5 + ARR(2) ! Deposit the sum of two integer
DBG> ! values into an integer variable.

If the current language is BLISS, the debugger interprets a variable in a language
expression as the address of that variable. To denote the value stored in a
variable, you must use the contents-of operator (period (.)). For example, when
the language is set to BLISS:
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DBG> EXAMINE Y ! Display the value of Y.
MOD4\Y: 3

DBG> EVALUATE Y ! Display the address of Y.
02475B

DBG> EVALUATE .Y ! Display the value of Y.

3

DBG> EVALUATE Y + 4 ! Add 4 to the address of Y and
02475F ! display the resulting value.
DBG> EVALUATE .Y + 4 ! Add 4 to the value of Y and display
7 ! the resulting value.

DBG>

For all languages, to obtain the address of a variable, use the
EVALUATE/ADDRESS command as described in Section 4.1.11. The EVALUATE
and EVALUATE/ADDRESS commands both display the address of an address
expression when the language is set to BLISS.

4.1.6.2 Numeric Type Conversion by the Debugger

When evaluating language expressions involving numeric types of different
precision, the debugger first converts lower-precision types to higher-precision
types before performing the evaluation. In the following example, the debugger
converts the integer 1 to the real 1.0 before doing the addition:

DBG> EVALUATE 1.5 + 1
2.5
DBG>

The basic rules are as follows:

e Ifinteger and real types are mixed, the integer type is converted to the real
type.

e If integer types of different sizes are mixed (for example, byte-integer and
word-integer), the one with the smaller size is converted to the larger size.

e Ifreal types of different sizes are mixed (for example, S_float and T float), the
one with the smaller size is converted to the larger size.

In general, the debugger allows more numeric type conversion than the
programming language. In addition, the hardware type used for a debugger
calculation (word, longword, S_float, and so on) might differ from that chosen by
the compiler. Because the debugger is not as strongly typed or as precise as some
languages, the evaluation of an expression by the EVALUATE command might
differ from the result that would be calculated by compiler-generated code and
obtained with the EXAMINE command.

4.1.7 Address Expressions Compared to Language Expressions
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Do not confuse address expressions with language expressions. An address
expression specifies a program location; a language expression specifies a value.
In particular, the EXAMINE command expects an address expression as its
parameter, and the EVALUATE command expects a language expression as its
parameter. These points are shown in the next examples.

In the following example, the value 12 is deposited into the variable X. This is
confirmed by the EXAMINE command. The EVALUATE command computes and
displays the sum of the current value of X and the integer literal 6,



Examining and Manipulating Program Data
4.1 General Concepts

DBG> DEPOSIT X = 12
DBG> EXAMINE X
MOD3\X: 12

DBG> EVALUATE X + 6
18

DBG>

In the next example, the EXAMINE command displays the value currently stored
at the memory location that is 6 bytes beyond the address of X:

DBG> EXAMINE X + 6
MOD3\X+6: 274903
DBG>

In this case the location is not associated with a compiler-generated type.
Therefore, the debugger interprets and displays the value stored at that location
in the type longword integer (see Section 4.1.5).

In the next example, the value of X + 6 (that is, 18) is deposited into the location
that is 6 bytes beyond the address of X. This is confirmed by the last EXAMINE
command.

DBG> EXAMINE X

MOD3\X: 12

DBG> DEPOSIT X + 6 = X + 6
DBG> EXAMINE X

MOD3\X: 12

DBG> EXAMINE X + 6
MOD3\X+6: 18

DBG>

4.1.8 Specifying the Current, Previous, and Next Entity

When using the EXAMINE and DEPOSIT commands, you can use three special
built-in symbols (address expressions) to refer quickly to the current, previous,
and next data locations (logical entities). These are the period (.), the circumflex
(7), and the Return key.

The period (.), when used by itself with an EXAMINE or DEPOSIT command,
denotes the current entity—that is, the program location most recently referenced
by an EXAMINE or DEPOSIT command. For example:

DBG> EXAMINE X
SIZE\X: 7

DBG> DEPOSIT . = 12
DBG> EXAMINE .
SIZE\X: 12

DBG>

The circumflex (») and Return key denote, respectively, the previous and next
logical data locations relative to the last EXAMINE or DEPOSIT command (the
logical predecessor and successor, respectively). The circumflex and Return key
are useful for referring to consecutive indexed components of an array. The
following example shows the use of these operators with an array of integers,
ARR:
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DBG> EXAMINE ARR(5) ! Examine element 5 of array ARR.
MAIN\ARR(5): 448670

DBG> EXAMINE " ! Examine the previous element (4).
MAIN\ARR(4): 792802

DBG> EXAMINE ! Examine the next element (5).
MAIN\ARR(5): 448670

DBG> EXAMINE ! Examine the next element (6).
MAIN\ARR(6): 891236

DBG>

The debugger uses the type associated with the current entity to determine
logical successors and predecessors.

You can also use the built-in symbols %CURLOC, %PREVLOC, and %NEXTLOC
to achieve the same purpose as the period, circumflex, and Return key,
respectively. These symbols are useful in command procedures and also if

your program uses the circumflex for other purposes. Moreover, using the Return
key to signify the logical successor does not apply to all contexts. For example,
you cannot press the Return key after entering the DEPOSIT command to
indicate the next location, but you can always use the symbol %2NEXTLOC for
that purpose.

Note that, like EXAMINE and DEPOSIT, the EVALUATE/ADDRESS command
also resets the values of the current, previous, and next logical-entity built-in
symbols (see Section 4.1.11). However, you cannot press the Return key after
entering the EVALUATE/ADDRESS command to indicate the next location. For
more information about debugger built-in symbols, see Appendix B.

The previous examples show the use of the built-in symbols after referencing a
symbolic name with the EXAMINE or DEPOSIT command. If you examine or
deposit into a memory address, that location might or might not be associated
with a compiler-generated type. When you reference a memory address, the
debugger uses the following conventions to determine logical predecessors and
successors:

e If the address has a symbolic name (the name of a variable, component of
a composite variable, routine, and so on), the debugger uses the associated
compiler-generated type.

e If the address does not have a symbolic name, the debugger uses the type
longword integer by default.

As the current entity is reset with new examine or deposit operations, the
debugger associates each new location with a type in the manner indicated to
determine logical successors and predecessors. This is shown in the following
examples.

Assume that a Fortran program has declared three variables, ARY, FLT, and
BTE, as follows:

e ARY is an array of three word integers (2 bytes each)
e FLT is an F_floating type (4 bytes)
e BTE is a byte integer (1 byte)

Assume that storage for these variables has been allocated at consecutive
addresses in memory, starting with 1000. For example:
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1000: ARY(1)
1002: ARY(2)
1004: ARY(3)
1006: FLT

1010: BTE

1011: undefined

Examining successive logical data locations will give the following results:

DBG> EXAMINE 1000 ! Examine ARY(1l), associated with 1000.
MOD3\ARY(1): 13 ! Current entity is now ARY(1).

DBG> EXAMINE ! Examine next location, ARY(2),
MOD3\ARY(2): 7 ! using type of ARY(1l) as reference.
DBG> EXAMINE ! Examine next location, ARY(3).
MOD3\ARY(3): 19 ! Current entity is now ARY(3).

DBG> EXAMINE ! Examine entity at 1006 (FLT).

MOD3\FLT: 1.9117807E+07 ! Current entity is now FLT.

DBG> EXAMINE ! Examine entity at 1010 (BTE).

MOD3\BTE: 43 ! Current entity is now BTE.

DBG> EXAMINE ! Examine entity at 1011 (undefined).
1011: 17694732 ! Interpret data as longword integer.
DBG> ! Location is not symbolized.

The same principles apply when you use type qualifiers with the EXAMINE
and DEPOSIT commands (see Section 4.5.2). The type specified by the qualifier
determines the data boundary of an entity and, therefore, any logical successors
and predecessors.

4.1.9 Language Dependencies and the Current Language

The debugger enables you to set your debugging context to any of several
supported languages. The setting of the current language determines how the
debugger parses and interprets the names, numbers, operators, and expressions
you specify in debugger commands, and how it displays data.

By default, the current language is the language of the module containing the
main program, and it is identified when you bring the program under debugger
control. For example:

$ PASCAL/NOOPTIMIZE/DEBUG TEST1
$ LINK/DEBUG TEST1
$ DEBUG/KEEP

Debugger Banner and Version Number

DBG> RUN TEST1
Language: PASCAL, Module: TEST1
DBG>

When debugging modules whose code is written in other languages, you can use
the SET LANGUAGE command to establish a new language-dependent context.
Section 14.3 highlights some important language differences. Debugger support
for operators and other constructs in language expressions is listed for each
language in the debugger’s online help (type HELP Language).
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4.1.10 Specifying a Radix for Entering or Displaying Integer Data
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The debugger can interpret and display integer data in any one of four radixes:
decimal, hexadecimal, octal, and binary. The default radix is decimal for most
languages.

On Alpha processors, the exceptions are BLISS, MACRO-32 and MACRO-64,
which have a default radix of hexadecimal.

You can control the radix for the following kinds of integer data:
e Data that you specify in address expressions or language expressions
e Data that is displayed by the EVALUATE and EXAMINE commands

You cannot control the radix for other kinds of integer data. For example,
addresses are always displayed in hexadecimal radix in a SHOW CALLS display.
Or, when specifying an integer n with various command qualifiers (/AFTER:n,
/UP:n, and so on), you must use decimal radix.

The technique you use to control radix depends on your objective. To establish
a new radix for all subsequent commands, use the SET RADIX command. For
example:

DBG> SET RADIX HEXADECIMAL

After this command is executed, all integer data that you enter in address or
language expressions is interpreted as being hexadecimal. Also, all integer data
displayed by the EVALUATE and EXAMINE commands is given in hexadecimal
radix.

The SHOW RADIX command identifies the current radix (which is either the
default radix, or the radix last established by a SET RADIX command). For
example:

DBG> SHOW RADIX

input radix: hexadecimal
output radix: hexadecimal
DBG>

The SHOW RADIX command identifies both the input radix (for data entry)
and the output radix (for data display). The SET RADIX command qualifiers
/INPUT and /OUTPUT enable you to specify different radixes for data entry and
display. For more information, see the SET RADIX command.

Use the CANCEL RADIX command to restore the default radix.

The examples that follow show several techniques for displaying or entering
integer data in another radix without changing the current radix.

To convert some integer data to another radix without changing the current
radix, use the EVALUATE command with a radix qualifier (/BINARY, /DECIMAL,
/HEXADECIMAL, /OCTAL). For example:

DBG> SHOW RADIX

input radix: decimal

output radix: decimal
DBG> EVALUATE 18 + 5

23 ! 23 is decimal integer.
DBG> EVALUATE/HEX 18 + 5

00000017 ! 17 is hexadecimal integer.
DBG>
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The radix qualifiers do not affect the radix for data entry.

To display the current value of an integer variable (or the contents of a program
location that has an integer type) in another radix, use the EXAMINE command
with a radix qualifier. For example:

DBG> EXAMINE X

MOD4\X: 4398 ! 4398 is a decimal integer.
DBG> EXAMINE/OCTAL . ! X is the current entity.
MOD4\X: 00000010456 ! 10456 is an octal integer.
DBG>

To enter one or more integer literals in another radix without changing the
current radix, use one of the radix built-in symbols %BIN, %2DEC, %HEX, or
%OCT. A radix built-in symbol directs the debugger to treat an integer literal
that follows (or all numeric literals in a parenthesized expression that follows) as
a binary, decimal, hexadecimal, or octal number, respectively. These symbols do
not affect the radix for data display. For example:

DBG> SHOW RADIX
input radix: decimal
output radix: decimal

DBG> EVAL $%$BIN 10 ! Evaluate the binary integer 10.

2 ! 2 is a decimal integer.
DBG> EVAL %HEX (10 + 10) ! Evaluate the hexadecimal integer 20.
32 ! 32 is a decimal integer.

65 ! 65 is a decimal integer.
DBG> EVAL/HEX $0CT 4672 ! Treat 4672 as octal and display in hex.
000009BA ! 9BA is a hexadecimal number.

DBG> EXAMINE X + $DEC 12
MOD3\X+12: 493847

! Examine the location 12 decimal bytes

|
|
|
|
DBG> EVAL %HEX 20 + 33 ! Treat 20 as hexadecimal, 33 as decimal.
|
|
|
|
! beyond the address of X.

DBG> DEPOS J = %0CT 7777777 ! Deposit an octal value.
DBG> EXAMINE . ! Display that value in decimal radix.
MOD3\J: 2097151
DBG> EXAMINE/OCTAL . ! Display that value in octal radix.
MOD3\J: 00007777777
DBG> EXAMINE %HEX 0A34D ! Examine location A34D, hexadecimal.
SHARESLIBRTL+4941: 344938193 ! 344938193 is a decimal integer.
DBG>

Note

When specifying a hexadecimal integer that starts with a letter rather
than a number (for example, A34D in the last example), add a leading
0. Otherwise, the debugger tries to interpret the integer as a symbol
declared in your program.

For more examples showing the use of the radix built-in symbols, see
Appendix B.

4.1.11 Obtaining and Symbolizing Memory Addresses

Use the EVALUATE/ADDRESS command to determine the memory address
or the register name associated with a symbolic address expression, such as a
variable name, line number, routine name, or label. For example:
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DBG> EVALUATE/ADDRESS X ! A variable name
2476

DBG> EVALUATE/ADDRESS SWAP ! A routine name
1536

DBG> EVALUATE/ADDRESS %LINE 26

1629

DBG>

The address is displayed in the current radix (as defined in Section 4.1.10). You
can specify a radix qualifier to display the address in another radix. For example:

DBG> EVALUATE/ADDRESS/HEX X
000009AC
DBG>

If a variable is associated with a register instead of a memory address, the
EVALUATE/ADDRESS command displays the name of the register, regardless of
whether a radix qualifier is used. The following command indicates that variable
K (a nonstatic variable) is associated with register R2:

DBG> EVALUATE/ADDRESS K
%R2
DBG>

Like the EXAMINE and DEPOSIT commands, EVALUATE/ADDRESS resets

the values of the current, previous, and next logical-entity built-in symbols (see
Section 4.1.8). Unlike the EVALUATE command, EVALUATE/ADDRESS does not
affect the current-value built-in symbols %CURVAL and backslash (\ ).

The SYMBOLIZE command does the reverse of EVALUATE/ADDRESS, but
without affecting the current, previous, or next logical-entity built-in symbols. It
converts a memory address or a register name into its symbolic representation
(including its path name) if such a representation is possible (Chapter 5 explains
how to control symbolization). For example, the following command shows that
variable K is associated with register R2:

DBG> SYMBOLIZE %R2

address MOD3\$%R2:
MOD3\K

DBG>

By default, symbolic mode is in effect (SET MODE SYMBOLIC). Therefore, the
debugger displays all addresses symbolically if symbols are available for the
addresses. For example, if you specify a numeric address with the EXAMINE

command, the address is displayed in symbolic form if symbolic information is
available:

DBG> EVALUATE/ADDRESS X

2476

DBG> EXAMINE 2476
MOD3\X: 16

DBG>

However, if you specify a register that is associated with a variable, the
EXAMINE command does not convert the register name to the variable name.
For example:
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DBG> EVALUATE/ADDRESS K
%R2

DBG> EXAMINE %R2
MOD3\%R2: 78

DBG>

By entering the SET MODE NOSYMBOLIC command, you disable symbolic mode
and cause the debugger to display numeric addresses rather than their symbolic
names. When symbolization is disabled, the debugger might process commands
somewhat faster because it does not need to convert numbers to names. The
EXAMINE command has a /[INO]J[SYMBOLIC qualifier that enables you to control
symbolization for a single EXAMINE command. For example:

DBG> EVALUATE/ADDRESS Y

512

DBG> EXAMINE 512

MOD3\Y: 28

DBG> EXAMINE/NOSYMBOLIC 512
512: 28

DBG>

Symbolic mode also affects the display of instructions.

For example, on Integrity servers:

DBG> EXAMINE/INSTRUCTION .3%PC

HELLO\main\%LINE 8: add r34=200028, rl
DBG> EXAMINE/NOSYMBOL/INSTRUCTION .3%PC

65969: add r34 = 200028, rl
DBG>

4.2 Examining and Depositing into Variables

The examples in this section show how to use the EXAMINE and DEPOSIT
commands with variables.

Languages differ in the types of variables they use, the names for these types,
and the degree to which different types can be intermixed in expressions. The
following generic types are discussed in this section:

e Scalars (such as integer, real, character, or Boolean)

e Strings
e Arrays
e Records

e Pointers (access types)

The most important consideration when examining and manipulating variables in
high-level language programs is that the debugger recognizes the names, syntax,
type constraints, and scoping rules of the variables in your program. Therefore,
when specifying a variable with the EXAMINE or DEPOSIT command, you use
the same syntax that is used in the source code. The debugger processes and
displays the data accordingly. Similarly, when assigning a value to a variable, the
debugger follows the typing rules of the language. It issues a diagnostic message
if you try to deposit an incompatible value. The examples in this section show
some of these invalid operations and the resulting diagnostics.
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When using the DEPOSIT command (or any other command), note the following
behavior. If the debugger issues a diagnostic message with a severity level of 1
(informational), the command is still executed (the deposit is made in this case).
The debugger aborts an illegal command line only when the severity level of the
message is W (warning) or greater.

For additional language-specific information, see the debugger’s online help (type
HELP Language).

4.2.1 Scalar Types
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The following examples show use of the EXAMINE, DEPOSIT, and EVALUATE
commands with some integer, real, and Boolean types.

Examine a list of three integer variables:

DBG> EXAMINE WIDTH, LENGTH, AREA
SIZE\WIDTH: 4

SIZE\LENGTH: 7

SIZE\AREA: 28

DBG>

Deposit an integer expression:

DBG> DEPOSIT WIDTH = CURRENT WIDTH + 10
DBG>

The debugger checks that a value to be assigned is compatible with the data type
and dimensional constraints of the variable. The following example shows an
attempt to deposit an out-of-bounds value (X was declared as a positive integer):

DBG> DEPOSIT X = -14
$DEBUG-I-IVALOUTBNDS, value assigned is out of bounds at or near DEPOSIT
DBG>

If you try to mix numeric types (integer and real of varying precision) in a
language expression, the debugger generally follows the rules of the language.
Strongly typed languages do not allow much, if any, mixing. With some
languages, you can deposit a real value into an integer variable. However,
the real value is converted into an integer. For example:

DBG> DEPOSIT I = 12345
DBG> EXAMINE I
MOD3\I: 12345
DBG> DEPOSIT I
DBG> EXAMINE I
MOD3\I: 123
DBG>

123.45

If numeric types are mixed in an expression, the debugger performs type
conversion as discussed in Section 4.1.6.2. For example:
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DBG> DEPOSIT Y = 2.356 ! Y is of type G floating point.
DBG> EXAMINE Y -
MOD3\Y: 2.35600000000000
DBG> EVALUATE Y + 3
5.35600000000000
DBG> DEPOSIT R = 5.35E3 ! R is of type F floating point.
DBG> EXAMINE R -
MOD3\R: 5350.000
DBG> EVALUATE R*50
267500.0
DBG> DEPOSIT I = 22222
DBG> EVALUATE R/I
0.2407524
DBG>

The next example shows some operations with Boolean variables. The values
TRUE and FALSE are assigned to the variables WILLING and ABLE,
respectively. The EVALUATE command then obtains the logical conjunction
of these values.

DBG> DEPOSIT WILLING = TRUE
DBG> DEPOSIT ABLE = FALSE

DBG> EVALUATE WILLING AND ABLE
False

DBG>

4.2.2 ASCII String Types

When displaying an ASCII string value, the debugger encloses it within quotation
marks (") or apostrophes (’), depending on the language syntax. For example:

DBG> EXAMINE EMPLOYEE_NAME
PAYROLL\EMPLOYEE NAME: "Peter C. Lombardi"
DBG>

To deposit a string value (including a single character) into a string variable, you

must enclose the value in quotation marks (") or apostrophes (7). For example:

DBG> DEPOSIT PART NUMBER = "WG-7619.3-84"
DBG>

If the string has more ASCII characters (1 byte each) than can fit into the location
denoted by the address expression, the debugger truncates the extra characters
from the right and issues the following message:

$DEBUG-I-ISTRTRU, string truncated at or near DEPOSIT
If the string has fewer characters, the debugger pads the remaining characters to
the right of the string by inserting ASCII space characters.

4.2.3 Array Types

You can examine an entire array aggregate, a single indexed element, or a slice
(a range of elements). However, you can deposit into only one element at a time.
The following examples show typical operations with arrays.

The following command displays the values of all the elements of the array
variable ARRX, a one-dimensional array of integers:

4-17



Examining and Manipulating Program Data
4.2 Examining and Depositing into Variables

DBG> EXAMINE ARRX

MOD3\ARRX
(1): 42
(2): 17
(3): 278
(4): 56
(5): 113
(6): 149

DBG>

The following command displays the value of element 4 of array ARRX (depending
on the language, parentheses or brackets are used to denote indexed elements):

DBG> EXAMINE ARRX(4)
MOD3\ARRX(4): 56
DBG>

The following command displays the values of all the elements in a slice of ARRX.
This slice consists of the range of elements from element 2 to element 5:

DBG> EXAMINE ARRX(2:5)

MOD3\ARRX
(2): 17
(3): 278
(4): 56
(5): 113
DBG>

In general, a range of values to be examined is denoted by two values separated
by a colon (valuel:value2). Depending on the language, two periods (..) can be
used instead of a colon.

You can deposit a value to only a single array element at a time (you cannot
deposit to an array slice or an entire array aggregate with a single DEPOSIT
command). For example, the following command deposits the value 53 into
element 2 of ARRX:

DBG> DEPOSIT ARRX(2) = 53
DBG>

The following command displays the values of all the elements of array REAL_

ARRAY, a two-dimensional array of real numbers (three per dimension):

DBG> EXAMINE REAL ARRAY
PROG2\REAL ARRAY

(1,1): 27.01000
(1,2): 31.00000
(1,3): 12.48000
(2,1): 15.08000
(2,2): 22.30000
(2,3): 18.73000

DBG>

The debugger issues a diagnostic message if you try to deposit to an index value
that is out of bounds. For example:

DBG> DEPOSIT REAL_ARRAY(1,4) = 26.13

$DEBUG-I-SUBOUTBND, subscript 2 is out of bounds, value is 4,
bounds are 1..3

DBG>
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In the previous example, the deposit operation was executed because the
diagnostic message is of I level. This means that the value of some array element
adjacent to (1,3), possibly (2,1) might have been affected by the out-of-bounds
deposit operation.

To deposit the same value to several components of an array, you can use a
looping command such as FOR or REPEAT. For example, assign the value RED
to elements 1 to 4 of the array COLOR_ARRAY:

DBG> FOR I = 1 TO 4 DO (DEPOSIT COLOR ARRAY(I) = RED)
DBG>
You can also use the built-in symbols (.) and (*) to step through array elements,
as explained in Section 4.1.8.
4.2.4 Record Types
Note

The generic term record is used here to denote a data structure whose
elements have heterogeneous data types—what is called a struct type in
the C language.

You can examine an entire record aggregate, a single record component, or several
components. However, you can deposit into only one component at a time. The
following examples show typical operations with records.

The following command displays the values of all the components of the record
variable PART:

DBG> EXAMINE PART

INVENTORY \PART:
ITEM: "WF-1247"
PRICE: 49.95
IN STOCK: 24

DBG>

The following command displays the value of component IN_STOCK of record
PART (general syntax):

DBG> EXAMINE PART.IN STOCK
INVENTORY\PART.IN STOCK: 24
DBG>

The following command displays the value of the same record component using
COBOL syntax (the language must be set to COBOL):

DBG> EXAMINE IN STOCK OF PART
INVENTORY\IN STOCK of PART:
IN STOCK: 24

DBG>

The following command displays the values of two components of record PART:

DBG> EXAMINE PART.ITEM, PART.IN STOCK

INVENTORY\PART.ITEM: "WF-1247"
INVENTORY\PART.IN STOCK: 24
DBG>
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The following command deposits a value into record component IN_STOCK:

DBG> DEPOSIT PART.IN STOCK = 17
DBG>

4.2.5 Pointer (Access) Types

You can examine the entity designated (pointed to) by a pointer variable and
deposit a value into that entity. You can also examine a pointer variable.

For example, the following Pascal code declares a pointer variable A that
designates a value of type real:

TYPE
T = “REAL;
VAR

The following command displays the value of the entity designated by the pointer
variable A:

DBG> EXAMINE A"
MOD3\A™: 1.7
DBG>

In the following example, the value 3.9 is deposited into the entity designated by
A:

DBG> DEPOSIT A" = 3.9
DBG> EXAMINE A"
MOD3\A": 3.9

DBG>

When you specify the name of a pointer variable with the EXAMINE command,
the debugger displays the memory address of the object it designates. For
example:

DBG> EXAMINE/HEXADECIMAL A
SAMPLE\A: 0000B2A4
DBG>

4.3 Examining and Depositing Instructions
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The debugger recognizes address expressions that are associated with
instructions. This enables you to examine and deposit instructions using the
same basic techniques as with variables.

When debugging at the instruction level, you might find it convenient to first
enter the following command. It sets the default step mode to stepping by
instruction:

DBG> SET STEP INSTRUCTION
DBG>
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There are other step modes that enable you to execute the program to specific
kinds of instructions. You can also set breakpoints to interrupt execution at these
instructions.

In addition, you can use a screen-mode instruction display (see Section 7.4.4) to
display the actual decoded instruction stream of your program.

4.3.1 Examining Instructions

If you specify an address expression that is associated with an instruction in an
EXAMINE command (for example, a line number), the debugger displays the
first instruction at that location. You can then use the period (.), Return key,
and circumflex (*) to display the current, next, and previous instruction (logical
entity), as described in Section 4.1.8.

For example, on Alpha processors:

DBG> EXAMINE $LINE 12

MOD3\%LINE 12: BIS R31,R31,R2

DBG> EXAMINE

MOD3\%LINE 12+4: BIS R31,R2,R0 ! Next instruction
DBG> EXAMINE

MOD3\%LINE 12+8: ADDL R31,R0,R0 ! Next instruction
DBG> EXAMINE "

MOD3\%LINE 12+4: BIS R31,R2,R0 ! Previous instruction
DBG>

Line numbers, routine names, and labels are symbolic address expressions that
are associated with instructions. In addition, instructions might be stored in
various other memory addresses and in certain registers during the execution of
your program.

The program counter (PC) is the register that contains the address of the next
instruction to be executed by your program. The command EXAMINE .%PC
displays that instruction. The period (.), when used directly in front of an
address expression, denotes the contents of operator—that is, the contents of the
location designated by the address expression. Note the following distinction:

e EXAMINE %PC displays the current PC value, namely the address of the
next instruction to be executed.

e EXAMINE .%PC displays the contents of that address, namely the next
instruction to be executed by the program.

As shown in the previous examples, the debugger knows whether an address
expression is associated with an instruction. If it is, the EXAMINE command
displays that instruction (you do not need to use the /INSTRUCTION
qualifier). You use the /INSTRUCTION qualifier to display the contents

of an arbitrary program location as an instruction—that is, the command
EXAMINE/INSTRUCTION causes the debugger to interpret and format the
contents of any program location as an instruction (see Section 4.5.2).

When you examine consecutive instructions in a MACRO-32 program, the
debugger might misinterpret data as instructions if storage for the data is
allocated in the middle of a stream of instructions. The following example shows
this problem. It shows some MACRO-32 code with two longwords of data storage
allocated directly after the BRB instruction at line 7 (line numbers have been
added to the example for clarity).
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module TEST

1: .TITLE TEST

2:

3: TESTSSTART::

4. .WORD 0

5:

6: MOVL #2,R2

7: BRB LABEL 2

8:

9: .LONG  "X12345
10: .LONG  "X14465
11:

12: LABEL 2:

13: ~ MOVL #5,R5

14:

15: .END TESTSSTART

The following EXAMINE command displays the instruction at the start of line 6:

DBG> EXAMINE 3LINE 6
TEST\TEST$START\SLINE 6: MOVL S"#02,R2
DBG>

The following EXAMINE command correctly interprets and displays the logical
successor entity as an instruction at line 7:

DBG> EXAMINE
TEST\TEST$START\SLINE 7: BRB TEST\TEST$START\LABEL 2
DBG>

However, the following three EXAMINE commands incorrectly interpret the three
logical successors as instructions:

DBG> EXAMINE

TEST\TEST$START\SLINE 7+2: MULF3 S"#11.00000,S"#0.5625000,S"#0.5000000
DBG> EXAMINE

$DEBUG-W-ADDRESSMODE, instruction uses illegal or undefined addressing modes
TEST\TEST$START\SLINE 7+6: MULD3  S"#0.5625000[R4],S"#0.5000000,@W"5505(R0)
DBG> EXAMINE

TESTSSTART+12: HALT

DBG>

4.4 Examining and Depositing into Registers

The EXAMINE command displays contents of any register that is accessible
in your program. You can use the DEPOSIT command to change the contents
of these registers. The number and type of registers vary for each OpenVMS
platform, as described in the following sections.

4.4.1 Examing and Depositing into Alpha Registers
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On Alpha processors, the Alpha architecture provides 32 general (integer)
registers and 32 floating-point registers, some of which are used for temporary
address and data storage. Table 4-1 identifies the debugger built-in symbols that
refer to Alpha registers.
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Table 4-1 Debugger Symbols for Alpha Registers

Symbol Description

Alpha Integer Registers

%R0 . .. %R28 Registers RO ... R28

%FP (%R29) Stack frame base register (FP)

%SP (%R30) Stack pointer (SP)

%R31 ReadAsZero/Sink (RZ)

%PC Program counter (PC)

%PS Processor status register (PS). The built-in symbols %PSL and

%PSW are disabled for Alpha processors.

Alpha Floating-Point Registers

%FO0 ... %F30 Registers FO ... F30
%F31 ReadAsZero/Sink

On Alpha processors:

*  You can omit the percent sign (% ) prefix if your program has not declared a
symbol with the same name.

¢ You cannot deposit a value into register R30.

*  You cannot deposit a value into registers R31 or F31. They are permanently
assigned the value 0.

e There are no vector registers.

The following examples show how to examine and deposit into registers:

DBG> SHOW TYPE ! Show type for locations without
type: long integer ! a compiler-generated type.
DBG> SHOW RADIX ! Identify current radix.

input radix: decimal

output radix: decimal

DBG> EXAMINE $R11 ! Display value in R1l.
MOD3\%R11l: 1024

DBG> DEPOSIT %R11 = 444 ! Deposit new value into R11l.
DBG> EXAMINE $R11 ! Check new value.

R11: 444

DBG> EXAMINE %PC ! Display value in program counter.
MOD\%PC: 1553

DBG> EXAMINE %SP ! Display value in stack pointer.
0\%SP: 2147278720

DBG>

See Section 4.3.1 for specific information about the PC.

Processor Status (Alpha Only)

On Alpha processors, the processor status (PS) is a register whose value
represents a number of processor state variables. The first three bits of the
PS are reserved for the use of the software. The values of these bits can be
controlled by a user program. The remainder of the bits, bits 4 to 64, contain
privileged information and cannot be altered by a user-mode program.
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The following example shows how to examine the contents of the PS:

DBG> EXAMINE %PS
MOD1\$PS:
SP ALIGN IPL VMM CM IP SW
48 0 0 USER 0 3
DBG>

See the Alpha Architecture Reference Manual for complete information about the
PS, including the values of the various bits.

You can also display the information in the PS in other formats. For example:

DBG> EXAMINE/LONG/HEX %PS

MOD1\%PS: 0000001B

DBG> EXAMINE/LONG/BIN %PS

MOD1\%PS: 00000000 00000000 00000000 00011011
DBG>

The command EXAMINE/PS displays the value at any location in PS format.
This is useful for examining the combined current and saved PS values.

4.4.2 Examing and Depositing into Integrity server Registers
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On Integrity server processors, the Integrity server architecture provides:
e Up to 128 64-bit general registers

e Up to 128 82-bit floating-point registers (the debugger allows you to treat
these as full octawords),

e Up to 64 1-bit predicate, 8 64-bit branch, and 128 (only 20 are accessible/used)
application registers

e Special registers (for example, %PC) and viritual registers (for example,
%RETURN_PC)

Most of these registers are read/writable from user mode debug. Some, however,
are not writable and others are only accessible from the higher privileges related
with the System Code Debugger (SCD) configuration (see OpenVMS Alpha System
Analysis Tools Manual).

Table 4-2 Debugger Symbols for Integrity server Registers

Symbol Description

Integrity server Application Registers

%KRO ... %KR7 Kernel registers 0 ... 7

%RSC (%AR16) Register Stack Configuration

%BSP (%AR17) Backing Store Pointer

%BSPSTORE Backing Store Pointer for Memory Stores
(%AR18)

%RNAT (%AR19) RSE NaT Collection

%CCV ($AR32) Compare and Exchange Compare Value

%UNAT (%AR36) User NaT Collection

(continued on next page)
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Table 4-2 (Cont.) Debugger Symbols for Integrity server Registers

Symbol

Description

Integrity server Application Registers

%FPSR (%AR40)
%PFS (%AR64)
%LC (%AR65)
%EC (%AR66)
%CSD

%SSD

Floating-point Status
Previous Function State
Loop Count

Epilog Count

Code Segment

Stack Segment

Control Registers

%DCR (%CRO0)
%ITM (%CR1)
%IVA (%CR2)

%PTA (%CR8)

%PSR. (%CR9,
%ISPR)

%ISR (%CR17)
%IIP (%CR19)
%IFA (%CR20)
%ITIR (%CR21)
%IIPA (%9CR22)
%IFS (%CR23)
%IIM (%CR24)
%IHA (%CR25)
%LID (%CR64)
%TPR (%CR66)

%IRRO . .. %IRR3
(%CR68 . ..
%CRT1)

%ITV (%CR72)
%PMV (%CR73)
%CMCV (%CR74)

%IRR0 and %IRR1
(%CR80 and
%CR81)

Default Control

Interval Timer Match (only visible for SCD)
Interruption Vector Address (only visible for SCD)
Page Table Address (only visible for SCD)

Interruption Processor Status

Interruption Status

Interruption Instruction Pointer
Interruption Faulting Address
Interruption TLB Insertion

Interruption Instruction Previous
Interruption Function State
Interruption Immediate

Interruption Hash Address

Local Interrupt ID (only visible for SCD)
Task Priority (only visible for SCD)
External Interrupt Request 0 . . . 3 (only visible for SCD)

Interval Timer (only visible for SCD)

Performance Monitoring (only visible for SCD)
Corrected Machine Check Vector (only visible for SCD)
Local Redirection 0:1 (only visible for SCD)

(continued on next page)
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Table 4-2 (Cont.) Debugger Symbols for Integrity server Registers

Symbol

Description

Special Registers

%IH (%SR0)
%PREV_BSP
%PC (%IP)
%RETURN_PC
%CFM
%NEXT_PFS
%PSP
%CHFCTX_ADDR
%0SSD
%HANDLER_FV
%LSDA

% UM

Invocation Handle

Previous Backing Store Pointer

Program Counter (Instruction Pointer | slot number)
Return Program Counter

Current Frame Marker

Next Previous Frame State

Previous Stack Pointer

Condition Handling Facility Context Address
Operating System Specific Data

Handler Function Value

Language Specific Data Area

User Mask

Predicate Registers

%PR (%PRED)
%P0 . .. %P63

Predicate Collection Register—Collection of %P0 . .. %P63
Predicate (single-bit)Registers 0 ... 63

Branch Registers

%RP (%B0)

Return Pointer

%B1 ... %B7 Branch Registers 1 ... 7
General Integer Registers
%R0 General Integer Register 0
%GP (%R1) Global Data Pointer
%R2 ... %R11 General Integer Registers 2 ... 11

%SP (%R12)
%TP (%R13)
%R14 ... %R24
%AP (%R25)
%R26 . .. %R127

Stack Pointer

Thread Pointer

General Integer Registers 14 ... 24
Argument Information

General Integer Registers 26 ... 127

Output Registers

%0UTO . ..
%OUT7

Output Registers, runtime aliases (i.e., If the frame has allocated
output registers, then %OUTO0 maps to the first allocated output
registers, for example, %R38, etc.)

(continued on next page)
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Table 4-2 (Cont.) Debugger Symbols for Integrity server Registers

Symbol Description

General Registers

%GRNATO and General Register Not A Thing (NAT) collection registers 64 bits
%GRNAT1 each, for example, %GRNAT0<3,1,0> is the NAT bit for %R3.

Floating Point Registers

%F0 ... %F127 Floating Point Registers 0 ... 127

On Integrity server processors:

You can omit the percent sign (%) prefix if your program has not declared a
symbol with the same name.

You cannot deposit values into the following kinds of registers: unallocated,
disabled, or unreadable registers. For example:

—  %R38 to %R127, if only %R32 to %R37 were allocated
—  %FO0 (always 0.0)

—  %F1 (always 1.0)

— %R0 (always 0)

- %SP

- %P0 (always 1)

—  %GRNATO0 and %GRNAT1

— All of the special registers, except %PC

— Most of the control and application registers (see below)

For regular user mode debug and SCD, you can also deposit into registers, as
follows:

— Control registers %IPSR, %ISR, %IIP, %IFA, %ITIR, %IIPA, %IFS, %IIM,
and %IHA for exception frames

— Application registers RSC and %CCV
For SCD ONLY, you can also deposit into registers, as follows:
— Application registers %KR0 to %KR7

— Control registers #DCR, %ITM, %IVA, %PTA, %LID, %TPR, %IRRO0 to
%IRR3, %ITV, %PMV, %CMCV, %2LRR0, and %LRR1

There are no vector registers.

Some register reads are automatically formatted. You can override this
formatting, as shown in Section 4.4.1 (for example, EXAMINE/QUAD/HEX
%FPSR).

For information on the Floating Point Status Register (%FPSR), see the Intel
IA-64 Architecture Software Developer’s Manual Volume 1. Example:
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DBG> ex %fpsr

LOOPER\main\%FPS

—rdoocooNH

DBG>
You can also force this formatting on any location (see EXAMINE/FPSR).

e For information about Previous Function State (%PFS), Current Frame
Maker (%CFM), Interrupt Function State (%IFS), and Next Previous
Function State (2NEXT_PFS) registers, see Intel IA-64 Architecture Software
Developer’s Manual, Volume 1. Example:

DBG> ex %$pfs

LOOPER\main\%PFS:
PPL PEC SOF SOL SOR RRB GR RRB FR RRB PR
30 29 21 0 0 0 0
DBG> ex %cfm
LOOPER\main\%CFM:
SOF SOL SOR RRB_GR RRB_FR RRB_PR
6 5 0 0 0 0
DBG> ex %ifs
LOOPER\main\%IFS:
SOF SOL SOR RRB_GR RRB_FR RRB_PR
6 5 0 0 0 0

DBG> ex %next pfs
LOOPER\main\%NEXT PFS:
PPL PEC SOF SOL SOR RRB_GR RRB FR RRB PR
3 0 6 5 0 0 0 0
DBG>

Also see EXAMINE/PFS and EXAMINE/CFM.

e For information about the Process Status Register (%PSR), see the Intel IA-64
Architecture Software Developer’s Manual, Volume 2. Example:

DBG> ex %psr
LOOPER\main\%PSR:
IA BN ED RI SS DD DA ID IT MC IS CPL RT TB LP DB SI DI PP SP DFH DFL
o 1000O0OOO0OCI1IO0O0O 310°0O0O0T1O00 0 O
DT PK I IC MFH MFL AC UP BE
101 1 1 1 0 0 O
DBG>

Also see EXAMINE/PSR.

¢ The debugger defaults to a bit vector format for the %GRNATO0, %GRANT1,
and %PR registers. For example:

DBG> ex %grnat0,%pr

LOOPER\main\%GRNATO:

11111111 11111111 11111111 11000000 00000000 00000000 00000000 00000000
LOOPER\main\%PR:

00000000 00000000 00000000 00000000 11111111 01010110 10010110 10100011
DBG>
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e The debugger defaults to single bits for registers %p0 ... %p63. For example:

DBG> ex %pb6,%p7

LOOPER\main\%P6: 0
LOOPER\main\%P7: 1
DBG>

4.5 Specifying a Type When Examining and Depositing

The preceding sections explain how to use the EXAMINE and DEPOSIT
commands with program locations that have a symbolic name and, therefore, are
associated with a compiler-generated type.

Section 4.5.1 describes how the debugger formats (types) data for program
locations that do not have a symbolic name and explains how you can control the
type for those locations.

Section 4.5.2 explains how to override the type associated with any program
location, including a location that has a symbolic name.

4.5.1 Defining a Type for Locations Without a Symbolic Name

Program locations that do not have a symbolic name and, therefore, are not
associated with a compiler-generated type have the type longword integer by
default. Section 4.1.5 explains how to examine and deposit into such locations
using the default type.

The SET TYPE command enables you to change the default type in order to
examine and display the contents of a location in another type, or to deposit a
value of one type into a location associated with another type. Table 4-3 lists the
type keywords for the SET TYPE command.

Table 4-3 SET TYPE Keywords

ASCIC D_FLOAT PACKED
ASCID DATE_TIME INSTRUCTION QUADWORD
ASCII:n EXTENDED_FLOAT! LONG_FLOAT! S_FLOAT!
ASCIW F_LOAT LONG_LONG_FLOAT! T_FLOAT!
ASCIZ FLOAT LONGWORD TYPE=(type-expression)
BYTE G_FLOAT OCTAWORD WORD
X_FLOAT!

IIntegrity server and Alpha specific

For example, the following commands set the type for locations without a
symbolic name to, respectively, byte integer, G_floating, and ASCII with 6 bytes
of ASCII data. Each successive SET TYPE command resets the type.

DBG> SET TYPE BYTE
DBG> SET TYPE G_FLOAT
DBG> SET TYPE ASCII:6

Note that the SET TYPE command, when used without the /OVERRIDE
qualifier, does not affect the type for program locations that have a symbolic
name (locations associated with a compiler-generated type).

The SHOW TYPE command identifies the current type for locations without a
symbolic name. To restore the default type for such locations, enter the SET
TYPE LONGWORD command.
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4.5.2 Overriding the Current Type
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The SET TYPE/OVERRIDE command enables you to change the type associated
with any program location, including locations with compiler-generated types.
For example, after the following command is executed, an unqualified EXAMINE
command displays the contents of only the first byte of the location specified
and interprets the contents as byte integer data. An unqualified DEPOSIT
command modifies only the first byte of the location specified and formats the
data deposited as byte integer data.

DBG> SET TYPE/OVERRIDE BYTE

See Table 4-3 for the valid type keywords for the SET TYPE/OVERRIDE
command.

To identify the current override type, enter the SHOW TYPE/OVERRIDE
command. To cancel the current override type and restore the normal
interpretation of locations that have a symbolic name, enter the CANCEL
TYPE/OVERRIDE command.

The EXAMINE and DEPOSIT commands have qualifiers that enable you to
override the type currently associated with a program location for the duration
of the EXAMINE or DEPOSIT command. These qualifiers override any previous
SET TYPE or SET TYPE/OVERRIDE command as well as any compiler-
generated type. See the DEPOSIT and EXAMINE commands for the type
qualifiers available to each command.

When used with a type qualifier, the EXAMINE command displays the entity
specified by the address expression in that type. For example:

DBG> EXAMINE/BYTE . ! Type is byte integer.
MOD3\SLINE 15 : -48

DBG> EXAMINE/WORD . ! Type is word integer.
MOD3\SLINE 15 : 464

DBG> EXAMINE/LONG . ! Type is longword integer.
MOD3\SLINE 15 : 749404624

DBG> EXAMINE/QUAD . ! Type is quadword integer.
MOD3&LINE 15 : +0130653502894178768

DBG> EXAMINE/FLOAT . ! Type is F floating.
MOD3$LINE 15 :  1.9117807E-38 -

DBG> EXAMINE/G FLOAT . ! Type is G floating.
MOD3%LINE 15 :* 1.509506018605227E-300

DBG> EXAMINE/ASCII . ! Type is ASCII string.
MOD3\$LINE 15 : ".."

DBG>

When used with a type qualifier, the DEPOSIT command deposits a value of that
type into the location specified by the address expression, which overrides the
type associated with the address expression.

The remaining sections provide examples of specifying integer, string, and
user-declared types with type qualifiers and the SET TYPE command.
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4.5.2.1 Integer Types
The following examples show the use of the EXAMINE and DEPOSIT commands
with integer-type qualifiers (/BYTE, /WORD, /[LONGWORD). These qualifiers
enable you to deposit a value of a particular integer type into an arbitrary
program location.

DBG> SHOW TYPE ! Show type for locations without

type: long integer ! a compiler-generated type.

DBG> EVALU/ADDR . ! Current location is 724.

724

DBG> DEPO/BYTE . = 1 ! Deposit the value 1 into one byte
! of memory at address 724.

DBG> EXAM . ! By default, 4 bytes are examined.

724: 1280461057

DBG> EXAM/BYTE . ! Examine one byte only.

724: 1

DBG> DEPO/WORD . = 2 ! Deposit the value 2 into first two
! bytes (word) of current entity.

DBG> EXAM/WORD . ! Examine a word of the current entity.

724: 2

DBG> DEPO/LONG 724 = 999 ! Deposit the value 999 into 4 bytes
!(a longword) beginning at address 724.

DBG> EXAM/LONG 724 ! Examine 4 bytes (longword)
724: 999 ! beginning at address 724.
DBG>

4.5.2.2 ASCII String Type

The following examples show the use of the EXAMINE and DEPOSIT commands
with the /ASCIIL:n type qualifier.

When used with the DEPOSIT command, this qualifier enables you to deposit
an ASCII string of length n into an arbitrary program location. In the example,
the location has a symbolic name (I) and, therefore, is associated with a compiler-
generated integer type. The command syntax is as follows:

DEPOSIT/ASCII:n address-expression = "ASCII string of length n"
The default value of n is 4 bytes.

DBG> DEPOSIT I = "abcde" ! T has compiler-generated integer type.
$DEBUG-W-INVNUMBER, invalid numeric string ’abcde’

! So, it cannot deposit string into I.
DBG> DEP/ASCII:5 I = "abcde"! /ASCII qualifier overrides integer

! type to deposit 5 bytes of

! ASCII data.
DBG> EXAMINE . ! Display value of I in compiler-
MOD3\I: 1146048327 ! generated integer type.
DBG> EXAM/ASCII:5 . ! Display value of I as 5-byte
MOD3\I: "abcde" ! ASCII string.
DBG>

To enter several DEPOSIT/ASCII commands, you can establish an override ASCII
type with the SET TYPE/OVERRIDE command. Subsequent EXAMINE and
DEPOSIT commands then have the effect of specifying the /ASCII qualifier with
these commands. For example:
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DBG> SET TYPE/OVER ASCII:5! Establish ASCII:5 as override type.

DBG> DEPOSIT I = "abcde" ! Can now deposit 5-byte string into I.
DBG> EXAMINE I ! Display value of I as 5-byte

MOD3\I: "abcde" ! ASCII string.

DBG> CANCEL TYPE/OVERRIDE ! Cancel ASCII override type.

DBG> EXAMINE I ! Display I in compiler-generated type.
MOD3\I: 1146048327

DBG>

4.5.2.3 User-Declared Types
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The following examples show the use of the EXAMINE and DEPOSIT commands
with the /TYPE=(name) qualifier. The qualifier enables you to specify a user-
declared override type when examining or depositing.

For example, assume that a Pascal program contains the following code, which
declares the enumeration type COLOR with the three values RED, GREEN, and
BLUE:

TYPE
COLOR = (RED,GREEN,BLUE);

During the debugging session, the SHOW SYMBOL/TYPE command identifies
the type COLOR as it is known to the debugger:

DBG> SHOW SYMBOL/TYPE COLOR
data MOD3\COLOR

enumeration type (COLOR, 3 elements), size: 1 byte
DBG>

The next example displays the value at address 1000, which is not associated
with a symbolic name. Therefore, the value 0 is displayed in the type longword
integer, by default.

DBG> EXAMINE 1000
1000: 0
DBG>

The next example displays the value at address 1000 in the type COLOR. The
preceding SHOW SYMBOL/TYPE command indicates that each enumeration
element is stored in 1 byte. Therefore, the debugger converts the first byte of the
longword integer value 0 at address 1000 to the equivalent enumeration value,
RED (the first of the three enumeration values):

DBG> EXAMINE/TYPE=(COLOR) 1000
1000:  RED
DBG>

The following DEPOSIT command deposits the value GREEN into address 1000
with the override type COLOR. The EXAMINE command displays the value at
address 1000 in the default type, longword integer:

DBG> DEPOSIT/TYPE=(COLOR) 1000 = GREEN
DBG> EXAMINE 1000

1000: 1

DBG>



Examining and Manipulating Program Data
4.5 Specifying a Type When Examining and Depositing

The following SET TYPE command establishes the type COLOR for locations,
such as address 1000, that do not have a symbolic name. The EXAMINE
command now displays the value at 1000 in the type COLOR:

DBG> SET TYPE TYPE=(COLOR)
DBG> EXAMINE 1000

1000: GREEN

DBG>
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Controlling Access to Symbols in Your
Program

Symbolic debugging enables you to specify variable names, routine names, and so
on, precisely as they appear in your source code. You do not need to use numeric
memory addresses or registers when referring to program locations.

In addition, you can use symbols in the context that is appropriate for the
program and its source language. The debugger supports the language
conventions regarding data types, expressions, scope and visibility of entities, and
SO on.

To have full access to the symbols that are associated with your program, you
must compile and link the program using the /DEBUG command qualifier.

Under these conditions, the way in which symbol information is passed from your
source program to the debugger and is processed by the debugger is transparent
to you in most cases. However, certain situations might require some action.

For example, when you try to set a breakpoint on a routine named COUNTER,
the debugger might display the following diagnostic message:

DBG> SET BREAK COUNTER
$DEBUG-E-NOSYMBOL, symbol 'COUNTER’ is not in the symbol table
DBG>

You must then set the module where COUNTER is defined, as explained in
Section 5.2.

The debugger might display the following message if the same symbol X is
defined (declared) in more than one module, routine, or other program unit:

DBG> EXAMINE X
$DEBUG-E-NOUNIQUE, symbol ‘X’ is not unique
DBG>

You must then resolve the symbol ambiguity, perhaps by specifying a path name
for the symbol, as explained in Section 5.3.

This chapter explains how to handle these and other situations related to
accessing symbols in your program.

The chapter discusses only the symbols (typically address expressions) that are
derived from your source program:

¢ The names of entities that you have declared in your source code, such as
variables, routines, labels, array elements, or record components

¢ The names of modules (compilation units) and shareable images that are
linked with your program
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Elements that the debugger uses to identify source code—for example, the
specifications of source files, and source line numbers as they appear in a
listing file or when the debugger displays source code

The following types of symbols are discussed in other chapters:

The symbols you create during a debugging session with the DEFINE
command are covered in Section 13.4.

The debugger’s built-in symbols, such as the period (.) and %PC, are
discussed throughout this manual in the appropriate context and are defined
in Appendix B.

Also, see Section 4.1.11 for information about how to obtain the memory
addresses and register names associated with symbolic address expressions and
how to symbolize program locations.

Note

If your program was optimized during compilation, certain variables

in the program might be removed by the compiler. If you then try to
reference such a variable, the debugger issues a warning (see Section 1.2
and Section 14.1).

Before you try to reference a nonstatic (stack-local or register) variable,
its defining routine must be active on the call stack. That is, program
execution must be paused somewhere within the defining routine (see
Section 3.4.3).

5.1 Controlling Symbol Information When Compiling and Linking

To take full advantage of symbolic debugging, you must compile and link your
program with the /DEBUG qualifier as explained in Section 1.2.

The following sections describe how symbol information is created and passed to
the debugger when compiling and linking.

5.1.1 Compiling

When you compile a source file using the /DEBUG qualifier, the compiler creates
symbol records for the debug symbol table (DST records) and includes them in
the object module being created.

DST records provide not only the names of symbols but also all relevant
information about their use. For example:

Data types, ranges, constraints, and scopes associated with variables

Parameter names and parameter types associated with functions and
procedures

Source-line correlation records, which associate source lines with line
numbers and source files

Most compilers allow you to vary the amount of DST information put in an object
module by specifying different options with the /DEBUG qualifier. Table 5-1
identifies the options for most compilers (see the documentation supplied with
your compiler for complete information).
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Table 5-1 Compiler Options for DST Symbol Information

Compiler Command Qualifier DST Information in Object Module

/DEBUG! Full

/DEBUG=TRACEBACK? Traceback only (module names, routine names, and
line numbers)

/NODEBUG? None

1 /DEBUG, /DEBUG=ALL, and /DEBUG=(SYMBOLS,TRACEBACK) are equivalent.
2 /DEBUG=TRACEBACK and DEBUG=(NOSYMBOLS,TRACEBACK) are equivalent.
3 /NODEBUG, /DEBUG=NONE, and /DEBUG=(NOSYMBOLS,NOTRACEBACK) are equivalent.

The TRACEBACK option is a default for most compilers. That is, if you omit
the /DEBUG qualifier, most compilers assume /DEBUG=TRACEBACK. The
TRACEBACK option enables the traceback condition handler to translate
memory addresses into routine names and line numbers so that it can give a
symbolic traceback if a run-time error has occurred. For example:

$ RUN FORMS

$PAS-F-ERRACCFIL, error in accessing file PAS$OUTPUT
$PAS-F-ERROPECRE, error opening/creating file
$RMS-F-FNM, error in file name

$TRACE-F-TRACEBACK, symbolic stack dump follows

module name routine name line rel PC abs PC
PAS$IO BASIC _PASSCODE 00000192 00001CED
PAS$IO_BASIC _PAS$CODE 0000054D 000020A8
PAS$IO BASIC _PAS$CODE 0000028B 00001DE6
FORMS FORMS 59 00000020 000005A1
$

Traceback information is also used by the debugger’s SHOW CALLS command.
5.1.2 Local and Global Symbols

DST records contain information about all of the symbols that are defined in your
program. These are either local or global symbols.

Typically, a local symbol is a symbol that is referenced only within the module
where it is defined; a global symbol is a symbol such as a routine name,
procedure entry point, or a global data name, that is defined in one module but
referenced in other modules.

A global symbol that is defined in a shareable image and is referenced in
another image (for example the main, executable image of a program) is called a
universal symbol. When creating a shareable image, you must explicitly define
any universal symbols as such at link time. See Section 5.4 for information about
universal symbols and shareable images.

Generally, the compiler resolves references to local symbols, and the linker
resolves references to global symbols.

The distinction between local and global symbols is discussed in various parts of
this chapter in connection with symbol lookup and with shareable images and
universal symbols.
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5.1.3 Linking

When you enter the LINK/DEBUG command to link object modules and produce
an executable image, the linker performs several functions that affect debugging:

It builds a debug symbol table (DST) from the DST records contained in
the object modules being linked. The DST is the primary source of symbol
information during a debugging session.

It resolves references to global symbols and builds a global symbol table
(GST). The GST duplicates some of the global symbol information already
contained in the DST, but the GST is used by the debugger for symbol lookup
under certain circumstances.

It puts the DST and GST in the executable image.

It sets flags in the executable image that cause the image activator to
pass control to the debugger when you enter the DCL command RUN (see
Section 1.2).

Section 5.4 explains how to link shareable images for debugging, including how
to define universal symbols (global symbols that are defined within a shareable
image and referenced from another image).

Table 5—2 summarizes the level of DST and GST information passed to the
debugger depending on the compiler or LINK command option. The compiler
command qualifier controls the level of DST information passed to the linker. The
LINK command qualifier controls not only how much DST and GST information
is passed to the debugger but also whether the program can be brought under
debugger control (see Section 1.2).

Table 5-2 Effect of Compiler and Linker on DST and GST Symbol Information

Compiler DST Data GST Data
Command DST Data in LINK Command Passed Passed
Qualifier Object Module Qualifier? to Debugger to Debugger®
/DEBUG Full /DEBUG Full Full
/DEBUG=TRACE Traceback only /DEBUG Traceback only Full
/NODEBUG None /DEBUG None Full

/DEBUG Full /DSF* Full Full®
/DEBUG=TRACE Traceback only /DSF* Traceback only Full®
/NODEBUG None /DSF* None Full®

1 See Table 5-1 for additional information.
2 You must also specify the /SHAREABLE qualifier when creating a shareable image (see Section 5.4).

3 GST data includes global symbol information that is resolved at link time. GST data for an executable image includes
the names and values of global routines and global constants. GST data for a shareable image includes universal symbols
(see Section 5.1.2 and Section 5.4).

4Alpha only.

5DBG$IMAGE_DSF_PATH must point to the directory in which the .DSF file resides.

(continued on next page)
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Table 5-2 (Cont.) Effect of Compiler and Linker on DST and GST Symbol Information

Compiler DST Data GST Data
Command DST Data in LINK Command Passed Passed
Qualifier’ Object Module Qualifier? to Debugger to Debugger®
/DEBUG Full /TRACES® Traceback only Full
/DEBUG=TRACE Traceback only /TRACE Traceback only Full
/NODEBUG None /TRACE None Full

/DEBUG Full /NOTRACE’

1 See Table 5-1 for additional information.
2 You must also specify the /SHAREABLE qualifier when creating a shareable image (see Section 5.4).

3 GST data includes global symbol information that is resolved at link time. GST data for an executable image includes
the names and values of global routines and global constants. GST data for a shareable image includes universal symbols
(see Section 5.1.2 and Section 5.4).

6 LINK/TRACEBACK and LINK/NODEBUG are equivalent. This is the default for the LINK command.

7 The RUN/DEBUG command allows you to run the debugger, but if you entered the LINK/NOTRACEBACK command
you will be unable to do symbolic debugging.

If you specify /INODEBUG with the compiler command and subsequently link and
execute the image, the debugger issues the following message when the program
is brought under debugger control:

$DEBUG-I-NOLOCALS, image does not contain local symbols

The previous message, which occurs whether you linked with the /TRACEBACK
or /DEBUG qualifier, indicates that no DST has been created for that image.
Therefore, you have access only to global symbols contained in the GST.

If you do not specify /DEBUG with the LINK command, the debugger issues the
following message when the program is brought under debugger control:

$DEBUG-I-NOGLOBALS, some or all global symbols not accessible

The previous message indicates that the only global symbol information available
during the debugging session is stored in the DST.

These concepts are discussed in later sections. In particular, see Section 5.4 for
additional information related to debugging shareable images.

5.1.4 Controlling Symbol Information in Debugged Images

Symbol records occupy space within the executable image. After you debug your
program, you might want to link it again without using the /DEBUG qualifier to
make the executable image smaller. This creates an image with only traceback
data in the DST and with a GST.

The LINK/NOTRACEBACK command enables you to secure the contents of an
image from users after it has been debugged. Use this command for images that
are to be installed with privileges (see the OpenVMS System Manager’s Manual
and the OpenVMS System Management Utilities Reference Manual). When

you use the /NOTRACEBACK qualifier with the LINK command, no symbolic
information (including traceback data) is passed to the image.
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5.1.5 Creating Separate Symbol Files (Alpha Only)

On Alpha systems, you can LINK your program with the /DSF qualifier to create
a separate file that contains symbol information. By default, the symbol file has
the same file name as the executable file created by the LINK utility, and has file
type .DSF. For example:

$ CC/DEBUG/NOOPTIMIZE TESTPROGRAM.C

$ LINK/DSF TESTPROGRAM

$ DEFINE DBGSIMAGE DSF PATH SYSS$DISK:[]
$ DEBUG/KEEP TESTPROGRAM

This example does the following:

1. Compiles TESTPROGRAM.C

2. Creates TESTPROGRAM.EXE and TESTPROGRAM.DSF

3. Defines logical name DBG$IMAGE_DSF_PATH as the current directory
4. Invokes the kept debugger

This procedure allows you to create smaller executable files and still have
global symbol information available for debugging. Certain applications, such as
installed resident files, require that the executable not contain symbol tables. In
addition, .DSF files allow you to deliver executable files without symbol tables to
customers, but retain separate .DSF files for future debugging needs.

Note

For ease of debugging, use the /INOOPTIMIZE qualifer (if possible) when
compiling the program. See Section 14.1 for information about debugging
optimized code.

Debugging an executable file that has a separate symbol (.DSF) file requires the
following:

e The name of the .DSF file must match the name of the .EXE file being
debugged.

¢  You must define DBG$IMAGE_DSF_PATH to point to the directory that
contains the .DSF file.

See the OpenVMS Linker Utility Manual for more information about using the
/DSF qualifier.

5.2 Setting and Canceling Modules

You need to set a module if the debugger is unable to locate a symbol that you
have specified (for example, a variable name X) and issues a message as in the
following example:

DBG> EXAMINE X
$DEBUG-E-NOSYMBOL, symbol ’X’ is not in the symbol table
DBG>

This section explains module setting, and the conditions under which you might
need to set or cancel a module, using the SET MODULE and CANCEL MODULE
commands.
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When you compile and link your program using the /DEBUG command qualifier,
as explained in Section 5.1, complete symbol information is passed from the
program’s source code to its executable image.

Symbol information is contained in the debug symbol table (DST) and global
symbol table (GST) within the executable image. The DST contains detailed
information about local and global symbols. The GST duplicates some of the
global symbol information contained in the DST.

To facilitate symbol searches, the debugger loads symbol information from the
DST and GST into a run-time symbol table (RST), which is structured for efficient
symbol lookup. Unless symbol information is in the RST, the debugger does not
recognize or properly interpret the associated symbol.

Because the RST takes up memory, the debugger loads it dynamically,
anticipating what symbols you might want to reference in the course of program
execution. The loading process is called module setting, because all symbol
information for a given module is loaded into the RST at one time.

When your program is brought under debugger control, all GST records are
loaded into the RST, because global symbols must be accessible throughout the
debugging session. Also, the debugger sets the module that contains the main
program (the routine specified by the image transfer address, where execution is
paused at the start of a debugging session). You then have access to all global
symbols and to any local symbols that should be visible within the main program.

Subsequently, whenever execution of the program is interrupted, the debugger
sets the module that contains the routine in which execution is paused. (For
Ada programs, the debugger also sets any module that is related by a with-
clause or subunit relationship, as explained in the debugger’s online help. Type
Help Language_Support_Ada.) This enables you to reference the symbols that
should be visible at that program location (in addition to the global symbols).
This default mode of operation is called dynamic mode. When setting a module
dynamically, the debugger issues a message such as the following:

$DEBUG-I-DYNMODSET, setting module MOD4

If you try to reference a symbol that is defined in a module that has not been set,
the debugger warns you that the symbol is not in the RST. You must then use the
SET MODULE command to set the module containing that symbol explicitly. For
example:

DBG> EXAMINE X

$DEBUG-E-NOSYMBOL, symbol ‘X’ is not in the symbol table
DBG> SET MODULE MOD3

DBG> EXAMINE X

MOD3\ROUT2\X: 26

DBG>

The SHOW MODULE command lists the modules of your program and identifies
which modules are set.

When a module is set, the debugger automatically allocates memory as needed by
the RST. This can eventually slow down the debugger as more modules are set. If
performance becomes a problem, you can use the CANCEL MODULE command
to reduce the number of set modules, which automatically releases memory.

Or you can disable dynamic mode by entering the SET MODE NODYNAMIC
command. When dynamic mode is disabled, the debugger does not set modules
automatically. Use the SHOW MODE command to determine whether dynamic
mode is enabled or disabled.
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For additional information about module setting specific to Ada programs, see the
debugger’s online help (type Help Language_Support_Ada).

Section 5.4 explains how to set images and modules when debugging shareable
images.

5.3 Resolving Symbol Ambiguities

Symbol ambiguities can occur when a symbol (for example, a variable name X) is
defined in more than one routine or other program unit.

In most cases, the debugger resolves symbol ambiguities automatically, by using
the scope and visibility rules of the currently set language and the ordering of
routine calls on the call stack, as explained in Section 5.3.1.

However, in some cases the debugger might respond as follows when you specify
a symbol that is defined multiple times:

e It might not be able to determine the particular declaration of the symbol
that you intended. For example:

DBG> EXAMINE X
$DEBUG-W-NOUNIQUE, symbol ‘X’ is not unique
DBG>

e It might reference the declaration that is visible in the current scope, which
may not be the one you want.

To resolve such problems, you must specify a scope where the debugger should
search for a particular declaration of the symbol. In the following example, the
pathname COUNTER\ X uniquely specifies a particular declaration of X:

DBG> EXAMINE COUNTER\X
COUNTER\X: 14
DBG>

The following sections discuss scope concepts and explain how to resolve symbol
ambiguities.

5.3.1 Symbol Lookup Conventions

This section explains how the debugger searches for symbols, resolving

most potential symbol ambiguities using the scope and visibility rules of the
programming language and also its own rules. Section 5.3.2 and Section 5.3.3
describe supplementary techniques that you can use when necessary.

You can specify symbols in debugger commands by using either a path name or
the exact symbol.

If you use a path name, the debugger looks for the symbol in the scope denoted
by the pathname prefix (see Section 5.3.2).

If you do not specify a pathname prefix, by default, the debugger searches the
run-time symbol table (RST) as explained in the following paragraphs (you can
modify this default behavior with the SET SCOPE command as explained in
Section 5.3.3).

First, the debugger looks for symbols in the PC scope (also known as scope
0), according to the scope and visibility rules of the currently set language.
This means that, typically, the debugger first looks within the block or routine
surrounding the current PC value (where execution is currently paused). If the
symbol is not found, the debugger searches the nesting program unit, then its
nesting unit, and so on. The precise manner, which depends on the language,
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ensures that the correct declaration of a symbol that is defined multiple times is
chosen.

However, you can reference symbols throughout your program, not just those that
are visible in the PC scope as defined by the language. This is necessary so you
can set breakpoints in arbitrary areas, examine arbitrary variables, and so on.
Therefore, if the symbol is not visible in the PC scope, the debugger continues
searching as follows.

After the PC scope, the debugger searches the scope of the calling routine (if
any), then its caller, and so on. Symbolically, the complete scope search list is
denoted (0,1,2, . .. ,n), where 0 denotes the PC scope and n is the number of calls
on the call stack. Within each scope (call frame), the debugger uses the visibility
rules of the language to locate a symbol.

This search list, based on the call stack, enables the debugger to differentiate
symbols that are defined multiple times in a convenient, predictable way.

If the symbol is still not found, the debugger searches the rest of the RST—that
is, the other set modules and the global symbol table (GST). At this point the
debugger does not attempt to resolve any symbol ambiguities. Instead, if more
than one occurrence of the symbol is found, the debugger issues a message such
as the following:

$DEBUG-W-NOUNIQUE, symbol 'Y’ is not unique

If you have used a SET SCOPE command to modify the default symbol search
behavior, you can restore the default behavior with the CANCEL SCOPE
command.

5.3.2 Using SHOW SYMBOL and Path Names to Specify Symbols Uniquely

If the debugger indicates that a symbol reference is not unique, use the SHOW
SYMBOL command to obtain all possible path names for that symbol, then
specify a path name to reference the symbol uniquely. For example:

DBG> EXAMINE COUNT
$DEBUG-W-NOUNIQUE, symbol 'COUNT’ is not unique

DBG> SHOW SYMBOL COUNT

data MOD7\ROUT3\BLOCK1\COUNT
data MOD4\ROUT2\COUNT

routine MOD2\ROUT1\ROUT3\COUNT

DBG> EXAMINE MOD4\ROUT2\COUNT
MOD4\ROUT2\COUNT: 12
DBG>

The command SHOW SYMBOL COUNT lists all declarations of the symbol
COUNT that exist in the RST. The first two declarations of COUNT are
variables (data). The last declaration listed is a routine. Each declaration
is shown with its pathname prefix, which indicates the path (search scope)
the debugger must follow to reach that particular declaration. For example,
MOD4\ ROUT2\ COUNT denotes the declaration of the symbol COUNT in
routine ROUT2 of module MOD4.

The pathname format is as follows. The leftmost element of a path name
identifies the module containing the symbol. Moving toward the right, the path
name lists the successively nested routines and blocks that lead to the particular
declaration of the symbol (which is the rightmost element).

The debugger always displays symbols with their path names, but you need to
use path names in debugger commands only to resolve an ambiguity.
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The debugger looks up line numbers like any other symbols you specify (by
default, it first looks in the module where execution is paused). A common use of
path names is for specifying a line number in an arbitrary module. For example:

DBG> SET BREAK QUEUE MANAGER\SLINE 26

The SHOW SYMBOL command identifies global symbols twice, because global
symbols are included both in the DST and in the GST. For example:

DBG> SHOW SYMBOL X

data ALPHA\X ! global X

data ALPHA\BETA\X ! local X

data X (global) ! same as ALPHA\X
DBG>

In the case of a shareable image, its global symbols are universal symbols and the
SHOW SYMBOL command identifies universal symbols twice (see Section 5.1.2
and Section 5.4).

5.3.2.1 Simplifying Path Names

Path names are often long. You can simplify the process of specifying path names
in three ways:

e Abbreviate a path name
e Define a brief symbol for a path name
e Set a new search scope so you do not have to use a path name

To abbreviate a path name, delete the names of nesting program units starting
from the left, but leave enough of the path name to specify it uniquely. For
example, ROUT3\ COUNT is a valid abbreviated path name for the routine in the
first example of Section 5.3.2.

To define a symbol for a path name, use the DEFINE command. For example:

DBG> DEFINE INTX = INT STACK\CHECK\X
DBG> EXAMINE INTX

To set a new search scope, use the SET SCOPE command, which is described in
Section 5.3.3.

5.3.2.2 Specifying Symbols in Routines on the Call Stack

You can use a numeric path name to specify the scope associated with a routine
on the call stack (as identified in a SHOW CALLS display). The pathname prefix
"0\ " denotes the PC scope, the pathname prefix "1\ * denotes scope 1 (the scope
of the caller routine), and so on.

For example, the following commands display the current values of two distinct
declarations of Y, which are visible in scope 0 and scope 2, respectively:

DBG> EXAMINE 0\Y
DBG> EXAMINE 2\Y

By default, the EXAMINE Y command signifies EXAMINE 0\Y.

See the SET SCOPE/CURRENT command description in Section 5.3.3. That
command enables you to reset the reference for the default scope search list
relative to the call stack.
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5.3.2.3 Specifying Global Symbols

To specify a global symbol uniquely, use a backslash (\ ) as a prefix to the symbol.
For example, the following command displays the value of the global symbol X:

DBG> EXAMINE \X

5.3.2.4 Specifying Routine Invocations

When a routine is called recursively, you might need to distinguish among several
calls to the same routine, all of which generate new symbols with identical names.

You can include an invocation number in a path name to indicate a particular
call to a routine. The number must be a nonnegative integer and must follow the
name of the rightmost routine in the path name. A 0 denotes the most recent
invocation; 1 denotes the previous invocation, and so on. For example, if PROG
calls COMPUTE and COMPUTE calls itself recursively, and each call creates a
new variable SUM, the following command displays the value of SUM for the
most recent call to COMPUTE:

DBG> EXAMINE PROG\COMPUTE 0\SUM

To refer to the variable SUM that was generated in the previous call to
COMPUTE, express the path name with a 1 in place of the 0.

When you do not include an invocation number, the debugger assumes that the
reference is to the most recent call to the routine (the default invocation number
is 0).

See the SET SCOPE/CURRENT command description in Section 5.3.3. That
command enables you to reset the reference for the default scope search list
relative to the call stack.

5.3.3 Using SET SCOPE to Specify a Symbol Search Scope

By default, the debugger looks up symbols that you specify without a pathname
prefix by using the scope search list described in Section 5.3.1.

The SET SCOPE command enables you to establish a new scope for symbol
lookup so that you do not have to use a path name when referencing symbols in
that scope.

In the following example, the SET SCOPE command establishes the path name
MOD4\ ROUT2 as the new scope for symbol lookup. Then, references to Y
without a pathname prefix specify the declaration of Y that is visible in the new
scope.

DBG> EXAMINE Y

$DEBUG-E-NOUNIQUE, symbol 'Y’ is not unique
DBG> SHOW SYMBOL Y

data MOD7\ROUT3\BLOCK1\Y

data MOD4\ROUT2\Y

DBG> SET SCOPE MOD4\ROUT2
DBG> EXAMINE Y
MOD4\ROUT2\Y: 12

DBG>

After you enter a SET SCOPE command, the debugger applies the path name you
specified in the command to all references that are not individually qualified with
path names.
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You can specify numeric path names with SET SCOPE. For example, the
following command sets the current scope to be three calls down from the PC
scope:

DBG> SET SCOPE 3

You can also define a scope search list to specify the order in which the debugger
should search for symbols. For example, the following command causes the
debugger to look for symbols first in the PC scope (scope 0) and then in the scope
denoted by routine ROUT2 of module MOD4:

DBG> SET SCOPE 0, MOD4\ROUT2

The debugger’s default scope search list is equivalent to entering the following
command (if it existed):

DBG> SET SCOPE 0,1,2,3, ... ,n
Here the debugger searches successively down the call stack to find a symbol.

You can use the SET SCOPE/CURRENT command to reset the reference for the
default scope search list to another routine down the call stack. For example, the
following command sets the scope search list to be 2,3,4, ... ,n:

DBG> SET SCOPE/CURRENT 2

To display the current scope search list for symbol lookup, use the SHOW SCOPE
command. To restore the default scope search list (see Section 5.3.1), use the
CANCEL SCOPE command.

5.4 Debugging Shareable Images

By default, your program might be linked with several Compaq-supplied
shareable images (for example, the run-time library image LIBRTL.EXE). This
section explains how to extend the concepts described in the previous sections
when debugging user-defined shareable images.

A shareable image is not intended to be directly executed. A shareable image
must first be included as input in the linking of an executable image, and then
the shareable image is loaded at run time when the executable image is run. You
do not have to install a shareable image to debug it. Instead, you can debug your
own private copy by assigning a logical name to it.

See the OpenVMS Linker Utility Manual for detailed information about linking
shareable images.

5.4.1 Compiling and Linking Shareable Images for Debugging
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The basic steps in compiling and linking a shareable image for debugging are as
follows:

1. Compile the source files for the main image and for the shareable image, by
using the /DEBUG qualifier.

2. Link the shareable image with the /SHAREABLE and /DEBUG command
qualifiers and declare any universal symbols for that image. (A universal
symbol is a global symbol that is defined in a shareable image and referenced
in another image.)

3. Link the shareable image against the main image by specifying the shareable
image with the /SHAREABLE file qualifier as a linker option. Also specify
the /DEBUG command qualifier.
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4. Define a logical name to point to the local copy of the shareable image. You
must specify the device and directory as well as the image name. Otherwise
the image activator looks for an image of that name in the system default
shareable image library directory, SYS$SHARE.

5. Bring the main image under debugger control. The shareable image is loaded
at run time.

These steps are shown next with a simple example. In the example, MAIN.FOR
and SUB1.FOR are the source files for the main (executable) image; SHR1.FOR
and SHR2.FOR are the source files for the shareable image to be debugged.

You compile the source files for each image as described in Section 5.1.

$ FORTRAN/NOOPT/DEBUG MAIN,SUB1
$ FORTRAN/NOOPT/DEBUG SHR1,SHR2

On Alpha processors, use the LINK command with the SYMBOL_VECTOR option
to create the shareable image and specify any universal symbols. For example:

$ LINK/SHAREABLE/DEBUG SHR1,SHR2,SYS$INPUT:/OPTIONS
SYMBOL_VECTOR=(SHR_ROUT=PROCEDURE)

In the previous examples:

e The /SHAREABLE command qualifier creates the shareable image SHR1.EXE
from the object files SHR1.0BJ and SHR2.0BdJ.

e The /OPTIONS qualifier appended to SYS$SINPUT: enables you to specify the
universal symbol SHR_ROUT.

e The /DEBUG qualifier builds a debug symbol table (DST) and a global symbol
table (GST) for SHR1.EXE and puts them in that image. The GST contains
the universal symbol SHR_ROUT.

You have now built the shareable image SHR1.EXE in your current default
directory. Because SHR1.EXE is a shareable image, you do not execute it
explicitly. Instead you link SHR1.EXE against the main (executable) image:

$ LINK/DEBUG MAIN,SUB1,SYSSINPUT:/OPTIONS
SHR1.EXE/SHAREABLE
$

In the previous example:

e The LINK command creates the executable image MAIN.EXE from
MAIN.OBJ and SUB1.0BJ.

e The /DEBUG qualifier builds a DST and a GST for MAIN.EXE and puts them
in that image.

e The /SHAREABLE qualifier appended to SHR1.EXE specifies that SHR1.EXE
is to be linked against MAIN.EXE as a shareable image.

When you execute the resulting main image, MAIN.EXE, any shareable images
linked against it are loaded at run time. However, by default, the image activator
looks for shareable images in the system default shareable image library
directory, SYS$SHARE. Therefore, you must define the logical name SHR1 to
point to SHR1.EXE in your current default directory. Be sure to specify the
device and directory:

$ DEFINE SHR1 SYSSDISK:[]SHR1.EXE
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You can now bring both MAIN and SHR1 under debugger control by specifying
MAIN with the debugger RUN command (after starting the debugger):

$ DEBUG/KEEP
Debugger Banner and Version Number
DBG> RUN MAIN

5.4.2 Accessing Symbols in Shareable Images

All the concepts covered in Section 5.1, Section 5.2, and Section 5.3 apply to the
modules of a single image, namely the main (executable) image. This section
provides additional information that is specific to debugging shareable images.

When you link shareable images for debugging as explained in Section 5.4.1,
the linker builds a DST and a GST for each image. The GST for a shareable
image contains only universal symbols. To conserve memory, the debugger builds
an RST for an image only when that image is set, either dynamically by the
debugger or when you use a SET IMAGE command.

The SHOW IMAGE command identifies all shareable images that are linked with
your program, shows which images are set, and identifies the current image (see
Section 5.4.2.2 for a definition of the current image). Only the main image is set
initially when you bring the program under debugger control.

The following sections explain how the debugger sets images dynamically
during program execution and how you can access symbols in arbitrary images
independently of execution.

See Section 3.4.3.4 for information about setting watchpoints in installed writable
shareable images.

5.4.2.1 Accessing Symbols in the PC Scope (Dynamic Mode)

By default, dynamic mode is enabled. Therefore, whenever the debugger
interrupts execution, the debugger sets the image and module where execution is
paused, if they are not already set.

Dynamic mode gives you the following access to symbols automatically:

¢ You can reference symbols defined in all set modules in the image where
execution is paused.

e You can reference any universal symbols in the GST for that image.

By setting other modules in that image with the SET MODULE command, you
can reference any symbol defined in the image.

After an image is set, it remains set until you cancel it with the CANCEL
IMAGE command. If the debugger slows down as more images and modules
are set, use the CANCEL IMAGE command. You can also enter the SET MODE
NODYNAMIC command to disable dynamic mode.

5.4.2.2 Accessing Symbols in Arbitrary Images
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The last image that you or the debugger sets is the current image. The current
image is the debugging context for symbol lookup. Therefore, when using the
following commands, you can reference only the symbols that are defined in the
current image:

DEFINE/ADDRESS
DEFINE/VALUE
DEPOSIT
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EVALUATE

EXAMINE

TYPE

(SET,CANCEL) BREAK
(SET,SHOW,CANCEL) MODULE
(SET,CANCEL) TRACE
(SET,CANCEL) WATCH

SHOW SYMBOL

Note that the SHOW BREAK, SHOW TRACE, and SHOW WATCH commands
identify any breakpoints, tracepoints, or watchpoints that have been set in all
images.

To reference a symbol in another image, use the SET IMAGE command to make
the specified image the current image, then use the SET MODULE command to
set the module where that symbol is defined (the SET IMAGE command does not
set any modules). The following sample program shows these concepts.

The sample program consists of a main image PROG1 and a shareable image
SHR1. Assume that you have just brought the program under debugger control
and that execution is paused within the main program unit in image PROG1.
Assume that you want to set a breakpoint on routine ROUT2, which is defined in
some module in image SHR1.

If you try to set a breakpoint on ROUT2, the debugger looks for ROUTZ2 in the
current image, PROG1:

DBG> SET BREAK ROUT2
$DEBUG-E-NOSYMBOL, symbol 'ROUT2’ is not in symbol table
DBG>

The SHOW IMAGE command shows that image SHR1 needs to be set:

DBG> SHOW IMAGE

image name set base address end address
*PROG1 yes 00000200 000009FF
SHR1 no 00001000 00001FFF
total images: 2 bytes allocated: 32856

DBG> SET IMAGE SHR1
DBG> SHOW IMAGE

image name set base address end address
PROG1 yes 00000200 000009FF
*SHR1 yes 00001000 00001FFF
total images: 2 bytes allocated: 41948
DBG>

SHR1 is now set and is the current image. However, because the SET IMAGE
command does not set any modules, you must set the module where ROUT2 is
defined before you can set the breakpoint:

DBG> SET BREAK ROUT2

$DEBUG-E-NOSYMBOL, symbol 'ROUT2’ is not in symbol table
DBG> SET MODULE/ALL

DBG> SET BREAK ROUT2

DBG> GO

break at routine ROUT2

10: SUBROUTINE ROUT2(A,B)

DBG>
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Now that you have set image SHR1 and all its modules and have reached the
breakpoint at ROUTZ2, you can debug using the normal method (for example, step
through the routine, examine variables, and so on).

After you have set an image and set modules within that image, the image and
modules remain set even if you establish a new current image. However, you
have access to symbols only in the current image at any one time.

5.4.2.3 Accessing Universal Symbols in Run-Time Libraries and System Images

The following paragraphs describe how to access a universal symbol (such as

a routine name) in a run-time library or other shareable image for which no
symbol-table information was generated. With this information you can, for
example, use the CALL command to execute a run-time library or system service
routine as explained in Section 13.7.

Enter the SET MODULE command with the following command syntax:
SET MODULE SHARES$image-name

For example:

DBG> SET MODULE SHARES$LIBRTL

The debugger creates dummy modules for each shareable image in your program.
The names of these shareable image modules have the prefix SHARE$. The
command SHOW MODULE/SHARE identifies these shareable image modules as
well as the modules in the current image.

Once a shareable image module has been set with the SET MODULE command,
you can access all of the image’s universal symbols. For example, the following
command lists all of the universal symbols in LIBRTL:

DBG> SHOW SYMBOL * IN SHARESLIBRTL

routine SHARE$LIBRTL\STRS$SAPPEND
routine SHARE$SLIBRTL\STRS$DIVIDE
routine SHARESLIBRTL\STRSROUND

routine SHARE$LIBRTL\LIBSWAIT
routine SHARE$SLIBRTL\LIBSGETDVI

You can then specify these universal symbols with, for example, the CALL or SET
BREAK command.

Setting a shareable image module with the SET MODULE command loads the
universal symbols for that image into the run-time symbol table so that you can
reference these symbols from the current image. However, you cannot reference
other (local or global) symbols in that image from the current image. That is,
your debugging context remains set to the current image.
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5.4.3 Debugging Resident Images (Alpha Only)

A resident image is a shareable module that is created and installed in a
particular way to enhance its efficiency. The requirements of creating such an
image include linking the image without a symbol table, and running the image
in system space. These requirements make such an image difficult to debug. The
following procedure creates a resident image that can be more easily debugged.

1.

10.

Compile the shareable image. For example:

$ CC/DEBUG/NOOPTIMIZE RESIDENTMODULE.C

Link the shareable image using the /DSF qualifier. For example:
$ LINK/NOTRACEBACK/SHAREABLE/SECTION_BINDING/DSF RESIDENTMODULE

See the OpenVMS Linker Utility Manual for information about linking the
image.

Create the installed resident image. See OpenVMS System Management
Utilities Reference Manual: A-L for information about using the Install utility.
See OpenVMS System Manager’s Manual, Volume 2: Tuning, Monitoring, and
Complex Systems for information about resident images.

Compile the program that calls the resident image. For example:

$ CC/DEBUG/NOOPTIMIZE TESTPROGRAM

Create the executable image that calls the resident image. For example:
$ LINK/DSF TESTPROGRAM

Create a private copy of the resident image. For example:

$ COPY SYSSLIBRARY:RESIDENTMODULE.EXE []RESIDENTMODULE.EXE

Define a logical name that points to the private copy of the resident image.
For example:

$ DEFINE RESIDENTMODULE [ ]RESIDENTMODULE

Make sure that the .DSF file for the test program and the .DSF file for the
resident module both reside in the same directory.

Define DBG$IMAGE_DSF_PATH to point to the directory that contains the
.DSF files.

Invoke the debugger. For example:
$ DEBUG/KEEP TESTPROGRAM

You should now have access to all debugging options for the executable and
resident images.
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Controlling the Display of Source Code

The term source code refers to statements in a programming language as they
appear in a source file. Each line of source code is also called a source line.

This chapter covers the following topics:
e Obtaining information about source files and source lines

e Specifying the location of a source file that has been moved to another
directory after it was compiled

e Displaying source lines by specifying line numbers, code address expressions,
or search strings

e Controlling the display of source code at breakpoints, tracepoints, and
watchpoints and after a STEP command has been executed

e Using the SET MARGINS command to improve the display of source lines
under certain circumstances

The techniques described in this chapter apply to screen mode as well as line
(noscreen) mode. Any difference in behavior between line mode and screen mode
is identified in this chapter and in the descriptions of the commands discussed.
(Screen mode is described in Chapter 7.)

If your program has been optimized by the compiler, the code that is executing as
you debug might not always match your source code. See Section 14.1 for more
information.

6.1 How the Debugger Obtains Source Code Information

When a compiler processes source files to generate object modules, it assigns

a line number to each source line sequentially. For most languages, each
compilation unit (module) starts with line 1. For other languages like Ada, each
source file, which might represent several compilation units, starts with line 1.

Line numbers appear in a source listing obtained with the /LIST compile-
command qualifier. They also appear whenever the debugger displays source
code, either in line mode or screen mode. Moreover, you can specify line numbers
with several debugger commands (for example, TYPE and SET BREAK).

The debugger displays source lines only if you have specified the /DEBUG
command with both the compile command and the LINK command. Under these
conditions, the symbol information created by the compiler and passed to the
debug symbol table (DST) includes source-line correlation records. For a given
module, source-line correlation records contain the full file specification of each
source file that contributes to that module. In addition, they associate source
records (symbols, types, and so on) with source files and line numbers in the
module.
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6.2 Specifying the Location of Source Files

The debug symbol table (DST) contains the full file specification of each source
file when it was compiled. By default, the debugger expects a source file to be
in the same directory it was in at compile time. If a source file is moved to a
different directory after it is compiled, the debugger does not find it and issues a
warning such as the following when attempting to display source code from that
file:

$DEBUG-W-UNAOPNSRC, unable to open source file DISK:[JONES.WORK]PRG.FOR;2

In such cases, use the SET SOURCE command to direct the debugger to the new
directory. The command can be applied to all source files for your program or to
only the source files for specific modules.

For example, after you enter the following command line, the debugger looks for
all source files in WORK$:[JONES.PROG3]:

DBG> SET SOURCE WORKS:[JONES.PROG3]

You can specify a directory search list with the SET SOURCE command.
For example, after the following command line is entered, the debugger

looks for source files first in the current default directory ([1) and then in
WORKS$:[JONES.PROG3]:

DBG> SET SOURCE [], WORKS:[JONES.PROG3]

If you want to apply the SET SOURCE command only to the source files for a
given module, use the /MODULE=module-name qualifier and specify that module.
For example, the following command line specifies that the source files for module
SCREEN_IO are in the directory DISK2:[SMITH.SHARE] (the search of source
files for other modules is not affected by this command):

DBG> SET SOURCE/MODULE=SCREEN_IO DISK2:[SMITH.SHARE]

To summarize, the SET SOURCE/MODULE command specifies the location of
source files for a particular module, but the SET SOURCE command specifies
the location of source files for modules that were not mentioned explicitly in SET
SOURCE/MODULE commands.

When you enter a SET SOURCE command, be aware that one of the two
qualifiers, /LATEST or /EXACT, will always be active. The /LATEST qualifier
directs the debugger to search for the latest version of your source files (the
highest-numbered version in your directory). The /EXACT qualifier, the default,
directs the debugger to search for the version last compiled (the version recorded
in the debugger symbol table created at compile time). For example, A SET
SOURCE/LATEST command might search for SORT.FOR;3 while a SET
SOURCE/EXACT command might search for SORT.FOR;1.

Use the SHOW SOURCE command to display all source directory search lists
currently in effect. The command displays the search lists for specific modules (as
previously established by one or more SET SOURCE/MODULE commands) and
the search list for all other modules (as previously established by a SET SOURCE
command). For example:



Controlling the Display of Source Code
6.2 Specifying the Location of Source Files

DBG> SET SOURCE [PROJA], [PROJB],USERS:[PETER.PROJC]
DBG> SET SOURCE/MODULE=COBOLTEST [], DISKS$2:[PROJD]
DBG> SHOW SOURCE

source directory search list for COBOLTEST:

[]
DISK$2:[PROJD]
source directory search list for all other modules:
[PROJA]
[PROJB]
USERS : [PETER.PROJC]
DBG>

If no SET SOURCE or SET SOURCE/MODULE command has been entered, the
SHOW SOURCE command indicates that no search list is currently in effect.

Use the CANCEL SOURCE command to cancel the effect of a previous SET
SOURCE command. Use the CANCEL SOURCE/MODULE command to cancel
the effect of a previous SET SOURCE/MODULE command (specifying the same
module name).

When a source directory search list has been canceled, the debugger again
expects the source files corresponding to the designated modules to be in the
same directories they were in at compile time.

For more information about how the debugger locates source files that have been
moved to another directory after compile time, see the SET SOURCE command.

6.3 Displaying Source Code by Specifying Line Numbers

The TYPE command enables you to display source lines by specifying compiler-
assigned line numbers, where each line number designates a line of source
code.

For example, the following command displays line 160 and lines 22 to 24 of the
module being debugged:

DBG> TYPE 160, 22:24
module COBOLTEST

160: START-IT-PARA.
module COBOLTEST

22: 02 SC2v2  PIC S99v99 COMP VALUE 22.33.
23: 02 SC2V2N PIC S99v99 COMP VALUE -22.33.
24: 02 CPP2 PIC PP99 COMP VALUE 0.0012.

DBG>

You can display all the source lines of a module by specifying a range of line
numbers starting from 1 and ending at a number equal to or greater than the
largest line number in the module.

After displaying a source line, you can display the next line in that module by
entering a TYPE command without a line number—that is, by entering a TYPE
command and then pressing the Return key. For example:

DBG> TYPE 160
module COBOLTEST
160: START-IT-PARA.
DBG> TYPE
module COBOLTEST
161: MOVE SC1 TO ESO.
DBG>

You can then display the next line and successive lines by entering the TYPE
command repeatedly, which lets you read through your code one line at a time.
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To display source lines in an arbitrary module of your program, specify the
module name with the line numbers. Use standard pathname notation—that is,
first specify the module name, then a backslash (\ ), and finally the line numbers
(or the range of line numbers) without intervening spaces. For example, the
following command displays line 16 of module TEST:

DBG> TYPE TEST\16

If you specify a module name with the TYPE command, the module must be set.
Use the SHOW MODULE command to determine whether a particular module is
set. Then use the SET MODULE command, if necessary (see Section 5.2).

If you do not specify a module name with the TYPE command, the debugger
displays source lines for the module in which execution is currently paused by
default—that is, the module associated with the PC scope. If you have specified
another scope with the SET SCOPE command, the debugger displays source lines
in the module associated with the specified scope.

In screen mode, the output of a TYPE command updates the current source
display (see Section 7.2.6).

After displaying source lines at various locations in your program, you can
redisplay the line at which execution is currently paused by pressing KP5.

6.4 Displaying Source Code by Specifying Code Address

Expressions

The EXAMINE/SOURCE command enables you to display the source line
corresponding to a code address expression. A code address expression denotes
the address of a machine-code instruction and, therefore, must be one of the
following:

e A line number associated with one or more instructions

A label

¢ A routine name
e The memory address of an instruction

You cannot specify a variable name with the EXAMINE/SOURCE command,
because a variable name is associated with data, not with instructions.

When you use the EXAMINE/SOURCE command, the debugger evaluates the
address expression to obtain a memory address, determines which compiler-
assigned line number corresponds to that address, and then displays the source
line designated by the line number.

For example, the following command line displays the source line associated with
the address (declaration) of routine SWAP:

DBG> EXAMINE/SOURCE SWAP
module MAIN

47: procedure SWAP(X,Y: in out INTEGER) is
DBG>

If you specify a line number that is not associated with an instruction, the
debugger issues a diagnostic message. For example:
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DBG> EXAMINE/SOURCE %LINE 6

$DEBUG-I-LINEINFO, no line 6, previous line is 5, next line is 8
$DEBUG-E-NOSYMBOL, symbol '$LINE 6’ is not in the symbol table
DBG>

When using the EXAMINE/SOURCE command with a symbolic address
expression (a line number, label, or routine), you might need to set the module
in which the entity is defined, unless that module is already set. Use the SHOW
MODULE command to determine whether a particular module is set. Then, if
necessary, use the SET MODULE command (see Section 5.2).

The command EXAMINE/SOURCE .%PC displays the source line corresponding
to the current PC value (the line that is about to be executed). For example:

DBG> EXAMINE/SOURCE .$PC
module COBOLTEST

162: DISPLAY ESO.
DBG>

Note the use of the contents-of operator (.), which specifies the contents of
the entity that follows the period. If you do not use the contents-of operator,
the debugger tries to find a source line for the PC rather than for the address
currently stored in the PC:

DBG> EXAMINE/SOURCE %PC
$DEBUG-W-NOSRCLIN, no source line for address 7FFF005C
DBG>

The following example shows the use of a numeric path name (1\) to display
the source line at the PC value one level down the call stack (at the call to the
routine in which execution is paused):

DBG> EXAMINE/SOURCE .1\%PC

In screen mode, the output of an EXAMINE/SOURCE command updates the
current source display (see Section 7.2.6).

The debugger uses the EXAMINE/SOURCE command in the following contexts to
display source code at the current PC value.

Keypad key 5 (KP5) is bound to the following debugger command sequence:
EXAMINE/SOURCE .%SOURCE_SCOPE\%PC; EXAMINE/INST .%INST_SCOPE\%PC

This command sequence displays the source line and the instruction at which
execution is currently paused in the current scope. Pressing KP5 enables you to
quickly determine your debugging context.

The predefined source display SRC is an automatically updated display that
executes the following built-in command every time the debugger interrupts
execution and prompts for commands (see Section 7.4.1):

EXAMINE/SOURCE .%SOURCE_SCOPE\$PC

6.5 Displaying Source Code by Searching for Strings

The SEARCH command enables you to display any source lines that contain an
occurrence of a specified string.

The syntax of the SEARCH command is as follows:

SEARCH[ /qualifier[, ... ]] [range] [string]
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The range parameter can be a module name, a range of line numbers, or a
combination of both. If you do not specify a module name, the debugger uses the
current scope to find source lines, as with the TYPE command (see Section 6.3).

By default, the SEARCH command displays the source line that contains the first
(next) occurrence of a string in a specified range (SEARCH/NEXT). The command
SEARCH/ALL displays all source lines that contain an occurrence of a string in a
specified range. For example, the following command line displays the source line
that contains the first occurrence of the string pro in module SCREEN_IO:

DBG> SEARCH SCREEN IO pro

The remaining examples use source lines from one COBOL module, in the current
scope, to show various aspects of the SEARCH command.

The following command line displays all source lines within lines 40 to 50 that
contain an occurrence of the string D:

DBG> SEARCH/ALL 40:50 D
module COBOLTEST

40: 02 D2N COMP-2 VALUE -234560000000.

41: 02 D COMP-2 VALUE 222222.33.

42: 02 DN COMP-2 VALUE -222222.333333.

47: 02 DRO COMP-2 VALUE 0.1.

48: 02 DR5 COMP-2 VALUE 0.000001.

49: 02 DR10 COMP-2 VALUE 0.00000000001.

50: 02 DR15 COMP-2 VALUE 0.0000000000000001.
DBG>

After you have found an occurrence of a string in a particular module, you can
enter the SEARCH command with no parameters to display the source line
containing the next occurrence of the same string in the same module. This is
similar to using the TYPE command without a parameter to display the next
source line. For example:

DBG> SEARCH 42:50 D
module COBOLTEST
42: 02 DN COMP-2 VALUE -222222.333333.
DBG> SEARCH
module COBOLTEST
47: 02 DRO COMP-2 VALUE 0.1.
DBG>

By default, the debugger searches for a string as specified and does not interpret
the context surrounding an occurrence of the string (this is the behavior of
SEARCH/STRING). If you want to locate an occurrence of a string that is

an identifier in your program (for example, a variable name) and exclude

other occurrences of the string, use the /IDENTIFIER qualifier. The command
SEARCH/IDENTIFIER displays only those occurrences of the string that are
bounded on either side by a character that cannot be part of an identifier in the
current language.

The default qualifiers for the SEARCH command are /NEXT and /STRING. If you
want to establish different default qualifiers, use the SET SEARCH command.
For example, after the following command is executed, the SEARCH command
behaves like SEARCH/IDENTIFIER:

DBG> SET SEARCH IDENTIFIER
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Use the SHOW SEARCH command to display the default qualifiers currently in
effect for the SEARCH command. For example:

DBG> SHOW SEARCH
search settings: search for next occurrence, as an identifier
DBG>

6.6 Controlling Source Display After Stepping and at Eventpoints

By default, the debugger displays the associated source line when a breakpoint,
tracepoint, or watchpoint is triggered and upon the completion of a STEP
command.

When you enter a STEP command, the debugger displays the source line at which
execution is paused after the step. For example:

DBG> STEP
stepped to MAIN\RLINE 16

16: RANGE := 500;
DBG>

When a breakpoint or tracepoint is triggered, the debugger displays the source
line at the breakpoint or tracepoint, respectively. For example:

DBG> SET BREAK SWAP
DBG> GO

break at MAIN\SWAP
47: procedure SWAP(X,Y: in out INTEGER) is
DBG>

When a watchpoint is triggered, the debugger displays the source line
corresponding to the instruction that caused the watchpoint to be triggered.

The SET STEP [NO]JSOURCE command enables you to control the display of
source code after a step and at breakpoints, tracepoints, and watchpoints. SET
STEP SOURCE, the default, enables source display. SET STEP NOSOURCE
suppresses source display. For example:

DBG> SET STEP NOSOURCE
DBG> STEP

stepped to MAIN\RLINE 16
DBG> SET BREAK SWAP

DBG> GO

break at MAIN\SWAP
DBG>

You can selectively override the effect of a SET STEP SOURCE command or
a SET STEP NOSOURCE command by using the qualifiers /SOURCE and
/NOSOURCE with the STEP, SET BREAK, SET TRACE, and SET WATCH
commands.
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The STEP/SOURCE command overrides the effect of the SET STEP NOSOURCE
command, but only for the duration of that STEP command (similarly,
STEP/NOSOURCE overrides the effect of SET STEP SOURCE for the duration of
that STEP command). For example:

DBG> SET STEP NOSOURCE
DBG> STEP/SOURCE
stepped to MAIN\SLINE 16
16: RANGE := 500;
DBG>

The SET BREAK/SOURCE command overrides the effect of the SET STEP
NOSOURCE command, but only for the breakpoint set with that SET BREAK
command (similarly, SET BREAK/NOSOURCE overrides the effect of SET STEP
SOURCE for the breakpoint set with that SET BREAK command). The same
conventions apply to the SET TRACE and SET WATCH commands. For example:

DBG> SET STEP SOURCE
DBG> SET BREAK/NOSOURCE SWAP
DBG> GO

break at MAIN\SWAP
DBG>

6.7 Setting Margins for Source Display

The SET MARGINS command enables you to specify the leftmost and rightmost
source-line character positions at which to begin and end the display of a source
line (respectively, the left and right margins). This is useful for controlling the
display of source code when, for example, the code is deeply indented or long lines
wrap at the right margin. In such cases, you can set the left margin to eliminate
indented space in the source display, and you can decrease the right margin
setting to truncate lines and prevent them from wrapping.

For example, the following command line sets the left margin to column 20 and
the right margin to column 35.

DBG> SET MARGINS 20:35

Subsequently, only that portion of the source code that is between columns 20 and
35 is displayed when you enter commands that display source lines (for example,
TYPE, SEARCH, STEP). Use the SHOW MARGINS command to identify the
current margin settings for the display of source lines.

Note that the SET MARGINS command affects only the display of source lines.
It does not affect the display of other debugger output (for example, output from
an EXAMINE command).

The SET MARGINS command is useful mostly in line (noscreen) mode. In screen
mode, the SET MARGINS command has no effect on the display of source lines
in a source display, such as the predefined display SRC.
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Screen Mode

Screen mode is an enhancement to the command line interface of the OpenVMS
debugger that enables you to simultaneously display separate groups of data
about the debugging session, in a manner similar to that available with the HP
DECwindows Motif for OpenVMS user interface (see Part III). For example,
you can display source code in one portion of the screen, register contents in a
different portion, debugger output in another portion, and so on.

To invoke screen mode, press PF3 on the keypad (or enter the SET MODE
SCREEN command). To return to line-oriented debugging, press PF1 PF3 (or
enter the SET MODE NOSCREEN command).

Note

Note that you cannot enter screen mode from within the DECWindows
Motif interface to the debugger.

Screen mode output is best displayed on VT-series terminals with higher numbers
than VT52, and on workstations running VWS. The larger screen of workstations
is particularly suitable to using a number of displays for different purposes.

This chapter covers the following topics:

e Screen mode concepts and terminology used throughout the chapter

e Using different kinds of displays

e Directing debugger output to different displays by assigning display attributes

e Using predefined displays SRC, OUT, PROMPT, INST, REG, IREG, and
FREG (Alpha only), which are automatically available when you enter screen
mode

e Scrolling, hiding, deleting, moving, and resizing a display
e Creating a new display

e Specifying a display window

¢ Creating a display configuration

e Saving the current state of screen displays

¢ Changing your terminal screen’s height and width during a debugging session
and the effect on display windows

e Using screen-related debugger built-in symbols
e Using predefined windows

e Enabling country-specific features for screen mode
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Many screen mode commands are bound to keypad keys. For key definitions, see
Appendix A.

Note

This chapter provides information common to programs that run in one or
several processes. See Chapter 15 for additional information specific to
multiprocess programs.

7.1 Concepts and Terminology

A display is a group of text lines. The text can be lines from a source file,
assembly-language instructions, the values contained in registers, your input to
the debugger, debugger output, or program input and output.

You view a display through its display window, which can occupy any
rectangular area of the screen. Because a display window is typically smaller
than the associated display, you can scroll the display window up, down, right,
and left across the display text to view any part of the display.

Figure 7-1 is an example of screen mode that shows three display windows. The
name of each display (SRC, OUT, and PROMPT) appears at the top left corner of
its display window. The display name serves both as a tag on the display itself
and as a name for future reference in commands.

Figure 7-1 Default Screen Mode Display Configuration

— SRC: module SQUARESSMAIN — scroll-source

7: C -- Square all non-zero elements and store in output array
8: K=0
9: DO 10 I =1, N
10: IF(INARR(I) .NE. 0) THEN
-> 11: OUTARR (K) = INARR(I)**2
12: ENDIF
13: 10 CONTINUE
14: C
15: C -— Print the squared output values. Then stop.
16: PRINT 20, K
17: 20 FORMAT ('’ Number of non-zero elements is’,I4)
— OUT-output
stepped to SQUARESSMAIN\RLINE 9
9: DO 10 I =1, N
SQUARESSMATIN\N: 9
SQUARESSMAIN\K:
stepped to SQUAREssMAIN\%LINE 11
— PROMPT —error-program-prompt
DBG> EXAM N, K

DBG> STEP 2
DGB>

ZK-6503-GE

Figure 7-1 is the default display configuration established when you first invoke
screen mode. SRC, OUT, and PROMPT are three of the predefined displays
that the debugger provides when you enter screen mode (see Section 7.4). You can
modify the configuration of these displays as well as create additional displays.
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Displays SRC, OUT, and PROMPT have the following basic characteristics:

e SRC is a source-code display that occupies the upper half of the screen
(it displays Fortran code in Figure 7-1). The name of the source module
displayed, SQUARES$MAIN, is to the right of the display name.

e OUT, located in a window directly below SRC, shows the output of debugger
commands.

e PROMPT, at the bottom of the screen, shows the debugger prompt and
debugger input.

Conceptually, displays are placed on the screen as on a pasteboard. The display
most recently referenced by a command is put on top of the pasteboard by default.
Therefore, depending on their screen locations, display windows that you have
referenced recently might overlay or hide other display windows.

The debugger maintains a display list, which is the pasting order of displays.
Several keypad key definitions use the display list to cycle through the displays
currently on the pasteboard.

Every display belongs to a display kind (see Section 7.2). The display kind
determines what type of information the display can capture and display, such as
source code, or debugger output. The display kind defines whether displayed data
is paged into the memory buffer or discarded when the memory buffer overflows.
The display kind also determines how the contents of the display are generated.

The contents of a display are generated in two ways:

e Some displays are automatically updated. Their definition includes a
command list that is executed whenever the debugger gains control from
the program. The output of the command list forms the contents of those
displays. Display SRC belongs to that category: it is automatically updated
so that an arrow points to the source line at which execution is currently
paused.

e Other displays, for example, display OUT, are updated in response to
commands you enter interactively. For a display of this type to be updated, it
must first be assigned an appropriate display attribute (with the SELECT
command). The display attribute identifies the display as the target display
for one or more types of output (see Section 7.3).

The names of any attributes assigned to a display appear to the right of the
display name, in lowercase letters. In Figure 7-1, SRC has the source and scroll
attributes (SRC is the current source display and the current scrolling
display), OUT has the output attribute (it is the current output display),
and so on. Note that, although SRC is automatically updated by its own built-in
command, it can also receive the output of certain interactive commands (such as
EXAMINE/SOURCE) because it has the source attribute.

The concepts introduced in this section are developed in more detail in the rest of
this chapter.
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7.2 Display Kinds

Every display has a display kind. The display kind determines the type of
information a display contains, how that information is generated, and whether
the memory buffer associated with the display is paged.

Typically, you specify a display kind when you use the DISPLAY command to
create a new display (if you do not specify a display kind, an output display is
created). You can also use the DISPLAY command to change the display kind of
an existing display with the following keywords:

DO (commandy,...])
INSTRUCTION
INSTRUCTION (command)
OUTPUT

REGISTER

SOURCE

SOURCE (command)

The contents of a register display are generated and updated automatically
by the debugger. The contents of other kinds of displays are generated by
commands, and these display kinds fall into two general groups.

A display that belongs to one of the following display kinds has its contents
updated automatically according to the command or command list you supply
when defining that display:

DO (command],...])
INSTRUCTION (command)
REGISTER

SOURCE (command)

The command list specified is executed each time the debugger gains control
from your program, if the display is not marked as removed. The output of the
commands forms the new contents of the display. If the display is marked as
removed, the debugger does not execute the command list until you view that
display (marking that display as unremoved).

A display that belongs to one of the following display kinds derives its contents
from commands that you enter interactively:

INSTRUCTION
OUTPUT
SOURCE

To direct debugger output to a specific display in this group, you must first select
it with the SELECT command. The technique is explained in the following
sections and in Section 7.3. After a display is selected for a certain type of output,
the output from your commands forms the contents of the display.

7.2.1 DO (Command[; ... ]) Display Kind
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A DO display is an automatically-updated display. The commands in the
command list are executed in the order listed each time the debugger gains
control from your program. Their output forms the contents of the display and
erases any previous contents.
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For example, the following command creates the DO display CALLS at window
Q3. (Window Q3 refers to screen dimensions of the window. For information
about screen dimensions and predefined windows, see Section 7.12.) Each time
the debugger gains control from the program, the SHOW CALLS command is
executed and the output is displayed in CALLS, replacing any previous contents.

DBG> DISPLAY CALLS AT Q3 DO (SHOW CALLS)

The following command creates a DO display named V2_DISP that shows the
contents of elements 4 to 7 of the vector register V2 (using Fortran array syntax).
The display is automatically updated whenever the debugger gains control from
the program:

DBG> DISPLAY V2 DISP AT RQ2 DO (EXAMINE %V2(4:7))

The default size of the memory buffer associated with any DO display is 64 lines.
When the memory buffer is full, the oldest lines are discarded to make room for
new text. You can use the DISPLAY/SIZE command to change the buffer size.

7.2.2 INSTRUCTION Display Kind

An instruction display shows the output of an EXAMINE/INSTRUCTION
command within the instruction stream of a routine. Because the instructions
displayed are decoded from the image being debugged and show the exact code
that is executing, this kind of display is particularly useful in helping you debug
optimized code (see Section 14.1).

In the display, one line is devoted to each instruction. Source-line numbers
corresponding to the instructions are displayed in the left column. The instruction
at the location being examined is centered in the display and is marked by an
arrow in the left column.

Before anything can be written to an instruction display, you must select it as the
current instruction display with the SELECT/INSTRUCTION command.

In the following example, the DISPLAY command creates the instruction display
INST2 at RH1. The SELECT/INSTRUCTION command then selects INST2 as
the current instruction display. When the EXAMINE/INSTRUCTION X command
is executed, window RH1 fills with the instruction stream surrounding the
location denoted by X. The arrow points to the instruction at location X, which is
centered in the display.

DBG> DISPLAY INST2 AT RH1 INSTRUCTION
DBG> SELECT/INSTRUCTION INST2
DBG> EXAMINE/INSTRUCTION X

Each subsequent EXAMINE/INSTRUCTION command updates the display.

The default size of the memory buffer associated with any instruction display is
64 lines; however, you can scroll back and forth to view all the instructions within
the routine. You can use the DISPLAY/SIZE command to change the buffer size
and improve performance.

7.2.3 INSTRUCTION (Command) Display Kind

This is an instruction display that is automatically updated with the output of
the command specified. That command, which must be an
EXAMINE/INSTRUCTION command, is executed each time the debugger gains
control from your program.
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For example, the following command creates the instruction display INST3 at
window RS45. Each time the debugger gains control, the built-in command
EXAMINE/INSTRUCTION .%INST_SCOPE\ %PC is executed, updating the
display.

DBG> DISPLAY INST3 AT RS45 INSTRUCT (EX/INST .%INST SCOPE\%PC)

This command creates a display that functions like the predefined display INST.
The built-in EXAMINE/INSTRUCTION command displays the instruction at the
current PC value in the current scope (see Section 7.4.4).

If an automatically updated instruction display is selected as the current
instruction display, it is updated like a simple instruction display by an
interactive EXAMINE/INSTRUCTION command (in addition to being updated by
its built-in command).

The default size of the memory buffer associated with any instruction display is
64 lines; however, you can scroll back and forth to view all the instructions within
the routine. You can use the DISPLAY/SIZE command to change the buffer size
and improve performance.

7.2.4 OUTPUT Display Kind

An output display shows any debugger output that is not directed to another
display. New output is appended to the previous contents of the display.

Before anything can be written to an output display, it must be selected as

the current output display with the SELECT/OUTPUT command, or as the
current error display with the SELECT/ERROR command, or as the current
input display with the SELECT/INPUT command. See Section 7.3 for more
information about using the SELECT command with output displays.

In the following example, the DISPLAY command creates the output display
OUT2 at window T2 (the display kind OUTPUT can be omitted from this
example, because it is the default kind). The SELECT/OUTPUT command then
selects OUT2 as the current output display. These two commands create a display
that functions like the predefined display OUT:

DBG> DISPLAY OUT2 AT T2 OUTPUT
DBG> SELECT/OUTPUT OUT2

OUT2 now collects any debugger output that is not directed to another display.
For example:

¢ The output of a SHOW CALLS command goes to OUT2.

e If no instruction display has been selected as the current instruction display,
the output of an EXAMINE/INSTRUCTION command goes to OUT2.

e By default, debugger diagnostic messages are directed to the PROMPT
display. They can be directed to OUT2 with the SELECT/ERROR command.

The default size of the memory buffer associated with any output display is 64
lines. When the memory buffer is full, the oldest lines are discarded to make
room for new text. You can use the DISPLAY/SIZE command to change the buffer
size.
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A register display is an automatically updated display that shows the current
values, in hexadecimal format, of the processor registers and as many of the top
call-stack values as will fit in the display.

The register values displayed are for the routine in which execution is currently
paused. The values are updated whenever the debugger takes control. Any

changed values are highlighted.

There are up to three predefined register displays. The REG, IREG, and FREG
displays are predefined on Alpha and Integrity server processors. The contents of
the predefined displays are shown in Table 7-1.

Table 7-1 Predefined Register Displays

Display Alpha Intel ltanium
REG - RO to R31 -PC
-PC - CFM
-PS - R1 to R31
- FO to F31 - R32 to R127 ( as
- FPCR many as are used)
- SFPCR - F2 to F127
- top of call-stack values - top-of-stack
values
IREG - RO to R31 -PC
-PC - CFM
-PS - R1 to R31
- top of call-stack values - top of call-stack
The data is shown in values
hexadecimal format. The data is shown
in hexadecimal
format.
FREG - FO to F31 - F2 to F127
- FPCR - top-of-stack
- SFPCR values

- top of call-stack values

The data is shown in floating-

point format.

The register data
is shown in the
format consistent
with the data
value (integer or
floating-point);
the stack values
are shown in
floating-point
format.

On Alpha processors, the predefined display REG contains, in hexadecimal
format, general-purpose registers RO to R28, FP (R29), SP (R30), R31, PC,
PS floating-point registers FO to F31, FPCR, SFPCR, and as many of the top

call-stack values as will fit in the display.

On Alpha processors, the predefined display IREG contains, in hexadecimal
format, general-purpose registers RO to R28, FP, and as many of the top call-stack
values as can be displayed in the window.

On Alpha processors, the predefined display FREG contains floating-point
registers FO to F31, FPCR, SFPCR, displayed in floating-point format and as
many of the top call-stack values (in hexadecimal format) as can be displayed in
the window.
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The default size of the memory buffer associated with any register display is 64
lines. When the memory buffer is full, the oldest lines are discarded to make
room for new text. You can use the DISPLAY/SIZE command to change the buffer
size.

7.2.6 SOURCE Display Kind

A source display shows the output of a TYPE or EXAMINE/SOURCE command
within the source code of a module, if that source code is available. Source line
numbers are displayed in the left column. The source line that is the output of
the command is centered in the display and is marked by an arrow in the left
column. If a range of lines is specified with the TYPE command, the lines are
centered in the display, but no arrow is shown.

Before anything can be written to a source display, you must select it as the
current source display with the SELECT/SOURCE command.

In the following example, the DISPLAY command creates source display SRC2 at
Q2. The SELECT/SOURCE command then selects SRC2 as the current source
display. When the TYPE 34 command is executed, window RH1 fills with the
source code surrounding line 34 of the module being debugged. The arrow points
to line 34, centered in the display.

DBG> DISPLAY SRC2 AT Q2 SOURCE
DBG> SELECT/SOURCE SRC2
DBG> TYPE 34

Each subsequent TYPE or EXAMINE/SOURCE command updates the display.

The default size of the memory buffer of a source display is 64 lines. The memory
buffer of a source display is paged, enabling you to scroll back and forth through
the entire source module or routine. You can use the DISPLAY/SIZE command to
change the buffer size to improve performance.

7.2.7 SOURCE (Command) Display Kind
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This is a source display that is automatically updated with the output of the
command specified. That command, which must be an EXAMINE/SOURCE or
TYPE command, is executed each time the debugger gains control from your
program.

For example, the following command creates source display SRC3 at window
RS45. Each time the debugger gains control, it executes the built-in command
EXAMINE/SOURCE . %SOURCE_SCOPE\ %PC and updates the display.

DBG> DISPLAY SRC3 AT RS45 SOURCE (EX/SOURCE .$SOURCE_SCOPE\%PC)

This command creates a display that functions like the predefined display SRC.
The built-in EXAMINE/SOURCE command displays the source line for the
current PC value in the current scope (see Section 7.4.1).

If you select an automatically updated source display as the current source
display, it displays the output generated by an interactive

EXAMINE/SOURCE or TYPE command in addition to the output generated by
its built-in command.

The default size of the memory buffer of a source display is 64 lines. The memory
buffer of an automatically updated source display is paged, enabling you to scroll
back and forth through the entire source module or routine. You can use the
DISPLAY/SIZE command to change the buffer size to improve performance.
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7.2.8 PROGRAM Display Kind

A program display can receive the output of the program being debugged. The
predefined PROMPT display belongs to the program display kind, and is the only
display permitted of that kind. You cannot create a new display of the program
display kind.

To avoid possible confusion, the PROMPT display has several restrictions (see
Section 7.4.3).

7.3 Display Attributes

In screen mode, the output from commands you enter interactively is directed
to various displays according to the type of output and the display attributes
assigned to these displays. For example, debugger diagnostic messages go to
the display that has the error attribute (the current error display). By assigning
one or more attributes to a display, you can mix or isolate different kinds of
information.
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The attributes have the following names:

error
input
instruction
output
program
prompt
scroll
source

When a display is assigned an attribute, the name of that attribute appears

in lowercase letters on the top border of its window to the right of the display
name. Note that the scroll attribute does not affect debugger output but is used
to control the default display for the SCROLL, MOVE, and EXPAND commands.

By default, attributes are assigned to the predefined displays as follows:
e SRC has the source and scroll attributes

e OUT has the output attribute

e PROMPT has the prompt, program, and error attributes

To assign an attribute to a display, use the SELECT command with the qualifier
of the same name as the attribute. In the following example, the DISPLAY
command creates the output display ZIP. The SELECT/OUTPUT command

then selects ZIP as the current output display—the display that has the output
attribute. After this command is executed, the word "output" disappears from
the top border of the predefined output display OUT and appears instead on
display ZIP, and all the debugger output formerly directed to OUT is now directed
to ZIP.

DBG> DISPLAY ZIP OUTPUT
DBG> SELECT/OUTPUT ZIP

You can assign specific attributes only to certain display kinds. The following
list identifies each of the SELECT command qualifiers, its effect, and the display
kinds to which you can assign that attribute:

Apply to

SELECT Qualifier Display Kind Description

/ERROR Output Selects the specified display as the current error
Prompt display. Directs any subsequent debugger diagnostic

message to that display. If no display is specified,
selects the PROMPT display as the current error
display.

/INPUT Output Selects the specified display as the current input
display. Echoes any subsequent debugger input in
that display. If no display is specified, unselects the
current input display: debugger input is not echoed
to any display.
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SELECT Qualifier

Apply to
Display Kind

Description

/INSTRUCTION

/OUTPUT

/PROGRAM

/PROMPT

/SCROLL

/SOURCE

Instruction

Output
Prompt

Prompt

Prompt

All

Source

Selects the specified display as the current
instruction display. Directs the output of any
subsequent EXAMINE/INSTRUCTION command

to that display. Keypad key sequence PF4 COMMA
selects the next instruction display in the display list
as the current instruction display. If no display is
specified, unselects the current instruction display:
no display has the instruction attribute.

Selects the specified display as the current output
display. Directs any subsequent debugger output

to that display, except where a particular type of
output is being directed to another display (such

as diagnostic messages going to the current error
display). Keypad key sequence PF1 KP3 selects the
next output display in the display list as the current
output display. If no display is specified, selects the
PROMPT display as the current output display.

Selects the specified display as the current program
display. Tries to force any subsequent program
input or output to that display. If no display is
specified, unselects the current program display:
program input and output are no longer forced to the
PROMPT display.

Selects the specified display as the current prompt
display where the debugger prompts for input. You
cannot unselect the PROMPT display.

Selects the specified display as the current scrolling
display. Makes that display the default display

for any subsequent SCROLL, MOVE, or EXPAND
command. You can specify any display (however,
note that the PROMPT display cannot be scrolled).
The /SCROLL qualifier is the default if you do not
specify a qualifier with the SELECT command. Key
KP3 selects as the current scrolling display the next
display in the display list after the current scrolling
display. If no display is specified, unselects the
current scrolling display: no display has the scroll
attribute.

Selects the specified display as the current source
display. Directs the output of any subsequent TYPE
or EXAMINE/SOURCE command to that display.
Keypad key sequence PF4 KP3 selects the next
source display in the display list as the current
source display. If no display is specified, unselects
the current source display: no display has the source
attribute.

Subject to the restrictions listed, a display can have several attributes. In the
preceding example, ZIP was selected as the current output display. In the next
example, ZIP is further selected as the current input, error, and scrolling display.
After these commands are executed, debugger input, output, and diagnostics

are logged in ZIP in the proper sequence as they occur, and ZIP is the current

scrolling display.

DBG> SELECT/INPUT/ERROR/SCROLL ZIP

To identify the displays currently selected for each of the display attributes, use

the SHOW SELECT command.
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If you use the SELECT command with a particular qualifier but without
specifying a display name, the effect is typically to deassign that attribute (to
unselect the display that had the attribute). The exact effect depends on the
attribute, as described in the preceding table.

7.4 Predefined Displays
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The debugger provides the following predefined displays that you can use to
capture and display different kinds of data:

SRC, the predefined source display

OUT, the predefined output display

PROMPT, the predefined prompt display

INST, the predefined instruction display

REG, the predefined register display

FREG, the predefined floating-point register display (Alpha only)
IREG, the predefined integer register display

When you enter screen mode, the debugger puts SRC in the top half of the screen,
PROMPT in the bottom sixth, and OUT between SRC and PROMPT, as shown
in Figure 7-1. Displays INST, REG, FREG (Alpha only), and IREG are initially
removed from the screen by default.

To re-create this default configuration, press BLUE MINUS on the keypad (PF4
followed by the MINUS (-) key).

The basic features of the predefined displays are described in the next sections.
As explained in other parts of this chapter, you can change certain characteristics
of these displays, such as the buffer size or display attributes. You can also create
additional displays similar to the predefined displays.

To display summary information about the characteristics of any display, use the
SHOW DISPLAY command.

Table 7-2 summarizes key information about the predefined displays.

Table 7-2 Predefined Displays

Display Name Display Kind Valid Display Attributes Visible on Startup

SRC Source Scroll X
Source (By Default)

ouT Output Error X
Input
Output (By Default)
Scroll

PROMPT Output Error (By Default) X
Output
Program (By Default)
Prompt (By Default)

Scroll *
INST Instruction Instruction
Scroll
REG Register Scroll

1The predefined PROMPT display cannot be scrolled.

(continued on next page)
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Table 7-2 (Cont.) Predefined Displays

Display Name Display Kind Valid Display Attributes Visible on Startup
FREG (Alpha only)  Register Scroll
IREG Register Scroll

7.4.1 Predefined Source Display (SRC)
Note

See Chapter 6 for information about how to make source code available
for display during a debugging session.

The predefined display SRC (see Figure 7-1) is an automatically updated source
display.

You can use SRC to display source code in two basic ways:

e By default, SRC automatically displays the source code for the module in
which execution is currently paused. This enables you to quickly determine
your current debugging context.

e In addition, because SRC has the source attribute by default, you can use
it to display the source code for any part of your program as explained in
Section 7.4.1.1.

The name of the module whose source code is displayed is shown at the right
of the display name, SRC. The numbers displayed at the left of the source code
are the compiler-generated line numbers, as they might appear in a compiler-
generated listing file.

As you execute the program under debugger control, SRC is automatically
updated whenever execution is paused. The arrow in the leftmost column
indicates the source line to be executed next. Specifically, execution is paused at
the first instruction associated with that source line. Thus, the line indicated by
the arrow corresponds to the current program counter (PC) value. The PC is a
register that contains the memory address of the next instruction to be executed.

If the debugger cannot locate source code for the routine in which execution is
paused (because, for example, the routine is a run-time library routine), it tries
to display source code in the next routine down on the call stack for which source
code is available. When displaying source code for such a routine, the debugger
issues the following message:

$DEBUG-I-SOURCESCOPE, Source lines not available for .0\3%PC.
Displaying source in a caller of the current routine.

Figure 7-2 shows this feature. The source display shows that a call to routine
TYPE is currently active. TYPE corresponds to a Fortran run-time library
procedure. No source code is available for that routine, so the debugger displays
the source code of the calling routine. The output of a SHOW CALLS command,
shown in the output display, identifies the routine where execution is paused and
the call sequence leading to that routine.

In such cases, the arrow in the source window identifies the line to which
execution returns after the routine call. Depending on the source language and
coding style, this might be the line that contains the call statement or the next
line.
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Figure 7-2 Screen Mode Source Display When Source Code Is Not Available

— SRC: module TEST—scroll-source

$DEBUG-I-SOURCESCOPE, Source lines not available for .0\%PC
Displaying source in a caller of the current routine

3: CHARACTER* (*) ARRAYX
-> 4z TYPE *, ARRAYX
5: RETURN
6: END
—OUT-output
stepped to SHARE$SFORRTL+810
module name routine name line rel PC abs PC
SHARESFORRTL SHARESFORRTL 00000322 00000B2A
*TEST TEST 4 0000001E 00000436
*A A 3 00000011 00000411

— PROMPT-error-program-prompt
DBG> STEP

DBG> SHOW CALLS

DBG>
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If your program was optimized during compilation, the source code displayed

in SRC might not always represent the code that is actually executing. The
predefined instruction display INST is useful in such cases, because it shows the
exact instructions that are executing (see Section 7.4.4).

The built-in command that automatically updates display SRC is
EXAMINE/SOURCE .%2SOURCE_SCOPE\ %PC. For information about the
EXAMINE/SOURCE command, see Section 6.4. The built-in debugger symbol
%SOURCE_SCOPE denotes a scope and has the following properties:

By default %SOURCE_SCOPE denotes scope 0, which is the scope of the
routine where execution is currently paused.

If you have reset the scope search list relative to the call stack by means
of the SET SCOPE/CURRENT command (see Section 7.4.1.2), %SOURCE_
SCOPE denotes the current scope specified (the scope of the routine at the
start of the search list).

If source code is not available for the routine in the current scope,
%SOURCE_SCOPE denotes scope n, where n is the first level down the
call stack for which source code is available.

7.4.1.1 Displaying Source Code in Arbitrary Program Locations

You can use display SRC to display source code throughout your program, if
source code is available for display:
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You can scroll through the entire source display by pressing KP2 (scroll down)
or KP8 (scroll up) as explained in Section 7.5.1. This enables you to view any
of the source code within the module in which execution is paused.

You can display the source code for any routine that is currently on the call
stack by using the SET SCOPE/CURRENT command (see Section 7.4.1.2).
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¢ Because SRC has the source attribute, you can display source code throughout
your program by using the TYPE and EXAMINE/SOURCE commands:

— To display arbitrary source lines, use the TYPE command (see
Section 6.3).

— To display the source line associated with a code location (for example,
a routine declaration), use the EXAMINE/SOURCE command (see
Section 6.4).

When using the TYPE or EXAMINE/SOURCE command, make sure that the
module in which you want to view source code is set first. Use the SHOW
MODULE command to determine whether a particular module is set. Then
use the SET MODULE command, if necessary (see Section 5.2).

After manipulating the contents of display SRC, you can redisplay the location
at which execution is currently paused (the default behavior of SRC) by pressing
KP5.

7.4.1.2 Displaying Source Code for a Routine on the Call Stack
The command SET SCOPE/CURRENT lets you display the source code for any
routine that is currently on the call stack. For example, the following command
updates display SRC so that it shows the source code for the caller of the routine
in which execution is currently paused:

DBG> SET SCOPE/CURRENT 1

To reset the default scope for displaying source code, enter the command CANCEL
SCOPE. The command causes display SRC to show the source code for the routine
at the top of the call stack where execution is paused.

7.4.2 Predefined Output Display (OUT)

Figure 7-1 and Figure 7-2 show some typical debugger output in the predefined
display OUT.

Display OUT is a general-purpose output display. By default, OUT has the output
attribute so it displays any debugger output that is not directed to the source
display SRC or the instruction display INST. For example, if display INST is

not displayed or does not have the instruction attribute, any output that would
otherwise update display INST is shown in display OUT.

By default, OUT does not display debugger diagnostic messages (these appear
in the PROMPT display). You can assign display attributes to OUT so that
it captures debugger input and diagnostics as well as normal output (see
Section 7.3).

By default, the memory buffer associated with predefined display OUT contains
100 lines.

7.4.3 Predefined Prompt Display (PROMPT)

The predefined display PROMPT is the display in which the debugger prompts
for input. Figure 7-1 and Figure 7-2 show PROMPT in its default location, the
bottom sixth of the screen.

By default, PROMPT has the prompt attribute. In addition, PROMPT also has
(by default) the program and error attributes, which force program output and
diagnostic messages to that display.
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PROMPT has different properties and restrictions than other displays. This is to
eliminate possible confusion when manipulating that display:

e The PROMPT display window is always fully visible. You cannot hide
PROMPT (with the DISPLAY/HIDE command), remove PROMPT from the
pasteboard (with the DISPLAY/REMOVE command), or delete PROMPT (with
the CANCEL DISPLAY command).

®  You can assign PROMPT the scroll attribute so that it receives the output of
the MOVE and EXPAND commands. However, you cannot scroll through the
PROMPT display.

e The PROMPT display window always occupies the full width of the screen,
beginning in the first column.

e  You can move PROMPT vertically anywhere on the screen, expand it to fill
the full screen height, or contract it down to two lines.

The debugger alerts you if you try to move or expand a display such that it is
hidden by PROMPT.

7.4.4 Predefined Instruction Display (INST)
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Note

By default, the predefined instruction display INST is not shown on the
screen and does not have the instruction attribute (see Section 7.4.4.1 and
Section 7.4.4.2).

Display INST is an automatically updated instruction display. It shows the
decoded instruction stream of your program. This is the exact code that is
executing, including the effects of any compiler optimization.

A VAX example is shown in Figure 7-3.

This type of display is useful when debugging code that has been optimized. In
such cases some of the code being executed might not match the source code that
is shown in a source display. See Section 14.1 for information about the effects of
optimization.

You can use INST in two basic ways:

e By default, INST automatically displays the decoded instructions for the
routine in which execution is currently paused. This enables you to quickly
determine your current debugging context.

e In addition, if INST has the instruction attribute, you can use it to display
the decoded instructions for any part of your program as explained in
Section 7.4.4.2.

The name of the routine whose instructions are displayed is shown at the right of
the display name, INST. The numbers displayed at the left of the instructions are
the compiler-generated source line numbers.

As you execute the program under debugger control, INST is updated
automatically whenever execution is paused. The arrow in the leftmost column
points to the instruction at which execution is paused. This is the instruction
that will be executed next and whose address is the current PC value.
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Figure 7-3 Screen Mode Instruction Display (VAX Example)

— INST: routine SQUARES$MAIN

TSTL

: BLEQ

Line 10: MOVL

: TSTL

: BEQL

->ne 11: MOVL

: MOVL

: MULL3
Line 13: AOBLEQ
Line 16: PUSHAL
: MNEGL

B~16(R11)

SQUARESSMAIN\$LINE 16

BA41R11),RO

W*-164(R11)[RO]

SQUARESSMAIN\$LINE 13

B~12(R11),R1

B~4(R11),R0

W'-164(R11) [RO],W"~164 (R11)[R0],B =84 (R11)[R1]
BA%géRll),B 4(R11),SQUARESSMAINASLINE 10

A

S*#1,-(SP)

— OUT-ou'l':put
SQUARESS$SMAIN\N:
SQUARES$MAIN\K:

SQUARES$MAIN\I:
SQUARESSMAIN\K:

DBG> STEP
DBG> EXAMINE I, K
DBG>

— PROMPT-error-program-prompt

stepped to SQUARES$MAIN\SLINE 9
9: DO 10 I =1, N

3

0
stepped to SQUARES$MAIN\RLINE 11

1
0
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The built-in command that automatically updates display INST is
EXAMINE/INSTRUCTION .%INST_SCOPE\ %PC. For information about the
EXAMINE/INSTRUCTION command, see Section 4.3.1. The built-in debugger
symbol %INST_SCOPE denotes a scope and has the following properties:

e By default %INST_SCOPE denotes scope 0, which is the scope of the routine
where execution is currently paused.

e If you have reset the scope search list relative to the call stack by means of
the SET SCOPE/CURRENT command (see Section 7.4.4.3), %2INST_SCOPE
denotes the current scope specified (the scope of the routine at the start of the
search list).

7.4.4.1 Displaying the Instruction Display

By default, display INST is marked as removed (see Section 7.5.2) from the
display pasteboard and is not visible. To show display INST, use one of the
following methods:

e Press KP7 to place displays SRC and INST side by side. This enables you to

compare the source code and the decoded instruction stream.

e Press PF1 KP7 to place displays INST and REG side by side.

e Enter the DISPLAY INST command to place INST in its default or most
recently defined location (see Section 7.5.2).
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7.4.4.2 Displaying Instructions in Arbitrary Program Locations

You can use display INST to display decoded instructions throughout your
program as follows:

¢  You can scroll through the entire instruction display by pressing KP2 (scroll
down) or KP8 (scroll up) as explained in Section 7.5.1. This enables you to
view any instruction within the routine in which execution is paused.

¢  You can display the instruction stream for any routine that is currently on the
call stack by using the SET SCOPE/CURRENT command (see Section 7.4.4.3).

e If INST has the instruction attribute, you can display the instructions
for any code location throughout your program by using the
EXAMINE/INSTRUCTION command as follows:

— To assign INST the instruction attribute, use the
SELECT/INSTRUCTION INST command (see Section 7.2.2 and
Section 7.3). Note that the instruction attribute is automatically assigned
to INST when you display it by pressing either KP7 or PF1 KP7.

— To display the instructions associated with a code location (for example,
a routine declaration), use the EXAMINE/INSTRUCTION command (see
Section 4.3.1).

If no display has the instruction attribute, the output of an
EXAMINE/INSTRUCTION command is directed at display OUT.

After manipulating the contents of display INST, you can redisplay the location
at which execution is currently paused (the default behavior of INST) by pressing
KP5.

7.4.4.3 Displaying Instructions for a Routine on the Call Stack

The SET SCOPE/CURRENT command lets you display the instructions for any
routine that is currently on the call stack. For example, the following command
updates display INST so that it shows the instructions for the caller of the routine
in which execution is currently paused:

DBG> SET SCOPE/CURRENT 1

To reset the default scope for displaying instructions, enter the CANCEL SCOPE
command. The command causes display INST to show the instructions for the
routine at the top of the call stack where execution is paused.

7.4.4.4 Displaying Register Values for a Routine on the Call Stack
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The SET SCOPE/CURRENT command lets you display the register values
associated with any routine that is currently on the call stack. For example, the
following command updates display REG so that it shows the register values for
the caller of the routine in which execution is currently paused:

DBG> SET SCOPE/CURRENT 1

To reset the default scope for displaying register values, enter the CANCEL
SCOPE command. This command causes display REG to show the register values
for the routine at the top of the call stack, where execution is paused.
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7.5 Manipulating Existing Displays
This section explains how to perform the following functions:
e Use the SELECT and SCROLL commands to scroll a display.

e Use the DISPLAY command to show, hide, or remove a display; the CANCEL
DISPLAY command to permanently delete a display; and the SHOW
DISPLAY command to identify the displays that currently exist and their
order in the display list.

e Use the MOVE command to move a display across the screen.
e Use the EXPAND command to expand or contract a display.

Section 7.7 and Section 7.2 discuss more advanced techniques for modifying
existing displays with the DISPLAY command—how to change the display
window and the type of information displayed.

7.5.1 Scrolling a Display

A display usually has more lines of text (and possibly longer lines) than can
be seen through its window. The SCROLL command lets you view text that is
hidden beyond a window’s border. You can scroll through all displays except for
the PROMPT display.

The easiest way to scroll displays is with the keypad keys, described later in this
section. Using the relevant commands is explained first.

You can specify a display explicitly with the SCROLL command. Typically,
however, you first use the SELECT/SCROLL command to select the current
scrolling display. This display then has the scroll attribute and is the default
display for the SCROLL command. You then use the SCROLL command with
no parameter to scroll that display up or down by a specified number of lines, or
to the right or left by a specified number of columns. The direction and distance
scrolled are specified with the command qualifiers (/UP:n, /RIGHT:n, and so on).

In the following example, the SELECT command selects display OUT as the
current scrolling display (/SCROLL can be omitted because it is the default
qualifier); the SCROLL command then scrolls OUT to reveal text 18 lines down:

DBG> SELECT OUT
DBG> SCROLL/DOWN:18

Several useful SELECT and SCROLL command lines are assigned to keypad keys
(See Appendix A for a keypad diagram):

¢ Pressing KP3 assigns the scroll attribute to the next display in the display
list after the current scrolling display. To select a display as the current
scrolling display, press KP3 repeatedly until the word "scroll" appears on the
top line of that display.

e Press KP8, KP2, KP6, or KP4 to scroll up, down, right, or left, respectively.
The amount of scroll depends on which key state you use (DEFAULT, GOLD,
or BLUE).
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7.5.2 Showing, Hiding, Removing, and Canceling a Display

The DISPLAY command is the most versatile command for creating and
manipulating displays. In its simplest form, the command puts an existing
display on top of the pasteboard where it appears through its current window.
For example, the following command shows the display INST through its current
window:

DBG> DISPLAY INST

Pressing KP9, which is bound to the DISPLAY %NEXTDISP command, enables
you to achieve this effect conveniently. The built-in function #NEXTDISP
signifies the next display in the display list. (Appendix B identifies all screen-
related built-in functions.) Each time you press KP9, the next display in the list
is put on top of the pasteboard in its current window.

By default, the top line of display OUT (which identifies the display) coincides
with the bottom line of display SRC. If SRC is on top of the pasteboard, its bottom
line hides the top line of OUT (keep this in mind when using the DISPLAY
command and associated keypad keys to put various displays on top of the
pasteboard).

To hide a display at the bottom of the pasteboard, use the DISPLAY/HIDE
command. This command changes the order of that display in the display list.

To remove a display from the pasteboard so that it is no longer seen (yet is not
permanently deleted), use the DISPLAY/REMOVE command. To put a removed
display back on the pasteboard, use the DISPLAY command.

To delete a display permanently, use the CANCEL DISPLAY command. To
re-create the display, use the DISPLAY command as described in Section 7.6.

Note that you cannot hide, remove, or delete the PROMPT display.

To identify the displays that currently exist, use the SHOW DISPLAY command.
They are listed according to their order on the display list. The display that is on
top of the pasteboard is listed last.

For more information about the DISPLAY options, see the DISPLAY command.
Note that the DISPLAY command accepts optional parameters that let you
modify other characteristics of existing displays, namely the display window and
the type of information displayed. The techniques are discussed in Section 7.7
and Section 7.2.

7.5.3 Moving a Display Across the Screen
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Use the MOVE command to move a display across the screen. The qualifiers
/UP:n, /IDOWN:n, /RIGHT:n, and /LEFT:n specify the direction and the number of
lines or columns by which to move the display. If you do not specify a display, the
current scrolling display is moved.

The easiest way to move a display is by using keypad keys:
¢ Press KP3 repeatedly as needed to select the current scrolling display.

e Put the keypad in the MOVE state, then press KP8, KP2, KP4, or KP6 to
move the display up, down, left, or right, respectively. See Appendix A.
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7.5.4 Expanding or Contracting a Display

Use the EXPAND command to expand or contract a display. The qualifiers /UP:n,
/DOWN:n, /RIGHT:n, and /LEFT:n specify the direction and the number of lines
or columns by which to expand or contract the display (to contract a display,
specify negative integer values with these qualifiers). If you do not specify a
display, the current scrolling display is expanded or contracted.

The easiest way to expand or contract a display is to use the keypad keys:
e Press KP3 repeatedly as needed to select the current scrolling display.

e Put the keypad in the EXPAND or CONTRACT state, then press KP8, KP2,
KP4, or KP6 to expand or contract the display vertically or horizontally. See
Appendix A.

The PROMPT display cannot be contracted (or expanded) horizontally. Also, it
cannot be contracted vertically to less than two lines.

7.6 Creating a New Display

To create a new screen display, use the DISPLAY command. The basic syntax is
as follows:

DISPLAY display-name [AT window-spec] [display-kind]

The display name can be any name that is not already used to name a display
(use the SHOW DISPLAY command to identify all existing displays). A newly
created display is placed on top of the pasteboard, on top of any existing displays
(except for the predefined PROMPT display, which cannot be hidden). The display
name appears at the top left corner of the display window.

Section 7.7 explains the options for specifying windows. If you do not provide a
window specification, the display is positioned in the upper or lower half of the
screen, alternating between these locations as you create new displays.

Section 7.2 explains the options for specifying display kinds. If you do not specify
a display kind, an output display is created.

For example, the following command creates a new output display named OUT2.
The window associated with OUT?2 is either the top or bottom half of the screen.

DBG> DISPLAY OUT2

The following command creates a new DO display named EXAM_XY that is
located in the right third quarter (RQ3) of the screen. This display shows the
current value of variables X and Y and is updated whenever the debugger gains
control from the program.

DBG> DISPLAY EXAM XY AT RQ3 DO (EXAMINE X,Y)

For more information, see the DISPLAY command.

7.7 Specifying a Display Window
Display windows can occupy any rectangular portion of the screen.

You can specify a display window when you create a display with the DISPLAY
command. You can also change the window currently associated with a display
by specifying a new window with the DISPLAY command. When specifying a
window, you have the following options:

e Specify a window in terms of lines and columns.
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e Use the name of a predefined window, such as H1.

e Use the name of a window definition previously established with the SET
WINDOW command.

Each of these techniques is described in the following sections. When specifying
windows, keep in mind that the PROMPT display always remains on top of the
display pasteboard and, therefore, occludes any part of another display that
shares the same region of the screen.

Display windows, regardless of how specified, are dynamic. This means that, if
you use a SET TERMINAL command to change the screen height or width, the
window associated with a display expands or contracts in proportion to the new
screen height or width.

7.7.1 Specifying a Window in Terms of Lines and Columns

The general form of a window specification is (start-line,line-count|,start-
column,column-count]). For example, the following command creates the output
display CALLS and specifies that its window be 7 lines deep starting at line 10,
and 30 columns wide starting at column 50:

DBG> DISPLAY CALLS AT (10,7,50,30)

If you do not specify start-column or column-count, the window occupies the full
width of the screen.

7.7.2 Using a Predefined Window

The debugger provides many predefined windows. These have short, symbolic
names that you can use in the DISPLAY command instead of having to specify
lines and columns. For example, the following command creates the output
display ZIP and specifies that its window be RH1 (the top right half of the
screen):

DBG> DISPLAY ZIP AT RHI

The SHOW WINDOW command identifies all predefined window definitions as
well as those you create with the SET WINDOW command.

7.7.3 Creating a New Window Definition
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The predefined windows should be adequate for most situations, but you can
also create a new window definition with the SET WINDOW command. This
command, which has the following syntax, associates a window name with a
window specification:

SET WINDOW window-name AT (start-line,line-count|[,
start-column,column-count])

After creating a window definition, you can use its name (like that of a predefined
window) in a DISPLAY command. In the following example, the window
definition MIDDLE is established. That definition is then used to display

OUT through the window MIDDLE.

DBG> SET WINDOW MIDDLE AT (9,4,30,20)
DBG> DISPLAY OUT AT MIDDLE

To identify all current window definitions, use the SHOW WINDOW command.
To delete a window definition, use the CANCEL WINDOW command.
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7.8 Sample Display Configuration

How to best use screen mode depends on your personal style and on what type of
error you are looking for. You might be satisfied to use the predefined displays. If
you have access to a larger screen, you might want to create additional displays
for various purposes. The following example gives some ideas.

Assume you are debugging in a high-level language and are interested in tracing
the execution of your program through several routine calls.

First set up the default screen configuration—that is, SRC in H1, OUT in
S45, and PROMPT in S6 (the keypad key sequence PF4 MINUS gives this
configuration). SRC shows the source code of the module in which execution is
paused.

The following command creates a source display named SRC2 in RH1 that shows
the PC value at scope 1 (one level down the call stack, at the call to the routine
in which execution is paused):

DBG> DISPLAY SRC2 AT RH1 SOURCE (EXAMINE/SOURCE .1\$%PC)

Thus the left half of your screen shows the currently executing routine and the
right half shows the caller of that routine.

The following command creates a DO display named CALLS at S4 that executes
the SHOW CALLS command each time the debugger gains control from the
program:

DBG> DISPLAY CALLS AT S4 DO (SHOW CALLS)

Because the top half of OUT is now hidden by CALLS, make OUT’s window
smaller as follows:

DBG> DISPLAY OUT AT S5
You can create a similar display configuration with instruction displays instead of
source displays.

7.9 Saving Displays and the Screen State

The SAVE command enables you to make a snapshot of an existing display and
save that copy as a new display. This is useful if, for example, you later want to
refer to the current contents of an automatically updated display (such as a DO
display).

In the following example, the SAVE command saves the current contents of
display CALLS into display CALLS4, which is created by the command:

DBG> SAVE CALLS AS CALLS4

The new display is removed from the pasteboard. To view its contents, use the
DISPLAY command:

DBG> DISPLAY CALLS4

The EXTRACT command has two uses. First, it enables you to save the contents
of a display in a text file. For example, the following command extracts the
contents of display CALLS, appending the resulting text to the file COB34.TXT:

DBG> EXTRACT/APPEND CALLS COB34
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Second, the EXTRACT/SCREEN_LAYOUT command enables you to create a
command procedure that can later be executed during a debugging session

to re-create the previous state of the screen. In the following example, the
EXTRACT/SCREEN_LAYOUT command creates a command procedure with the
default specification SYS$DISK:[IDBGSCREEN.COM. The file contains all the
commands needed to re-create the current state of the screen.

DBG> EXTRACT/SCREEN_LAYOUT

DBG> @DBGSCREEN

Note that you cannot save the PROMPT display as another display, or extract it
into a file.

7.10 Changing the Screen Height and Width
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During a debugging session, you can change the height or width of your terminal
screen. One reason might be to accommodate long lines that would wrap if
displayed across 80 columns. Or, if you are at a workstation, you might want to
reformat your debugger window relative to other windows.

To change the screen height or width, use the SET TERMINAL command.
The general effect of the command is the same whether you are at a VT-series
terminal or at a workstation.

In this example, assume you are using a workstation window in its default
emulated VT100-screen mode, with a screen size of 24 lines by 80 columns.
You have started the debugger and are using it in screen mode. You now want
to take advantage of the larger screen. The following command increases the
screen height and width of the debugger window to 35 lines and 110 columns
respectively:

DBG> SET TERMINAL/PAGE:35/WIDTH:110

By default, all displays are dynamic. A dynamic display automatically adjusts
its window dimensions in proportion when a SET TERMINAL command
changes the screen height or width. This means that, when using the SET
TERMINAL command, you preserve the relative positions of your displays. The
/INOIDYNAMIC qualifier on the DISPLAY command lets you control whether
or not a display is dynamic. If a display is not dynamic, it does not change

its window coordinates after you enter a SET TERMINAL command (you can
then use the DISPLAY, MOVE, or EXPAND commands, or various keypad key
combinations, to move or resize a display).

To see the current terminal width and height being used by the debugger, use the
SHOW TERMINAL command.

Note that the debugger’s SET TERMINAL command does not affect the terminal
screen size at DCL level. When you exit the debugger, the original screen size is
maintained.
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7.11 Screen-Related Built-In Symbols

The following built-in symbols are available for specifying displays and screen
parameters in language expressions:

e  %SOURCE_SCOPE—To display source code. %SOURCE_SCOPE is described
in Section 7.4.1.

e  %INST _SCOPE—To display instructions. %INST_SCOPE is described in
Section 7.4.4.

e  %PAGE, %WIDTH—To specify the current screen height and width.

e  %CURDISP, %CURSCROLL, %NEXTDISP, %NEXTINST, %NEXTOUTPUT,
%NEXTSCROLL, 2NEXTSOURCE—To specify displays in the display list.

7.11.1 Screen Height and Width

The built-in symbols %PAGE and %WIDTH return, respectively, the current
height and width of the terminal screen. These symbols can be used in various
expressions, such as for window specifications. For example, the following
command defines a window named MIDDLE that occupies a region around the
middle of the screen:

DBG> SET WINDOW MIDDLE AT (%PAGE/4,%PAGE/2,%WIDTH/4,%WIDTH/2)

7.11.2 Display Built-In Symbols

Each time you refer to a specific display with a DISPLAY command, the display
list is updated and reordered, if necessary. The most recently referenced display
is put at the tail of the display list, because that display is pasted last on the
pasteboard (you can identify the display list by entering a SHOW DISPLAY
command).

You can use display built-in symbols to specify displays relative to their positions
in the display list. These symbols, listed as follows, enable you to refer to
displays by their relative positions in the list instead of by their explicit names.
The symbols are used mainly in keypad key definitions or command procedures.

Display symbols treat the display list as a circular list. Therefore, you can enter
commands that use display symbols to cycle through the display list until you
reach the display you want.

%CURDISP The current display. This is the display most recently referenced
with a DISPLAY command—the least occluded display.
%CURSCROLL The current scrolling display. This is the default display for the

SCROLL, MOVE, and EXPAND commands, as well as for the
associated keypad keys (KP2, KP4, KP6, and KP8).

%NEXTDISP The next display in the list after the current display. The next
display is the display that follows the topmost display. Because
the display list is circular, this is the display at the bottom of the
pasteboard—the most occluded display.

%NEXTINST The next instruction display in the display list after the current
instruction display. The current instruction display is the display
that receives the output from the EXAMINE/INSTRUCTION
commands.
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%2NEXTOUTPUT The next output display in the display list after the current output
display. An output display receives debugger output that is not
already directed to another display.

%NEXTSCROLL The next display in the display list after the current scrolling
display.

%NEXTSOURCE The next source display in the display list after the current source
display. The current source display is the display that receives the
output from the TYPE and EXAMINE/SOURCE commands.

7.12 Screen Dimensions and Predefined Windows

On a VT-series terminal, the screen consists of 24 lines by 80 or 132 columns. On
a workstation, the screen is larger in both height and width. The debugger can
accommodate screen sizes up to 100 lines by 255 columns.

The debugger has many predefined windows that you can use to position
displays on the screen. In addition to the full height and width of the screen, the
predefined windows include all possible regions that result from:

e Dividing the screen vertically into equal fractions: halves, thirds, quarters,
sixths, or eighths

e Combining vertically contiguous equal fractions: halves, thirds, quarters,
sixths, or eighths

¢ Dividing the vertical fractions into left and right halves
The SHOW WINDOW command identifies all predefined display windows.

The following conventions apply to the names of predefined windows. The
prefixes L and R denote left and right windows, respectively. Other letters denote
the full screen (F'S) or fractions of the screen height (H: half, T: third, Q: quarter,
S: sixth, E: eighth). The trailing numbers denote specific segments of the screen
height, starting from the top. For example:

e  Windows T1, T2, and T3 occupy the top, middle, and bottom thirds of the
screen, respectively.

e  Window RH2 occupies the right bottom half of the screen.
e  Window LQ23 occupies the left middle two quarters of the screen.
e  Window S45 occupies the fourth and fifth sixths of the screen.

The following four commands create displays that have windows identical in size
and location (the top half of the screen):

DBG> DISPLAY XYZ AT H1 SOURCE
DBG> DISPLAY XYZ AT Q12 SOURCE
DBG> DISPLAY XYZ AT S123 SOURCE
DBG> DISPLAY XYZ AT E1234 SOURCE

The horizontal boundaries (start-column, column-count) of the predefined
windows for the default terminal screen width of 80 columns are as follows:

e Left-hand windows: (1,40)
e Right-hand windows: (42,39)

7-26



Screen Mode

7.12 Screen Dimensions and Predefined Windows

Table 7-3 lists the vertical boundaries (start-line, line-count) of single-segment
display windows predefined for the default terminal screen height of 24 lines.
Table 7-3 does not list windows that consist of multiple segments such as E23 (a
display window created from the combination of display windows E2 and E3).

Table 7-3 Predefined Windows

Window Name Start-line,Line-count Window Location
FS (1,23) Full screen

H1 (1,1D) Top half

H2 (13,11) Bottom half
T1 1,7 Top third

T2 9,7 Middle third
T3 17,7 Bottom third
Q1 (1,5) Top quarter
Q2 (7,5) Second quarter
Q3 (13,5) Third quarter
Q4 (19,5) Bottom quarter
S1 (1,3) Top sixth

S2 (5,3) Second sixth
S3 (9,3) Third sixth

S4 (13,3) Fourth sixth
S5 17,3) Fifth sixth

S6 (21,3) Bottom sixth
E1l (1,2) Top eighth

E2 (4,2) Second eighth
E3 (7,2) Third eighth
E4 (10,2) Fourth eighth
E5 (13,2) Fifth eighth
E6 (16,2) Sixth eighth
E7 (19,2) Seventh eighth
E8 (22,2) Bottom eighth

7.13 Internationalization of Screen Mode

You can enable country-specific features for screen mode by defining logical

names, as follows:

e DBG$SMGSHR — For specifying the Screen Management (SMG) shareable
image. The debugger uses the SMG shareable image in its implementation of
screen mode. Asian variants of the SMG shareable image handle multibyte
characters. Hence, if an Asian variant of SMG is used by the debugger, the
screen mode interface to the debugger will be able to display and manipulate

multibyte characters.

Define the DBG$SMGSHR logical name as follows:

$ DEFINE/JOB DBGSSMGSHR <name of Asian_ SMG>
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where <name_of _Asian_SMG> varies according to the variants of Asian
OpenVMS. For example, the name of the Asian SMG in Japanese OpenVMS
is JSY$SMGSHR.EXE.

SMG$DEFAULT_CHARACTER_SET — For the Asian SMG and multibyte
characters. This logical need only be defined if DBG$SMGSHR has been
defined. See the documentation on Asian or Japanese screen management
routines for details on how to define this logical name.
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DECwindows Motif Interface

This part describes the HP DECwindows Motif for OpenVMS user interface of the
debugger.

For information about the debugger’s command interface, see Part II.
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Introduction

This chapter introduces the HP DECwindows Motif for OpenVMS user interface
of the debugger. For information about the command interface, see Part II.

Note

The HP DECwindows Motif for OpenVMS user interface to the OpenVMS
Debugger Version 7.1 or later requires Version 1.2 or later of HP
DECwindows Motif for OpenVMS.

This chapter provides the following information:

e A functional overview of the OpenVMS Debugger, including its user interface
options—HP DECwindows Motif for OpenVMS and command (Section 8.1)

e An orientation to the debugger’s HP DECwindows Motif for OpenVMS screen
features, such as windows, menus, and so on (Section 8.2)

e Instructions for entering debugger commands at the command-entry prompt
(Section 8.3)

e Instructions for accessing online help (Section 8.4)

For information about starting a debugging session, see Chapter 9. For detailed
information about using the Motif interface for debugging, see Chapter 10. For
the source code of program EIGHTQUEENS.EXE, shown in the figures of this
chapter, see Appendix D.

8.1 Introduction

The OpenVMS Debugger has a HP DECwindows Motif for OpenVMS graphical
user interface (GUI) for workstations. This enhancement to the screen-mode
command interface accepts mouse input to choose items from menus and to
activate or deactivate push buttons, to drag the pointer to select text in windows,
and so on. The debugger’s HP DECwindows Motif for OpenVMS GUI menus and
push buttons provide the functions for most basic debugging tasks.

The HP DECwindows Motif for OpenVMS GUI is layered on the character-cell
command interface and has a command-entry prompt on the command line
(in the command view). From the HP DECwindows Motif for OpenVMS GUI
command line, you can enter debugger commands for the following purposes:

e To perform certain operations by using the HP DECwindows Motif for
OpenVMS user interface menus and push buttons for certain operations

e To do debugging tasks not available through the HP DECwindows Motif for
OpenVMS GUI menus and push buttons
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You can customize the HP DECwindows Motif for OpenVMS GUI to associate
other debugger commands with new or existing push buttons.

You can run the HP DECwindows Motif for OpenVMS GUI in local mode or in
client/server mode. Client/server mode allows you to debug programs remotely
from another OpenVMS node. The user interface in both Motif modes is virtually
identical. Chapter 9 describes how to start interfaces.

Notes

The HP DECwindows Motif for OpenVMS GUI does not recognize the
HELP command at its command-entry prompt. Choose the On Commands
item in the Help menu for online help on debugger commands.

You cannot use the HP DECwindows Motif for OpenVMS GUI to debug
detached processes such as print symbionts that run without a command
line interpreter (CLI). See Section 1.11 for details about debugging
detached processes that do not have a CLI.

8.1.1 Convenience Features

The following paragraphs highlight some of the convenience features of the
debugger’s default HP DECwindows Motif for OpenVMS interface. Section 8.2
gives visual details. (Convenience features of the debugger’s command interface
are described in detail in Section 1.1.2.)

Source-Code Display

The OpenVMS Debugger is a source-level debugger. The debugger displays in
the source view the source code that surrounds the instruction where program
execution is paused currently. You can enable and disable the display of compiler-
generated line numbers.

A source browser lets you:

e List the images, modules, and routines of your program

e Display source code from selected modules or routines

¢ Display the underlying hierarchy of modules and routines
e Set breakpoints by double-clicking on selected routines

Call-Stack Navigation

The call-stack menu on the main window lists the sequence of routine calls
currently on the call stack. Click on a routine name in the call-stack menu to set
(to that routine) the context (scope) for

e Source code display (in the source view)
e Register display (in the register view)
e Instruction display (in the instruction view)

e  Symbol searches
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Breakpoints

You set, activate, and deactivate breakpoints by clicking on buttons next to the
source lines in the source view or the instruction view. Optionally, you can set,
deactivate, or activate breakpoints by selecting items in window pull-down menus,
pop-up menus, context-sensitive menus, or dialog boxes. You can set conditional
breakpoints, which suspend program execution if the specified condition is true.
You can set action breakpoints, which execute one or more debugger commands
when the breakpoint suspends program execution. The main window push
buttons, the instruction view push buttons, and the breakpoint view give a
visual indication of activated, deactivated, and conditional breakpoints.

Push Buttons

Push buttons in the push button view control common operations: by clicking
on a push button, you can start execution, step to the next source line, display
the value of a variable selected in a window, interrupt execution, and so on.

You can modify, add, remove, and resequence push buttons and the associated
debugger commands.

Context-Sensitive Pop-Up Menus

Context-sensitive pop-up menus list common operations associated with your
view (source view, command view, and so on.) When you click MB3, the pop-up
menu lists actions for the text you have selected, the source line at which you are
pointing, or the view in which you are working.

Displaying and Manipulating Data

To display the value of a variable or expression, select the variable or expression
in the source view and click on a push button, such as Examine (examine
variable). You can also display selected values by choosing items from window
pull-down menus (such as Examine, in the Commands pull-down menu), context-
sensitive menus, or dialog boxes. You can display values in different type or radix
formats.

To change the value of a variable, edit the currently displayed value in the
monitor view. You can also change values by selecting items in window pull-
down menus (such as Deposit, in the Commands pull-down menu), context-
sensitive pop-up menus, or dialog boxes.

The monitor view displays the updated values of specified variables whenever the
debugger regains control from your program.

Kept Debugger RERUN Command

You can run the debugger in a state known as the kept debugger from which
you can rerun the same program or run another program without exiting the
debugger. When rerunning a program, you can choose to save the current state
of breakpoints, tracepoints, and static watchpoints. The kept debugger is also
available in the screen mode debugger. See Section 9.1 for information on starting
the kept debugger.

Client/Server Configuration

You can run the debugger in a client/server configuration, which allows you to
debug programs that run on an OpenVMS node remotely from another OpenVMS
node using the HP DECwindows Motif for OpenVMS interface, or from a PC
using the Microsoft Windows interface. Up to 31 debug clients can simultaneously
access the same debug server, which allows many debugging options.
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Instruction and Register Views

The instruction view shows the decoded instruction stream (the code that

is actually executing) of your program. This view is useful if the program you
are debugging has been optimized by the compiler, in which case the source
code in the source view may not reflect the code that is executing. You can set
breakpoints on instructions and display the memory addresses and source-code
line numbers associated with each instruction.

The register view displays the current contents of all machine registers. You
can edit the displayed values to deposit other values into the registers.

Debugger Status Indicator

The debugger has a status indicator to identify the state of the debugger, which
can be one of the following:

e D-—the program being debugged is running
e U—the Debugger is executing a user command

Threads Program Support
The threads view displays information about the current state of all tasks of a

multithread program. You can modify threads characteristics to control thread
execution, priority, state transitions, and so on.

Integration with Command Interface

The debugger’s HP DECwindows Motif for OpenVMS GUI is an enhancement
to the character-cell debugger. It is layered on, and closely integrated with, the
command-driven character-cell debugger:

e  When you use the HP DECwindows Motif for OpenVMS GUI menus and push
buttons, the debugger echoes your commands in the command view to provide
a record of your actions.

e  When you enter commands at the prompt, the debugger updates the HP
DECwindows Motif for OpenVMS views accordingly.

Integration with Source-Level Editor

You can edit program source code without exiting from the debugger. In the editor
view, you can display the source code, search and replace text, or add additional
text. Editor view text buffers allow you to move quickly back and forth between
new or existing files, and copy, cut, and paste text from buffer to buffer.

The text editor available through the debugger’s HP DECwindows Motif for
OpenVMS menu interface is a simple convenience feature, not intended to replace
sophisticated text editors such as the Language-Sensitive Editor (LSE). To use a
different editor, enter the Edit command at the DBG> prompt in the command
view (see the EDIT command).

Customization

You can modify the following and other aspects of the debugger’s HP DECwindows
Motif for OpenVMS interface and save the current settings in a resource file to
customize your debugger startup environment:

e Configuration of windows and views (for example, size, screen location, order)

e  Push button order, labels, and associated debugger commands (this includes
adding and removing push buttons)

e Character fonts for displayed text
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Online Help

Online help is available for the debugger’s HP DECwindows Motif for OpenVMS
interface (context-sensitive help) and for its command interface.

8.2 Debugger Windows and Menus

The following sections describe the debugger windows, menus, views, and other
features of the OpenVMS Debugger HP DECwindows Motif for OpenVMS
interface.

8.2.1 Default Window Configuration

By default, the debugger starts up in the main window, as shown in Figure 8-1.

When you start the debugger as explained in Section 9.1, the source view is
initially empty. Figure 8-1 shows the source view after a program has been
brought under debugger control (by directing the debugger to run a specific
image, in this example, EIGHTQUEENS).

You can customize the startup configuration to your preference as described in
Section 10.10.1.

Figure 8-1 Debugger Main Window

28 OpenVMS Debugha - process 1 - QUEENSB\EIGHTQUEENS D EIEE-]

File Edit Break Commands Options Help

H

| s | program eightqueens( output) ;
2

3 | var

4 i:integer;

B a : array[1..8] of boolean ;
B b : array[2..16] of boolean ;
7 ¢ : array[-7..7] of boolean ;
8 # : arrayl1..8] of integer ;

9 safe : boolean ; k: integer;
1

1

1

1

1

1

1

1

procedure print ;

begin {* print %)
for k := 1 to 8 do

18 write{ x[k1: 2} ;

writeln ;

20| end ; (* print ¥)

NONAWN=O

0 0ooo
z

22| procedure trycoll j : integer ) ;

var
25 i:integer;

0 27 | procedure setqueen ;

EI 3

@ P call Stack: | 0 : EIGHTQUEENS — |
.Smleonltud Examine stspl Step—lnl Step—RstuTI @ Go I

‘%DEBUG—I-VERSION: Expected VMSDEBUG.DAT version: 72
Use OPTIONS SAVE or RESTORE to update your file.

[

9 | {I—

OpenVMS 164 Debug64 Version V8.3-014

%DEBUG—I-INITIAL, L PASCAL, sdule: EIGHTQUEENS
DBG>

8.2.2 Main Window

The main window (see Figure 8-1) includes:
e Title bar (see Section 8.2.2.1)
e Source view (see Section 8.2.2.2)

e (Call Stack view (see Section 8.2.2.4)
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e  Push button view (see Section 8.2.2.5)
e (Command view (see Section 8.2.2.6)

If the debugger is running on an Alpha or Integrity server processor, the name of
the debugger is "OpenVMS Debug64."

8.2.2.1 Title Bar
The title bar, at the top of the main window, displays (by default) the name of the
debugger, the name of the program being debugged, and the name of the source
code module that is currently displayed in the source view.

8.2.2.2 Source View
The source view shows the following:

e Source code of the program you are debugging and, by default, the compiler-
generated line numbers (to the left of the source code). To choose not to
display line numbers, see Section 10.1.

e Breakpoint toggle push buttons.

e (Current-location pointer (a triangle to the left of breakpoint push buttons),
which points to the line of source code that will be executed when program
execution resumes.

For more information about displaying source code, see Section 8.2.2.3 and
Section 10.1.

8.2.2.3 Menus on Main Window
Figure 8-2 and Table 8-1 describe the menus on the main window.

Figure 8—-2 Menus on Main Window

&8 OpenVMS Debugbs (ol E e
| File Edit Break Commands Options Help
File Edit Commands Help

Run Image... Cut Examine... On Context

Run Foreign Command... Copy Deposit... On Window

Rerun Same... Paste Edit File On Help

On Yersion

Browse Sources Ll | Pom— On Commands
¥ Display Line Numbers all

Server Cennentinn.,

Exit Debug?

Break Options|

On Exception Views...
“ Show Message Separators
Activate All Customize Buttons...
Deactivate All Save Options
Cancel all Restore Default Options
Edit Options File
Set...
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Table 8-1 Menus on Main Window

Menu ltem Description
File Run Image... Bring a program under debugger control by specifying
an executable image.
Run Foreign Bring a program under debugger control by specifying
Command... a symbol for a foreign command.
Rerun Same... Rerun the same program under debugger control.
Browse Sources Display the source code in any module of your program.
Set breakpoints on routines.
e  Symbolic—List only those modules for which the
debugger has symbolic information.
e All—List all modules.
Display Line Display or hide line numbers in the source view.
Numbers
Server (Client/Server mode) Specify the network binding
Connection... string of the server for connection.
Exit Debug? End the debugging session, terminating the debugger.
Edit Cut Cut selected text and copy it to the clipboard. You can
cut text only from fields or regions that accept input
(although, in most cases, Cut copies the selected text to
the clipboard).
Copy Copy selected text from the window to the clipboard
without deleting the text.
Paste Paste text from the clipboard to a text-entry field or
region.
Break On Exception Break on any exception signaled during program
execution.
Activate All Activate any previously set breakpoints.
Deactivate All Deactivate any previously set breakpoints.
Cancel All Remove all breakpoints from the debugger’s breakpoint
list and from the breakpoint view.
Set... Set a new breakpoint, optionally associated with a
particular condition or action, at a specified location.
Commands Examine... Examine the current value of a variable or expression.
The output value may be typecast or changed in radix.
Deposit... Deposit a value to a variable. The input value may be
changed in radix.
Edit File Edit the source code of your file in the debugger’s
editor.
Options Views... Display one or more of the following:

Breakpoint view

Monitor view

Instruction view

Tasking view

Register view (see Table 8-2)

(continued on next page)
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Table 8-1 (Cont.) Menus on Main Window

Menu ltem Description

Track Language Notify you if the debugger enters a module that is

Changes written in a language different from the previously
executed module.

Show Message Display a dotted line between each command and

Separators message displayed by the debugger.

Customize Modify, add, remove, or resequence a push button in

Buttons... the push button view and the associated debugger
command.

Save Options Save the current settings of all HP DECwindows Motif
for OpenVMS features of the debugger that you can
customize interactively, such as the configuration of
windows and views, and push button definitions. This
preserves the current debugger configuration for the
next time you run the debugger.

Restore Default Copy the system default debugger resource file

Options DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT
to the user-specific resource file DECW$USER_
DEFAULTS:VMSDEBUG.DAT. The default options
take effect when you next start the debugger.

Edit Options File Load and display the user-specific resource file
DECW$USER_DEFAULTS:VMSDEBUG.DAT in the
debug editor for review and modification.

Help On Context Enable the display of context-sensitive online help.

On Window Display information about the debugger.

On Help Display information about the online help system.

On Version

On Commands

Display information about this version of the debugger.

Display information about debugger commands.

Table 8-2 Displays in Register View

Register Type Alpha Displays Integrity Server Displays

Call Frame RO, R25, R26, PC, CFM, BSP, BSPSTORE, PFS, RP,
R27, FP, SP, UNAT, GP, SP, TP, Al
Fo, F1, PC, PS,
FPCR, SFPCR

General Purpose RO-R28, FP, SP, PC, GP, R2-R11, SP, TP, R14-R24, Al,
R31 R26-R127

Floating Point FO-F31 F2 - F127

8.2.2.4 Call Stack Menu

The Call Stack menu, between the source view and the push button view, shows
the name of the routine whose source code is displayed in the source view. This
menu lists the sequence of routine calls currently on the stack and lets you set

the scope of source code display and symbol searches to any routine on the stack
(see Section 10.6.2).
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Figure 8-3 and Table 8-3 describe the default push buttons in the main window.
You can modify, add, remove, and resequence buttons and their associated
commands as explained in Section 10.10.3.

Figure 8-3 Default Buttons in the Push Button View

Stop

M:m]wﬂ:smp~nomrnl O_Gﬂ

Table 8—-3 Default Buttons in the Push Button View

Button

Description

Stop

Go
STEP

S/in

S/ret
S/call
EX

E/az

E/ac

EVAL

MON

Interrupt program execution or a debugger operation without ending the
debugging session.

Start or resume execution from the current program location.

Execute the program one step unit of execution. By default, this is one
executable line of source code.

When execution is suspended at a routine call statement, move execution
into the called routine just past the start of the routine. This is the same
behavior as STEP if not at a routine call statement.

Execute the program directly to the end of the current routine.
Execute the program directly to the next Call or Return instruction.

Display, in the command view, the current value of a variable whose name
you have selected in a window.

Display, in the command view, the current value of a variable whose
name you have selected in a window. The variable is interpreted as a
zero-terminated ASCII string.

Display, in the command view, the current value of a variable whose name
you have selected in a window. The variable is interpreted as a counted
ASCII string preceded by a one-byte count field that contains the length of
the string.

Display, in the command view, the value of a language expression in the
current language (by default, the language of the module containing the
main program).

Display, in the monitor view, a variable name that you have selected in a
window and the current value of that variable. Whenever the debugger
regains control from your program, it automatically checks the value and
updates the displayed value accordingly.

8.2.2.6 Command View

The command view, located directly under the push button view in the main

window, accepts typed command input on the command line (see Section 8.3),
and displays debugger output other than that displayed in the optional views.
Examples of such output are:

¢ The result of an Examine operation.

e Diagnostic messages. For online help on debugger diagnostic messages, see
Section 8.4.4.
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e Command echo. The debugger translates your HP DECwindows Motif for
OpenVMS menu and push button input into debugger commands and displays
those commands on the command line in the command view, providing a
record of your most recent commands. This enables you to correlate your
input with debugger actions.

You can clear the entire command view, leaving only the current command-line
prompt, by choosing Clear Command Window from the pop-up menu.

You can clear the current command line by choosing Clear Command Line from
the pop-up menu.

8.2.3 Optional Views Window

8-10

Table 8—4 lists the optional views. They are accessible by choosing Views... from
the Options menu on the main window.

Table 8-4 Optional Views

View Description

Breakpoint view  List all breakpoints that are currently set and identify those which
are activated, deactivated, or qualified as conditional breakpoints. The
breakpoint view also allows you to modify the state of each breakpoint.

Monitor view List variables whose values you want to monitor as your program
executes. The debugger updates the values whenever it regains control
from your program (for example, after a step or at a breakpoint).
Alternatively, you can set a watchpoint, causing execution to stop
whenever a particular variable has been modified. You can also change
the values of variables.

Instruction view  Display the decoded instruction stream of your program and allow you
to set breakpoints on instructions. By default, the debugger displays
the corresponding memory addresses and source-code line numbers to
the left of the instructions. You can choose to suppress these.

Register view Display the current contents of all machine registers. The debugger
updates the values whenever it regains control from your program. The
register view also lets you change the values in registers.

Tasking view List all the existing (nonterminated) tasks of a tasking program.
Provides information about each task and allows you to modify the
state of each task.

Figure 8-5 shows a possible configuration of the breakpoint view, monitor view,
and register view, as a result of the selections in the View menu in Figure 8—4.

Figure 8-6 shows the instruction view, which is a separate window so that you
can position it where most convenient. Figure 8-7 shows the tasking view.

Note that the registers and instructions displayed are system-specific. Figure 8-5
and Figure 8-6 show Integrity server-specific registers and instructions.

You can move and resize all windows. You can also save a particular configuration
of the windows and views so that it is set up automatically when you restart the
debugger (see Section 10.10.1).



Introduction
8.2 Debugger Windows and Menus

Note

If you are debugging a Ul application and you have many debugger
windows overlapping the user program’s windows, the X server will
occasionally abruptly terminate the user program.

To avoid this problem, refrain from overlapping or covering windows
belonging to the user program.

Figure 8-4 Debugger Main Window and the Optional Views Window

File Edit Break Commands Options Help
26
) 27| procedure setqueen ;
28 A = |
29| begin (* setqueen *) § Debug: VIEWS e
= 30 alil ;= false ;
o 31 bli + il := false ; I Breakpoints
0 32 cli — jl := false ;
) 33| end; (* setqueen *) I Monitors
34 J Instructions
) 35| procedure removequeen ;
36 ) Threads
begin (* removequeen *)
- g: agm bl b a9 I Registers
39 bli + true ; < call Frame
o 40 cli — jl:=true ;
1 a1 | end ; (* removequeen *) “ General Purpose
42 A . N
43| begin ¢ trycol *} “ Floating Point
(== as) 1:- Il:'
repea e ]
O :g ip::i+1 T oK | Help I
i 0 a7 safe := alil and bl + jl and cli - j1;
i o ag if safe then
49 begin
" J 50 setqueen ;
0 51 x[{d:=i;
0O s2 if j < 8 then

=
call stack: | 0: TRvcoL — |
—

%DEBUG—I-INITIAL, L PASCAL, dule: EIGHTQUEENS B
DBG> set break trycol

DEG> set break setqueen

DBG> set break removequeen

DEG> go

break at routine EIGHTQUEENS\EIGHTQUEENS\TRYCOL
DEG> monitor a

DBG>

L | B |
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Figure 8-5 Monitor, Breakpoint, and Register Views
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Figure 8-7 Thread View

Thread-id State Hold Pri Substate Thread—object
2070875584 RUN NO 24 main threa
2 susp NO 24 Timed Cond Wait UNKNOWN
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Figure 8-8 Menus on Optional Views Window

Open¥MS Debug32 -

File Ereak Monitor Register Tasks Options Help
File | Monitor | Tasks | Help |
Close Expand int ahart On Context
Exit Debug? Collapse long Antivate On Window

Hald On Help
Break | Deposit... quad | - -
— - b short Hohold On Version
On Exception Toggle Watchpoint s
s chars sake Yisible On Commands

Typecast =3
Activate All - )
= Change Radix =3 1 all b= | | Abort All Tasks
Deactivate All . hex = -
= Change All Radix  [> Nohold All Tasks
Cancel all octal Options |

Remove binary Vi
Toggle — dosimal Views...
- ecimal
Set/Modify... - O Track Language Changes
cancel Register h_l O Show Message Separators

Change Radix =3 ex Customize Buttons...

Change All Radix [ octal Save Options

binar -
¥ Restore Default Options
decimal -
- Edit Options File

8.2.3.1 Menus on Optional Views Window
Figure 8-8 and Table 8-5 describe the menus on the optional views window.
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Table 8-5 Menus on Optional Views Window

Menu Item Description
File Close Close the optional views window.
Exit Debug? End the debugging session, terminating the debugger.
Break On Exception Break on any exception signaled during program
execution.

Activate All Activate any previously set breakpoints.

Deactivate All Deactivate any previously set breakpoints.

Cancel All Remove all breakpoints from the debugger’s breakpoint
list and from the breakpoint view.

Toggle Toggle a breakpoint.

Set/Modify... Set a new breakpoint, optionally associated with a
particular condition or action, at a specified location.

Cancel Cancel (delete) an individual breakpoint.

Monitor Expand Expand monitor view output to include the values
of component parts of a selected item as well as the
aggregate value.

Collapse Collapse the monitor view output to show only the
aggregate value of a selected item, instead of the values of
each component part.

Deposit... Change the value of a monitored element.

Toggle Toggle a selected watchpoint.

Watchpoint

Typecast Use the submenu to typecast output for a selected variable
to int, long, quad, short, or char*.

Change Radix Use the submenu to change the output radix for a selected
variable to hex, octal, binary, or decimal.

Change All Radix  Use the submenu to change the output radix for all
subsequent monitored elements to hex, octal, binary, or
decimal.

Remove Remove an element from the monitor view.

Register Change Radix Use the submenu to change radix for selected register to
hex, octal, binary, or decimal.

Change All Radix  Use the submenu to change radix for all registers to hex,
octal, binary, or decimal.

Tasks Abort Request that the selected task be terminated at the next
allowed opportunity.

Activate Make the selected task the active task.

Hold Place the selected task on hold.

Nohold Release the selected task from hold.

Make Visible Make the selected task the visible task.

All Use the submenu to abort all tasks or release all tasks

from hold.

(continued on next page)
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Table 8-5 (Cont.) Menus on Optional Views Window

Menu

Item

Description

Options

Help

Views...

Customize
Buttons...

Save Options

Restore Default
Options

Edit Options File

On Context
On Window
On Help

On Version

On Commands

Display one or more of the following:

Breakpoint view
Monitor view
Instruction view
Tasking view
Register view

Modify, add, remove, or resequence a push button in the
push button view and the associated debugger command.

Save the current settings of all HP DECwindows Motif for
OpenVMS features of the debugger that you can customize
interactively, such as the configuration of windows and
views, and push button definitions. This preserves your
current debugger configuration for the next time you run
the debugger.

Copy the system default debugger resource file
DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT

to the user-specific resource file DECW$USER_
DEFAULTS:VMSDEBUG.DAT. The default options take
effect when you next start the debugger.

Load and display the user-specific resource file
DECWS$USER_DEFAULTS:VMSDEBUG.DAT in the
debug editor for review and modification.

Enable the display of context-sensitive online help.
Display information about the debugger.

Display information about the online help system.
Display information about this version of the debugger.

Display information about debugger commands.

8.3 Entering Commands at the Prompt

The debugger’s HP DECwindows Motif for OpenVMS GUI is layered on the
command interface. The command line, the last line in the command view
and identified by the command-entry prompt (DBG>), lets you enter debugger
commands for the following purposes:

¢ As an alternative to using the HP DECwindows Motif for OpenVMS GUI
menus and push buttons for certain operations

e To do debugging tasks not available through the HP DECwindows Motif for
OpenVMS GUI pull-down menus and push buttons

Figure 8-9 shows the RUN command in the command view.
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Commands at the Prompt
Figure 8-9 Entering Commands at the Prompt

ool

OpenVMS VAX Debug Version and Bammer

DBG> rum elghtqueens
Language: G, Module: EIGHT(QUEENS

Type GO to reach MAIN program
No source line for address: 0000C4E7
DBG>

[ |:>|I

When you use the HP DECwindows Motif for OpenVMS interface pull-down
menus and push buttons, the debugger translates your input into debugger
commands and echoes these commands on the command line so that you have a
record of your commands. Echoed commands are visually indistinguishable from
commands that you enter explicitly on the command line.

For information about the debugger’s command interface, see Part II. For online
help about the commands, see Section 8.4.3.

In addition to entering debugger commands interactively at the prompt, you can
also place them in debugger initialization files and command files for execution
within the HP DECwindows Motif for OpenVMS environment.

You can also take advantage of the keypad support available at the command-
entry prompt. (This support is a subset of the more extensive keypad support
provided for the command interface, which is described in Appendix A.) The
commands in Table 8-6 are mapped to individual keys on your computer
keypad.

Table 8-6 Keypad Definitions in the HP DECwindows Motif for OpenVMS
Debugger Interface

Command Corresponding Key
Step/Line KPO

Step/Into GOLD-KPO
Step/Over BLUE-KPO
Examine KP1

Examine” GOLD-KP1

Go KP,

Show Calls KP5

Show Calls 3 GOLD-KP5

To enter one of these commands, press the key or keys indicated, followed by the
Enter key on the keypad. (The GOLD key is PF1; the BLUE key is PF4.)

For information on changing these key bindings, or binding commands to
unassigned keys on the keypad, see Section 10.10.4.4.
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8.3.1 Debugger Commands That Are Not Available in the HP DECwindows

Motif for OpenVMS Interface

Table 8-7 lists the debugger commands that are disabled in the debugger’s HP
DECwindows Motif for OpenVMS interface. Many of them are relevant only to

the debugger’s screen mode.

Table 8—7 Debugger Commands Not Available in the HP DECwindows Motif for
OpenVMS User Interface

ATTACH SELECT

CANCEL MODE (SET,SHOW) ABORT_KEY
CANCEL WINDOW (SET,SHOW) KEY
DEFINE/KEY (SET,SHOW) MARGINS
DELETE/KEY SET MODE [NOJKEYPAD
DISPLAY SET MODE [NOJSCREEN
EXAMINE/SOURCE SET MODE [NOJSCROLL
EXPAND SET OUTPUT [NOJTERMINAL
EXTRACT (SET,SHOW) TERMINAL
HELP! (SET,SHOW) WINDOW
MOVE (SET,CANCEL) DISPLAY
SAVE SHOW SELECT

SCROLL SPAWN

1Help on commands is available from the Help menu in a debugger window.

The debugger issues an error message if you enter any of these commands on
the command line, or if the debugger encounters one of these commands while
executing a command procedure.

8.4 Displaying Online Help About the Debugger

The following types of online help about the debugger and debugging are
available during a debugging session:

e Context-sensitive help—information about an area or object in a window or

dialog box

e Task-oriented help—consists of an introductory help topic named Overview of
the Debugger and several subtopics on specific debugging tasks

e Help on debugger commands and various topics, such as language support

e Help on debugger diagnostic messages

Task-oriented topics related to context-sensitive topics are connected through the
list of additional topics in the help windows.

8-17



Introduction

8.4 Displaying Online Help About the Debugger

8.4.1 Displaying Context-Sensitive Help

Context-sensitive help is information about an area or object in a window or a
dialog box.

To display context-sensitive help:

1. Choose On Context from the Help menu in a debugger window. The pointer
shape changes to a question mark (?).

2. Place the question mark on an object or area in a debugger window or dialog
box.

3. Click MB1. Help for that area or object is displayed in a Help window.
Additional topics provide task-oriented discussions, where applicable.

To display context-sensitive help for a dialog box, you can also click on the Help
button in the dialog box.

Notes

Chapter 12, which is organized by task, explains how to use the
debugger’s Heap Analyzer.

You cannot obtain true context-sensitive help about any push button other
than Stop. This is because all other buttons can be modified or removed.

8.4.2 Displaying the Overview Help Topic and Subtopic

The Overview help topic (Overview of the Debugger) and its subtopics provide
task-oriented information about the debugger and debugging.

To display the Overview topic, use either of these techniques:
¢ Choose On Window from the Help menu in a debugger window.
e Choose Go To Overview from the View menu of a debugger help window.

To display information about a particular topic, choose it from the list of
additional topics.

8.4.3 Displaying Help on Debugger Commands

To display help on debugger commands:
1. Choose On Commands from the Help menu of a debugger window.

2. Choose the command name or other topic (for example, Language_Support)
from the list of additional topics.

Note that the Help command is not available through the command line interface
in the command view.

8.4.4 Displaying Help on Debugger Diagnostic Messages

8-18

Debugger diagnostic messages are displayed in the command view. To display
help on a particular message:

1. Choose On Commands from the Help menu of a debugger window.
2. Choose Messages from the list of additional topics.

3. Choose the message identifier from the list of additional topics.
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Starting and Ending a Debugging Session

This chapter explains how to:

Start the debugger (Section 9.1)

Continue when your program completes execution (Section 9.2)

Rerun the same program from the current debugging session (Section 9.3)
Run another program from the current debugging session (Section 9.4)
Interrupt program execution and debugger operations (Section 9.6)

End a debugging session (Section 9.7)

Start the debugger in additional ways for specific purposes (Section 9.8)

Debug a program already running in a subprocess or detached process
(Section 9.5)

9.1 Starting the Kept Debugger

This section explains the most common way to start the debugger from DCL level
($) and bring your program under debugger control. Section 9.8 explains optional
ways to start the debugger.

Starting the kept debugger as explained here enables you to use the Connect (see
Section 9.5), Rerun (see Section 9.3), and Run (see Section 9.4) features.

To start the debugger and bring your program under debugger control:

1.

Verify that you have compiled and linked the program as explained in
Section 1.2.

Enter the following command line:
$ DEBUG/KEEP

By default, the debugger starts up as shown in Figure 9-1. The main window
remains empty until you bring a program under debugger control (Step 4).
Upon startup, the debugger executes any user-defined initialization file (see
Section 13.2).

Bring your program under debugger control using one of the following three
techniques:

e Ifthe program is already running in a subprocess or detached process, use
the CONNECT command to bring the program under debugger control.
See Section 9.5.
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Figure 9-1 Debugger at Startup

Open¥MS Debug32

File Edit Break Commands Options

>

COMPALL

OpenVMS VAX Debug Version and Banner

Call Stack: | =] |

Run a specified image (this is the most common technique):

1. Choose Run Image... from the File menu on the main window. The
Run Image dialog lists the executable images in your current directory
(see Figure 9-2).

2. Click on the name of the image to be debugged. The Image: field
displays the image name.

3. If applicable, enter arguments to be passed to the program in the
Arguments: field. If you specify a quoted string, you might have to
add quotation marks because the debugger strips quotation marks
when parsing the string.

4. Click on OK.

Run an image by specifying a DCL command or a symbol for a foreign

command:

1. Choose Run Foreign Command... from the File menu on the main

window. The Run Foreign Command dialog is displayed (see
Figure 9-3).

Enter the symbol in the Foreign Command: field (such a symbol can
provide a shortcut around the directory and file selection process).
The foreign command X1, shown in Figure 9-3, has been previously
defined:

$X1 :== RUN MYDISK:[MYDIR.MYSUBDIR]EIGHTQUEENS.EXE

Enter any arguments to be passed with the command in the
Arguments: field.
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Figure 9-2 Running a Program by Specifying an Image
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4. Click on OK.



Starting and Ending a Debugging Session
9.1 Starting the Kept Debugger

9-4

Once the debugger has control of the program, the debugger:

e Displays the program’s source code in the main window, as shown in
Figure 9-4.

e Suspends execution at the start of the main program. The current-location
pointer to the left of the source code shows which line of code will be executed
next.

Figure 9-4 Source Display at Startup

BEE

File Edit Break Commands Options ﬂelpl

& OpenVYMS Debug64 - process 1 - EIGHTQUEENS\EIGHTQUEENS

| —

| '
] 1.3
a " call Stack: 0 :LIBSINITIALIZE
—
.Stupl O Go | STEPI s/intul sfrecl s/calll EX E.o’azI E.n’al:I E\-"ALI MONl
—
DEG> RUN EIGHTQUEENS.EXE n
%DEBUG—I-INITIAL, Language: C, Module: EIGHTQUEENS
%DEBUG—I-NOTATMAIN, Type GO to reach MAIN program
DEG>
-]

The message displayed in the command view indicates that this debugging
session is initialized for a C program and that the name of the source module is
EIGHTQUEENS.

With certain programs, the debugger sets a temporary breakpoint to suspend
program execution at the start of some initialization code, before the main
program, and displays the following message:

Type GO to reach MAIN program
No source line for address: nnnnnnnn

With some of these programs (for example, Ada programs), the breakpoint
enables you to debug the initialization code using full symbolic information.

The initialization sets up language-dependent debugger parameters. These
parameters control the way the debugger parses names and expressions, formats
debugger output, and so on.

You can now debug your program as explained in Chapter 10.
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Note the following restrictions about running a program under debugger control:

¢  You cannot use the procedure in this section to connect the debugger to a
running program (see Section 9.8.2).

¢ To run a program under debugger control over a network link, you must use
the debugger client/server interface. See Section 9.9 for more information.

If you try to run a program that does not exist, or misspell the name of a program
that does exist, the following error messages are displayed in the DECterm
window, rather than in the command view:

$DCL-W-ACTIMAGE, error activating image
-CLI-E-IMAGEFNF, image file not found

9.2 When Your Program Completes Execution

When your program completes execution normally during a debugging session,
the debugger issues the following message:

'Normal successful completion’
You then have the following options:

¢  You can rerun your program from the same debugging session (see
Section 9.3).

¢ You can run another program from the same debugging session (see
Section 9.4).

¢  You can end the debugging session (see Section 9.7).

9.3 Rerunning the Same Program from the Current Debugging
Session

When running the kept debugger (see Section 9.1), you can rerun the program
currently under debugger control at any time during a debugging session.

To rerun the program:

1. Choose Rerun Same... from the File menu on the main window. The Rerun
dialog is displayed (see Figure 9-5).

2. Enter any arguments to be passed to the program, if required, in the
Arguments: field. If you specify a quoted string, you might have to add
quotation marks because the debugger strips quotation marks when parsing
the string.

3. Choose whether or not to keep the current state of any breakpoints,
tracepoints, or static watchpoints that you previously set, activated, or
deactivated (see Section 10.4 and Section 10.5.5). Nonstatic watchpoints
might or might not be saved, depending on the scope of the variable being
watched relative to the main program unit (where execution restarts).

4. Click on OK.
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Figure 9-5 Rerunning the Same Program
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When you rerun a program, it is in the same initial state as a program that is
brought under debugger control as explained in Section 9.1, except for any saved
breakpoints, tracepoints, or static watchpoints. The source display and current
location pointer are updated accordingly.

Exit Debug?

When you rerun a program, the debugger uses the same version of the image
that is currently under debugger control. To debug a different version of that
program (or a different program) from the same debugging session, choose Run
Image... or Run Foreign Command.. from the File menu on the main window
(see Section 9.1).

9.4 Running Another Program from the Current Debugging Session

You can bring another program under debugger control at any time during a
debugging session, if you started the debugger as explained in Section 9.1. Follow
the procedure in that section for bringing a program under debugger control (also
note the restrictions about using that procedure).

9.5 Debugging an Already Running Program
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This section describes how to debug a program that is already running in a
subprocess or in a detached process. Perform the following steps:

1. Start the Kept debugger configuration using the DCL command:
$ DEBUG/KEEP

2. At the DBG> prompt, use the CONNECT command to interrupt the program
and bring it under debug control. CONNECT can be used to attach to
a program running in a subprocess or attach to a program running in a
detached process. Detached processes must meet both of the following
requirements:

e The detached process UIC must be in the same group as your process

e The detached process must have a CLI mapped

The second requirement effectively means that the program must have been
started with a command similar to this:

$ RUN/DETACH/INPUT=xxx.com SYS$SYSTEM:LOGINOUT

where xxx.com is a command procedure that starts the program with
/NODEBUG.
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Once you have connected to the program, the rest of the debugging session is
the same as a normal debugger session.

3. When you have finished debugging the program, do either of the following:

e Use the DISCONNECT command to release debugger control of the
program. The program continues execution.

e Exit the debugger. The program will terminate.

9.6 Interrupting Program Execution and Aborting Debugger
Operations

To interrupt program execution during a debugging session, click on the Stop
button on the push button view (see Figure 8-3). This is useful if, for example,
the program is in an infinite loop.

To abort a debugger operation in progress, click on Stop. This is useful if, for
example, the debugger is displaying a long stream of data.

Clicking on Stop does not end the debugging session. Clicking on Stop has no
effect when the program is not running or when the debugger is not executing a
command.

9.7 Ending a Debugging Session

To end a debugging session and terminate the debugger, choose Exit Debugger
from the File menu on the main window, or enter EXIT at the prompt (to avoid
confirmation dialogue). This returns control to system level.

To rerun your program from the current debugging session, see Section 9.3.

To run another program from the current debugging session, see Section 9.4.

9.8 Additional Options for Starting the Debugger

In addition to the startup procedure described in Section 9.1, the following
options are available for starting the debugger from DCL level ($):

e Start the debugger by running the program to be debugged with the DCL
command RUN (see Section 9.8.1).

e Interrupt a running program by pressing Ctrl/Y and then start the debugger
using the DCL command DEBUG (see Section 9.8.2).

e Override the debugger’s default (HP DECwindows Motif for OpenVMS user
interface (see Section 9.8.3) to achieve the following:

— Display the HP DECwindows Motif for OpenVMS user interface on
another workstation

— Display the command interface in a DECterm window along with any
program input/output (I/0)

— Display the command interface and program I/O in separate DECterm
windows

In all cases, before starting the debugger, verify that you have compiled and
linked the modules of your program (as explained in Section 1.2).
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9.8.1 Starting the Debugger by Running a Program

You can start the debugger and also bring your program under debugger control
in one step by entering the DCL command RUN filespec (assuming the program
was compiled and linked with the /DEBUG qualifier).

However, you cannot then use the Rerun or Run features explained in Section 9.3
and Section 9.4, respectively. To rerun the same program or run a new program
under debugger control, you must first exit the debugger and start it again.

To start the debugger by running a program, enter the DCL command
RUN filespec to start the debugger. For example:

$ RUN EIGHTQUEENS

By default, the debugger starts up as shown in Figure 9—4, executing any user-
defined initialization file and displaying the program’s source code in the main
window. The current-location pointer shows that execution is paused at the start
of the main program. The debugger sets the language-dependent parameters to
the source language of the main program unit.

For more information about debugger startup, see Section 9.1.
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9.8.2 Starting the Debugger After Interrupting a Running Program

You can bring a program that is executing freely under debugger control. This is
useful if you suspect that the program might be in an infinite loop or if you see
erroneous output.

To bring your program under debugger control:

1. Enter the DCL command RUN/NODEBUG filespec to execute the program
without debugger control.

2. Press Ctrl/Y to interrupt the executing program. Control passes to the DCL
command interpreter.

3. Enter the DCL command DEBUG to start the debugger.
For example:

$ RUN/NODEBUG EIGHTQUEENS

Interrupt

$ DEBUG
[starts debugger]

At startup, the debugger displays the main window and executes any user-defined
initialization file, and sets the language-dependent parameters to the source
language of the module in which execution was interrupted.

To help you determine where execution was interrupted:
1. Look at the main window.
2. Enter the SET MODULES/CALLS command at the command-entry prompt.

3. Display the Call Stack menu on that window to identify the sequence of
routine calls on the call stack. The routine at level 0 is the routine in which
execution is currently paused (see Section 10.3.1).

When you start the debugger in this manner, you cannot then use the Rerun or
Run features explained in Section 9.3 and Section 9.4, respectively. To rerun the
same program or run a new program under debugger control, you must first exit
the debugger and start it again.

For more information about debugger startup, see Section 9.1.

9.8.3 Overriding the Debugger’s Default Interface

By default, if your workstation is running HP DECwindows Motif for OpenVMS,
the debugger starts up in the HP DECwindows Motif for OpenVMS user interface,
which is displayed on the workstation specified by the HP DECwindows Motif for
OpenVMS applicationwide logical name DECW$DISPLAY.

This section explains how to override the debugger’s default DECwindows Motif
user interface to achieve the following:

e Display the debugger’s HP DECwindows Motif for OpenVMS user interface
on another workstation

e Display the debugger’s command interface in a DECterm window along with
any program I/O
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e Display the debugger’s command interface and program I/O in separate
DECterm windows

The logical name DBG$DECWS$DISPLAY enables you to override the
default interface of the debugger. In most cases, there is no need to define
DBG$DECW$DISPLAY because the default is appropriate.

Section 9.8.3.4 provides more information about the logical names
DBG$DECW$DISPLAY and DECW$DISPLAY.

9.8.3.1 Displaying the Debugger’s HP DECwindows Motif for OpenVMS User Interface on

Another Workstation

If you are debugging a HP DECwindows Motif for OpenVMS application that
uses most of the screen (or if you are debugging pop-ups in a Motif application),
you might find it useful to run the program on one workstation and display the
debugger’s HP DECwindows Motif for OpenVMS user interface on another. To do
so:

1. Enter a logical definition with the following syntax in the DECterm window
from which you plan to run the program:

DEFINE/JOB DBG$DECWSDISPLAY workstation pathname

The path name for the workstation where the debugger’s HP DECwindows
Motif for OpenVMS user interface is to be displayed is workstation_pathname.
See the description of the SET DISPLAY command in the OpenVMS DCL
Dictionary for the syntax of this path name.

It is recommended that you use a job definition. If you use a process
definition, it must not have the CONFINE attribute.

2. Run the program from that DECterm window. The debugger’s HP
DECwindows Motif for OpenVMS user interface is now displayed on the
workstation specified by DBG$DECWS$DISPLAY. The application’s windowing
interface is displayed on the workstation where it is normally displayed.

3. Use client/server mode (see Section 9.9.2).

9.8.3.2 Displaying the Debugger’s Command User Interface in a DECterm Window
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To display the debugger’s command interface in a DECterm window, along with
any program I/O:

1. Enter the following definition in the DECterm window from which you plan
to start the debugger:

$ DEFINE/JOB DBGSDECWSDISPLAY " "

You can specify one or more spaces between the quotation marks. You should
use a job definition for the logical name. If you use a process definition, it
must not have the CONFINE attribute.

2. Start the debugger from that DECterm window (see Section 9.1). The
debugger’s command interface is displayed in the same window.

For example:

$ DEFINE/JOB DBGS$DECWSDISPLAY " "
$ DEBUG/KEEP

Debugger Banner and Version Number

DBG>
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You can now bring your program under debugger control as explained in
Section 9.1.

9.8.3.3 Displaying the Command Interface and Program Input/Output in Separate DECterm
Windows
This section describes how to display the debugger’s command interface in a
DECterm window other than the DECterm window in which you start the
debugger. This separate window is useful when using the command interface to
debug a screen-oriented program as follows:

e The program’s input/output (I/0) is displayed in the window from which you
start the debugger.

e The debugger’s I/O, including any screen-mode display, is displayed in the
separate window.

The effect is the same as entering the SET MODE SEPARATE command at the
DBG> prompt on a workstation running VWS rather than HP DECwindows Motif
for OpenVMS. (The SET MODE SEPARATE command is not valid when used in
a DECterm window.)

The following example shows how to display the debugger’s command interface in
a separate debugger window titled Debugger.

1. Create the command procedure SEPARATE_WINDOW.COM shown in
Example 9-1.

Example 9-1 Command Procedure SEPARATE_WINDOW.COM

! Simulates effect of SET MODE SEPARATE from a DECterm window
!
CREATE/TERMINAL/NOPROCESS -
/WINDOW_ATTRIBUTES=(TITLE="Debugqer“,—
ICON_NAME="Debugger" ,ROWS=40)-
/DEFINE LOGICAL=(TABLE=LNM$JOB,DBGS$INPUT,DBGSOUTPUT)

< U >

$ ALLOCATE DBGS$OUTPUT

$ EXIT

$ !

$ ! The command CREATE/TERMINAL/NOPROCESS creates a DECterm

$ ! window without a process.

$ !

$ ! The /WINDOW ATTRIBUTES qualifier specifies the window's

§ ! title (Debugger), icon name (Debugger), and the number

$ | of rows in the window (40).

$ !

$ ! The /DEFINE_LOGICAL qualifier assigns the logical names

$ | DBGSINPUT and DBGSOUTPUT to the window, so that it becomes
$ ! the debugger input and output device.

$ !

$ ! The command ALLOCATE DBGSOUTPUT causes the separate window
$ ! to remain open when you end the debugging session.

o

Execute the command procedure as follows:

$ @SEPARATE_ WINDOW
$DCL-I-ALLOC, _MYNODE$TWAS: allocated

A new DECterm window is created with the attributes specified in
SEPARATE_WINDOW.COM.

3. Follow the steps in Section 9.8.3.2 to display the debugger’s command
interface. The interface is displayed in the new window.
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4. You can now enter debugger commands in the debugger window. Program I/O
is displayed in the DECterm window from which you started the debugger.

5. When you end the debugging session with the EXIT command, control returns
to the DCL prompt in the program I/O window but the debugger window
remains open.

6. To display the debugger’s command interface in the same window as the
program’s I/O (as in Section 9.8.3.2), enter the following commands:

$ DEASSIGN/JOB DBGSINPUT
$ DEASSIGN/JOB DBGSOUTPUT

The debugger window remains open until you close it explicitly.

9.8.3.4 Explanation of DBGSDECWS$DISPLAY and DECWS$DISPLAY
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By default, if your workstation is running HP DECwindows Motif for OpenVMS,
the debugger starts up in the HP DECwindows Motif for OpenVMS user interface,
which is displayed on the workstation specified by the HP DECwindows Motif for
OpenVMS applicationwide logical name DECW$DISPLAY. DECW$DISPLAY is
defined in the job table by FileView or DECterm and points to the display device
for the workstation.

For information about DECW$DISPLAY, see the description of the DCL
commands SET DISPLAY and SHOW DISPLAY in the OpenVMS DCL Dictionary.

The logical name DBG$DECWS$DISPLAY is the debugger-specific equivalent

of DECW$DISPLAY. DBG$DECWS$DISPLAY is similar to the debugger-specific
logical names DBG$INPUT and DBG$OUTPUT. These logical names enable you
to reassign SYS$INPUT and SYS$OUTPUT, respectively, to specify the device on
which debugger input and output are to appear.

The default user interface of the debugger results when DBG$DECW$DISPLAY
is undefined or has the same translation as DECW$DISPLAY. By default,
DBG$DECW$DISPLAY is undefined.

The algorithm that the debugger follows when using the logical definitions of
DECW$DISPLAY and DBG$DECW$DISPLAY is as follows:

1. If the logical name DBG$DECW$DISPLAY is defined, then use it. Otherwise,
use the logical name DECW$DISPLAY.

2. Translate the logical name. If its value is not null (if the string contains
characters other than spaces), the HP DECwindows Motif for OpenVMS user
interface is displayed on the specified workstation. If the value is null Gf
the string consists only of spaces), the command interface is displayed in the
DECterm window.

To enable the OpenVMS Debugger to start up in the HP DECwindows Motif for
OpenVMS user interface, first enter one of the following DCL commands:

SDEFINE DBGSDECWSDISPLAY "WSNAME::0"
$SET DISPLAY/CREATE/NODE=WSNAME

where WSNAME is the nodename of your workstation.



Starting and Ending a Debugging Session
9.9 Starting the Motif Debug Client

9.9 Starting the Motif Debug Client

The OpenVMS Debugger Version 7.2 features a client/server interface that allows
you to debug programs running on OpenVMS on a VAX or Alpha CPU from a
client interface running on the same or separate system.

The debugger client/server retains the functionality of the kept debugger, but
splits the debugger into two components: the debug server and the debug client.
The debug server runs on an OpenVMS system, and is just like the kept debugger
without the user interface. The debug client contains the user interface, and runs
on an OpenVMS system using HP DECwindows Motif for OpenVMS, or on a PC
running Microsoft Windows 95 or Microsoft Windows NT.

9.9.1 Software Requirements
The debug server requires OpenVMS Version 7.2 or later.
The debug client can run on any of the following:

e OpenVMS Version 7.2 or later, along with HP DECwindows Motif for
OpenVMS Version 1.2-4

e  Microsoft Windows 95
e  Microsoft Windows NT Version 3.51 or later (Intel or Alpha)

The OpenVMS Debugger client/server configuration also requires that the
following be installed on the OpenVMS node running the server:

e A TCP/IP stack
e DCE RPC

Notes

If you are running TCP/IP Services for OpenVMS (UCX) Version 4.1, you
must have ECO2 installed. You can also run a later version of UCX.

The OpenVMS Version 7.2 installation procedures automatically install
DCE RPC.

9.9.2 Starting the Server

You can start the debug server after logging in directly to the OpenVMS system,
or you may find it more convenient to log in remotely with a product such as
eXcursion, or an emulator such as Telnet.

To start the debug server, enter the following command:
$ DEBUG/SERVER

The server displays its network binding strings. The server port number is
enclosed in square brackets ([]1). For example:
$ DEBUG/SERVER

$DEBUG-I-SPEAK: TCP/IP: YES, DECnet: YES, UDP: YES

$DEBUG-I-WATCH: Network Binding: ncacn ip tcp:16.32.16.138[1034]
$DEBUG-I-WATCH: Network Binding: ncacn_dnet nsp:19.10[RPC224002690001]
$DEBUG-I-WATCH: Network Binding: ncadg ip udp:16.32.16.138[1045]
$DEBUG-I-AWAIT: Ready for client connection...
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$ debug/server

Use one of the network binding strings to identify this server when you connect
from the client (see Section 9.9.4). The following table matches the network
binding string prefix with its associated network transport:

Network Transport Network Binding String Prefix
TCP/TP ncacn_ip_tcp
DECnet ncacn_dnet_nsp
UDP ncadg_ip_udp
Notes

You can usually identify the server using only the node name and the port
number. For example, nodnam[1034].

Messages and program output appear by default in the window in which
you start the server. You can redirect program output to another window
as required.

The following example contains an error message that indicates that DCE is not
installed:

$LIB-E-ACTIMAGE, error activating image disk:[SYSn.SYSCOMMON.][SYSLIB]DTSSS$SHR.EXE;
-RMS-E-FNF, file not found

This indicates that DCE is installed but not configured.

9.9.3 Primary Clients and Secondary Clients

The debugger client/server interface allows more than one client to be connected
to the same server. This allows team debugging, classroom sessions, and other
applications.

The primary client is the first client to connect to the server. A secondary client
is an additional client that has connected to the same server. The primary client
controls whether or not any secondary clients can connect to the server.

Section 9.9.4 describes how to specify the number of secondary clients allowed in
a session.

9.9.4 Starting the Motif Client
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A session is the connection between a particular client and a particular server.
Each session is identified within the client by the network binding string the
client used to connect to the server. Once the debug server is running, start the
Motif debug client. To do so, enter the following command:

$ DEBUG/CLIENT

To establish a session from the Motif debug client, click on Server Connection
from the File menu. The Server Connection dialog displays, in the Connection
list, the default network binding string. This string is based on the last string
you entered, or the node on which the client is running. There is not necessarily
a server associated with the default binding string. Figure 9-6 shows the Server
Connection dialog.
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Figure 9-6 Debug Server Connection Dialog

Server Connection - I

Connection [locall: |_§_ncacn_ip_tcp:16.32.16.141[10?4]

Username  llogink |

Password: |

Active Sessions: |

Session Status: INACTIVE SESSION
Image: NO ACTIVE IMAGE
Platform: UNDEFINED
Clients: 0

Connect Time: 00:00:00
——Client Controls ———————Server Controls

IConnectI I%Z)%fxxmz%z{.‘%:l I'?'é?S?I IS%{);}I IOptionsI IHeIpI ICanceh

From the buttons at the bottom of the Server Connection dialog, you can
e Connect to the selected server to begin and activate a new session

¢ Disconnect from a session

e Test whether the session is still available

e Stop the server

e (Cancel the connection operation and dismiss the dialog

In addition, the Options button invokes the Server Options dialog, which allows
you to select the network transport to be used (see Section 11.5.1).

The Server Options dialog also allows you to select the number of secondary
clients (0-31) allowed for a new session.

Figure 9-7 shows the Server Options dialog.

Figure 9-7 Server Options Dialog

Server Options

Use Network Protocol:

< Ter/IP O DEChet > uDP

Allow Secondary Clients:

To connect the client to a server, perform the following steps:

1. Open the File menu.

2. Click Server Connection.
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3. Enter the server network binding string in the Connection field, or select the
default string.

4. Click Options.

In the Server Options dialog, click on the network transport: TCP/IP, DECnet,
or UDP.

6. In the Server Options dialog. select the number of secondary clients (0-31) to
be allowed.

7. Click OK to dismiss the Server Options dialog.
8. In the Server Connection dialog, click Connect.

You can establish connections to an unlimited number of servers by repeating the
sequence above and specifying the new network binding string each time.

9.9.5 Switching Between Sessions
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Each time you connect to a server and initiate a session, the session is listed in
the Active Sessions list in the Server Connection dialog (see Figure 9-8). You can
switch back and forth between sessions. Each time you switch to a new session,
the debugger updates the contents of any open debugger displays with the new
context.

To switch to a different session, perform the following steps:

1. Open the File menu.

2. Click Server Connection.

3. Click the Active Sessions list to display the list of active sessions.
4

Double click the required session in the Active Sessions list. This selects the
session as the current session, dismisses the Server Connection dialog, and
updates the debugger displays with the current context.

Note that you cannot change the number of secondary clients allowed on a session
while that session is active. To change the number of clients allowed on a session,
you must be the primary client, and perform the following steps:

1. Open the File menu.

2. Specify the network binding string of the session.
3. Click Disconnect.

4. Click Options.
5

In the Server Options dialog, click on the network transport: TCP/IP, DECnet,
or UDP.

6. In the Server Options dialog, select the number of secondary clients (0-31) to
be allowed.

7. Click OK to dismiss the Server Options dialog.

8. In the Server Connection dialog, click Connect.
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Figure 9-8 Active Sessions List

Server Connection

Connection [locall: |_§_ncacn_ip_tcp:16.32.16.138[4961]

Username llogink |é’> EBUGTSY

Password:

Active Sessions: ncacn_ip_tcp:16.32.16.25[1910]

ncacn_ip_tcp:16.32.16.138[4961]
Session Status: RIVIARY. TICACTT_TP_TCP. T6.3 2. 10, 25[1910]

Image: SQUEENS
Platform: Alpha
Clients: 2

Connect Time: wed Aug 6 10:52:40 1997
——Client Controls ———————Server Controls
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9.9.6 Closing a Client/Server Session

Click on Exit Debug? on the File menu to invoke the Confirm Exit dialog.
Figure 9-9 shows the Confirm Exit dialog.

Figure 9-9 Confirm Exit Dialog

M Exit Client
B Exit Server

Once you have invoked the Confirm Exit dialog, perform one of the following:
e To terminate both the client and the server (default) click OK.
e To dismiss the Confirm Exit dialog without taking any action, click Cancel.
e To terminate only the debug client, perform the following steps:

1. Click Exit Server.

2. Click OK.
e To terminate only the debug server, perform the following steps:

1. Click Exit Client.

2. Click OK.

If you do not terminate the debug server, you can connect to the server from
another debug client. If you do not terminate the client, you can connect to
another server for which you know the network binding string.
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Using the Debugger

This chapter explains how to:

¢ Display the source code of your program (Section 10.1)

e Edit your program under debugger control (Section 10.2)

e Execute your program under debugger control (Section 10.3)

e Suspend execution with breakpoints (Section 10.4)

e Examine and manipulate program variables (Section 10.5)

e Access program variables (Section 10.6)

e Display and modify values stored in registers (Section 10.7)

e Display the decoded instruction stream of your program (Section 10.8)
¢ Debug tasking programs (Section 10.9)

e (Customize the debugger’s HP DECwindows Motif for OpenVMS user interface
(Section 10.10)

The chapter describes window actions and window menu choices, but you can
perform most common debugger operations by choosing items from context-
sensitive pop-up menus. To access these menus, click MB3 while the mouse
pointer is in the window area.

You can also enter commands at the HP DECwindows Motif for OpenVMS
command prompt. For information about entering debugger commands, see
Section 8.3.

For the source code of programs EIGHTQUEENS.EXE and SQUEENS.EXE,
shown in the figures of this chapter, see Appendix D.

10.1 Displaying the Source Code of Your Program

The debugger displays the source code of your program in the main window (see
Figure 10-1).

Whenever execution is suspended (for example, at a breakpoint), the debugger
updates the source display by displaying the code surrounding the point at which
execution is paused. The current-location pointer, to the left of the source code,
marks which line of code will execute next. (A source line corresponds to one or
more programming-language statements, depending on the language and coding
style.)
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Figure 10-1 Source Display

OpenVMS Debug32 - EIGHTQUEENS: EIGHTQUEENS

File Edit Break Commands Options Help I
8 int x[8]: 2
: []
10 /* Solve eight-gqueens problem */
11 main{}
»0O 12 t
13 int 1;
O 14 for (i=0; i <=7; i++)
O 15 a[i] = 1;
O 16 for (i=0; i ¢=15; i++)
@ I call stack: |l] : main =3 —||

By default, the debugger displays compiler-generated line numbers to the left of
the source code. These numbers help identify breakpoints, which are listed in the
breakpoint view (see Section 10.4.4). You can choose not to display line numbers
so that more of the source code can show in the window. To hide or display line
numbers, toggle Display Line Numbers from the File menu on the main window.

The Call Stack menu, between the source view and the push button view, shows
the name of the routine whose source code is displayed.

The current-location pointer is normally filled in as shown in Figure 10-1. It
is cleared if the displayed code is not that of the routine in which execution is
paused (see Section 10.1.3 and Section 10.6.2).

You can use the scroll bars to show more of the source code. However, you can
scroll vertically through only one module of your program at a time. (A module
corresponds generally to a compilation unit. With many programming languages,
a module corresponds to the contents of a source file. With some languages, such
as Ada, a source file might contain one or more modules.)

The following sections explain how to display source code for other parts of
your program so that you can set breakpoints in various modules, and so on.
Section 10.1.3 explains what to do if the debugger cannot find source code for
display. Section 10.6.2 explains how to display the source code associated with
routines that are currently active on the call stack.

After navigating the main window, you can redisplay the location at which
execution is paused by clicking on the Call Stack menu.

If your program was optimized during compilation, the source code displayed
might not reflect the actual contents of some program locations (see Section 1.2).

10.1.1 Displaying the Source Code of Another Routine
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To display source code of another routine:
1. Choose Browse Sources from the File menu on the main window (see
Figure 10-2).

Select SYMBOLIC display the names of all modules linked in the image.
Select ALL to display the names of only those modules for which the debugger
has symbolic information.
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The Source Browser dialog box displays the name of your executable image,
which is highlighted, and the class of shareable images linked with it
(SYMBOLIC or ALL). The name of a linked image is dimmed if no symbolic
information is available for that image.

2. Double click on the name of your executable image. The names of the
modules in that image are displayed (indented) under the image name.

3. Double click on the name of the module containing the routine of interest.
The names of the routines in that module are displayed (indented) under the
module name, and the Display Source button is now highlighted.

Click on the name of the routine whose source code you want to display.

Click on the Display Source push button. The debugger displays in the source
view the source code of the target routine, along with an empty breakpoint
button to the left of the source code. If the instruction view is open, this
display is updated to show the machine code of the target routine.

Section 10.6.2 describes an alternative way to display routine source code for
routines currently active on the call stack.
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Figure 10-2 Displaying Source Code of Another Routine
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10.1.2 Displaying the Source Code of Another Module

To display source code of another module:

1.

Choose Browse Sources from the File menu on the main window.

Select SYMBOLIC display the names of all modules linked in the image.
Select ALL to display the names of only those modules for which the debugger
has symbolic information.

The Source Browser dialog box displays the name of your executable image,
which is highlighted, and the class of shareable images linked with it
(SYMBOLIC or ALL). The names of the shareable images are dimmed if no
symbolic information is available for them.

Double click on the name of your executable image. The names of the
modules in that image are displayed (indented) under the image name.

Click on the name of the module whose source code you want to display. The
Display Source button is now highlighted.

Click on Display Source. The source display in the main window now shows
the routine’s source code. (If the instruction display in the instruction view is
open, this display is updated to show the routine’s instruction code.)

10.1.3 Making Source Code Available for Display

In certain cases, the debugger cannot display source code. Possible causes are:

Execution might be paused within a module of your program that was
compiled or linked without the debug option (see Section 1.2).

Execution might be paused within a system or library routine for which

no symbolic information is intended to be available. In such cases you can
quickly return execution to the calling routine by clicking one or more times
on the S/ret button in the push button view (see Section 10.3.5).

The source file might have been moved to a different directory after it was
compiled. Section 10.1.4 explains how to tell the debugger where to look for
source files.

If the debugger cannot find source code for display, it tries to display the source
code for the next routine down on the call stack for which source code is available.
If the debugger can display source code for such a routine, the current-location
pointer is moved to point to the source line to which execution returns in the
calling routine.

10.1.4 Specifying the Location of Source Files

Information about the characteristics and the location of source files is embedded
in the debug symbol table of your program. If a source file has been moved to a
different directory since compile time, the debugger might not find the file. To
direct the debugger to your source files, use the SET SOURCE command at the
DBG> prompt (see Section 6.2).
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10.2 Editing Your Program
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The debugger provides a simple text editor you can use to edit your source files
while debugging your program (see Figure 10-3).

The text editor available through the debugger’s HP DECwindows Motif for
OpenVMS menu interface is a simple convenience feature, not intended to replace
sophisticated text editors such as the Language-Sensitive Editor (LSE). You
cannot substitute a more sophisticated editor for the text editor invoked with the
Edit File item in the Commands menu. To use a different editor, enter the EDIT
command at the DBG> prompt in the command view (see EDIT in the Command
Reference Dictionary of this manual).

Note

When you enter an EDIT command at the command prompt, the debugger
uses the DECterm window that invoked the debugging session as the
user-defined-editor window (as opposed to the debugger’s built-in editor,
which is hardwired to the COMMANDS EDIT FILE pull-down menu).
This behavior constitutes a tradeoff that allows a more flexible choice of
editors. If you inadvertently exit this DECterm window using FILE EXIT
or MWM Close, the debugging session terminates abruptly, having lost its
parent window.

Figure 10-3 Editor Window

Editor Open¥MS Debug32

File Edit Help

DISKD$:[USER.QUEENS]8QUEENS _SUB.C;2 &3 |

extern void printQ;
int x[81;

void trycol{j)
int j;

H
int m;
int safe;

m ;
while (m++ < 7)

safe = {a[m] ==1) && (blm + jl == 1) && (c[m - j + 7] ==1);
if (safe)

<]l 1| 2]

Find | | E [ rReplace with |

I

To invoke the editor, choose the Edit File item in the Commands menu on the
main window. By default, the editor opens a buffer and displays the module
currently displayed in the source view. The buffer is named with the file
specification of the file in the buffer. If no file is displayed in the source view, the
editor displays an empty text buffer, called main_buffer. The buffer name appears
in the buffer menu, which is just under the menu bar of the editor view.

| Read 966 bytes from DISKD$:[USER.QUEENS]8QUEENS_SUB.C;2
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The editor allows you to create any number of text buffers by choosing New (for
empty text buffers) or Open (for existing files) from the File menu. The name of
each text buffer appears in the buffer menu. You can cut, copy, and paste text
from buffer to buffer by choosing items from the Edit menu and selecting buffers
from the buffer menu.

You can perform forward and backward search and replace operations by entering
strings in the Find and Replace with fields and clicking on a directional arrow.
You can perform a repeated search for the string by continuing to press the
Return key. You can also continue a search by choosing the Find/Replace Next or
Find/Replace Previous items in the Edit menu.

To save the file, choose the Save or Save As... items from the File menu. If you do
not save your corrections before closing a modified buffer or exiting the debugger,
the debugger displays a warning message.

To test any changes to the source code:

1. Select a DECterm window separate from that in which the debugger is
running.

2. Recompile the program.

3. Relink the program.

4. Return to the debugging session.
5

Choose the Run Image... item in the File menu on the main window.

10.3 Executing Your Program
This section explains how to:
¢ Determine where execution is currently paused within your program
e Start or resume program execution
e Execute the program one source line at a time, step by step
For information about rerunning your program or running another program from
the current debugging session, see Section 9.3 and Section 9.4.
10.3.1 Determining Where Execution Is Currently Paused

To determine where execution is currently paused within your program:

1. If the current-location pointer is not visible in the main window, click on the
Call Stack menu of that window to display the pointer (see Figure 10-1).

2. Look at the current-location pointer:

e If the pointer is filled in, it marks the source line whose code will execute
next (see Section 10.1). The Call Stack menu always shows the routine at
scope level 0 (where execution is paused) when the pointer is filled in.

e If the pointer is cleared, the source code displayed is that of a calling
routine, and the pointer marks the source line to which execution returns
in that routine:

— If the Call Stack menu shows level 0, source code is not available
for display for the routine in which execution is paused (see
Section 10.1.3).
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— If the Call Stack menu shows a level other than 0, you are displaying
the source code for a calling routine (see Section 10.6.2).

To list the sequence of routine calls that are currently active on the call stack,
click on the Call Stack menu. Level 0 denotes the routine in which execution is
paused, level 1 denotes the calling routine, and so on.

10.3.2 Starting or Resuming Program Execution

To start program execution or resume execution from the current location, click
on the Go button in the push button view (see Figure 8-3).

Letting your program run freely without debugger intervention is useful in
situations such as the following:

e To test for an infinite loop. In this case, you start execution; then, if your
program does not terminate and you suspect that it is looping, click on the
Stop button. The main window will show where you interrupted program
execution, and the Call Stack menu will identify the sequence of routine calls
at that point (see Section 10.3.1).

e To execute your program directly to a particular location. In this case,
you first set a breakpoint at the location (see Section 10.4) and then start
execution.

Once started, program execution continues until one of the following events
oceurs:

e The program completes execution.

e A breakpoint is reached (including a conditional breakpoint whose condition
is true).

e A watchpoint is triggered.
¢ An exception is signaled.
e You click on the Stop button on the push button view.

Whenever the debugger suspends execution of the program, the main window
display is updated and the current-location pointer marks which line of code will
execute next.

10.3.3 Executing Your Program One Source Line at a Time
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To execute one source line of your program, click on the STEP button in the push
button view or enter the STEP command in the command view. This debugging
technique (called stepping) is one of the most commonly used.

After the line executes, the source view is updated and the current-location
pointer marks which line of code will execute next.

Note the following points about source lines and the stepping behavior:

e A source line can consist of one or more programming language elements
depending on the language and coding style used.

e  When you click on the STEP button, the debugger executes one executable
line and suspends execution at the start of the next executable line, skipping
over any intervening nonexecutable lines.
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e Executable lines are those for which instructions were generated by the
compiler (for example, lines with routine call or assignment statements).
Executable lines have a button to their left in the main window.

e Examples of nonexecutable lines are comment lines or lines with variable
declarations without value assignments. Nonexecutable lines do not have a
button to their left in the main window.

Keep in mind that if you optimized your code at compilation time, the source code
displayed might not reflect the code that is actually executing (see Section 1.2).

10.3.4 Stepping into a Called Routine

When program execution is paused at a routine call statement, clicking on the
STEP button typically executes the called routine in one step (depending on
the coding style used), and the debugger suspends execution at the next source
line in the calling routine (assuming no breakpoint was set within the called
routine). This enables you to step through the code quickly without having to
trace execution through any called routines (some of which might be system or
library routines). This is called stepping over called routines.

To step into a called routine so that you can execute it one line at a time:

1. Suspend execution at the routine call statement, for example, by setting a
breakpoint (see Section 10.4) and then clicking on the Go button in the push
button view.

2. When execution is paused at the call statement, click on the S/in button
in the push button view, or enter the STEP/INTO command at the DBG>
prompt. This moves execution just past the start of the called routine.

Once execution is within the called routine, click on the STEP button to execute
the routine line by line.

Clicking on the S/in button when execution is not paused at a routine call
statement is the same as clicking on the STEP button.

10.3.5 Returning from a Called Routine

When execution is suspended within a called routine, you can execute your
program directly to the end of that routine by clicking on the S/ret button in the
push button view, or enter the STEP/RETURN command at the DBG> prompt.

The debugger suspends execution just before the routine’s return instruction
executes. At that point, the routine’s call frame has not been deleted from the call
stack, so you can still get the values of variables local to that routine, and so on.

You can also use the S/call button in the push button view (or enter the
STEP/CALL command at the DBG> prompt) to execute the program directly
to the next Return or Call instruction.

The S/ret button is particularly useful if you have inadvertently stepped into a
system or library routine (see Section 10.1.3).
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10.4 Suspending Execution by Setting Breakpoints

A breakpoint is a location in your program at which you want execution to stop so
that you can check the current value of a variable, step into a routine, and so on.

When using the debugger’s HP DECwindows Motif for OpenVMS user interface,
you can set breakpoints on:

e Specific source lines
e Specific routines (functions, subprograms, and so on)

e Exceptions signaled during the execution of your program

Note

If you are stopped at a breakpoint in a routine that has control of the
mouse pointer by a PointerGrab or a KeyboardGrab, your workstation
will hang.

To work around this problem, debug your program using two
workstations. For more information, see Section 9.8.3.1.

The debugger provides two ways to qualify breakpoints:

e  You can set a conditional breakpoint. The debugger suspends execution
at a conditional breakpoint only when a specified relational expression is
evaluated as true.

¢  You can set an action breakpoint. The debugger executes one or more
specified system-specific commands when it reaches the breakpoint.

You can set a breakpoint that is both a conditional and action breakpoint.

The following sections explain these breakpoint options.

10.4.1 Setting Breakpoints on Source Lines
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You can set a breakpoint on any source line that has a button to its left in
the source display. These are the lines for which the compiler has generated
executable code (routine declarations, assignment statements, and so on).

To set a breakpoint on a source line:
1. Find the source line on which you want to set a breakpoint (see Section 10.1).

2. Click on the button to the left of that line. (The breakpoint is set when the
button is filled in.) The breakpoint is set at the start of the source line—that
is, on the first machine-code instruction associated with that line.

Figure 104 shows that a breakpoint has been set on the start of line 37.
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Figure 10-4 Setting a Breakpoint on a Source Line

Open¥MS Debug32 — EIGHTQUEENS: EIGHTQUEENS

(s}
o

Break Commands Options

v

if (safe)

m]

O 33 {

O 31 setqueenim, j);

O 35 x[J] =m + 1; N
O 36 if (j <)

= 37 trycol{j + 1);

O 38 else

O 39 print{)

2

oo loe o

DBG> examine j
EIGHTQUEENS\trycol\j: 4

DBG> SET BREAK EIGHTQUEENS\:LINE 37
DBG>

10.4.2 Setting Breakpoints on Routines with Source Browser

Setting a breakpoint on a routine enables you to move execution directly to the
routine and inspect the local environment.

To set a breakpoint on a routine:

1. Choose Browse Sources from the File menu on the main window (see
Figure 10-2).

Select SYMBOLIC to display the names of all modules linked in the image.
Select ALL to display the names of only those modules for which the debugger
has symbolic information.

The Source Browser dialog box displays the name of your executable image,
which is highlighted, and the class of shareable images linked with it
(SYMBOLIC or ALL). The name of a linked image is dimmed if no symbolic
information is available for that image.

2. Double click on the name of the executable image. The names of the modules
in that image are displayed (indented) under the image name.

3. Double click on the name of the target module. The names of the routines
in that module are displayed (indented) under the module name (see
Figure 10-5).

4. Double click on the name of the routine on which to set a breakpoint. The
debugger echoes the results of your SET BREAKPOINT command on the
command line in the command view.

Alternatively, click once on the name of the routine, then click the Set
Breakpoint button in the Source Browser view. The debugger echoes the
results of your SET BREAKPOINT command on the command line in the
command view.
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Figure 10-5 Setting a Breakpoint on a Routine
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10.4.3 Setting an Exception Breakpoint

| Display Source ” Set Ereakpoint | | Cancel |

An exception breakpoint suspends execution when an exception is signaled and
before any exception handler declared by your program executes. This enables
you to step into the exception handler (if one is available) to check the flow of

control.

To set an exception breakpoint, choose On Exception from the Break menu on the

main window or the optional views window.

10.4.4 Identifying the Currently Set Breakpoints

There are three ways to determine which breakpoints are currently set:

e Scroll through your source code and note the lines whose breakpoint button is
filled in. This method can be time consuming and also does not show which
breakpoints were set and then deactivated (see Section 10.4.5).

10-12



Using the Debugger
10.4 Suspending Execution by Setting Breakpoints

¢ Choose Views... from the Options menu on the main window or the optional
views window. When the Views dialog box appears, click on Breakpoint View
to display the breakpoint view (see Figure 8—4).

The breakpoint view lists a module name and line number for each breakpoint
(see Section 10.1). A filled-in button next to the breakpoint identification
indicates that the breakpoint is activated. A cleared button indicates that the
breakpoint is deactivated.

e Enter the SHOW BREAK command at the DBG> prompt in the command
view. The debugger lists all the breakpoints that are currently set, including
specifications for conditional breakpoints, and commands to be executed at
action breakpoints.

10.4.5 Deactivating, Activating, and Canceling Breakpoints

After a breakpoint is set, you can deactivate, activate, or delete it.

Deactivating a breakpoint causes the debugger to ignore the breakpoint during
program execution. However, the debugger keeps the breakpoint listed in the
breakpoint view so that you can activate it at a later time, for example, when you
rerun the program (see Section 9.3). Note the following points:

e To deactivate a specific breakpoint, clear the button for that breakpoint in the
main window or in the breakpoint view.

In the breakpoint view, you can also choose Toggle from the Break menu, if
the breakpoint is currently activated.

e To deactivate all breakpoints, choose Deactivate All from the Break menu.
Activating a breakpoint causes it to take effect during program execution:

e To activate a breakpoint, fill in the button for that breakpoint in the main
window or in the breakpoint view.

In the breakpoint view, you can also choose Toggle from the Break menu, if
the breakpoint is currently deactivated.

e To activate all breakpoints, choose Activate All from the Break menu.

When you cancel a breakpoint, it is no longer listed in the breakpoint view so
that later you cannot activate it from that list. You have to reset the breakpoint
as explained in Section 10.4.1 and Section 10.4.2. Note the following points:

e To cancel a specific breakpoint, choose Cancel from the Break menu on the
optional views window.

e To cancel all breakpoints, choose Cancel All from the Break menu.

10.4.6 Setting a Conditional Breakpoint

The debugger suspends execution of the program at a conditional breakpoint
only when a specified expression is evaluated as true. The debugger evaluates
the conditional expression when program execution reaches the breakpoint and
ignores the breakpoint if the expression is not true.

The following procedure sets a conditional breakpoint, whether or not a
breakpoint was previously set at that location:

1. Display the source line on which you want to set the conditional breakpoint
(see Section 10.1).
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2. Do one of the following:

e Press Ctrl/MB1 on the button to the left of the source line. This displays
the Set/Modify Breakpoint dialog box, showing the source line you selected
in the Location: field (see Figure 10-6).

¢ Choose the Set or Set/Modify item from the Break menu. When the
Set/Modify Breakpoint dialog box displays, enter the source line in the
Location: field.

3. Enter a relational expression in the Condition: field of the dialog box. The
expression must be valid in the source language. For example, a/3]/ == 0 is a
valid relational expression in the C language.

4. Click on OK. The conditional breakpoint is now set. The debugger indicates
that a breakpoint is conditional by changing the shape of the breakpoint’s
button from a square to a diamond.

Figure 10-6 Setting a Conditional Breakpoint
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The following procedure modifies a conditional breakpoint; that is, it can be used
either to change the location or condition associated with an existing conditional
breakpoint, or to change an unqualified breakpoint into a conditional breakpoint:

1. Choose Views... from the Options menu on the main window or optional
views window. When the Views dialog box appears, click on Breakpoint View
to display the breakpoint view.

2. From the breakpoint view, do one of the following:
e Press Ctrl/MB1 on the button to the left of the listed breakpoint.

e (lick on a breakpoint listed in the view, and choose the Set/Modify item
from the Break menu.

3. Follow steps 3 and 4 of the previous procedure, as appropriate.
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10.4.7 Setting an Action Breakpoint

When a program reaches an action breakpoint, the debugger suspends execution
of the program and executes a specified list of commands.

To set an action breakpoint, whether or not a breakpoint was previously set at
that location:

1. Display the source line on which you want to set the action breakpoint (see
Section 10.1).

2. Do one of the following:

e Press Ctrl/MB1 on the button to the left of the source line. This displays
the Set/Modify Breakpoint dialog box, showing the source line you selected
in the Location: field (see Figure 10-6).

e (Choose the Set or Set/Modify item from the Break menu. When the
Set/Modify Breakpoint dialog box displays, enter the source line in the
Location: field.

3. Enter one or more debugger commands in the Action: field of the dialog box.
For example: DEPOSIT x[j] = 3; STEP; EXAMINE a

4. Click on OK. The action breakpoint is now set (see Figure 10-7.)

Figure 10-7 Setting an Action Breakpoint
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DBG> go
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DBG > I

The following procedure modifies an action breakpoint; that is, it can be used
either to change the location or command associated with an existing action
breakpoint, or to change an unqualified breakpoint into an action breakpoint:

1. Choose Views... from the Options menu on the main window or optional views
window, then click on Breakpoint View when the Views dialog box appears.

2. From the breakpoint view, do one of the following:

e Press Ctrl/MB1 on the button to the left of the listed breakpoint.
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¢ C(Click on a breakpoint listed in the view, and choose the Set/Modify item
in the Break menu.

3. Follow steps 3 and 4 of the previous procedure, as appropriate.

10.5 Examining and Manipulating Variables

This section explains how to:

Select variable names from windows
Display the value of a variable
Monitor a variable

Watch a variable

Change the value of a variable

See Section 10.6, which also applies to all operations on variables.

10.5.1 Selecting Variable Names from Windows

Use the following techniques to select variable names from windows for the
operations described in the sections that follow (see Section 10.5.2 for examples).
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When selecting names, follow the syntax of the source programming language:

To specify a scalar (nonaggregate) variable, such as an integer, real, Boolean,
or enumeration type, select the variable’s name.

To specify an entire aggregate, such as an array or structure (record), select
the variable’s name.

To specify a single element of an aggregate variable, select the entity using
the language syntax. For example:

— The string arr2[7] specifies element 7 of array arr2 in the C language.

— The string employee.address specifies component address of record
(structure) employee in the Pascal language.

To specify the object designated by a pointer variable, select the entity
following the language syntax. For example, in the C language, the string
*int point specifies the object designated by pointer int point.

Select character strings from windows as follows:

In any window, to select a string delimited by blank spaces, use the standard
HP DECwindows Motif for OpenVMS word selection technique: position the
pointer on that string and then double click MB1.

In any window, to select an arbitrary character string, use the standard

HP DECwindows Motif for OpenVMS text-selection technique: position the
pointer on the first character, press and hold MB1 while dragging the pointer
over the string and then release MB1.

In the debugger source display, you also have the option of using language-
sensitive text selection. To select a string delimited by language-dependent
identifier boundaries, position the pointer on that string and press
Ctrl/MB1.
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For example, suppose the source display contains the character string
arr2[m], then:

— To select arr2, position the pointer on arr2 and press Ctrl/MBI1.

— To select m, position the pointer on m and press Ctrl/MB1.

You can change the key sequence for language-sensitive text selection as
explained in Section 10.10.4.2.

10.5.2 Displaying the Current Value of a Variable

To display the current value of a variable:

1.
2.

Find and select the variable name in a window as explained in Section 10.5.1.

Click on the EX button in the push button view. The debugger displays the
variable and its current value in the command view. The debugger displays
the value of a variable in the current scope, which might not be the same as
the source location you were intending.

Figure 10-8, Figure 10-9, and Figure 10-10 show how to display the value of an
integer variable, array aggregate, and array element, respectively.

Figure 10-8 Displaying the Value of an Integer Variable

File Edit Break Commands Options
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Call Stack: |0 : trycol 3
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DBG> go

break at EIGHTQUEENS\trycol\trycol 1\:LINE 32
DBG> examine j

EIGHTQUEENS\trycolyj: 4

DBG >

To display the current value in a different type or radix, use the following
alternative method:

1.
2.

Find and select the variable name in a window as explained in Section 10.5.1.

Choose Examine... in the Commands menu in the main window.
The Examine dialog box appears with the name selected in the
Variable/Expression field.

Choose the default, int, long, quad, short, or char* item from the Typecast
menu within the dialog box.
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Figure 10-9 Displaying the Value of an Array Aggregate
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4. Choose the default, hex, octal, decimal, or binary item from the Output Radix
menu within the dialog box.

5. Click on OK.

The value, altered to your specification, appears in the command view.

Figure 10-11 shows that the variable j has been typecast as long.
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Figure 10-11 Typecasting the Value of a Variable
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Figure 10-12 Changing the Value of a Variable
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10.5.3 Changing the Current Value of a Variable

To change the current value of a variable:

¢ Find and select the variable name in a window as explained in Section 10.5.1.

¢ Choose Deposit... from the Commands menu in the main window. The
Deposit dialog box appears with the name selected in the Variable field.

e Enter the new value in the Value field.

¢ Choose the default, hex, octal, decimal, or binary item from the Input Radix

menu within the dialog box.

e (Click on OK.

The new value, altered to your specification, appears in the command view and is

assigned to the variable.

Figure 10-12 shows a new value for the variable safe.
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10.5.4 Monitoring a Variable

When you monitor a variable, the debugger displays the value in the monitor
view and checks and updates the displayed value whenever the debugger regains
control from your program (for example, after a step or at a breakpoint).

Note

You can monitor only a variable, including an aggregate such as an array
or structure (record). You cannot monitor a composite expression or
memory address.

To monitor a variable (see Figure 10-13):
1. Find and select the variable name in a window as explained in Section 10.5.1.
2. Click on the MON button in the push button view. The debugger:

¢ Displays the monitor view (if it is not displayed)

e Puts the selected variable’s name, along with its qualifying path name, in
the Monitor Expression column

e Puts the value of the variable in the Value/Deposit column
e Puts a cleared button in the Watched column (see Section 10.5.5).

You can typecast the output value when monitoring variables by choosing the
Typecast item in the Monitor menu.

You can change the output radix when monitoring variables as follows:

¢ Choose Change Radix in the Monitor menu to change the output radix for a
selected monitored element.

e (Choose the Change All Radix in the Monitor menu to change the output radix
for all subsequently monitored elements.

To remove a monitored element from the monitor view, choose Remove from the
Monitor menu.

10.5.4.1 Monitoring an Aggregate (Array or Structure) Variable
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If you select the name of an aggregate variable, such as an array or structure
(record) and click on the MON button, the debugger displays the word Aggregate
in the Value/Deposit column of the monitor view. To display the values of all
elements (components) of an aggregate variable, double click on the variable
name in the Monitor Expression column (or choose Expand in the Monitor menu).
The displayed element names are indented relative to the parent name (see
Figure 10-14). If an element is also an aggregate, you can double click on its
name to display its elements, and so on.
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Figure 10-13 Monitoring a Variable

OpenVMS Debug32 - EIGHTQUEENS: EIGHTQUEENS

File Edit Break Commands Options

{

26 int m;

27 int BEEES;
0O 28 m=-1;
O 29 while (m++ < 7)
O 3o {
O safe = (a[m] ==1) & (b[m + j] == 1) && (c[m - j +
= if (safe)

OpenVMS Debug32 — EIGHTQUEENS: EIGHTQUEENS

File Ereak Monitor Register Tasks Options

Monitor View
Watched Monitor Expression Value/Deposit

DBG> SET BREAK EIGHIQU O EIGHTQUEENS:\trycolisafe 1044
DBG> go
break at routine EIGHTI
DBG> step
stepped to EIGHTQUEENS

DBG> monitor safe
DBG>

[ |2}

Open¥MS Debug32 - EIGHTQUEENS:

File EBreak Monitor Register Tasks Options

Monitor View
Watched Monitor Expression Value/Deposit
[ml EIGHTQUEENS\a[D:7] Aggregate
EIGHTOUEENS\a[ 0]
EIGHTOUEENS\a[1]
EIGHTOUEENS\a[ 2]
EIGHTQUEENS\a[ 3]
EIGHTOUEENS\a[ 4]
EIGHTOUEENS\a[5]
EIGHTOUEENS\a[ 6]
EIGHTOUEENS\a[ 7]

ooooooon
ﬂ.l—‘l—‘.l—‘.l—‘.|

To collapse an expanded display so that only the aggregate parent name is shown
in the monitor view, double click on the name in the Monitor Expression column
(or choose Collapse from the Monitor menu).

If you have selected a component of an aggregate variable, and the component
expression is itself a variable, the debugger monitors the component that

was active when you made the selection. For example, if you select the array
component arr[i] and the current value of i is 9, the debugger monitors arr[9]
even if the value of i subsequently changes to 10.
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10.5.4.2 Monitoring a Pointer (Access) Variable

If you select the name of a pointer (access) variable and click on the MON button,
the debugger displays the address of the referenced object in the
Value/Deposit column of the monitor view (see the top entry in Figure 10-15).

To monitor the value of the referenced object (to dereference the pointer variable),
double click on the pointer name in the Monitor Expression column. This adds
an entry for the referenced object in the monitor view, indented under the
pointer entry (see the bottom entry in Figure 10-15). If a referenced object is

an aggregate, you can double click on its name to display its elements, and so
on.

Figure 10-15 Pointer Variable and Referenced Object in Monitor View
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10.5.5 Watching a Variable
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Whenever the program changes the value of a watched variable, the debugger
suspends execution and displays the old and new values in the command view.

To watch a variable (also known as setting a watchpoint on a variable):

e Monitor the variable as explained in Section 10.5.4. The debugger puts a
button in the Watched column of the monitor view whenever you monitor a
variable. See Figure 10-16.

e (Click on the button in the Watched column. A filled-in button indicates that
the watchpoint is set.

Figure 10-16 Watched Variable in Monitor View
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To deactivate a watchpoint, clear its Watched button in the monitor view (by
clicking on the button) or choose Toggle Watchpoint in the Monitor menu. To
activate a watchpoint, fill in its Watched button or choose Toggle Watchpoint in
the Monitor menu.
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Section 10.6.1 explains static and nonstatic (automatic) variables and how to
access them. The debugger deactivates a nonstatic watchpoint when execution
moves out of (returns from) the variable’s defining routine. When a nonstatic
variable is no longer active, its entry is dimmed in the monitor view and its
Watched button is cleared.

The debugger does not automatically reactivate nonstatic watchpoints if execution
later returns to the variable’s defining routine. You must reactivate nonstatic
watchpoints explicitly.

10.5.6 Changing the Value of a Monitored Scalar Variable

To change the value of a scalar (nonaggregate) variable, such as an integer or
Boolean type (see Figure 10-17):

1. Monitor the variable as explained in Section 10.5.4.

2. Click on the variable’s value in the Value/Deposit column of the monitor view.
A small dialog box is displayed over that value, which you can now edit.

Enter the new value in the dialog box.

4. Click on the check mark (OK) in the dialog box. The dialog box is removed
and replaced by the new value, indicating that the variable now has
that value. The debugger notifies you if you try to enter a value that is
incompatible with the variable’s type, range, and so on.

Figure 10-17 Changing the Value of a Monitored Scalar Variable
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To cancel a text entry and dismiss the dialog box, click on X (Cancel).

You can change the value of only one component of an aggregate variable (such
as an array or structure) at a time. To change the value of an aggregate-variable
component (see Figure 10-18):

1. Display the value of the component as explained in Section 10.5.4.1.

2. Click on the variable’s value in the Value/Deposit column of the monitor view.
A small dialog box is displayed over that value, which you can now edit.

Enter the new value in the dialog box.

4. Click on the check mark (OK) in the dialog box. The dialog box is removed
and replaced by the new value, indicating that the variable now has
that value. The debugger notifies you if you try to enter a value that is
incompatible with the variable’s type, range, and so on.
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Figure 10-18 Changing the Value of a Component of an Aggregate Variable
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10.6 Accessing Program Variables

This section provides some general information about accessing program variables
while debugging.

If your program was optimized during compilation, you might not have access to
certain variables while debugging. When you compile a program for debugging, it
is best to disable optimization, if possible (see Section 1.2.1).

Before you check on the value of a variable, always execute the program beyond
the point where the variable is declared and initialized. The value contained in
any uninitialized variable should be considered invalid.

10.6.1 Accessing Static and Nonstatic (Automatic) Variables
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Note

The generic term nonstatic variable is used here to denote what is called
an automatic variable in some languages.

A static variable is associated with the same memory address throughout
execution of the program. You can always access a static variable.

A nonstatic variable is allocated on the stack or in a register and has a value only
when its defining routine or block is active (on the call stack). Therefore, you can
access a nonstatic variable only when program execution is paused within the
scope of its defining routine or block (which includes any routine called by the
defining routine).

A common technique for accessing a nonstatic variable is first to set a breakpoint
on the defining routine and then to execute the program to the breakpoint.

Whenever the execution of your program makes a nonstatic variable inaccessible,
the debugger notifies you as follows:

e Ifyou try to display the value of the variable or monitor the variable (as
explained in Section 10.5.2 and Section 10.5.4, respectively), the debugger
issues a message that the variable is not active or not in scope.



Using the Debugger
10.6 Accessing Program Variables

e If the variable (or an expression that includes the variable) is currently being
monitored, its entry becomes dimmed in the monitor view. When the entry
is dimmed, the debugger does not check or update the variable’s displayed
value; also, you cannot change that value as explained in Section 10.5.3. The
entry is fully displayed whenever the variable becomes accessible again.

e If the variable is currently being watched (as explained in Section 10.5.5),
the watchpoint is deactivated (its Watched button is cleared) and its entry
is dimmed in the monitor view. However, note that the watchpoint is not
reactivated automatically when the variable becomes accessible again.

10.6.2 Setting the Current Scope Relative to the Call Stack

While debugging a routine in your program, you can set the current scope to a
calling routine (a routine down the stack from the routine in which execution is
currently paused). This enables you to:

e Determine where the current routine call originated
¢ Determine the value of a variable declared in a calling routine

e Determine the value of a variable during a particular invocation of a routine
that is called recursively

e Change the value of a variable in the context of a routine call

The Call Stack menu on the main window lists the names of the routines (and,
under certain conditions, the images and modules) of your program that are
currently active on the stack, up to the maximum number of lines that can be
displayed on your screen (see Figure 10-19). The numbers on the left side of the
menu indicate the level of each routine on the stack relative to level 0, which
denotes the routine in which execution is paused.

To set the current scope to a particular routine on the stack, choose the routine’s
name from the Call Stack menu (see Figure 10-19). This causes the following to
occur:

e The Call Stack menu, when released, shows the name and relative level of
the routine that is now the current scope.

¢ The main window shows that routine’s source code.
e The instruction view (if displayed) shows that routine’s decoded instructions.

e The register view (if displayed) shows the register values associated with that
routine call.

e If the scope is set to a calling routine (a call-stack level other than 0), the
debugger clears the current-location pointer, as shown in Figure 10-19.

e The debugger sets the scope for symbol searches to the chosen routine, so that
you can examine variables, and so on, in the context of that scope.

When you set the scope to a calling routine, the current-location pointer (which
is cleared) marks the source line to which execution will return in that routine.
Depending on the source language and coding style used, this might be the line
that contains the call statement or some subsequent line.
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Figure 10-19 Current Scope Set to a Calling Routine
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10.6.3 How the Debugger Searches for Variables and Other Symbols

Symbol ambiguities can occur when a symbol (for example, a variable name X) is
defined in more than one routine or other program unit.

=

In most cases, the debugger automatically resolves symbol ambiguities. First,

it uses the scope and visibility rules of the currently set language. In addition,
because the debugger permits you to specify symbols in arbitrary modules (to set
breakpoints and so on), the debugger uses the ordering of routine calls on the call
stack to resolve symbol ambiguities.

In some cases, however, the debugger might respond as follows when you specify
a symbol that is defined multiple times:

e It might issue a "symbol not unique" message because it is not able to
determine the particular declaration of the symbol that you intended.

e It might reference the symbol declaration that is visible in the current scope,
not the one you want.

To resolve such problems, you must specify a scope where the debugger should
search for the particular declaration of the symbol:

e If the different declarations of the symbol are within routines that are
currently active on the call stack, use the Call Stack menu on the main
window to reset the current scope (see Section 10.6.2).

e Otherwise, enter the appropriate command at the command prompt
(EXAMINE or MONITOR, for example), specifying a path name prefix
with the symbol. For example, if the variable X is defined in two modules
named COUNTER and SWAP, the following command uses the path name
SWAP\ X to specify the declaration of X that is in module SWAP:
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DBG> EXAMINE SWAP\X

10.7 Displaying and Modifying Values Stored in Registers

The register view displays the current contents of all machine registers (see
Figure 10-20).

To display the register view, choose Views... from the Options menu on the main
window or the optional views window, then click on Registers when the Views
dialog box appears.

By default, the register view automatically displays the register values associated
with the routine in which execution is currently paused. Any values that change

as your program executes are highlighted whenever the debugger regains control

from your program.

To display the register values associated with any routine on the call stack, choose
its name from the Call Stack menu on the main window (see Section 10.6.2).

To change the value stored in a register:

1. Click on the register value in the register view. A small dialog box is
displayed over the current value, which you can now edit.

2. Enter the new value in the dialog box.

3. Click on the check mark (OK) in the dialog box. The debugger removes
the dialog box and displays the new value, indicating that the register now
contains that value. To dismiss the dialog box without changing the value in
the register, click on X (Cancel).

To change the radix used to display register values:

¢ Choose Change Radix in the Register menu to change the radix in current
and subsequent output for a selected register.

¢ Choose Change All Radix in the Register menu to change the radix in current
and subsequent output for all registers.

Figure 10-20 Register View
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10.8 Displaying the Decoded Instruction Stream of Your Program

The instruction view displays the decoded instruction stream of your program:
the code that is actually executing (see Figure 10—21). This is useful if the
program you are debugging has been optimized by the compiler so that the
information in the main window does not exactly reflect the code that is executing
(see Section 1.2).

Figure 10-21 Instruction View

&8 OpenVMS Debugbd (=] E
File Edit Ereak Help
J 0x20551 22: 1d4 r3 = [r3] <
J 0x20552 2 add r9 = D088, r12;; -
- 0x20560 x st4 [r9]1=r3
- W gx20561 44: add r32 = 0080, 12
J ox20562 = nop.i 000000 ;;
J ox20570 = std [r32] = r0
- 0x20571 | 3 nop.i oooooo
J 0x20572 : nop.i 000000 ;;
- 0x20580 46: add r3 = D080, ¥12 ;;
- 0x20581 X Id4 ¥3 = [¥3]
- 0x20582 | : nop.i 000000 ;;
- 0x20590 ‘ 5 add r3 = 0001, ¥3
/
ET =
|- -

To display the instruction view, choose Views... from the Options menu on the
main window or the optional views window, then click on Instructions when the
Views dialog box appears.

By default, the instruction view automatically displays the decoded instruction
stream of the routine in which execution is currently paused. The current-
location pointer, to the left of the instructions, marks the instruction that will
execute next.

By default, the debugger displays source code line numbers to the left of the
instructions with which they are associated. To hide or display line numbers,
toggle Display Line Numbers from the File menu in the instruction view.

By default, the debugger displays memory addresses to the left of the
instructions. To hide or display addresses, toggle Show Instruction Addresses
from the File menu in the instruction view.

After navigating the instruction view, click on the Call Stack menu to redisplay
the location at which execution is paused.

To display the instruction stream of any routine on the call stack, choose
the routine’s name from the Call Stack menu on the main window (see
Section 10.6.2).

10.9 Debugging Tasking (Multithread) Programs

Tasking programs, also called multithreaded programs, have multiple threads of
execution within a process and include the following:

e Programs in any language that use HP POSIX Threads Library or POSIX
1003.1b services.

e Programs that use language-specific tasking services (services provided
directly by the language). Currently, Ada is the only language with built-in
tasking services that the debugger supports.
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Within the debugger, the term task or thread denotes such a flow of control,
regardless of the language or implementation. The debugger’s tasking support
applies to all such programs.

The debugger enables you to display task information and modify task
characteristics to control task execution, priority, state transitions, and so
on.

The following sections summarize the tasking features of the debugger’s HP
DECwindows Motif for OpenVMS user interface. For more information about the
debugger’s tasking support, see Chapter 16.

10.9.1 Displaying Information About Tasks (Threads)

To display information about one or more tasks (threads) of your program, choose
Views... from the Options menu on the main window or the optional views
window, then click on Threads when the Views dialog box appears.

The Threads view gives information about all currently existing (nonterminated)
tasks of your program. The information is updated whenever the debugger
regains control from the program, as shown in Figure 10-22.

Figure 10-22 Thread View
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The displayed information includes:

e The thread ID. The arrow in the left column marks the active task; i.e., the
thread that runs when you click on the Go or STEP button.

¢ The thread priority.
e  Whether the task (thread) has been put on hold as explained in Section 10.9.2.

e The current state of the task (thread). The task in the RUN (running) state
is the active task.

e The current substate of the task (thread). The substate helps indicate the
possible cause of a task’s state.

e A debugger path name for the task (thread) object or the address of the task
object if the debugger cannot symbolize the task object.
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10.9.2 Changing Task (Threads) Characteristics

To modify a task’s (thread’s) characteristics or the tasking environment while
debugging, choose one of the following items from the Threads menu:

Threads Menu ltem Description

Abort Request that the selected task (thread) be terminated at the
next allowed opportunity. The exact effect depends on the
current event facility (language dependent). For Ada tasks,
this is equivalent to executing an abort statement.

Activate Make the selected task (thread) the active task.

Hold Place the selected task (thread) on hold.

Nohold Release the selected task (thread) from hold.

Make Visible Make the selected task the visible task (thread).

All Use the submenu to abort all tasks (threads) or release all

tasks (threads) from hold.

10.10 Customizing the Debugger’s HP DECwindows Motif for
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The debugger is installed on your system with a default debugger resource
file (DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT) that defines the startup
defaults for the following customizable parameters:

¢ Configuration of windows and views

e  Whether to show or hide line numbers in the main window

e Button names and associated debugger commands

e Key sequence to display the dialog box for conditional and action breakpoints

e Key sequence for language-sensitive text selection in the source view and
instruction view

e Character fonts for text in the views
e Character font for text displayed in specific windows and views

e Color of the text foreground and background colors in the source view,
instruction view, and editor view

e Display of program, module, and routine names in the main window title bar
e  Whether or not the debugger requires confirmation before exiting

A copy of the system default debugger resource file with explanatory comments is
included in Example 10-1 in Section 10.10.4.

You can modify the first three of these display attributes interactively from

the HP DECwindows Motif for OpenVMS user interface, as explained in

Section 10.10.1, Section 10.10.2, and Section 10.10.3. In each case, you can save
the modified display configuration for future debugging sessions by choosing Save
Options from the Options menu.

In addition, you can modify all the listed attributes of the debugger display
configuration by editing and saving the debugger resource file, as explained in
Section 10.10.4.
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When you choose Save Options from the Options menu or you edit and save

the local debugger resource file, the debugger creates a new version of the

local debugger resource file DECW$USER_DEFAULTS:VMSDEBUG.DAT that
contains the definitions of the display configuration attributes. When you next
start the debugger, it uses the attributes defined in the most recent local resource
file to configure the output display. You can fall back to previous debugger display
configurations with appropriate use of the DCL commands DELETE, RENAME,
and COPY.

To fall back to the system default display configuration, select Restore Default
Options from the OpenVMS Debugger Options menu.

10.10.1 Defining the Startup Configuration of Debugger Views

To define the startup configuration of the debugger views:
1. While using the debugger, set up your preferred configuration of views.

2. Choose Save Options from the Options menu to create a new version of the
debugger resource file.

When you next start the debugger, the debugger uses the most recent resource
file to create the new display configuration.

You can also define the startup display configuration by editing the definition of
these views in the resource file (see Section 10.10.4).
10.10.2 Displaying or Hiding Line Numbers in Source View and Instruction
View
The source view and instruction view display source line numbers by default at
debugger startup. To hide (or display) line numbers at debugger startup:

1. While using the debugger, choose Display Line Numbers from the File menu
on the main window (or the instruction view). Line numbers are displayed
when a filled-in button appears next to that menu item.

2. Choose Save Options from the Options menu to create a new version of the
debugger’s local resource file.

When you next start the debugger, the debugger uses the most recent resource
file to create the new display configuration.

You can also set the startup default for line numbers by setting the following
resources to either True or False in the resource file (see Section 10.10.4).

DebugSource.StartupShowSourceLineno: True
DebugInstruction.StartupShowInstLineno: True

10-31



Using the Debugger
10.10 Customizing the Debugger’s HP DECwindows Motif for OpenVMS Interface

10.10.3 Modifying, Adding, Removing, and Resequencing Push Buttons

The buttons on the push button view are associated with debugger commands.
You can:

e Change a button’s label or associated command
¢ Add a new button
¢ Remove a button

e Resequence a button

Note

You cannot modify or remove the Stop button.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

Section 10.10.3.1, Section 10.10.3.2, and Section 10.10.3.3 explain how to
customize push buttons interactively through the HP DECwindows Motif for
OpenVMS user interface. You can also customize push buttons by editing the
resource file. Button definitions in the resource file begin with:

DebugControl.Button
(See Example 10-1.)

10.10.3.1 Changing a Button’s Label or Associated Command
To change a button’s label or associated command:

1. Choose Customize Buttons... from the Options menu on the main window or
the optional views window. The Customize Buttons dialog box is displayed
(see Figure 10-23).

2. Within the dialog box, click on the button you are modifying. This fills the
Command and Label fields with the parameters for that button. The example
in Figure 10-23 shows that the STEP button was selected.

3. To change the button icon, pull down the Icon menu within the dialog box
and select one of the predefined icons. As Figure 10-23 shows, the Label field
dims and is filled with the debugger’s internal name for the predefined icon.
The icon itself appears in the dialog box’s push button display.

To change the button label, select None on the Icon menu and enter a new
label in the Label field.

4. To change the command associated with the button, enter the new command
in the Command field. For online help about the commands, see Section 8.4.3.

If the command is to operate on a name or language expression selected in
a window, specify %S as the command parameter. For example, the following
command displays the current value of the language expression that is
currently selected:

EVALUATE %s
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If the command is to operate on a debugger built-in symbol or any other name
that has a percent sign (%) as the first character, specify two percent signs.
For example:

EXAMINE $%%NEXTLOC

5. Click on Modify. The button’s label or associated command is changed within
the dialog box push button display.

6. Click on Apply. The button’s label or associated command is changed within
the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

Figure 10-23 Changing the STEP Button Label to an Icon
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10.10.3.2 Adding a New Button and Associated Command

To add a new button to the push button view and assign a debugger command to
that button:

1. Choose Customize Buttons... from the Options menu. The Customize Buttons
dialog box is displayed (see Figure 10—24).

2. Enter the debugger command for the new button in the Command field
(see Section 10.10.3.1). Figure 10-24 shows the debugger command
run mydisk:[mydirectory]x.exe was entered.

3. Enter a label for that button in the Label field or choose a predefined icon
from the Icon menu. Figure 10-24 shows that the Run-X label was chosen.

4. Click on Add. The button is added to the dialog box push button display.
5. Click on Apply. The button is added to the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.
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Figure 10-24 Adding a Button
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10.10.3.3 Removing a Button
To remove a button:

1. Choose Customize Buttons... from the Options menu on the main or optional
views window. The Customize Buttons dialog box is displayed.

2. Within the dialog box, click on the button you are removing. This fills the
Command and Label fields with the parameters for that button.

3. Click on Remove. The button is removed from the dialog box push button
display.

4. Click on Apply. The button is removed from the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.

10.10.3.4 Resequencing a Button
To resequence a button:

1. Choose Customize Buttons... from the Options menu on the main or optional
views window. The Customize Buttons dialog box is displayed.

2. Within the dialog box, click on the button you are resequencing. This fills the
Command and Label fields with the parameters for that button.

3. Click on the left or right arrow to move the button one position to the left or
right. Continue to click until the button has moved, one position at a time, to
its final position.

4. Click on Apply to transfer this position to the debugger’s push button view.

To save these modifications for future debugger sessions, choose Save Options
from the Options menu.
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10.10.4 Editing the Debugger Resource File

The debugger is installed on your system with a default debugger resource

file (DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT) that defines the default
display configuration for the debugger. When you modify the display attributes as
described in Section 10.10 and then save the modifications with the Save Options
command in the Options menu, the debugger creates a local debugger resource
file, DECW$USER_DEFAULTS:VMSDEBUG.DAT. You can edit this file to further
modify the debugger display configuration.

If you do not have a local debugger resource file, you can create one with
the Restore Default Options item in the Options menu. Whenever you start
the debugger, it creates the debugger display configuration as defined in

the most recent version of the local debugger resource file if there is one;
otherwise, the debugger uses the definitions in the system debugger resource
file, DECW$SYSTEM_DEFAULTS:VMSDEBUG.DAT.

You cannot edit the system resource file. You can modify the debugger

display configuration either by following the procedures in Section 10.10.1,
Section 10.10.2, and Section 10.10.3, or by editing and saving your local debugger
resource file.

Example 10-1 contains a copy of the system default debugger resource file. Most
entries are annotated within the file or are self-explanatory. Section 10.10.4.1,
Section 10.10.4.2, Section 10.10.4.3, and Section 10.10.4.4 contain additional
information about modifying certain key sequences. For complete information
about specifying key sequences, see the translation table syntax in the X Toolkit
Intrinsics documentation.

Note

The line in Example 10-1 that begins with DebugControl.ButtonList
does not completely fit in this example. This line identifies the button
definitions contained in the file. The full line in the file also contains
the following button names: StepReturnButton, StepCallButton,
ExamineButton, ExamineASCIZButton, ExamineASCICButton,
EvalButton, MonitorButton.
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Example 10-1 System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

|
! OpenVMS Debug32/64 Debugger Resource File
|

DebugVersion: 71
|
! GEOMETRY RESOURCES:

|

! Written when you execute "SAVE OPTIONS" from the Options Menu.
|

DebugSource.x: 11

DebugSource.y: 30

DebugSource.width: 620

DebugSource.height: 700

|

DebugControl.x: 650
DebugControl.y: 30
DebugControl.width: 600
DebugControl.height: 700
!

DebugEditor.x: 650
DebugEditor.y: 30
DebugEditor.width: 600
DebugEditor.height: 700
|

DebugInstruction.x: 11
DebugInstruction.y: 769
DebugInstruction.width: 620
DebugInstruction.height: 243
|

*DebugBrowser.x: 650
*DebugBrowser.y: 30
*DebugBrowser.width: 335
*DebugBrowser.height: 300

|
! LINE NUMBER DISPLAY RESOURCES:

|

! Create the line or address number display in views at startup?
|

DebugSource.StartupShowSourceLineno: True
DebugInstruction.StartupShowInstLineno: True
DebugInstruction.StartupShowInstAddrno: False

|

WINDOW PANE RESOURCES:

!
!
! Relative size of panes in main window.

! Main window height is derived from sum of panes.
!

DebugSource*SrcView.height: 460
DebugSource*PushbuttonPanel.height: 36

DebugSource*MessageOutputPanel.height: 145
!

DebugControl.BreakpointView.height: 175
DebugControl.MonitorView.height: 150

DebugControl.TaskView.height: 130
DebugControl.RegisterView.height: 250

(continued on next page)
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Example 10-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_

DEFAULTS:VMSDEBUG.DAT)

CUSTOM BUTTON RESOURCES:

The following resources determine which buttons to put in the button panel.
Buttons will show in the order they are listed here.

EXAMPLE:
ButtonCommand - Associates a command with the button.
ButtonLegend - Button Label or pixmap name if pixmap flag is True.

|
!
|
|
!
! For each button there MUST be a set of associated resources.
|
|
|
|
|

ButtonPixmapFlag - If True uses ButtonLegend as predefined pixmap name.

DebugControl
!
DebugControl

DebugControl
DebugControl
|

DebugControl
DebugControl
DebugControl
|

DebugControl
DebugControl
DebugControl
|

DebugControl
DebugControl
DebugControl
|

DebugControl
DebugControl
DebugControl
|

DebugControl
DebugControl

DebugControl.
DebugControl.
DebugControl.
|

DebugControl.
DebugControl.
DebugControl.
|

DebugControl.
DebugControl.
DebugControl.
|

DebugControl.
DebugControl.
DebugControl.

.ButtonList: \ GoButton, StepButton, StepInButton,

.ButtonCommand.GoButton: go
.ButtonLegend.GoButton: go_pixmap
.ButtonPixmapFlag.GoButton: True

.ButtonCommand.StepButton: step
.ButtonLegend.StepButton: STEP
.ButtonPixmapFlag.StepButton: False

.ButtonCommand.StepInButton: step/in
.ButtonLegend.StepInButton: S/in
.ButtonPixmapFlag.StepInButton: False

.ButtonCommand.StepReturnButton: step/return
.ButtonLegend.StepReturnButton: S/ret
.ButtonPixmapFlag.StepReturnButton: False

.ButtonCommand.StepCallButton: step/call
.ButtonLegend.StepCallButton: S/call
.ButtonPixmapFlag.StepCallButton: False

.ButtonCommand.ExamineButton: examine %s
.ButtonLegend.ExamineButton: EX
DebugControl.

ButtonPixmapFlag.ExamineButton: False

ButtonCommand.ExamineASCIZButton: examine/asciz %s
ButtonLegend.ExamineASCIZButton: E/az
ButtonPixmapFlag.ExamineASCIZButton: False

ButtonCommand.ExamineASCICButton: examine/ascic %s
ButtonLegend.ExamineASCICButton: E/ac
ButtonPixmapFlag.ExamineASCICButton: False

ButtonCommand.EvalButton: evaluate %s
ButtonLegend.EvalButton: EVAL
ButtonPixmapFlag.EvalButton: False
ButtonCommand.MonitorButton: monitor %s

ButtonLegend.MonitorButton: MON
ButtonPixmapFlag.MonitorButton: False

(continued on next page)
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Example 10-1 (Cont.) System Default Debugger Resource File (DECWS$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

!

! THE FOLLOWING RESOURCES CAN ONLY BE CHANGED BY EDITING THIS FILE.

| e e ——————

Be sure to trim off any trailing white-spaces.

FONT RESOURCES:

If a font is specified for a view, and the font is available on the
system, it will be used for that view.

For any views which do not explicitly specify a font, the font specified
by the resource "DebugDefault.Font" will be used if it is available on the
system.

If no font resources are specified at all, the debugger will use the
systems own default font specification.

The "DebugOptions.Font" applies to all optional views. We suggest that
you select a font with a point size no larger than 14 in the option views
in order to preserve label alignment.

1
|
!
|
!
|
1
|
1
|
1
|
1
|
|
!
|
|
! Using 132 column sources? Try this narrow font:

! -dec-terminal-medium-r-narrow--14-100-100-100-c-60-1s08859-1
|

1

FORMAT:  -*-FONTNAM-FACE-T-*-—*-PTS-%-*—%-*_CHARSET

|

DebugDefault.Font: -*-COURIER-BOLD-R-*--*-120-%-*%-*-*-1508859-1
DebugSource.Font: -*-COURIER-BOLD-R-*--%-120-*-%-%-%-TS08859-1
DebugInstruction.Font:  -*-COURIER-BOLD-R-*--%-140-*-*-%-%-TS08859-1
DebugMessage.Font: -*-COURIER-BOLD-R-*--%*-120-*%-*-*%-*-T7508859-1
DebugOptions.Font: -*-COURIER-BOLD-R-*-=*-120-*-*%-*-%_-T7508859-1

|

! STARTUP RESOURCES: 3=Iconified, 0=Visible
|

DebugSource.initialState: 0
DebugControl.initialState: 0
DebugEditor.initialState: 0
DebugInstruction.initialState: 0

(continued on next page)
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Example 10-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

COLOR RESOURCES:

Use any of the OSF Motif Named Colors.

Foreground = Text Color, Background = Window Color

Cornsilk, Lavender

To use your system default color scheme, comment out all lines

pertaining to color.

Common color scheme (unless overridden for a specific view)

*background: Gainsboro
*borderColor: Red
|

! Source View Colors

|

!DebugSource*background:  Gainsboro
DebugSource*topShadowColor:
DebugSource*bottomShadowColor:
DebugSource*src txt.foreground: blue
DebugSource*src:txt.background: white
DebugSource*src lineno txtw.foreground: red
DebugSource*cnt msg_txt.foreground: black
DebugSource*cnt _msg_txt.background: white
|

! Control View Colors

!

!DebugControl*background:  Gainsboro
DebugControl*topShadowColor:
DebugControl*bottomShadowColor:

|

! Instruction View Colors

|

!DebugInstruction*background: Gainsboro
DebugInstruction*topShadowColor:
DebugInstruction*bottomShadowColor:
DebugInstruction*inst txt.foreground: blue
DebugInstruction*inst txt.background: white

DebugInstruction*inst:addrno_txtw.foreground:

! Editor Colors
|

!DebugEditor*background:  Gainsboro

|
!
|
|
|
|
!
! Try: Gainsboro, MintCream, Linen, SeaShell, MistyRose, Honeydew
|
|
|
|
!
|
!

WindowTopshadow
WindowBottomshadow

WindowTopshadow
WindowBottomshadow

WindowTopshadow
WindowBottomshadow

red

DebugEditor*topShadowColor: WindowTopshadow
DebugEditor*bottomShadowColor: WindowBottomshadow

DebugEditor*edit textw.foreground: black
DebugEditor*edit textw.background: white

(continued on next page)
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Example 10-1 (Cont.) System Default Debugger Resource File (DECWS$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)

! REGISTER VIEW RESOURCES:

! Which Registers to display by default in the Register View?
! CF = Call Frame, GP = General Purpose, FP = Floating Point (Integrity server and Alpha Only)

*Show CF _Registers.set: True
*Show_GP_Registers.set: False
*Show FP Registers.set: False
|

! SHOW MESSAGE/COMMAND SEPARATOR LINES?
!

*Show_Message Separators.set: True
|

! TRACK LANGUAGE CHANGES? (parser follows module language)
|

*Track Language Changes.set: False
KEY SEQUENCE RESOURCES:

|

!

!

! Key sequence used to activate the dialog box for conditional and action
! breakpoints.

!

e
|

DebugSource.ModifyBreakpointToggleSequence: Ctrl <BtnlDown>, Ctrl <BtnlUp>

! GENERAL KEYPAD FUNCTIONS:

|

| <Key>0xFFB0=KP0, <Key>0xFF91,<Key>0xFFB0=GOLD-KPO,

!<Key>0xFF94,<Key>0xFFB0=BLUE-KP0, <Key>0xFFB1=KP1l,

!<Key>0xFF91,<Key>0xFFB1=GOLD-KP1, <Key>0xFFAC=KP,

DebugSource. *XmText.translations:#override\n\
<Key>0xFFB0: EnterCmdOnCmdLine("step/line") \n\
<Key>0xFFBl: EnterCmdOnCmdLine("examine") \n\
<Key>0xFFAC: EnterCmdOnCmdLine("go") \n\
<Key>0xFF91,<Key>0xFFB0: EnterCmdOnCmdLine("step/into") \n\
<Key>0xFF94,<Key>0xFFB0: EnterCmdOnCmdLine("step/over") \n\
<Key>0xFF91,<Key>0xFFBl: EnterCmdOnCmdLine("examine"") \n\
<Key>0xFFB5: EnterCmdOnCmdLine("show calls") \n\
<Key>0xFF91,<Key>0xFFB5: EnterCmdOnCmdLine("show calls 3") \n\
<Key>0xFF8D: activate()\n

NOTE: DO NOT use any double click combination for the following resource

|

! IDENTIFIER WORD SELECTION: (language-based delimiters)

|

! otherwise normal text selection in the source window will not work.

DebugSource.IdentifierSelectionSequence: Ctrl<BtnlDown>

|
!
! EXIT CONFIRMATION:

!

DebugDisplayExitConfirmDB: True

(continued on next page)
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Example 10-1 (Cont.) System Default Debugger Resource File (DECW$SYSTEM_
DEFAULTS:VMSDEBUG.DAT)
|

! COMMAND ECHO:
!

DebugEchoCommands:  True
|

TITLE FORMAT: Main window and optional view window.
The following title format directives are supported:

%t - The title of the debugger application.
%p - The name of the user program being debugged.

|
|
|
|
!
!
! %f - The name of the current file displayed in the source window.
|

DebugControl.TitleFormat: %t - %p: $f
!

DRAG AND DROP MESSAGE SUPRESSION: (Dont mess with these)

|
!
*.dragInitiatorProtocolStyle: DRAG_NONE
*.dragReceiverProtocolStyle: DRAG NONE

10.10.4.1 Defining the Key Sequence to Display the Breakpoint Dialog Box

By default, the key sequence for displaying the dialog box for conditional and
action breakpoints is Ctrl/MB1 (see Section 10.4.6 and Section 10.4.7). To define
another key sequence, edit the current definition of the following resource in the
resource file. For example:

DebugSource.ModifyBreakpointToggleSequence:  Ctrl<BtnlDown>(2)

10.10.4.2 Defining the Key Sequence for Language-Sensitive Text Selection

By default, the key sequence for language-sensitive text selection in the main
window and instruction view is Ctrl/MB1 (see Section 10.5.1). To define another
key sequence, edit the current definition of the following resource in the resource
file. For example:

DebugSource.IdentifierSelectionSequence: Ctrl<BtnlDown>

To avoid conflict with standard HP DECwindows Motif for OpenVMS word
selection, do not use a double-click combination, such as Ctrl<Btn1Down>(2).

10.10.4.3 Defining the Font for Displayed Text

To define another font for the text displayed in various debugger windows and
views, edit the current definition of the following resources in the resource file.
For example:

DebugDefault.Font: -*-COURIER-BOLD-R-*--%-120-%-%-%-%-1508859-1

10.10.4.4 Defining the Key Bindings on the Keypad

To bind a different command to a key that is already associated with a command,
edit the current definition of the following resources in the resource file. For
example:

<literal>(<Key>)0xFFB0: EnterCmdOnCmdLine("step/line 3") \n\

To bind a command to a key that is not currently associated with a command,
refer to the Keysym Encoding chapter of the X and Motif Quick Reference Guide
for key designations.
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10.11 Debugging Detached Processes
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You cannot use the HP DECwindows Motif for OpenVMS user interface to the
debugger to debug detached processes, such as print symbionts, which run
without a command line interpreter (CLI).

To debug a detached process that runs without a CLI, use the character-cell
(screen mode) interface to the debugger (see Section 1.11).



Part IV

PC Client Interface

This part introduces the debugger’s PC client interface.
For information about the debugger’s command interface, see Part II.

For information about the debugger’s Decwindows Motif interface, see Part III.
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Using the Debugger PC Client/Server Interface

This chapter describes the PC client/server interface to the debugger.

Note

The OpenVMS Version 7.3 debugger does not support previous versions of
the PC client. You must install the Version 1.1 PC client that is found in
the kit on the OpenVMS Version 7.3 distribution media, as identified in
Section 11.2.

Version 1.1 PC client is compatible with OpenVMS Version 7.3 and prior
debugger servers.

11.1 Introduction

The debug server runs on OpenVMS systems. The client is the user interface
to the debugger, from which you enter debugger commands that are sent to the
server. The server executes the commands and sends the results to the client
for display. The client runs on Microsoft Windows 95, Windows 98, Windows NT,
Windows 2000, and Windows XP.

[DEBUG_CLIENTSO11.KIT]DEBUGX86011.EXE

11.2 Installation of PC Client

There is no special installation procedure for the components that run on
OpenVMS. The system administrator must move the OpenVMS debug client kit
listed in the previous section from the OpenVMS distribution media to a place
accessible to PC users, such as a PATHWORKS share or an FTP server. The
client kit is a self-extracting .EXE file.

Once the appropriate executable file has been transferred to the PC, you can
run the file to install the debug client on the PC. The InstallShield installation
procedure guides you through the installation.

By default, the debug client is installed in the \Program Files\OpenVMS Debugger
folder. You can also click Browse to select an alternate location.

The installation creates an OpenVMS Debugger program folder that contains
shortcuts to the following items:

¢ Debug client
¢ Debug client Help file
e README file

e  Uninstall procedure
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11.3 Primary Clients and Secondary Clients

The primary client is the first client to connect to the server. A secondary client
is an additional client that has connected to the same server. The primary client
controls whether or not any secondary clients can connect to the server.

See Section 11.5 for details about specifying the number of secondary clients
allowed to connect to a debugging session.

11.4 The PC Client Workspace

The PC client workspace is analogous to the workspace of the Motif client (see
Chapter 8). The client workspace contains views to display dynamic information
and toolbars to contain shortcuts to debugger commands. You can configure the
views and toolbars to suit your personal requirements, create your own shortcuts,
and save your personal configurations.

These topics are discussed at length in the PC client Help file. You can access
the PC client Help directly from the OpenVMS Debugger folder that you created
during PC client installation (see Section 11.2), or from the Help menu within the
client. See the following topics:

e  Overview
e Getting Started
e Views

e Toolbars

11.5 Establishing a Server Connection

You can start the debug server after logging in directly to the OpenVMS system,
or you may find it more convenient to log in remotely with a product such as
eXcursion, or a terminal emulator such as Telnet.

Note

You must hold the DBGSENABLE_SERVER identifier in the rights
database to be able to run the debug server. Exercise care when using the
debug server. Once a debug server is running, anyone on the network has
the ability to connect to the debug server.

Before granting the DBGSENABLE_SERVER identifier, the system manager
must create it by entering the command DEBUG/SERVER from an account
with write access to the rights database. The system manager needs to do this
only once. The system manager can then run the Authorize utility to grant the
DBG$ENABLE_SERVER identifier to the user.

To start the debug server, enter the following command:
$ DEBUG/SERVER

The server displays its network binding strings. The server port number is
enclosed in square brackets ([]). For example:
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$ DEBUG/SERVER

$DEBUG-I-SPEAK: TCP/IP: YES, DECnet: YES, UDP: YES

$DEBUG-I-WATCH: Network Binding: ncacn ip tcp:16.32.16.138[1034]
$DEBUG-I-WATCH: Network Binding: ncacn_dnet nsp:19.10[RPC224002690001]
$DEBUG-I-WATCH: Network Binding: ncadg ip udp:16.32.16.138[1045]
$DEBUG-I-AWAIT: Ready for client connection...

Use one of the network binding strings to identify this server when you connect
from the client (see Section 9.9.4).

Note

You can usually identify the server using only the node name and the port
number. For example, nodnam[1034].

To establish a connection from the PC client, invoke the Connection dialog, either
from the File pull-down menu, or by selecting the C/S button on the Main toolbar.
The dialog displays the servers already known to this client, and the sessions
currently active by this client.

You can specify a server for a new connection, or select a particular session for
use.

From the buttons at the bottom of the dialog, you can
e Connect to the selected (or the default) server

e Disconnect from a server

e Test the client/server connection

e Stop the selected server

In addition, the Advanced button allows you to select the network protocol to
be used (see Section 11.5.1), and to select the number of secondary clients (0-30)
allowed for the client/server connection to be established (see Section 11.5.2).

11.5.1 Choosing a Transport

From the Connection dialog, select the network protocol to be used for the
client/server connection from the following:

e TCP/IP
e DECnet
e UDP

11.5.2 Secondary Connections

From the Connection dialog, you can enable up to 30 secondary clients to connect
to the server. You must be the primary client (the first client to connect to this
server), and perform the following steps:

1. On the Connection dialog, click Advanced.
2. Select the number of secondary clients (0-30) to be permitted.

3. Click Connect on the Connection dialog.
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The debugger dismisses the Connection dialog, makes the connection, and
indicates success (or failure) in the Command view. You can now begin your
debugging procedures.

11.6 Terminating a Server Connection

You can stop a server by entering Ctrl-Y on the node on which the server is
running. If you do so, then enter the DCL STOP command.

To stop the server from the client, perform the following steps:
1. Open the File pull-down menu.
2. Select Exit.

3. Click Server to stop only the server, or click Both to stop both the server and
the client.

An alternative way to stop the server is to perform the following steps:
1. Open the File pull-down menu.

2. Click Connection to invoke the Connection dialog.

3. Select the server connection from the Active Sessions list.

4. Click Stop.

11.6.1 Exiting Both Client and Server

To stop both the server and the client, perform the following steps:
1. Open the File pull-down menu.

2. Click Exit.

3. Click Both.

11.6.2 Exiting the Client Only

To stop only the client, perform the following steps:
1. Open the File pull-down menu.

2. Click Exit.

3. Click Client.

11.6.3 Stopping Only the Server
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To stop only the server, perform the following steps:
1. Open the File pull-down menu.

2. Click Exit.

3. Click Server.
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11.7 Documentation

In addition to the PC client Help file, the OpenVMS Debugger Manual is online
in HTML format. To access the manual from within the client, do the following:

1. Open the Help pull-down menu.
2. Click Contents.
3. Click Local Manual.
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Advanced Topics

This part describes advanced debugging techniques available in the OpenVMS
Debugger.
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Using the Heap Analyzer

The Heap Analyzer, available on OpenVMS Integrity servers and Alpha systems,
is a feature of the debugger that provides a graphical representation of memory
use in real time. By studying this representation, you can identify areas in your
application where memory usage and performance can be improved. For example,
you might notice allocations that are made too often, memory blocks that are too
large, evidence of fragmentation, or memory leaks.

After you locate an area of interest, you can request an enlarged, more detailed,
or altered view. You can also request additional information on the size, contents,
or address of the allocations shown.

After you narrow your interest to an individual allocation, you can request
traceback information. The analyzer allows you to correlate the traceback entry
for an allocation with source code in your application program. By scrolling
through the source code display, you can then identify problematic code and
decide how to correct it.

This chapter describes the following:

e Starting a Heap Analyzer session (Section 12.1)

e  Working with the default display (Section 12.2)

e Adjusting type determination and display (Section 12.3)
e Exiting the Heap Analyzer (Section 12.4)

e Sample session (Section 12.5)

12.1 Starting a Heap Analyzer Session
The following sections describe how to invoke the Heap Analyzer and run your
application.

12.1.1 Invoking the Heap Analyzer

You can invoke the Heap Analyzer during a debugging session in one of the
following ways:

1. In the debugger main window, choose Run Image or Rerun Same from the
File menu. When a dialog box appears, select the program you wish to
execute and click the Heap Analyzer toggle button.

2. At the debugger command entry prompt, enter the RUN/HEAP_ANALYZER
or RERUN/HEAP_ANALYZER program-image command.

3. On Alpha systems: At the DCL prompt ($) in a DECterm window outside the
debugger, enter the following command and then execute your program:

$ DEFINE/USER/NAME=CONFINE LIBRTL SYSSLIBRARY:LIBRTL INSTRUMENTED
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To use the heap analyzer with a protected image, enter the following
command and then execute your program:

$ DEFINE/EXEC/NAME=CONFINE LIBRTL SYS$LIBRARY:LIBRTL_INSTRUMENTED
This is necessary if the image was installed with the following command:
$ INSTALL ADD imagename/PROTECTED

You can invoke the Heap Analyzer outside a debugging session by entering

the DEFINE/USER (or DEFINE/SYSTEM) command detailed above, and then

the DCL command RUN/NODEBUG.

4. On Integrity server systems, at the Debug prompt (DBG>), enter the START
HEAP_ANALYZER command.

Note

The Heap Analyzer startup and the Heap Analyzer START command on
the Integrity servers kept debugger (START HEAP_ANALYZER) hangs
for threaded applications with upcalls enabled.

In such instances, for threaded or AST-involved applications, HP strongly
recommends that you either start the Heap Analyzer before setting up
any debug events or after disabling or canceling the debug events. (You
can enable/reset events after the Heap Analyzer startup and START
returns you to debugger control.)

After you successfully invoke the Heap Analyzer, the Heap Analyzer startup
screen appears.

Note

On OpenVMS Alpha systems, the Heap Analyzer does not work on
programs linked with the /NODEBUG qualifier.

On OpenVMS Integrity server systems, the Heap Analyzer does work on
programs linked with the /NODEBUG qualifier, although the traceback
information displayed is minimal.

12.1.2 Viewing Heap Analyzer Windows
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The Heap Analyzer contains a main window, six subsidiary windows, and a
control panel (see Figure 12-1.)

The Memory Map, the most important window, displays a representation of
your application’s dynamic memory use. At startup, the Memory Map shows the
images that comprise your application. As your application executes, you can

see the relative location and size of individual memory blocks, images, program

regions, memory zones, and dynamic strings as they are allocated and deallocated

in memory space.

The Message window displays information on your Heap Analyzer session. At
startup, the Message window contains the message “Heap Analyzer initialization
complete. Press Start button to begin program.” As your application executes,
informational and error messages appear in this window.



Using the Heap Analyzer
12.1 Starting a Heap Analyzer Session

The Push Button Control Panel contains buttons that allow you to control the
speed of the Memory Map display. At startup, you click on the Start button to
begin executing your application. As your application executes, you can click
on other buttons in the panel to pause, slow, or otherwise affect the continuous
display.

The Information window displays information on Memory Map segments. As
your application executes, you can pause execution at any time to request specific
information.

The Source window displays the application source code associated with a
segment in the Memory Map.

The Do-not-use Type List allows you to adjust the Memory Map display by
redetermining a segment’s type, or group name.

The Views-and-Types Display allows you to adjust the Memory Map display by
selectively viewing certain segment types.

The Type Histogram displays summary and statistical information on segment
types.

As you use the Heap Analyzer, you may need to increase or decrease the size of
the window in which you are working. To do this, pull the window pane sashes
between windows or resize the screen as a whole.

12-3



Using the Heap Analyzer
12.1 Starting a Heap Analyzer Session

Figure 12-1 Heap Analyzer Windows
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1. Memory Map Shows the graphical representation of memory, that
is, the part of PO-space that is in use. Each allocation
appears as a colored strip, or segment.

2. Message Window Displays Heap Analyzer informational and error
messages and one-line segment descriptions.

3. Information Window Shows additional information on segments and
segment types that appear in the Memory Map.

4. Source Window Shows application source code.

5. Do-not-use Type List Lists routines not used as segment types, the name
that characterizes segments.

6. Views-and-Types Display Lists all segment types known to the Heap Analyzer
and allows you to alter the segment display.

7. Push Button Control Panel Provides Start/Step, Pause, Slow, and Sync buttons
that allow you to control the speed of Memory Map
display.

8. Type Histogram Shows statistics on segment size and use.
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12.1.3 Viewing Heap Analyzer Pull-Down Menus

The Heap Analyzer provides pull-down menus that are grouped over the Memory
Map (see Figure 12-2). This figure is adjusted slightly so that all menu items can
be seen.

Figure 12-2 Heap Analyzer Pull-Down Menus
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1. File Menu Allows you to exit from the Heap Analyzer

2. Display Menu Allows you to adjust the Memory Map display and to clear the
Information window

3. Zoom Menu Provides a closer or further view of the Memory Map
4. View Menu Lets you select the granularity of the display

5. Options Menu Allows you to indicate a search directory list or to adjust the Do-not-
use Type List

6. Help Menu Provides context-sensitive or task-oriented online help
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12.1 Starting a Heap Analyzer Session

12.1.4 Viewing Heap Analyzer Context-Sensitive Menus

Most operations in the Heap Analyzer, however, are accomplished through
context-sensitive pop-up menus. Most Heap Analyzer windows contain a pop-up
menu listing available tasks (see Figure 12-3). To access a window’s pop-up
menu, position your mouse pointer in the window and click MB3.

Figure 12-3 Heap Analyzer Context-Sensitive Pop-Up Menus
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2. Information Window Pop-Up
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. Views-and-Types Display Pop-Up

° Display Type

Go to Type

Do Mot Use Type

Display Type Show] : Expand Save
Go to Type Hide |:cCollapse |: Remove
Do Not Use Type Reset || Reset Reset

Provides additional information on segments
displayed in the Memory Map, allows you to
jump to a segment’s type in the Views-and-
Types Display, or adds a segment’s type to the
Do-not-Use Type List.

Allows you to jump from a line of traceback
displayed in the Information window to the
related source code in the Source window.

Deletes a segment’s type from the Do-not-Use
Type List.

Left side: Provides additional information on
segment types listed, highlights a segment type
within the Views-and-Types Display, or adds a
segment type to the Do-not-Use Type List.

Right side: Allows you to adjust display
characteristics for the segment type highlighted
in the left side of the Views-and-Types Display.

Provides additional information on segment types
listed, highlights a segment type in the Type
Histogram, or adds the segment type to the
Do-not-Use Type List.
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12.1.5 Setting a Source Directory

If you are invoking the Heap Analyzer from a directory other than the one that
stores your application source code, you can set a source directory for the Heap
Analyzer as soon as the startup screen appears.

To set a source directory:

1. Choose Set Source... from the Options menu on the Heap Analyzer screen.

The Set Source dialog box appears.

2. Enter the directory specification for your source directory as you would for the
debugger SET SOURCE command.

For more information on this command, see the SET SOURCE command.
3. Click on OK.

The Heap Analyzer can now access your application.

12.1.6 Starting Your Application

If you invoked the Heap Analyzer from within a debugging session, start your
application by performing the following steps:

1. Click on the Start button in the Push Button Control Panel.

The Message window displays an "application starting" message, and the
Start button label changes to Step. The OpenVMS Debugger main window
pops forward.

2. Click on the Go button in the debugger’s control panel, and iconize the
OpenVMS Debugger window.

Memory events associated with your application begin showing in the Memory
Map.

If you invoked the Heap Analyzer outside a debugging session, start your
application by performing only step 1 above.

After your application is running, the Memory Map (and other parts of the Heap
Analyzer display) are continuously updated to reflect the state of your application.

Unless you intervene (see Section 12.1.7), this updating continues until an
occurrence causes memory events to stop. For example, your application might
prompt for input, the debugger might prompt for input, or your application might
finish execution.

12.1.7 Controlling the Speed of Display

To examine events in the Memory Map as your application is executing, you can
use the Heap Analyzer’s push buttons to slow, pause, and otherwise affect the
speed of the display. Figure 12—4 shows these push buttons on the Heap Analyzer
window just after the Start button was pushed.

The Slow and Pause push buttons allow you to slow or pause the display.
The Step push button allows you to single-step through memory events.

The Sync histogram (not shown) to the right of the Sync button indicates how far
behind your application the Heap Analyzer is running. For performance reasons,
the Heap Analyzer displays memory events a few seconds after their occurrence
in your application.
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Figure 12-4 Heap Analyzer Control Panel
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1. Start Button  Click to start executing your application and enable the Memory Map
display. Once you do so, the Start button changes to a Step button,
which is initially dimmed (inaccessible).

2. Step Button Click to single-step through memory events in the Memory Map
display. This button is dimmed until you click on the Pause button.

3. Pause Button Click to stop (or restart) execution of your application and the dynamic
Memory Map display.
4. Slow Button Click to slow the dynamic Memory Map display.

5. Sync Button Click to force concurrent execution of your application program and
display of memory events in the Memory Map.

The Sync push button allows you to synchronize Heap Analyzer display and
application execution, if this is important to you. Your application runs more
slowly when you request synchronization.

On OpenVMS Alpha systems, anything that uses system service interception,
like the debugger or the Heap Analyzer, is unable to intercept system service call
images activated by shared linkage. The image activator, therefore, avoids shared
linkage for images linked or run with /DEBUG, and instead activates private
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image copies. This affects performance of applications under Heap Analyzer
control, as images activated by shared linkage run faster.

12.2 Working with the Default Display

The following sections describe how to use the Heap Analyzer when memory
problems are clearly visible in the default Memory Map display.

Visible problems include allocations that are larger than you expect, that repeat
numerous times, that increment at each allocation, and that could occur in a
more efficient way.

In such cases, your Heap Analyzer session consists of the following steps:
1. Examine the Memory Map display.

2. Set display characteristics in the Memory Map (optional).

3. Request additional information on individual segments (optional).

4. Request traceback information on individual segments.
5

Correlate traceback entries with source code routines.

12.2.1 Memory Map Display

Depending on the size of your application, you may wish to examine the Memory
Map display as your application is running (by using the push buttons to slow,
pause, or step through events) or after your application completes running (by
using the Memory Map’s vertical scroll bar to scroll back through the display).

You can identify segments whose size or location are not what you expect by
remembering that a segment’s location in the Memory Map corresponds to

its location in dynamic memory. Lower addresses in dynamic memory are
represented in the upper left of the Memory Map display. Addresses increase to
the right and wrap at each line of the display.

12.2.2 Options for Memory Map Display

As you examine the Memory Map, you may wish to select display options that
allow you to see more clearly those parts of the display you are most interested
in.

The Display Menu allows you to control whether you see segment type names
within the Memory Map display, whether the display automatically scrolls to
show the most recent activity, and whether you can compress the display.

The Zoom Menu allows you to control the degree of magnification with which you
see segments in the Memory Map. Choosing the Far menu item, for example,
shows an overview of memory. Choosing Extremely Close shows a more detailed
view of memory.

Figure 12-5 shows the display options that appear in the Display pull-down
menu. The figure then lists all the display options available in the Memory Map.
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Figure 12-5 Heap Analyzer Display Menu and Zoom Menu
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1. Display Menu Text Visible: (Default.) Labels each segment in the Memory Map
with a segment name, provided that the segment is large enough
to carry a name label.

Auto Scroll: (Default.) Automatically scrolls the Memory Map to
the highest memory addresses (lower right) whenever the display
is expanded.

Reduce Scroll Region: When you request a limited or partial
Memory Map display (see Section 12.3.3.2), compresses the display
so that you can see as many segments as possible without scrolling
to their location in the original display.

Display All Segments: Displays segment definitions for all
segments in the Memory Map.

Clear Information Window: Clears text and messages from the
Information window.

2. Zoom Menu Options provide a closer or more distant view of the Memory Map.
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12.2.3 Options for Further Information

As you examine the Memory Map display, you may find that you need more
information on those segments that interest you. The Memory Map pop-up menu
allows you to request segment, contents, address, and type definitions for an
individual segment.

A segment definition has the following form:

cursor-address n:init-address + length = end-address name ( view )

cursor-address The address beneath your cursor when you click MB3.

n The number of your segment within the sequence of total segments.
init-address The initial address of your segment.

length The length (in bytes) of your segment.

end-address The last address of your segment.

name The segment type name of your segment.

view The view of your segment: block, image, region, or zone. (See

Section 12.3.3.2 for more information on views.)

For example, the following segment definition describes the 15th segment in your
Memory Map display, which is a segment of type LIBRTL:

0004ECA5 15: 00040000+0001CA00=0005CA00 LIBRTL (Image)

A contents definition consists of a partial segment definition (a segment definition
without a cursor-address) and an ASCII representation of the contents of segment
addresses. For example:

contents of: 38: 001C7000+000000C0=001C70C0
LIBTRL\LIB$VM\LIB$GET_VM (Block)

[ASCII representation]

An address definition takes the form of a statement describing user access to a
stated address. For example:

001C710B is read and write accessible by the user

A type definition takes the form of a statement summarizing the total number of
segments and total number of bytes devoted to a segment type. For example:

LIBRTL\LIB$VM\LIBSGET VM (Block) has 39 segments
using 00002160 bytes

Figure 12-6 shows the Memory Map context-sensitive pop-up menu. The figure
then lists all the mouse and pop-up menu item choices available in the Memory
Map.
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Figure 12-6 Heap Analyzer Memory Map Context-Sensitive Pop-Up Menu
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Click MB1: Displays the segment definition in the Message window.
Traceback of Allocation: Displays the traceback information associated
with a segment in the Information window (see Section 12.2.4).

Display Segment: Displays the segment definition in the Information
window.

Display Contents: Displays the segment definition and contents of each
address in the Information window.

Display Address: Displays the position (address) under your cursor and
the type of user access in the Information window.

Display Type: Displays the segment type definition in the Information
window.

Go to Type: Allows you to jump from a segment type listed in the Type
Histogram to the same segment type listed in the Views-and-Types
Display.

Do Not Use Type: Adds a segment type to the Do-not-use Type List.
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12.2.4 Requesting Traceback Information

After you identify an individual segment of interest, choose the Traceback of
Allocation menu item in the Memory Map pop-up menu. Traceback information
can help you understand why your segment was created. Viewing traceback is
also a preliminary step to displaying application code.

Traceback information consists of a partial segment definition (a segment
definition without a cursor address) and the list of element